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[M] micromeritics®

TRADEMARKS

Alconox is a registered trademark of the Alconox Company.

Flex is a registered trademark of Micromeritics Instrument Corporation.
Fomblin is a registered trademark of Solvay S.A.

Hastelloy is a registered trademark of Haynes International, Inc.

Kimwipe is a registered trademark of Kimberly-Clark Corporation.

MATLAB is a registered trademark of MathWorks.

MicroActive is a trademark of Micromeritics Instrument Corporation.
Micromeritics is a registered trademark of Micromeritics Instrument Corporation.
Microsoft and Windows are registered trademarks of Microsoft Corporation.
Nupro is a registered trademark of Nupro Company.

Python is a registered trademark of Python Software Foundation.

Smart VacPrep is a trademark of Micromeritics Instrument Corporation.
Teflon is a registered trademark of E. |. DuPont de Nemours Company.
TRIGEL is a trademark of Ball Screws & Actuators Co., Inc.

Viton is a registered trademark of E. |. DuPont Co., Inc.

This application may contain a binary form of the Info-ZIP tool to create .zip files. That source code is provided under the
following license:

This software is provided "as is," without warranty of any kind, express or implied. In no event shall Info-ZIP or its
contributors be held liable for any direct, indirect, incidental, special or consequential damages arising out of the use of
or inability to use this software.

Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it
and redistribute it freely, subject to the following restrictions:

1. Redistributions of source code must retain the above copyright notice, definition, disclaimer, and this list of con-
ditions.

2. Redistributions in binary form must reproduce the above copyright notice, definition, disclaimer, and this list of
conditions in documentation and/or other materials provided with the distribution.

3. Altered versions — including, but not limited to, ports to new operating systems, existing ports with new graph-
ical interfaces, and dynamic, shared, or static library versions — must be plainly marked as such and must not
be misrepresented as being the original source. Such altered versions also must not be misrepresented as
being Info-ZIP releases — including, but not limited to, labeling of the altered versions with the names "Info-ZIP"
(or any variation thereof, including, but not limited to, different capitalizations), "Pocket UnZip," "WiZ" or
"MacZip" without the explicit permission of Info-ZIP. Such altered versions are further prohibited from mis-
representative use of the Zip-Bugs or Info-ZIP e-mail addresses or of the Info-ZIP URL(s).

4. Info-ZIP retains the right to use the names "Info-ZIP," "Zip," "UnZip," "WiZ," "Pocket UnZip," "Pocket Zip," and
"MacZip" for its own source and binary releases.

Copyright

The software described in this manual is furnished under a license agreement and may be used or
copied only in accordance with the terms of the agreement.

Copyright © 2013 - 2021. Micromeritics Instrument Corporation. All rights reserved.
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WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each instrument it
manufactures to be free from defects in material and workmanship impairing its usefulness under normal use and
service conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any
instrument or defective parts when returned prepaid to us and which our examination discloses to have been defective.
The purchaser is responsible for all transportation charges involving the shipment of materials for warranty repairs.
Failure of any instrument or product due to operator error, improper installation, unauthorized repair or alteration, failure
of utilities, or environmental contamination will not constitute a warranty claim. The materials of construction used in
MICROMERITICS instruments and other products were chosen after extensive testing and experience for their
reliability and durability. However, these materials cannot be totally guaranteed against wear and/or decomposition by
chemical action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and authorization
to return the instrument or product. All repairs or replacements are made subject to factory inspection of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications are
made by persons other than its own authorized service personnel unless such work is authorized in writing by
MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their
respective brand names or trade names. We, therefore, make no express or implied warranty as to such
products. We shall use our best efforts to obtain from the manufacturer, in accordance with his customary prac-
tice, the repair or replacement of such of his products that may prove defective in workmanship or materials. Ser-
vice charges made by such manufacturer are the responsibility of the ultimate purchaser. This states our entire
liability in respect to such products, except as an authorized person of MICROMERITICS may otherwise agree
to in writing.

2. Ifaninstrument or product is found defective during the warranty period, replacement parts may, at the dis-
cretion of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check valves,
seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and
stems, seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects. Such
items which perform satisfactorily during the first 45 days after the date of shipment are assumed to be free of
manufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manufactures a
special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of its
products other than the liability stated above. This warranty is in lieu of all other warranties, express or implied, including
but not limited to, the implied warranties of merchantability or fitness for use.
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CORPORATE PROFILE

Micromeritics Instrument Corporation is the world’s leading supplier of high-performance systems
to characterize particles, powders and porous materials with a focus on physical properties,
chemical activity, and flow properties. Our technology portfolio includes: pycnometry, adsorption,
dynamic chemisorption, particle size and shape, intrusion porosimetry, powder rheology, and
activity testing of catalysts. The company has R&D and manufacturing sites in the USA, UK, and
Spain, and direct sales and service operations throughout the Americas, Europe, and Asia.
Micromeritics systems are the instruments-of-choice in more than 10,000 laboratories of the
world’s most innovative companies, prestigious government, and academic institutions. Our
world-class scientists and responsive support teams enable customer success by applying
Micromeritics technology to the most demanding applications. For more information, please visit
www.Micromeritics.com.
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CONTACT Us

Micromeritics Instrument Corporation
4356 Communications Drive
Norcross, GA/USA /30093-2901
Phone: 1-770-662-3636
Fax: 1-770-662-3696
www.Micromeritics.com

Instrument Service or Repair
Phone: 1-770-662-3666
International — contact your local distributor or call 1-770-662-3666
Service.Helpdesk@Micromeritics.com

Micromeritics Learning Center
Phone: 1-770-662-3607
www.Micro.edu

Flex Series Operator Manual i
350-42800-01 (Rev R) — Apr 2021


http://www.micromeritics.com/

About this Manual El micromeritics’

ABOUT THIS MANUAL

The following can be found on the Micromeritics web page (www.Micromeritics.com).

m Calculations document (PDF) m Smart VacPrep Operator Manual
m Error Messages document (PDF) (PDF)
m Parts and Accessories m Vacuum Pump Guide (PDF)

m = All references to 3500, Flex, or Flex Series in this document encompass the Flex,
3Flex, and Flex Confirm environments unless otherwise noted.

The following symbols or icons indicate safety precautions and/or supplemental information and
may appear in this manual:

Common Ilcons

Icon Refers to

C| Chemisorption and Dynamic Analysis

Physisorption only

Dynamic Analysis

Chemisorption only

CAUTION — Cautions contain information to help prevent actions that may damage
the analyzer or components.

P
DA
SC
/ NOTE — Notes contain important information applicable to the topic.

Flex Series Operator Manual
350-42800-01 (Rev R) — Apr 2021


http://www.micromeritics.com/

[M] micromeritics’ Abouttis Manu

A WARNING — Warnings contain information to help prevent actions that may cause
personal injury.

CFR NOTE — Notes that apply to 21CFR11 environments only (Confirm applications).

Note Dynamic Analysis and Chemisorption options are not applicable when the software is
installed in 21CFR11 environments.
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GENERAL SAFETY

A Do not modify this instrument without the authorization of a Micromeritics service per-
sonnel.

A Toxic or flammable gases require proper venting of exhaust.

& Use caution in the areas where this symbol is displayed on the instrument — such as
the heating mantles and furnace. These surfaces may be hot and could cause serious
burns. Use the gloves supplied in the accessories kit.

Any piece of laboratory equipment can become dangerous to personnel when improperly
operated or poorly maintained. All employees operating and maintaining Micromeritics
instruments should be familiar with its operation and should be thoroughly trained and instructed

on safety.

m Read the manual for any special operational instructions for the instrument.
m Know how the instrument functions and understand the operating processes.

Wear the appropriate personal protective equipment when operating this instru-
ment — such as eye protection, lab coat, protective gloves, etc.

When lifting or relocating the instrument, use proper lifting and transporting devices
for heavy instruments. Ensure that sufficient personnel are available to assist in
moving the instrument. The Flex weighs approximately 103 - 106 kg (227 - 234 Ib)
depending on configuration.

Always pay attention to the safety instructions provided on each label affixed to the
instrument and do not alter or remove the labels. When inspecting the instrument,
ensure that the safety labels have not become worn or damaged.

The Flex has a safety shield. Ensure it is in place when operating the instrument.
Proper maintenance is critical to personnel safety and smooth instrument oper-
ation and performance. Instruments require regular maintenance to help promote
safety, provide an optimum end test result, and to prevent costly down time. Failure
to practice proper maintenance procedures can lead to unsafe conditions and
shorten the life of the instrument.

Improper handling, disposing of, or transporting potentially hazardous materials
can cause serious bodily harm or damage the instrument. Always refer to the
MSDS when handling hazardous materials. Safe operation and handling of the
instrument, supplies, and accessories is the responsibility of the operator.

\Y
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INTENDED USE

Micromeritics Flex Surface Characterization Analyzer is a fully automated one, two or three
station instrument capable of high-performance physisorption and chemisorption analyses with
superior accuracy, resolution, and data reduction.

The instrument is intended to be operated by trained personnel familiar with the
proper operation of the equipment recommended by the manufacturer as well as
relevant hazards involved and prevention methods. All use, other than that described
in this manual, is seen as unintended use and can cause a safety hazard.

/ The instrument is intended to be used as per applicable local and national regulations.

Flex Series Operator Manual
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TRAINING

It is the responsibility of the customer to ensure that all personnel operating or maintaining the

equipment participate in training and instruction sessions. All personnel operating, inspecting,

servicing, or cleaning this instrument must be properly trained in operation and machine safety
before operating this instrument.

ENVIRONMENTALLY FRIENDLY USE PERIOD

Hazardous Substances Table

Hazardous Substances

Part Name |Lead |Mercury Cadmium | Hexavalent |Polybrominated |Polybrominated

(Pb) (Hg) (Cd) Chromium biphenyls diphenyl ethers

(Cr (VD)) (PBB) (PBDE)

Cover X o o o) o) 0
Power X o o o o o
Supplies
Printed
Circuit X o o o) o) o]
Boards
Cables, Con-
nectors & X o o o) o o
Transducers

o Hazardous substance is below the specified limits as described in SJ/T11363-2006.
x  Hazardous substance is above the specified limits as described in SJ/T11363-2006.

The Environmentally Friendly Use Period (EFUP) for all enclosed products
and their parts are per the symbol shown here, unless otherwise marked. Cer-
tain parts may have a different EFUP (for example, battery modules) and so | 25 :
are marked to reflect such. The Environmentally Friendly Use Period is valid \ d
only when the product is operated under the conditions defined in the product

manual.
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EI micromeritics® 1 Analyzer Components

1 ANALYZER COMPONENTS

CFR Dynamic Analysis and Chemisorption options are not applicable when the software is
Note installedin 21CFR11 environments.

Parts and accessories can be found online at www.Micromeritics.com.

FRONT COMPONENTS

Physisorption Chemisorption Cold Trap option

Front Components

Component Description
A | Access panels to Lift the pad and panel to access the reset buttons for the mantle,
reset buttons heater, and transformer.
B Elevator The elevator raises and lowers automatically when the analysis

is started and completed. During analysis, the elevator option-
ally lowers after the free space measurement to allow evac-
uation, then raises and continues the analysis.

C Mantle / Furnace Power connector for the mantle or furnace.
power connector

D Mantle / Furnace ther-| Connector for the thermocouple.
mocouple connector

Flex Series Operator Manual 1-1
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1 Analyzer Components

[M] micromeritics®

Front Components (continued)

Component

Description

E

Elevator reset button

Resets the elevator in case of failure. The message Elevator Cir-
cuit Breaker Open on the analyzer schematic indicates this reset
button should be used.

F Pg tube For measuring the saturation pressure.
Sample ports For installing up to three sample tubes.
H Manifold com- Holds the removable manifold compartment cover.
partment cover latch
| Power indicator light | Blinks when power is applied to the analyzer; illuminates when
the analysis program is initiated and ready for operation.
J Cooling gas port Forces air into the furnace to cool it down.
K | Thermocouple For chemical adsorption samples.

Cold Trap option Attaches to the left side of the analyzer and removes water of
reaction or other reaction products that might interfere with the
operation of the thermal conductivity detector or to remove
impure vapors in the analysis gas stream, especially water
vapor.

1-9 Flex Series Operator Manual
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1 Analyzer Components

BACK AND SIDE COMPONENTS

A. Power cord connector
B

. Vacuum pump foreline
connector

C. Gasinletvalves
D. Compressed air connector

E. Mass Spec external trig-
ger connector

F. Exhaust port
G. Mass Spec port

Chemisorption units

only
Back and Side Components
Components Description
Compressed For compressed air supply for the pneumatically actuated, hard seal

air connector

valves.

Ethernet port
(not shown)

Located on the side panel. Port for an Ethernet cable allowing com-
munication between the analyzer and the computer.

Exhaust port [&

The top port is to vent flowing chemisorption gas. The bottom port is
used for the optional mass spectrometer.

Gas inlet valves

Inlet valves 1-6 for analysis gases.

Mass spectrometer
external trigger signal

For connecting the external trigger signal for the optional mass spec-
trometer.

Mass spectrometer
exhaust port [&

For connecting the exhaust line for the optional mass spectrometer.

Power switch
(not shown)

Located on the side panel. For powering the analyzer on and off.

Power cord connector

For setting the power voltage and connecting the analyzer to the
power supply.

RS232 port (not shown)

Located on the side panel. connect the Smart VacPrep.

Vacuum pump foreline
connector

For attaching the dry diaphragm roughing vacuum pump hose.

Flex Series Operator Manual
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EQUIPMENT OPTIONS AND UPGRADES

Parts and accessories can be found online at www.Micromeritics.com.

Equipment Option Description

Chemisorption Includes a Mass Flow Controller for precise flowing preparation of
samples, a furnace to control sample temperature from ambient to
1100 °C, quartz flow-through sample tubes, an exhaust port for
venting hazardous gases, a mass spectrometer port and electronic
trigger signal, and six additional gas inlets for a total of twelve. The
single chemisorption port is port number 2. The micropore option is
required for the chemisorption port.

Chiller Dewar A closed loop recirculating system that utilizes a high surface area
copper coil to provide excellent heat transfer between the Dewar and
the recirculating liquids. The Chiller Dewar Quick Start Guide [part
number 025-42801-00] can be found on the Micromeritics web page
(www.Micromeritics.com).

CryoStat A closed-cycle CryoCooler based on the Gifford-McMahon (GM) refri-
geration principle. It uses helium gas from a helium compressor to
generate cryogenic temperatures. The cryostat eliminates the need
for liquid nitrogen and can obtain temperatures below the 77 K of
liquid nitrogen. The decibel rating of the CryoStat HC-4A Zephyr is

56 dBA at 1 meter.

Micropore Option Each port on the standard analyzer can be upgraded for high quality
micropore analyses with 10 torr and 0.1 torr transducers on each
micropore port. Any remaining ports continue to operate in standard
mode.

The micropore option is required to run krypton.

Thermal Conductivity |With the TCD option, dynamic analyses provide the ability to perform
Detector (TCD) temperature programmed reduction (TPR), oxidation (TPO),
desorption (TPD), and reactions (TPRx).

Provides the capability to investigate temperature dependence of
specific adsorption or desorption process profiles for catalyst and
adsorbents, as well as pulse chemisorption.

Vacuum Pump The analyzer requires a dry roughing vacuum pump for sample
analysis. Appropriate vacuum pumps are available from
Micromeritics.
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Iml micromeritics® Equipment Options and Upgrades

Equipment Option Description
Vapor Adsorption Vapor adsorption allows analyses with hydrocarbon vapors or water
Option vapor. The analyzer allows for dosing from one dedicated sample

port to the other two sample ports.

A vapor adsorption option provides for dosing from a reservoir
attached to the Psat port to all three sample ports. The vapor option
includes a stainless steel chamber with a hard seal, manual cutoff
valve to be attached in place of the Psat tube, and a heating mantle to
control the temperature of the chamber at an operator-specified
temperature between ambient and 43 °C.

Degasser Options Description

FlowPrep The FlowPrep applies both heat and a stream of inert gas to the
sample to remove adsorbed contaminants from the surface and pores
in preparation for analysis for up to six samples. Choose the tem-
perature, gas, and flow rate best suited for your sample material. The
FlowPrep is an independent unit and not controlled by the analyzer.

Smart VacPrep The Smart VacPrep prepares samples by heating and evacuation. It
contains six sample ports in which up to five temperatures, ramp
rates, and soak times per sample are individually controlled by the
analyzer program so that all degas information is integrated into the
sample data file for future reference. Samples can also be prepared,
started, and completed independently. There is no need to wait for
samples on other ports to finish. Front panel buttons allow a
QuickStart operation with preprogrammed conditions.

Up to three additional Smart VacPrep degassers can be connected to
one computer permitting 24 preparation ports to be used. The Smart
VacPrep is the recommended degassing unit.

VacPrep The VacPrep offers two methods for removing contaminants. In addi-
tion to flowing gas, it provides vacuum to prepare samples by heating
and evacuation of up to six samples. This combination provides pre-
paration method options best suited to your material or application.
Needle valves are also provided for introducing the vacuum slowly to
prevent fluidization of samples. The VacPrep is an independent unit
and not controlled by the analyzer.
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GAS REQUIREMENTS AND PURITY

Improper handling, disposing of, or transporting potentially hazardous materials can
cause serious bodily harm or damage the instrument. Always refer to the MSDS when
handling hazardous materials. Safe operation and handling of the instrument,
supplies, and accessories is the responsibility of the operator.

Compressed gases are required for analyses. Gas cylinders or an outlet from a central source
should be located near the analyzer.

Appropriate two-stage regulators which have been leak-checked and specially cleaned are
required. Pressure relief valves should be set to no more than 30 psig (200 kPag). All gases
should be of a purity listed below. Gas regulators can be ordered from Micromeritics. Parts and
accessories can be found online at www.Micromeritics.com.

All analyzer types Chemisorption units
(CGA 580) N, 99.999% All gases listed to the left and:
(CGA 580) He 99.999%
(CGA 350) H5 99.999%
(CGA 350) CO 99.990%
Pre-mix 10% CO in helium (required for Dynamic
Chemisorption units and TCD units only)

CRYOGEN REQUIREMENTS

Liquid nitrogen is commonly used as the cryogen to cool the sample during analysis. A liquid
nitrogen transfer system eliminates the need to pressurize storage Dewars. The Model 021 liquid
nitrogen transfer system is available from Micromeritics (www.Micromeritics.com).

Improper handling, disposing of, or transporting potentially hazardous materials can
cause serious bodily harm or damage the instrument. Always refer to the MSDS when
handling hazardous materials. Safe operation and handling of the instrument,
supplies, and accessories is the responsibility of the operator.
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Specifications for the Flex

SPECIFICATIONS FOR THE FLEX

Pressure Measurement

Analysis Physisorption

Analysis Range 1.3 x 10°to0 1.0 P/P
Micropore Analysis Standard on all ports

Dosing and Evacuation

Control Proprietary Servo

Roughing Pump 4 stage diaphragm
Krypton Analysis Standard on all ports

Analysis Gas Per Sample

Chemisorption

1 x 1076 to 900 mmHg

Standard on all ports
Proprietary Servo

4 stage diaphragm

Standard on all ports

One probe per gas port. 3Flex can use to up three gases concurrently.

Minimum Measurable Surface Area

Standard 0.01 m2/g
Krypton 0.0005 m2/g

Instrument Control and Features

0.01 m?/g
0.0005 m2/g

Temperature Control 45 +0.05 °C with 3 strategically placed RTDs

Adsorptive
Gas Inlets

12 standard; 16 optional

Vapor Sorption Option Standard ports 1 and 2, optional heated

Furnace N/A

Mass Flow Controller N/A

Programmable

0.1-50° C/min

50° C/min to 600° C

20° C/min from 600-800° C
10° C/min from 800-1100° C

Standard, flow up to 200 sccm,
1% of set point
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Instrument Control and Features (continued)

TCD with N/A Two optional levels of per-
Cold Trap formance available

Heated port for connection of

Standard External Dedic- external detectors including an
N/A . ;
ated Port available Cirrus quadrapole mass
spec

3 in situ for 3Flex
1 in situ for Flex
Degas
Up to 4 Smart VacPreps can be attached to
give a maximum of 24 additional degas ports

A/D Data Acquisition 29 bit (effective 25)

Pressure Transducer 6 for Flex
System 12 for 3Flex

1000 mmHg - 0.12% reading
Transducer Accuracy 10 mmHg - 2% reading
0.1mmHg - 0.15% reading

Cryogen

3.2L.
Cryogen Dewar Greater than 70 hours
Virtually unlimited duration with refill during analysis

Cryogen Free

Space Control Isothermal jacket

Environment

10 to 35 °C (50 to 95 °F), operating

Temperature 0to 50 °C (32 to 122 °F), non-operating

Humidity 20 to 80% relative, non-condensing

Indoor only

outlcr;c;]l((:ro l:Soer Altitude: 2000 m max
Pollution degree of the intended environment: 2

Flex Series Operator Manual
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Electrical
Voltage 100/120/230VAC
Frequency 50/60 Hz
Power 1350 VA
Physical

Height 112cm (44 in.)

Width 57.2 cm (23in.)

Depth 61cm (24 in.)

Weight 103 - 106 kg (227 - 234 Ib.) (depending on configuration)

Computer Requirements

Operating System

Desktop Installation
Required

10Base Tor100Base T
Ethernet Port

Read/Write Permissions

Drives

Windows 7 Professional or higher operating system is
recommended for the best user experience. For 21 CFR Part 11
environments, Windows 10 Professional or Windows 10 Enterprise
or higher is required.

The application should not be installed on a network drive with
shared access. Multiple users cannot operate the application at the
same time.

If the computer is to be connected to a network, two Ethernet ports
are required. If more than one Ethernet based unit is connected to
the same computer, an Ethernet switch will also be required. If a
Smart VacPrep is to be used, an Ethernet switch is required.

All users of the application will need Read/Write permission to all
directories and subdirectories where the application is installed.
For 21 CFR Part 11 environments, permission may be limited to
the installation directory.

USB port

Due to continuous improvements, specifications are subject to change without notice.
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2 ABOUT THE SOFTWARE

Software in 21CFR11 Environments on page 2 - 37

CFR Dynamic Analysis and Chemisorption options are not applicable when the software is
Note installedin a 21CFR11 environment.

The analyzer allows other computer programs to run while an automatic operation is in progress.
The Help menu provides access to the online operator manual.

Report options can be specified when creating the sample file. When running an analysis, data
gathered during the analysis process are compiled into the predefined reports. Reports can also
be defined and generated after an analysis has been run. Each selected report is displayed on its
own tab and reflects data collected during the analysis.

The MicroActive feature offers a Windows interface with an easy way to collect, organize, archive,
reduce raw data, and store sample files for later use. Scalable and editable graphs, and copy and
paste graphics, are easily generated. Customized reports can be viewed on a computer monitor,
printed, or exported for use in other programs.

In addition to customizable standard reports, user defined calculations and reports can be created
through the Advanced reports feature (using Python).

Data can be manipulated and displayed interactively using MicroActive reports.
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MENU STRUCTURE

All program functions use standard Windows menu functionality. The title bar contains a Unit [n]. If
multiple analyzers are installed, ensure the appropriate unit is selected before continuing.

Main Menu Bar Options

Option Description

File Use to manage files used by the application — such as sample files, ana-
lysis conditions files, report options files, etc.

Unit [n] Use to perform analyses, calibrations, and other analyzer operations. Unit

[n] displays on the menu bar for each analyzer attached to the computer.
Smart VacPrep (If installed.) Use to access the menu for each installed Smart VacPrep.

Reports Use to start or initiate reports and view the results.

Options Use to edit the default method, specify system configuration, specify units,
and change presentation options.

Window Use to manage open windows and display a list of open windows. A
checkmark appears to the left of the active window.

Help Provides access to the embedded operator manual, the Micromeritics web

page (www.Micromeritics.com), and information about the application.
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Common Fields and Buttons

COMMON FIELDS AND BUTTONS

The fields and buttons in the following table are located in multiple windows throughout the
analyzer application and have the same description or function. Fields and button descriptions not
listed in this table are found in tables in their respective sections. All entry fields will accept
information when using a bar code reader.

Common Fields and Buttons

Field or Button

Description

Add

Adds an item to the list.

Add Log Entry

Use to enter information that will display in the sample log report that
cannot be recorded automatically through the application. Click the but-
ton again to enter multiple log entries.

Append Use to insert one row at the end of a table.

Autoscale When enabled on report parameters windows, allows the x- and y-axes
to be scaled automatically. Autoscale means that the x- and y- ranges
will be set so that all the data are shown. If Autoscale is not selected,
the entered range is used.

Axis Range On report parameters windows, the From / To fields are enabled when

Autoscale options are not selected. Enter the starting and ending val-
ues for the x- and/or y-axes.

Bar Code (default field

Use to enter additional information about the sample, such as a sample

label name) lot number, sample ID, etc.

Browse Searches for afile.

Cancel Discards any changes or cancels the current process.

Clear Use to clear the table entries and display only one default value.

Close Closes the active window.

Close All Closes all active windows. If changes were made and not yet saved, a
prompt displays for each changed file providing the option to save the
file.

Comments Enter comments about the sample or analysis. Comments display in
the report header.

Copies Selects the number of copies to print. This field is only enabled when
Print is selected.

Delete When working with tables deletes the selected information.

Destination Selects the report destination.

Edit When working with report parameters, highlight the item in the Selected

Reports list box and click Edit to modify the report details.

Flex Series Operator Manual

350-42800-01 (Rev R) — Apr 2021




2 About the Software

[M] micromeritics®

Common Fields and Buttons (continued)

Field or Button

Description

Exit

Exits the application. If a file is open with unsaved changes, a prompt
displays providing the option to save the changes and exit or to exit the
application without saving the changes. If an analyzer is currently
operating, an additional prompt displays to confirm exiting from the
software.

Export Exports data in a sample file as a .TXT, .XML or .XLS file. When saved
to afile, the data can be imported into other applications.

File Selects the destination directory. Enter a new file name in the File
name field, or accept the default. Select to save the file as a report sys-
tem (.REP), a spreadsheet (.XLS), a portable document format (.PDF),
or an ASCII text (.TXT) file format.

File name Selects a file name from the list shown or enter a file name. If the
required file type is not shown, select the type of file from the list.

From/ To When working with report parameters windows, indicates the From and
To range for x- and/or y-axes.

Insert Inserts one row above the selected row in the table.

List Creates a list of sample or other type files. The list will contain file
name, date / time the file was created or last edited, file identification,
and file status.

Name Contains a list of files in the selected directory or library.

Next Moves to the next window or next step.

OK Saves and closes the active window.

Open Opens the selected file. Alternatively, double-click the file name in the
Name column to open the file.

Prev Moves to the previous window.

Preview Previews predefined reports. Click the tabs at the top of the window to
preview each selected report. When an analysis has not been run on a
sample, this button is disabled.

Print Sends the report to the selected destination (screen, printer, or file).

Remove Removes the selected file or files from the list.

Replace Selects another file where the values will replace the current file’s val-
ues.

Replace All Selects another .SMP file where the values will replace all values for
the active sample file. The original file will remain unchanged. No ana-
lysis data is added to the file. The only information added is sample
information, material properties, liquid properties, analysis and report-
ing parameters.
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Common Fields and Buttons (continued)

Field or Button

Description

Report

Displays a window to specify report output options.

Save Saves changes.

Save As Saves a file in the active window under a different file name. When sav-
ing sample information, a portion can be saved as a separate, stand-
alone file, such as Analysis Conditions or Report Options.

Start Starts the report, test, analysis, or operation.

Start Date Displays a calendar to select the start date for the report.

View Operation. Displays the data from the current analysis.

Instrument Log. Displays recent analyses, calibrations, errors, or
messages.

Instrument Schematic. Displays a schematic of the analyzer system.
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FILE STATUS

In the File Selector window, the Mic Description column and the Mic Status column display file
description and file status. The File Selector incorporates standard Windows features for resizing
windows, reordering and repositioning columns, and right-clicking an entry to display a menu of
standard Windows functions.

File Status

File Status Description

Analyzing Sample files that are currently being used for analysis.

Complete Sample files used in an analysis that has been completed.

Entered Sample files containing manually entered data.

No Analysis Sample files which have not been used to perform an analysis.

Prepared Sample files that have been used in an automatic degas operation
but have not been analyzed. This status is applicable only if using the
Smart VacPrep degasser.

Preparing Sample files that are currently being used in an automatic degas
operation. This status is applicable only if using the Smart VacPrep
degasser.

File Type and File Name Extension

File Type File Name
Extension
Alpha-s Curvel) ALS
Adsorptive Properties .ADP
Analysis Conditions ANC
Degas Conditions .DEG
Heat of Adsorption Report .HOA
Methods .MTH
Report Options .RPO
Sample Information .SMP
Sample Tube Properties .STB
SPC Report .SPC

1) Saves the relative pressures and resulting quantities adsorbed as an ASCII text file. These
data are derived by dividing the isotherm by the quantity adsorbed at 0.4 relative pressure.
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File Status

File Type and File Name Extension (continued)

File Type File Name
Extension
Thickness Curvel) .THK

File Types for Printing or Exporting

File Type File Name Extension
Portable document format .PDF
Report .REP
Spreadsheet XLS
Unicode TIXT
Extensible markup language XML

1) Saves the relative pressures and corresponding thicknesses as an ASCII text file. These data
are derived by dividing the condensed volume of adsorptive by the selected surface area. The
density conversion factor in the adsorptive properties file is used to convert quantity adsorbed to

volume of condensed adsorptive.
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KEYBOARD SHORTCUTS

Shortcut keys can be used to activate some menu commands. Shortcut keys or key combinations
(when applicable) are listed to the right of the menu item.

Certain menus or functions can also be accessed using the Alt key plus the underlined letter in the
menu command. For example, to access the File menu, press Alt + F, then press the underlined
letter on the submenu (such as pressing Alt + F then pressing O opens the File Selector).

/ If the underscore does not display beneath the letter on the menu or window, press
the Alt key on the keyboard.

Keyboard Shortcuts

Field or Button

Description

Alt +[Unit n] Opens the Unit [n] menu.

Alt + F Opens the File menu.

Alt + F4 Exits the program. If files are open with unsaved changes, a prompt to
save changes displays.

Alt + H Opens the Help menu.

Alt + 1 Opens the Options menu.

Alt+R Opens the Reports menu.

Alt+V Opens the Smart VacPrep menu.

Alt + W Opens the Window menu.

Ctrl + N Opens a new sample file.

Ctri+ O Opens the File Selector window.

Ctrl+ P Opens the File Selector to start a report from a selected .SMP file.

Ctrl+S Saves the open file.

F1 Opens the online help operator manual.

F2 Opens the File Selector window.

F3 When in the File Selector window, opens the file search box.

F4 When in the File Selector window, opens the address bar.

F5 Opens the File Selector window listing report options files.

F6 Cascades open windows.
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Keyboard Shortcuts (continued)

Field or Button Description

F7 Tiles all open application windows.

F8 Opens the File Selector to start a report from a selected .SMP file.

F9 Closes all open reports.

F10 Opens the Heat of Adsorption window.

Shift + F2 Opens the File Selector window listing sample information files.

Shift + F9 Opens the shortcut menu of either the selected component on the analyzer
schematic when manual control is enabled or onscreen reports.
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OPTION PRESENTATION

Options > Option Presentation

CFR For 21CFR11 environments, see Software in 21CFR11 Environments on page 2

Note -37.

Use to change the way sample files and parameter files display: Advanced, Basic, or Restricted.
Each display option shows sample information and options differently.

Option Presentation Display

Presentation Display

Description

Advanced

Displays all parts of sample and parameter files. Navigate to parameter
windows by selecting the tabs across the top of the window.

Basic

Displays sample information in a single window. This display option is
used after the parameter files have been created. The previously
entered or default parameter files are then accessible using drop-down
lists.

Restricted

Displays the sample file in a single window similar to the Basic display
option with certain functions disabled. A password is set when the
Restricted option is selected. That same password must be entered to
change to the Basic or Advanced display option. This display type is
typically used in laboratories — such as the pharmaceutical industry —
where analysis conditions must remain constant. The Advanced option
is not available in the view selector at the bottom of the window when
using the Restricted display option.

Show Degas
Conditions [

When enabled, displays the Degas Conditions tab when using
Advanced option presentation and the Degas Conditions drop-down
list when using Basic or Restricted option presentation. This option
may be deselected to hide the Degas Conditions tab if not using a
Smart VacPrep.

Check Shield

When enabled, checks to ensure the shield is in place around the
Dewar or furnace prior to starting an analysis. If this option is selected
and the Dewar or furnace shield is not in place prior to starting an
analysis, a warning message displays on the analyzer schematic
window. An entry is made in the analyzer log regardless of operator
choice.

Show Splash Screen

Enables (or disables) the splash screen upon application startup.
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To change the view for the selected window, use the drop-down list at the bottom of
the sample file editor.

The following examples show the same sample file in Advanced and Basic display. Basic and
Restricted displays will look the same. A password is required if using Restricted format.

Option Presentation Examples

8 [=[=]Ez]
Sample Degas Analysis Report
Description conditions Conditons optons
Method:  Default v
Sample: [ default
Operator:
Submitter:
Method: [Defauit 9
Sample:
Mass Operator:
@Enter O calculate
Sample Tube: =
el e [ Z (e
Sample +tube: | 20000 g Mass
Density: gfems oo @ Enter Ocalalate
Sample mass: g Empty tube:  1.0000 g
Type of Data
Sample + tube: 2.0000 g
(@ Automatically collected Density: 1,000 |gfcm?® 1.0000
(O Manually entered
Degas conditions: [Degas concitions -
Comments:
Add Log Entry Analysis conditions: [Run Cenditions -
Report options: [Report options -
Replace All...
Save As Close Advanced v Preview [ Save Ay ] [ close: ] [BESK ']

A sample file must be created for each analysis. The file can be created prior to or at
the time of analysis. The sample file identifies the sample, guides the analysis, and
specifies report options.
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LIBRARIES

Options > Manage Libraries

/ This feature is not available when using Restricted option presentation.

Manage Libraries X

Analysis Conditions v Manage

The library provides an easy way to locate and open specific analyzer files. Libraries are located
within the File Selector window and can be viewed only within the application.

The library gathers sample and parameter files that are stored in multiple locations — such as

folders on a C: drive, a network location, a connected external hard drive, or a connected USB
flash drive — providing access to all files. Even though libraries do not store actual sample and
parameter files, folders can be added or removed within each library.

One library can include up to 50 folders. Other items — such as saved searches and search
connectors — cannot be included.

When removing a folder from a library, the folder and its contents are not deleted from the original
file storage location. However, when deleting files or folders from within a library, they are deleted
from their original file storage location. (Deleted files and folders can be recovered from the
Recycle Bin located on the Windows desktop.)
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Methods

METHODS

Options > Default Method
File > Open > [ MTH File]

CFR
Note

For 21CFR11 environments, this section is applicable only to members of the
Developer group; however, members of the Analyst group may find information in this
section helpful. Sample file information that is available to Analysts is created by a

member in the Developer group using information in this section.

A Method determines the default sample identification format and sequence number. A Method is
a template of specifications that go into a newly created sample file. It allows for the definition of
complete sets of parameters for each type of sample commonly analyzed, so that only a single

selection is required for each new sample file created.

The Method drop-down list displays only those methods applicable to the open sample file type.

Developer Group view in a CFR21 environment

[E=8[E=R S

e egas sis Report Sample Degas
= Congiitions Conditions Options Description Conditions

000-002 [ Method:  Default

Sample:

[Clomit
[Clomit

Default Method Examples

Default Method Examples

Flex Series Operator Manual
350-42800-01 (Rev R) — Apr 2021



2 About the Software EI micromeritics®

Analyst Group view in a 21CFR environment

Default Methods

Field or Button Description

Sample file name Enter a format for the sample identification. The entry in this field

[text box] becomes a part of the saved sample file name. Include the $ symbol
to have the sample file number included as part of the identification.

Sample These field labels may be renamed and the new label becomes a

Operator part of all new sample files.

Submitter

Bar Code [text box]

Sequence Number Specify a default numeric string to be used as a prefix in the Sample

[text box] field when a new sample file is created. This number increments with
each sample file created.

Default Method Files

Method Selected Default File Modified
Physisorption 3500.SMP
Chemisorption* 3500Chemi.SMP
Dynamic Analysis * 3500DynamicChemi.SMP

* Not applicable in a 21CFR11 environment.
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CONFIGURE THE ANALYZER

SPECIFY GAS PORTS

Unit [n] > Unit Configuration

Use to display hardware / software configurations, calibrations, and gas selections of the
connected analyzer.

The analyzer has gas inlets for up to six analysis gases (12 with the chemisorption option, plus
four loop gas inlets with the TCD Loop option). The gases connected to the inlets must be
specified in the analysis program. If the gas is changed on one of the inlets, the same change
must be made on the Unit Configuration window. The analysis software must be kept informed of
any changes in gases.

Enter the gas mnemonic in the gas fields to indicate the type of gas connected to that valve.

Gas Connections
Gas Connections Loop Gas Connections
Active Gas Active Gas
Concentration % Concentration %
Valve 11: 0.000  Valve31: |Carbon Monoxide-Helum 10,000
valve 13: 0.000 Valve 33: [ none> - 0.000
Valve 15: 0.000
Valve 16: 0.000
Valve 21 10.000
Valve 22: 10.000
Valve 23: 0.000
Valve 24: |Hy v 0.000
Valve 25: 0.000
valve 26: 0.000
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Unit Configuration

Field or Button

Description

Calibrations [button]

Displays calibration information for analyzer components.

T el
123% of Nomina

L n
DooLEE2 kP 13% of Nomn

Configuration

Displays the IP address used by the analysis program, serial number,

[group box] and type of analyzer.
IP address. Displays the IP address of the analyzer.
Change IP. Displays the Board ID dialog, which describes the circuit
boards in the analyzer. Use the Board drop-down list to select a board
to view.
Board ID. Click to display information from the circuit boards in the
analyzer. Use the drop-down list to select a board to view. The
parameters shown cannot be edited.
CryoStat [button] Configure CryoStat X
IP Address: jl R Ijl R Ijl R Ijl
Port: E
Input: @A OB Oc OD
Output: @1 (J2 (O3 O4
Default ramp rate: °C/min
Cancel
Enter a value between 0 and 254.
IP Address. The IP address of the cryostat temperature controller.
Port. The computer port to which the cryostat temperature controller
is attached.
Input. Temperature sensor input channel.
Output. Heater output channel.
Default ramp rate.The rate at which the temperature will change
216 Flex Series Operator Manual
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Unit Configuration (continued)

Field or Button

Description

while advancing to the hold temperature.

Gas Selections
[group box]

Enter the mnemonics for the analysis gases attached to inlet valves.
Valves 11-16. [d[#

Valves 21-26. E With chemisorption option.

Valves 31-24. DA With loop configuration.

Loop Volume [text box]

DA

Enter the loop volume for TCD.

Options [group box]

Displays options installed on the analyzer.

Software Versions
[group box]

Displays the software versions of the MIC BIOS, controller, and ana-
lysis program.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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SPECIFY THE TYPE OF ANALYZER

Unit [n] > Physical Adsorption
Unit [n] > Chemical Adsorption
Unit [n] > Dynamic Analysis

/ This topic does not apply if physisorption units only are installed.

Up to four analyzers can be connected, and each analyzer may be either physisorption or
chemisorption. When multiple units are installed, the application’s title bar reflects the number of
analyzers installed and the type of analyzer.

% 3Flex

File Unit 1 Smart VacPrep Reports Options Window Help

Sample Analysis...
Reference Analysis...
Analysis Sequence...
Evacuate Ports...
Backfill Ports...

v Physical Adsorption
Chemical Adsorption

Dynamic Analysis

Disable Elevator

The analysis type affects the appearance of the analysis sample selection window, the analyzer
schematic, and the status window. This menu selection is disabled when an analysis is being
performed.

When application windows are opened, the title bar reflects both the serial number and the
analysis type. The title bar changes when the analysis type changes.
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UNIT SELECTION

Options > Units

Use to specify how data should appear on the application windows and reports. This menu option
is not available if using Restricted option presentation in a standard installation environment.

Unit Selections X
Quantity adsorbed unit: O pmol/g @ mmol/g Q cm?/g STP
Length unit: Onm @A
BIH/D-H pore dimension: (®) width () diameter (O radius
Pressure unit: (®)kPa () mbar (O mmHg
Pressure symbol: ®@p, p° OpP, Po
Temperature unit: O K @ °C
Physi. analysis temperature unit: @K (ec

Flex Series Operator Manual
350-42800-01 (Rev R) — Apr 2021



2 About the Software EI micromeritics®

ENVIRONMENTAL DEFAULTS FOR TCD ANALYZERS

Options > Environmental Defaults

Environmental Defaults X

Ambient temperature: °C
Atmospheric pressure: 101.3 | kPa

Enter a value between 10.0 and 40.0.

These values are used in some calculations to account for the effect of environmental conditions
on the analysis. These parameters are used in the Dynamic Analysis reports. To ensure accurate
loop calibration, enter current environmental conditions daily, or whenever there is a significant
change in one or more of the environmental conditions.

/ Saturation pressure (P,) of the adsorbate used by BET analysis is obtained from the
adsorptive properties for the experiment gas specified.

Environmental Defaults

Field or Button Description

Ambient temperature | The temperature of the room where the analyzer is located.
[text box]

Atmospheric The atmospheric pressure of the room where the analyzer is located.
pressure
[text box]

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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INSTRUMENT STATUS

SHow DASHBOARD

Unit [n] > Show Dashboard

Data for the dashboard comes from the logged diagnostic data. The dashboard is automatically
kept current as the relevant diagnostic data items are updated. The gauges will be updated even if
the dashboard window is not open.

0.00/0.00 0.000/0.000

min/maxc

"h Dashboard EI@

0/0 327
Anshysss completed/started Days until roughing pump
service is due.

0.00 = 0.00 0.000 = 0.000

Manifold temperature (°C) mean + 20, Nitrogen p® (kP3) mean + 20, min/max

/ Red numbers on the dashboard require attention. To reset the dashboard numbers,
right-click on the dashboard setting, then click Reset.

Dashboard Gauges

Field or Button

Description

Analyses
completed / started

Displays N/M where N is the number of analyses that have finished
data collection and M is the number of analyses that have been star-
ted. Analyses canceled or terminated by errors before the termination
stage starts are not counted as completed.

Days until roughing-
pump service is due

Annual maintenance is recommended. The number of days until the
anniversary of the last pump maintenance is shown. The displayed
value is updated at least once per day and when the maintenance
time is reset. When the displayed value is 30 or less, the value is dis-
played in red. Red negative numbers display if maintenance is past
due.

Flex Series Operator Manual 521
350-42800-01 (Rev R) — Apr 2021




2 About the Software

[M] micromeritics®

Dashboard Gauges (continued)

Field or Button

Description

Manifold outgas rate

Provides the qualitative indication of the outgas rate in the dosing
manifold. LED images constitute a bidirectional bar graph of the
outgas rate.

The gauge is updated when the Analysis Manifold Test is run. See
Schedule Diagnostic Tests on page 9 - 3 and Start Diagnostic
Test on page 9 - 1.

m Three green LEDs are lit if outgas rate is below 30% of outgas rate
limit.

m At 30%, the left LED turns off.

n At 60%, the center LED turns off.

m At 90%, three green LED lights turn off and the center yellow
LED turns on.

m At 110% and above, only the red LED turns on and attention is
required.

Manifold temperature

Displays the statistics of the manifold temperature reading. The
mean, the value at two standard deviations, the minimum, and the
maximum display.

Nitrogen P Displays statistics of the saturation pressures measured with nitrogen
gas at liquid nitrogen temperatures. The mean, two-sigma, minimum,
and maximum values display. The gauge is updated when a P is
logged with nitrogen as the adsorptive and a bath temperature of
772 K.

299 Flex Series Operator Manual

350-42800-01 (Rev R) — Apr 2021
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SHOW INSTRUMENT LOG

Unit [n] > Show Instrument Log

CFR
Note

In 21CFR11 environments, see System Audit Trail on page 2 - 41.

Use to display a log of recent analyses, calibrations, errors, or messages.

& Instrument Log =e e
[] Analysis Calibration Message []Include Message Number

11/6/2020 5:44:25 AM Message: Instrument Unit 1 - 5/N: demo - Dynamic Analysis connection A
11/2/2020 9:16:54 AM Message: Instrument Unit 1 - S/N: demo - Dynamic Analysis connection
11/2/2020 6:14:42 AM Message: Instrument Unit 1 - S/N: demo - Dynamic Analysis connection
11/2/2020 6:14:04 AM Message: Instrument Unit 1 - S/N: demo - Dynamic Analysis connection
11/2/2020 6:13:14 AM Message: Instrument Unit 1 - S/N: demo - Dynamic Analysis connection
10/26/2020 9:03:53 AM  Message: Instrument Unit 1 - S/N: demo - Dynamic Analysis connection
10/26/2020 8:08:39 AM  Message: Instrument Unit 1 - S/N: demo - Dynamic Analysis connection
10/26/2020 6:54:27 AM  Message: Instrument Unit 1 - S/N: demo - Dynamic Analysis connection
10/26/2020 6:54:20 AM Message: Instrument Unit 1 - S/N: demo - Dynamic Analysis connection ,
101725000 £:50-37 AM Moceana: Tnctrimant 1nit 1 - C/N- demn - Munamic Analveic cannactinn
< >

Add Log Entry | | Report...

Instrument Log

Field or Button Description

Add Log Entry [button] |Use to enter information to appear in the sample log report that can-
not be recorded automatically through the application. Click the but-
ton again to enter multiple log entries.

Analysis/ Select the logs to display.

Calibration/

Message [check box]

Include Message Enter any of the following information in the message text box to
Number [text box] generate a log report that includes the following:

m Message number in the text box to view all occurrences of the
entered message,

m Asterisk in the message box to see all numbered messages, or
m Several message numbers separated by commas to include only
messages with those numbers.

Numbered messages contain more detailed information about

analyzer operation.
Report [button] Click to select the print destination and the report start date.
y For fields and buttons not listed in this table, see Common Fields and But-

tons on page 2 - 3.
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SHOW INSTRUMENT SCHEMATIC

Unit [n] > Show Instrument Schematic

Use to display an analyzer schematic. To operate the valves and elevator from this window,
manual control must be enabled (Unit [n] > Enable Manual Control).
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Show Instrument Schematic

1.23e-002
mmHg

4 A500
mHg

Amb‘erlt
25 5 °C|

rlanlfold
G

Ports
245 o]

567.45 | 0.01 1345|

2. 4500

mmHg mmNg

567.45
mmHg

0.012346]
mmHg

19

Furnace
[Sample: 123.4 °C
Furnace: 24.5 °C
Target: 30.6 °C
Rate: 2.0 °C/min

External Trigger

¥
5
Ua

bt peedy

Furnace
[Sample: 123.4

Target: 30.6 °C

Furnace: 24.5 °C
P F

Rate: 2.0 °C/min

Dynamic Analysis with Loop option

Servo valve

Pg pressure

Port 1 pressure

Port 2 pressure

Port 3 pressure
Elevator
Temperature sensors
Manifold pressure
Vacuum gauge

— T OMMOO W >

Mass flow controller [«
Injection loop DAR

Loop gas exhaust port DAE
Septum DAE

Loop rotary valve DAE

Chemical exhaust port m
Cold trap
Cold trap rotary valve

OUVO Z =1 X ¢

* Displays only if TCD Loop Valve
option is installed.
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Analyzer Schematic Components

Schematic Description
Components
1-3 Sample ports
4 Po port
5 Servo isolation valve
6 Manifold vacuum
7 Vacuum gauge isolation valve
8 Inlet vacuum
9 Exhaust valve for chemisorption only
10 Reference volume (shown in Service Test mode only)
11-16 and 21-26 |Inletvalves
31-34 m Loop gas inlet valves (displays only if the TCD Loop Valve option is
installed)

Icon or Symbol |Description

Open Valve. Green indicates an open valve.

Closed Valve. Yellow indicates a closed valve. When manual control is
disabled, closed valves appear white.

Servo Valve. Closed.

Servo Valve. Open.

Elevator.

C| Sample Tube and Furnace Elevator. The sample tube icon is white
when the sample and furnace temperatures are 50 °C or lower. If either the
sample or furnace temperature exceeds 50 °C, the sample tube icon turns
orange. Temperature readings and ramp rate are displayed below and to
the left of the icon. The furnace icon resides on the elevator.

| ¢oDe
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Iml micromeritics® Show Instrument Schematic

Icon or Symbol |Description

l C| Mass Flow Controller (MFC). Controls the flow of gas into the sample

port. The current (C) rate and the target (T) rate are shown to the right of the
MFC icon. Applicable only for the gas used in the flowing operations. The
mass flow controller constant is preset for gases provided with the
application. See Chemisorption Tasks for Gas Adsorption on page 4 -
13.

IL Sample Tube. Cannot be manually controlled.

& FX¥ A warning that indicates the safety shield is not in place.
Removed

temperature, the target vapor source temperature, and rate of temperature

Vapor Source with Heating Mantle. Also displays the current
% increase.

Instrument Schematic Shortcut Menus

Schematic Shortcuts

Icon or Symbol Description

Valve options Automatic. Automatically operates the servo valve during dosing or
evacuation. Enter the target pressure.
Close. Closes the selected valve.

Direct. Used in Service Test mode only under the direction of a
Micromeritics Service Representative.

Open. Opens the selected valve.

Pulse. Use to quickly turn the valve on and off allowing the operation
to proceed in small increments.

Elevator options Raise. Select Raise to raise the elevator. When it is moving, press
the keyboard space bar to stop the movement (or right click and
ﬁ select Stop from the menu).

Lower. Select Lower and press the keyboard space bar to lower the
elevator.

Stop. Stops the elevator from moving.
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Schematic Shortcuts (continued)

Icon or Symbol Description
Temperature control On. Enables the temperature control.
options
Off. Disables the temperature control.
ﬂl Set. Select to set the following:
m Enable or disable temperature control
m Control sample temperature
m Control furnace temperature
m Cool the sample to less than 50 °C
m Set heater power percent
2_98 Flex Series Operator Manual
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PRESSURE TRANSDUCERS

The schematic shows the pressure transducers present in the system.

m All systems have 1000 mmHg pressure transducers on the manifold and the analysis ports.

m Optional 10 mmHg pressure transducers on the manifold and one or more analysis ports may
be present.

= Optional 0.1 mmHg pressure transducers on one or more analysis ports may be present.

When multiple pressure transducers are present in a port or the manifold, the display
automatically changes to show the pressure reading from the lowest range transducer currently
on the scale.

HEATING MANTLE

When samples are being degassed on the analysis ports, the following icons appear beneath the
elevator. When the mantle temperature is above 50 °C, the sample tube icons (not shown below)
turn orange. If using a GlasCol heating mantle, the sample temperature shows in the yellow
Degas Mantle box.

EMantle: 70.0 °C

‘Target: 70.0 °C
{Rate: 1.0 °C/min

Right-click the Degas Mantle box to set the target temperature or the rate of temperature increase.

@) Enable Temperature Control
Target Temperature: 20 °C
Ramp Rate: 0.1 =Cjfmin
_) Disable Temperature Control
OK ] [ Cancel

Select Enable Temperature Control, then enter both the Target Temperature and Ramp Rate. The
Set Heater Power Percent field (shown when Disable Temperature Control is selected) is enabled
in Service Test Mode only.
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SHow STATUS

Unit [n] > Show Status

Use to show the current status for each port.

= =3 |
\ [ |
%Status EI@ FET e 0Tl T RunTime  Manifold Gas
v | | | s
Samples
Sizge Last Point p (kPa) ple® Q (mmolfg) p° (kPa) Run Time
Details: [ 1
\ [ [ |
s;;:;‘: Last Point p (kP=) plp® Q@ (mmolfq) po (kP3) Run Time.
o . Chemisorption
- j j |
s:l.% ) Last Point p (kPa) plp® Q (mmolfq) p° (kPa) Run Time. B2 Status E@
Details: [ | e e
Description -
stem Recording ime:
Physisorption
Dynamic Analysis

If multiple units are attached to the computer, select Show Status on each Unit [n] menu. The
status for all units displays.
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ANALYSIS TYPES FOR TCD ANALYZERS

The basic concept for all analyses is the same: the filament detects changes in the gas mixture
flowing past it. The sample, gas selection, and analysis conditions determine what changes occur.

TEMPERATURE PROGRAMMED DESORPTION ANALYSIS

Temperature Programmed Desorption (TPD) analyses determine the number, type, and strength
of active sites available on the surface of a catalyst from measurement of the amount of gas
desorbed at various temperatures.

After the sample has been outgassed, reduced, or otherwise prepared, a steady stream of
analysis gas flows through the sample and adsorbs on the active sites. Programmed desorption
begins by raising the temperature linearly with time while a steady stream of inert carrier gas flows
through the sample.

At a certain temperature, the heat overcomes the activation energy; therefore, the bond between
the adsorbate and adsorbent will break, and the adsorbed species desorb. If different active
metals are present, they usually desorb the adsorbed species at different temperatures. These
desorbed molecules enter the stream of inert carrier gas and are swept to the detector, which
detects changes in gas composition. The volume of desorbed species, combined with the
stoichiometry factor and the temperature at which pre-adsorbed species desorb, yields the
number and strength of active sites.

Temperature Programmed Temperature Programmed Decomposition
Desorption

No pretreatment
No active sites to probe

m Heated pretreatment
m Active sites to probe
m Active gas to probe sites (NH3, CO,, Ho, Only inert gas is used

etc.) Material changes throughout temperature
m Material (sample) does not change during ramp

temperature ramp

Observe changes of gas phase species during temperature ramp.
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TEMPERATURE PROGRAMMED REDUCTION ANALYSIS

Temperature Programmed Reduction (TPR) determines the number of reducible species present
in the catalyst and reveals the temperatures at which the reduction occurs.

The TPR analysis begins by flowing analysis gas (typically hydrogen in an inert carrier gas such
as nitrogen or argon) through the sample, usually at ambient temperature. While the gas is
flowing, the temperature of the sample is increased linearly with time and the consumption of
hydrogen by adsorption/reaction is monitored. Changes in the concentration of the gas mixture
are determined. This information yields the hydrogen uptake volume.

When using any mixture of gases for TPR or TPO analyses, ensure the thermal
conductivities of the two gases in the mixture are quite different for maximum
sensitivity. See Gas Charts on page I - 1.

TEMPERATURE PROGRAMMED OXIDATION ANALYSIS

Temperature Programmed Oxidation (TPO) examines the extent to which a catalyst can be
oxidized or was previously reduced.

Usually the sample is pretreated and the metal oxides are reduced to the base metal, typically with
a gas mixture of hydrogen with either nitrogen or argon. Then the oxidizing gas, typically 2-5%
oxygen with helium, is applied to the sample in pulses or, alternatively, as a steady stream.

The furnace heats the sample tube and sample according to the user-selected temperature
program. The oxidation reaction occurs at a specific temperature. The analyzer measures the
uptake of oxygen.

When using any mixture of gases for TPR or TPO analyses, ensure the thermal
conductivities of the two gases in the mixture are quite different for maximum
sensitivity. See Gas Charts on page | - 1.
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PULSE CHEMISORPTION ANALYSIS

A Pulse chemisorption analysis determines the amount of gas irreversibly adsorbed and
subsequently calculates active surface area, percent metal dispersion, and the average active
particle size by applying measured doses of reactant gas to the sample.

The active gas interacts with each active site until all active sites are covered. Once the active
sites have been completely covered, the discretely injected gas volumes elute from the sample
tube unchanged. The amount chemisorbed is the difference between the total amount of active
gas injected and the amount that eluted from the system. The quantity of each pulse of reactant
gas is determined by the loop volume on an automatically controlled valve. A 0.5 cm3 loop is
provided with the analyzer and an optional 1cm3 loop is available.

ADDITIONAL USES OF THE TCD ANALYZER
The analyzer may also be used for temperature programmed reactions, catalyst pretreatment,

and isothermal reactions. The tremendous flexibility of the analyzer allows the use of custom
applications.

Temperature Programmed Reaction

A temperature programmed reaction monitors the products from the reaction between gases and
a catalyst at a specified temperature. The analyzer can be programmed to raise the temperature
of a catalyst bed at a constant ramping rate as the gases flow through the catalyst. At the optimal
temperature, the gases react in the presence of the catalyst, creating products. The products of
the reaction and the excess reactants can be diverted to a gas chromatograph or to a mass
spectrometer to be analyzed.

Catalyst Pretreatment

Catalyst pretreatment usually consists of activating a catalyst prior to its use in a chemical
reaction. For example, when a temperature programmed reaction is to be performed, the catalyst
must be reduced under a flow of H, at a specific temperature. The reduction is necessary to
create active sites, or reduce atoms of active metals, which are responsible for the activity of a
catalyst.

Isothermal Reaction

An isothermal reaction is similar to a temperature programmed reaction except that the catalyst is
kept at a constant temperature (isothermal) to perform the catalytic reaction. Both the product of
the reaction and the excess reactants can be diverted to a gas chromatograph or to a mass
spectrometer to be analyzed.
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APPLICATIONS

Catalytic processes that benefit from TPD/TPR analyses include:

m Polymerization s Oxidation
L] Hydrogenatlor? m Dehydrogenation
m Catalyst cracking = Hydrotreating

H ki
= ydroc.rac' Ing = Alkylation reforming
m |somerization

PEAK EDITOR FOR DYNAMIC ANALYSIS

Peak Editor for Dynamic Analysis on page 7 - 12

The TCD (Thermal Conductivity Detector) features a Peak Editor which allows the evaluation of
results, peak editing, and reports. Adjusting peak boundaries can be used to eliminate baseline
noise or other undesirable effects. The Peak Editor also allows the separation of composite
peaks.
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EXPORT FILES

File > Export
Exported Data Example on page G - 1

Provides the option to print the contents of one or more sample or parameter files to either the
screen, a printer, or a file. Data can be exported as a .PDF, .TXT, .XML, or .XLS file format. The
type of data to include or exclude can be selected during the export process. When exported to a
file, the data can be imported into other applications that read these file formats.

LIST FILES

File > List

Provides the option to create a list of sample file information —such as file name, date, time the
file was created or last edited, file identification, and file status.

Select one or more files from the file selector, click List, then provide the file destination.

File Listing
No. File Name Date Time Description Status
1 13x with CO2 at 0C Port 1B.SMP 8/10/2020  3:53:54 PM 13x with CO2 Port 1 Complete
2 13x with CO2 at 0C Port 2B.SMP 8/10/2020  3:53:54 PM 13x with CO2 Port 2 Complete
3 13x with CO2 at 0C Port 3B.SMP 8/10/2020  3:53:54 PM 13x with CO2 Port 3 Complete
4 13x with N2 and TranSeal Port 8/10/2020 3:53:54 PM 13X Zeol Tube 2w/ FS @ end of Complete
2.5MP analysis, Port 2
5 13x with N2 and TranSeal Port 8/10/2020  3:53:54 PM 13X Zeol Tube 1A w/ FS @ end of Complete
3.5MP analysis, Port 3
6 Activated Carbon with Butane C3 8/10/2020  3:53:55 PM Activated Carbon Tube C3 Butane Complete
Port 1.SMP Port 1
7 Activated Carbon with Butane C4 8/10/2020  3:53:55 PM Activated Carbon Tube C4 Butane Complete
Port 3.SMP Port 3
Example of File List

SOFTWARE SETUP

/ If the computer is to be connected to a network, a second Ethernet port on the
computer must be used for that purpose.

The Setup program is located on the installation media and is used to reinstall the software and
make analyzer changes — such as adding, moving, or removing a unit, etc.

refer to the computer's operating system manual or the internet for instructions. The
IP address for the computer and the IP address specified in the setup program must
match. The IP address must be 192.168.77.100.

/ If the IP address needs to be changed on the computer connected to the analyzer,
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SOFTWARE UNINSTALL

Uninstall Software in 21CFR11 Environments on page 2 - 42

The software can be uninstalled two ways. Either method removes only the files required to run
the software - not he analysis files.

m Click the Windows Start icon. Scroll to the Micromeritics entry. Select the Uninstall [analyzer]
option, then follow the prompts.

m Locate the uninstall.exe file in C:\Program Files (x86)\Micromeritics\[analyzer name] (or
wherever the application was installed). Double-click the uninstall.exe file then follow the
screen prompts.

SOFTWARE UPDATES

User Account Control in the Windows operating system must be enabled to ensure all
components of the Micromeritics application are installed properly. If UAC is not
enabled, right-click the setup.exe installer file and select Run as administrator.

The most current version of the analyzer software can be found on the Micromeritics web page
(www.Micromeritics.com).

When performing a software update, existing data files are not overwritten. There are three types
of subsequent installation:

m Later version than the current installation.
m Same version as the current installation.
m Earlier version than the current installation.

Insert the setup media into the media drive. The setup program starts automatically. If the
program does not start automatically, navigate to the installation media drive, locate and double-
click the setup.exe file.

CFR  Existing Confirm application users and groups are not affected by software updates.
Note Any changes to Confirm users and Confirm groups must be made using Windows
Users and Groups.
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SOFTWARE IN 21CFR11 ENVIRONMENTS

The Micromeritics Confirm applications for 21CFR11 environments require an
operating system of Windows 10 Professional or Windows 10 Enterprise or higher.
Management of users and groups is performed in Windows Users and Groups.

The Micromeritics Confirm application enables laboratory managers to develop analysis methods,
enforce industry standards, and produce audit trails. It also enables laboratory analysts to perform
analyses and produce reports.

USER PERMISSIONS

Confirm User Name

Description

mic_[analyzer model
number]_controller

mic_[analyzer model number]_controller is the user name used by all
installations.

m This user should have complete control over the installation dir-
ectory.

m The application is launched under this user name and has this
user’s privileges to the windows file system.

m This user should not be used by anyone or any other software that
is not a Micromeritics application.

m The system administrator has the option of modifying this account
so that the password never expires. Alternatively, if the password
does expire while the application is running, the application auto-
matically changes the password for this account.
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Confirm Group Name

Description

Developer Group

The default Developer group name is
mic_[analyzer model number]_developer. Members of the
Developer group:

m have rights to all functions of the Micromeritics application - includ-
ing Advanced option presentation which allows the creation and
modification of methods, sample files, and parameter files.

m can run an analysis.

m can also be assigned Administrator rights which control the user
profiles.

Analyst Group

The default Analyst group name is
mic_[analyzer model number]_analyst. Members of the Analyst

group:

m have access to the Basic presentation option only.

m may create sample files from pre-defined methods and can modify
only a limited number of input fields.
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OPTION PRESENTATION FOR 21CFR11 ENVIRONMENTS

Options > Option Presentation

Option Presentation Display

Presentation Display

Description

Advanced Displays all parts of sample and parameter files. Navigate to para-
meter windows by selecting the tabs across the top of the window.

Basic Displays sample information in a single window. This display option
is used after the parameter files have been created. The previously
entered or default parameter files are then accessible using drop-
down lists.

Show Degas When enabled, displays the Degas Conditions tab when using

Conditions Advanced option presentation and the Degas Conditions drop-down
list when using Basic or Restricted option presentation. This option
may be deselected to hide the Degas Conditions tab.

Check Shield When enabled, checks to ensure the shield is in place around the

dewar or furnace prior to starting an analysis. If this option is selected
and the dewar or furnace shield is not in place prior to starting an
analysis, a warning message displays on the analyzer schematic win-
dow. An entry is made in the analyzer log regardless of operator
choice.

Show Splash Screen

Enables (or disables) the splash screen upon application startup.

CFR  For members of the Developer group only. To change the view from Advanced

Note

(for Developers) to Basic (for Analysts), click the view selector drop-down list at the
bottom of the window. Select either Advanced (when in Basic view) or Basic (when

in Advanced view).
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BB New File = |
Sample Degas Analysis Report
Description Conditions Conditions Options
Method: Default
o | ‘ Bew e =Ry =
Operator: |
submiter | ] Method: |Default ]
Sample:
Sample tube: | Sample Tube o] [ e Operator:
Mass Mass
Ofnter — Oz=az Q@) Enter *) caleulate
sarvlem=s:| 01477 s ety be: [ 575510 o Sample mass: 10000 g Empty tube: | 1.0000 | g
Sample + tube: -35‘0237 a
Density: [__0.100 Jgjem e Sample + tube: | 2.0000 | g
1.0000
Type of Data
Automatcal collcted
O — Degas conditions: [egas conditions ~]
Analysis conditions: [Run Conditions ~]
Comments:
Pz Report options: [Report Options ]
Add Log Ertry... | | Reploce All.. |
Replace AlL..
Save Close Advanced ~ Preview Saveie Close [Besic ~) L
Advanced view / Developer group Basic view / Analyst group

CFR  Asample file must be created for each analysis. The file can be created prior to or at
the time of analysis. The sample file identifies the sample, guides the analysis, and

Note specifies report options.

m The Save button is disabled on sample files with a Complete status.

m When the Preview button is used to view reports for sample files with an unsaved status, the
report will have a Preview watermark.

m The Save As and Print buttons on the report window are also disabled.

CREATE A NEwW FOLDER

File > Create New Folder

Provides the option to create and name a new folder in the Confirm application folder. This option
may not be available depending on how the IT Administrator configures Windows permissions.
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SYSTEM AUDIT TRAIL

File > System Audit Trail

& System Audit Trail (=R ESR 5

System Audit Tral

~ | Reports
System Audit Trail
System Audit Trail

Confirm for TriStar Il Plus Version 2.03.03 Page 1

Date Time. Description

0604118 014640PM  MICUSALHajj has logged in successfully.
0604118 01:46:49 PM IN: demo) Instrument Unit 1- SIN: demo connection Show | [ Delete

Fide

06104118 01:5251PM olcal smp: Started analysis of file
Print
06104118 01:5251PM
0604118 01:5251 PM Save As
Default Style
06104118 01:53.00 PM

06i04/18  01:57:33PM
0604118 01:57:42 PM

Lists the current user, successful and failed application user login attempts, and contains a
description of all the changes made to sample files. Contains an audit trail of all system
initializations, user login attempts, and sample analyses.
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2 About the Software EI micromeritics®

UNINSTALL SOFTWARE IN 21CFR11 ENVIRONMENTS

When the software is uninstalled using uninstall.exe, only the files required to run the application
are removed. Parameter files, sample files, reports, calibration files, and data files are not
removed.

To uninstall the software, double-click the uninstall.exe file located in the software installation
directory, then follow the prompts.

CFR Touninstall the Micromeritics Confirm application, the owner of the application
Note directory and its contents must be set to the account of the administrator that is
removing the application installation. This account must also have permission to
modify the application directory and its contents. This may require modification to the
owner and to the access permissions of the application directory and its contents.

Upon uninstalling the Confirm application, the system administrator should go into
Windows Users and Groups to remove the Confirm users and groups. See the
Confirm Administrator Guide [part number 004-42821-01].

Depending on the network, Windows may not allow the uninstall.exe program to run. If this
happens. follow these steps:

1. In Windows Users and Groups, verify that the current user is not a member of the analyst
group or developer group. If so, remove the user from the group(s). Log OFF, then log back
ON to the computer.

2. In Windows Explorer, in the Confirm installation directory, double-click the uninstall.exe file
to run the uninstall program.

Flex Series Operator Manual
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[M] micromeritics’ 3 Sample Fies

3 SAMPLE FILES

Option Presentation on page 2 - 10
Software in 21CFR11 Environments on page 2 - 37

CFR Dynamic Analysis and Chemisorption options are not applicable when the software is
Note installed in 21CFR11 environments.

Sample files include the information required by the analyzer to perform analyses and collect data.
A sample file identifies the sample, guides the analysis, and specifies report options and may be
displayed in Advanced, Basic, or Restricted presentation display mode. After data has been
collected, the file will be shown in MicroActive mode or the tabbed file editor.

A sample file consists of parameter sets; however, parameter sets can also stand alone. A sample
file may be created either prior to or at the time of analysis.

Parameter files allow for repeated use of parameter sets. For example, if the same analysis
conditions exist for multiple analyses, an Analysis Conditions file containing the recurring
conditions can be created. When the sample file is created, the Analysis Conditions file can be
selected for the analysis conditions. Once it becomes part of the new sampile file, the new file can
be edited as needed without affecting the original Analysis Conditions file.

The analysis application contains a default method. A method is a template for sample files that
contains the parameters to be used for an analysis. When a new sample file is created, all the
parameters are filled with the values in the default method.

/ To change the view for the selected window, use the drop-down list at the bottom of
the sample file editor.
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3 Sample Files [M] micromeritics®

CREATE SAMPLE FILES

Options > Option Presentation > Show Degas Conditions P
File > New Sample > [.SMP File]
File > Open > [.SMP File]

CFR For21CFR11 environments, this section is applicable only to members of the

Note Developer group; however, members of the Analyst group may find information in this
section helpful. Sample file information that is available to Analysts is created by a

member in the Developer group using information in this section.

sample information metal table editor. Stoichiometry factors can also be set for each
pulse chemisorption experiment using the analysis conditions experiment step editor.
If required, stoichiometry factors for a completed pulse chemisorption experiment can
be viewed and modified using the peak editor’s stoichiometry settings window.

/ Analysis condition defaults for metal stoichiometry factors can be set using the

A For dynamic analyses, the Loop Volume and Environmental Default values must be
correct before starting an analysis.

Each analysis must be linked with a sample file before the analysis can proceed. A sample file can
consist of parameter files; however, parameter files can also stand alone.

Specify or change the option presentation by selecting Options > Option Presentation, or use
the view selector drop-down list at the bottom of the window.

Sample files created in the Basic option presentation must be selected from parameter files
created in the Advanced option presentation. The values specified in the parameter portions of the
default method are the defaults for new sample files. To navigate from one set of parameters to
another, select the parameter tab across the top of the window.

Sample Tube parameters are edited on the Sample Description tab.

/ For physisorption, the Degas Conditions tab displays only if enabled in Options >
Option Presentation > Show Degas Conditions.
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[M] micromeritics®

Create Sample Files

Advanced Option Presentation

BB New File = |-@ [
Sample Degas Analysis Report
Description Conditions Conditions Options
Method:  Default V
Sample: | 000-009 ]
Operator:
Submitter:
Bar Code:
Sample tube: | Sample Tube ~ Edt...
Mass
® Enter O Calculate
Sample mass: | 1.0000 |g 1.0000
2.0000
Density: | 1.000] gfam® oo
Type of Data User Parameters
(®) Automatically collected Parameter 1
(OManually entered Parameter 2
Parameter 3 0.000
Comments:
Add Log Entry
Replace All..
Save As Close Advanced v

B2 New File

E=mn

Sample ’
Description

Analysis
Conditions

Report
Options

Method: Default

Sample: 000-004

Operator:

Submitter:

Bar Code:

Mass
(® Enter

Sample mass: | 1.0000|

Type of Data
(® Automatically collected
(O Manually entered

O Calculate

Comments:

1.0000
2.0000
1.0000

Active Metals...

Save As

Add Log Entry...

Close

Replace All...

Advanced

Physisorption

Basic Option Presentation

BB New File

Method: Default v
Sample: 000010 ]
Operator: ‘
Sample tube: Sample Tube ~
Mass
(® Enter (O Calculate
Sample mass: | 1.0000 | g 1.0000
2.0000
o .
Density: 1.000 | g/em ST
Degas conditions: Degas Conditions ~
Analysis conditions: Run Conditions v
Report options: Report Options v
Add Log Entry... Replace All...
Save As Close Basic v

Chemisorption or Dynamic Analysis

B2 New File

Method: | Default v
Sample: [ 000-005 |
Operator: | ]
Mass
(®) Enter O Calculate
Sample mass: 1.0000
2.0000
1.0000
Analysis conditions: Run Conditions v
Report options: Report Options v
Active Metals... Add Log Entry... Replace All...
Save As Close Basic

Physisorption

File Editor Example for CFR21 environments

Chemisorption or Dynamic Analysis
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[M] micromeritics®

BB New File oo e
Sample Degas Analysis Report
Description Conditi Conditions Options
Method: | Default
Sample: )
-l ‘ BB ew Fie E=nEe =
Operator: | |
submiter | ] Method: |Default ]
Sample:
Sample tube: | Sample Tube o] [ e Operator:
Mass Mass
Enter ® Caleulate .
Ofnter - @) Enter ) Calculate
Sample mass: 0.1427 |g Empty tube: | 37.8810 |g
Sample mass: 10000 g Empty tube: | 1.0000 | g
Sample + tube: | 38,0237 | g
Density: [ 0.100 [g/eme e Sample +tube: | 2.0000 | g
1.0000
Type of Data
Automaticaly collcted
O — Degas conditions: [egas conditions ~]
Analysis conditions: [Run Conditions ~]
Comment its:
Pz Report options: [Report Options ]
Active Metals... Add Log Entry... | [ ReplaceAll.. |
Replace Al..
Close Advanced v Preview Save As Close [pesc -] Frevey

Advanced or Developer view

Basic or Analyst view

/

entered then sc

A bar code reader may be used to enter text into many of the fields on the Sample
Description window. Use a mouse to click in the field first where information is to be

an the bar code with the bar code reader.

Sample Files

Field or Button

Description

Active Metals [button]
[«

Displays a list of active metals. See Active Metals for Chemisorp-
tion Analyzers on page 3 - 13.

Add Log Entry [button]

Use to enter information that will display in the sample log report that
cannot be recorded automatically through the application. Click the
button again to enter multiple log entries.

Bar Code [text box] *

Use to enter additional information about the sample, such as a
sample lot number, sample ID, etc.

Comments [text box]

Enter comments about the sample or analysis. Comments display in
the report header.

Mass [group box]

If mass = 1, the reported surface area equals the total surface area
but it is always shown as m2/g. If an accurate mass is entered, the
reported surface area is normalized per gram of sample. Choose
whether to enter mass manually or have the system automatically
calculate mass. Enter a value for sample mass. Mass can be
changed any time before, during, or after analysis.

Enter. Enables the Sample mass field. Enter a value for the sample
mass.
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EI micromeritics® Create Sample Files

Sample Files (continued)

Field or Button

Description

Calculate. Enables the Empty tube and Sample + tube fields. Enter
the values necessary to calculate the sample mass. Equation used
to calculate sample mass:

Masssample = Masssample+tube - Masstube

Density. ﬂ Value is used for the calculated free space method only.
Use 0.000 for a blank analysis.

Method [drop-down box]

Select a method from the drop-down list.

Operator [text box] *

Enter operator identification information.

Sample [text box] *

Enter a sample description.

Sample Tube
[drop-down box] [

Select a sample tube file from the drop-down list, or click Edit to
modify or create a new sample tube file.

Submitter [fext box] *

Enter submitter identification information.

Type of Data
[group box]

Automatically collected. Select if the type of data will be
automatically collected by the system while an analysis is running.

Manually entered. Use to enter data manually that was collected
from another source. If Manually entered is selected, the Isotherm
Report becomes available in the Basic/Advanced drop-down list for
pasting or importing data into the file.

See Manually Enter Data on page 3 - 9.
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3 Sample Files

[M] micromeritics®

Sample Files (continued)

Field or Button

Description

User Parameters
[group box] [&d *

These fields are primarily used for the SPC (Statistical Process Con-
trol) reporting to specify sample characteristics or its manufacturing
process but may be used for other data by entering specific analysis
conditions or sample criteria. The entered parameters display on the
SPC Report. See SPC Report for Physisorption on page 7 - 4.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

* This field label may have been renamed or may not display if modified in Options > Default

Methods.
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Open a Sample File

[M] micromeritics®

OPEN A SAMPLE FILE

File > Open > [.SMP File]

When working with an existing sample file, consider making a copy of the sample file
to maintain the original configuration options.

File Type File Status Displays
Preparing
Prepared Tabbed file editor
Physisorption or No Analysis
Chemisorption Complete
Analyzing MicroActive report window
Entered
File Editor Example for CFR21
 Browie = ] 8 New File [E=E ol
Sample Degas Analysis ‘ Report
Description Conditions. Conditions
Method: | Default V|
Method:  Default
Sample:
Sample: | 000-009 |
Operator: ‘ ‘ ngramr
Submitter: | ] Mass
Bar Code: | | (@) Enter () Calculate
Sample tube: | Sample Tube v] Edi. Sample mass 1.0000 g Empty tube: | 1.0000 | g
’?:\jsEnler O Caleulate Sample + tube: 2.0000 | g
Sample mass: | 1.0000] g 1.0000 1.0000
2.0000
Density: 1.000 | g/em* 1.0000
Type of Data User Parameters Degas [Dagas Conditions - ]
(® Automatically collected Perameter 1| 0.000] _ —
(O Manually entered Perameter2 | 0.000] Analysis conditions: [Run Conditions v]
Peremeter3 o0 Report options: lRepw‘t Options - ]
Comments:
Add Log Entry
Add Log Entry... I I Replace All... I
Replace Al

Advanced or Developer view

Basic or Analyst view
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[M] micromeritics®

=R ]
Free Space
Isotherm -
8 @cvered  Avbient: [ 275088 |awe Anyss: [ 54,8541 |am
2 Ocalalated
2
£ Sample mess: [ 0.1427 ]
H Fuad roperty Information
H Open. Save s,
2 ettt [lacs phase .S, corecton o
:5 Oldeal gas aw correcton  Non-ideslty Factor: [ 0,0000000 |
3 Summary
@adsorptonpont | poand ..
ORete e O pmon pont
00 02 04 06 10 O#bsobitepresaire O yrface area paint
Relative Pressure (p/p’)
Summar
Isotherm i
0570462 el
0579603263
s 96,0996 nm
H
E
§
H
3 //

108

<
Enter a value between 0.0000 and 9999.0000.

102
Relative Pressure (p/p)

Cose

Example of a Report window

If a sample file with a Complete status is opened, to return to the tabbed file editor, select
Advanced or Basic from the view selector drop-down list at the bottom of the window.

CFR In 21CFR11 environments, this feature is applicable to members of the Developer
Note grouponly.
3.8 Flex Series Operator Manual
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El micpomepitics® Manually Enter Data

MANUALLY ENTER DATA

CFR In 21CFR11 environments, this feature is applicable to members of the Developer
Note grouponly.

This process allows the manual entry of pressure data from a sample file with a Complete status.
There are two methods for manually entering data into a sample file:

= Copy and paste onto the graph area of the interactive window.
= Import data into the interactive window.

CoPY AND PASTE MANUALLY ENTERED DATA

column header then click More... Scroll to the MIC entries and enable MIC Status.This

/ To display the file status in a search window, go to File > Open. Right-click the
is a snippet

1. Open a sample file with a Complete status. The file will open in the interactive reports win-
dow.

2. Right-click in the graph area of the interactive reports window, then select Copy data.

=8 e X

Quantity Adsorbed (mmol/g)

Quantity Adsorbed (mmol/g)

Example of Report window

3. Open another sample file using the Advanced option presentation.
On the Sample Description tab, select Manually entered in the Type of Data group box.

5. Inthe view selector drop-down list at the bottom of the window, click Advanced, then select
Isotherm.

s
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3 Sample Files

[M] micromeritics®

fo)o e

@entered  Ambient: | 10000 |cm?  Analyss: | 1,000 |em

Flid Property Information

Summary
@ Adsorption pont

@Relative pressure srana ]

O O Desorption pant

Otbuskiemesnre. | Ostce e port

atrelative pressure: Select a pressure.

lative pressure: Select a pressure.

Freespace
Isothorm )
, "

2 OCaladated

s

£ Sonple mas: [ 10000 o
3 Dl shaers corcton
2

3

00 o1 02 04 05 o6 07 09
Relative Pressure (p/p)
Isotherm
1

£ Singepoint desorpion
i “otal pore volume: -
§

I | Single point surface area:
£ atrel

3

1020 1020 1070 100
Relative Pressure (p/p’)
Enter s value between 00000 and 89990000
Swvehs e sothem

6. Ensure that all parameter fields are set appropriately, then click Paste.
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El micpomepitics® Manually Enter Data

IMPORT MANUALLY ENTERED DATA

When importing isotherm data from an external ASCI|I text file using the Import button on the
interactive window, the ASCI|I text file must use the following rules:

ASCII text file format rules

Data must be in two columns and separated by a comma or white-space. Acceptable column
headings are:

For Physisorption or Chemisorption:

Relative Pressure
Absolute Pressure (mmHg)
Absolute Pressure (kPa)
Absolute Pressure (mBar)

= Quantity Adsorbed (mmol/g)
m Quantity Adsorbed (cm3/g STP)
m Quantity Adsorbed (cm3/g STP)

Sample Physisorption ASCII Text File

Silica Alumina : Adsorption

Relative Pressure Quantity Adsorbed (cm3/g STP)
0.108629 50.6657
0.22288 60.7813
0.339909 71.3095
0.459512 84.4172
0.577447 102.672
0.654583 121.707
0.760074 179.096
0.855713 334.565
0.958511 394.675
0.996251 403.793
Silica Alumina : Desorption
Relative Pressure Quantity Adsorbed (cm3/g STP)
0.996251 403.793
0.86016 389.626
0.753567 256.264
0.664418 133.099
0.542416 96.7366
0.422295 79.7351
0.346371 71.5994
0.2519 62.8256
0.152718 54.2336
0.103389 49.5803
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3 Sample Files [M] micromeritics®

To import the ASCII text file

1. Open a new sample file in Advanced option presentation.
2. Onthe Sample Description tab, select Manually entered.
3. Inthe view selector drop-down list at the bottom of the window, click Advanced, then select

Isotherm.
Mews File 2 =8 E=R =
Isotherm RS
1o Measured
@ Entersd  Amblent: §.0000 | em® Analysis: 10000 cm®
Cdlculated

Sample Mass:  1.0000 g
Fiuid Property Information

Open... Save As...

Ads.-phase .5, correction

Quantity Adsorbed (cm?fg STF)

Summary
H H : : : : : : : ©) Adsorptin paint pandT...

; ; | | | | | | : @ Relative Pressure

: : i ; ; ; ; i i Desorption point e —
w0l 0z 03 04 05 0B 07 08 09 Absalute Pressure (%) Surface area paink [ —

Relative Pressure (p/p?)

Isotherm Summary
Single paint adsorption
1 T total pore volume: —
atrelative pressure: Selecta pressure.
haxirurn pore diarmeter —

Single point desarption
total pore volume: —
strelative pressure; Selecta pressure.
Maximum pare diameter —

Single point suace ares; —
Strelative pressure: Select a pressure

Quantity Adsorbed (cm®g STP)
=
o
1

o f f
1030 10718 102
Relative Pressure (p/p7)

Enter a value between 0.0000 and 9,499,0000.

Save hs Close Isotherm v Preview

4. Ensure that all parameter fields are set appropriately, then click Import.

5. Open the .TXT file. The data from the original sample file is imported and displayed. If an
error message displays instead, verify that the . TXT file format is correct.
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Iml micromeritics® Active Metals for Chemisorption Analyzers

ACTIVE METALS FOR CHEMISORPTION ANALYZERS

Options > Active Metals Defaults

Or, click Active Metals on the Sample Description tab when using Advanced presentation option.

Atomic Weights and Cross Sectional Areas on page B - 1

Up to 20 elements can be specified. At least one element must have a non-zero % of sample
weight.

o e
Element Atomic Atomic Density
Weight Cross Sect. | (gf/cm?2)
Area (nm?2) Adsorptive...
1 | chromium 51.9960 0.0635 7.190
2 | cobalt 58.9330 0.0662 8.900
3 | copper 63.5400 0.0680 8.960 Insert
4 | molybdenum 95.9400 0.0730 10.220
Delete
5 | nickel 58.7100 0.0649 8.902
6 | palladium 106.4000 0.0787  12.020 Clear
7 | platinum 195.0900 0.0800 21.450
Append
8 | rhenium 186.2000 0.0649 21.020
9 | rhodium 102.9050 0.0752 12.410
10 | silver 107.8680 0.0869 10.500
Enter a unique element name.
Save Close

Active Metals

Field or Button Description

% of Sample Weight * | Percentage, by weight, of each element contained in the sample.
[column]

% Reduced * [column] | The percent of metal reduced during preparation.
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3 Sample Files

[M] micromeritics®

Active Metals (continued)

Field or Button

Description

Adsorptive [button]

Click to display and modify both the adsorptives and their associated
stoichiometry factor. Stoichiometry factors for each gas are metal-
specific.

Adsorptives for chromium

Stoichiometry Factor. The stoichiometry factor is defined as the
moles of metal species covered per mole of adsorptive.

Atomic Cross Sect.
Area (nm?) [column]

Atomic cross-sectional area of the element.

Atomic Weight [column]

Atomic weight of the element.

Density g/cm?3 [column]

Density of the element.

Element Select or enter the active metal.

[drop-down box]

MxOy, X * Xand Y values specify the empirical formula for metal and oxygen,
MxOy, Y * respectively, in a metal oxide.

[column]

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

* Options are shown only when using the Active Metals button on the Sample Description tab.
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EI micromeritics® 4 Parameter Files

4 PARAMETER FILES

CFR In21CFR11 environments, this section is applicable only to members of the

Note Developer group; however, members of the Analyst group may find information in this
section helpful. Parameter file information that is available to Analysts is created by a
member in the Developer group using information in this section.

CFR Dynamic Analysis and Chemisorption options are not applicable when the software is
Note installedin 21CFR11 environments.

Parameter files allow for repeated use of parameter sets. For example, if the same analysis
conditions exist for multiple analyses, an Analysis Conditions file containing the recurring
conditions can be created. When the sample file is created, the Analysis Conditions file can be
selected for the analysis conditions. Once it becomes part of the new sample file, the new file can
be edited as needed without affecting the original Analysis Conditions file.

Methods include both analysis conditions and report options, offering the most convenient way to
repeat most analyses.

Predefined parameter files are included with the program and can be edited, as needed, or new
parameter files can be created.

The following file types can exist as part of the sample file as well as individual parameter files.

Parameter File Types

File Type File Extension

Adsorptive Properties |-ADP
Analysis Conditions ANC
Degas Conditions [g] |.DEG

Method .MTH
Report Options .RPO
Sample Tube [3] .STB
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4 Parameter Files EI micromeritics®

ADSORPTIVE PROPERTIES

File > Open > [.ADP File]

Or, for physisorption and chemisorption, click Edit next to the Adsorptive selection on the Analysis
Conditions tab when in Advanced option presentation. For a dynamic analysis, there is no
Adsorptive Properties tab; use File > Open > [.ADP file].

Adsorptive properties provide the adsorptive (analysis gas) characteristics for the analysis.

= |

Maximum manifold pressure: [ 123323 ke
e diameter: A
32.00

[ osss

ivity: .02

imate Thermal Conductivity and Mass Flow Constant

Vapor Source Temperature
[ as0]cc
[ Controled by instrument
using heating mantle

0.000 Dynamic chemi saturation pressure
(®) High-resolution fluid properties

(O Antoine equation for vapor pressure (bar)
versus temperature (K)

0.0000

0.0000

-273.150

Enter a value between 0.01 and 100.00.
Save Close

Adsorptive Properties

Field or Button Description

Adsorbate molecular | The molecular mass is used for the weight % column of the isotherm
weight [text box] tabular report and for the pressure composition isotherm plot.
Adsorbed phase free- | Adsorbed molecules occupy volume in the sample tube reducing the
space correction analysis free space. Select Adsorbed-phase free space correction to
[check box] adjust the reported quantity adsorbed to correct for this effect. This

option is appropriate for all sample analyses that use the real gas
equation of state.

Adsorptive Name of the adsorptive gas whose properties are being defined.
[drop-down box]

Dosing Method Normal. Dose from a pressurized tank of gas attached to a gas inlet
[group box] port.

From Psat tube. = Select if the Psat tube is to be filled with
condensed adsorptive and dosed from the Psat tube. Select this option
if using krypton.
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EI micromeritics® Adsorptive Properties

Adsorptive Properties (continued)

Field or Button

Description

From sample port 3. ﬁ Select if the tube attached to sample port 3 is
to be filled with condensed adsorptive and dosed from port 3.

Vapor source. PISC Select if a container of condensed vapor is to
be attached to the Psat port in place of the Psat tube and is dosed from
the Psat port.

Charge from inlet. P Use to have the tube automatically charged
with condensate from a gas inlet port after the Dewar is raised.

Purify adsorptive. E Use to have the condensate in the tube purified
after charging by evacuating the gas over the condensate. If Charge
from inlet is selected, select Purify adsorptive to have noncondensing
contaminants automatically removed from the dosing tube prior to
analysis. After the adsorptive has condensed in the selected Psat tube
or port 3, the remaining gas in the tube will be evacuated to remove
noncondensing contaminants. A small amount of the purified
adsorptive condensate will then return to gas phase to restore
equilibrium pressure in the tube.

Dynamic chemi
saturation pressure

Select if vapor is going to be used and enter the vapor defaults.

High-resolution fluid properties... Use to import parameters from a
Fluid Properties (.FPI) file. Changing fluid properties should only be
necessary if an adsorptive is to be used for which no adsorptive
properties are provided. Contact Micromeritics Scientific Services if
new fluid properties are required. See Contact Us on page iii.

Antoine equation... Enter the Antoine constants.

m A, B, C. Enter the Antoine constants used in the vapor
TCD calibration.

= Min/Max temperature. Enter the temperature range where the con-
stants are valid.

Fluid properties
[button]

Use to import parameters from a Fluid Properties (.FPI) file. Changing
fluid properties should only be necessary if an adsorptive is to be used
for which no adsorptive properties are provided. Contact Micromeritics
Scientific Services if new fluid properties are required. See Contact Us |

on page iii.
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4 Parameter Files

[M] micromeritics®

Adsorptive Properties (continued)

Field or Button

Description

Gas Blend [check box]

DA

Select to specify a preblended mixture of a chemically insert gas and a
chemically active gas. The Mass Flow Constant and Relative Thermal
Conductivity for the blend are automatically calculated from those for
the two gases in the blend.

Mass flow constant
[text box] [

Scaling factor for the Mass Flow Controller measured flow rate.
Applicable only for the gas used in the flow prep tasks. The default is
preset for gases provided with the application.

Maximum manifold
pressure
[text box]

The highest pressure to which the manifold will be dosed. To avoid
damage to the analyzer, this number is limited to 925 mmHg. Low pres-
sure sources will require lower numbers. For gases to be used for dos-
ing after charging a tube from a gas inlet, enter the maximum pressure
for dosing from the inlet, not from the tube of condensate.

Mnemonic [text box]

Enter the mnemonic name for the adsorptive. See Specify Gas Ports
on page 2 - 15.

Molecular cross-sec-
tional area [fext box]

The area that a single adsorbed molecule occupies on the surface of
the sample. Itis used in surface area calculations.

Relative Thermal
conductivity [s]=Y

See Gas Charts on page | - 1.

Therm. tran. hard-
sphere diameter

An estimate of molecular size used in calculating the thermal
transpiration correction.

[text box]

Vapor Source Select if the vapor source temperature is to be controlled by the ana-
Temperature lyzer. This field is enabled only if Vapor Source is selected.

[group box]

/

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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[M] micromeritics

@ Analysis Conditions for Physisorption and Chemisorp-

tion

ANALYSIS CONDITIONS FOR PHYSISORPTION AND CHEMISORPTION

CFR
Note

In 21CFR11 environments, this section is applicable only to members of the
Developer group; however, members of the Analyst group may find information in this
section helpful. Parameter file information that is available to Analysts is created by a
member in the Developer group using information in this section.

File > Open > [.ANC File]

Or, click the Analysis Conditions tab when in Advanced option presentation.

Analysis conditions specify the parameters used to guide an analysis.

C:\3Flex\param\Krypton Blank.anc

Analysis conditions: | Krypton Blank ]
Adsorptive: Krypton v] Edi...
Starting Pressure Dose  Equilibration Ending
Pressure | Increment | Amount Interval Pressure
(p/p°) (p/p°) (mmol/g) (s) (0/p°)

1 0.000000000 10 0.060000000
2 0.060000000 10 0.070000000

Insert
3 0.070000000 10 0.085000000
4 0.085000000 10 0.100000000 Delete
5 0.100000000 10 0.120000000 Clear
6 | 0.120000000 10 0.140000000

Append
7 0.140000000 10 0.180000000
8 | 0.180000000 10 0240000000 [] Absolute pressure dosing
9 | 0.240000000 10 0.300000000  Set external trigger
D during data collection
(Chemisorption option
required)
Preparation... Free Space... p°andT... Dosing... Termination...
Enter the dose increment for this row (0.00000 to 44.57016)

Save Close

15 CA\3Flex\param\H2 Pt-Al Ref Mat ANC

=R T

Analysis Conditions: | PEAI Ref Matl with H2 -
Adsorptive: | Hydrogen v Edit..
Pre-analysis evacuation time: | 0.50 | h
Starting Pressure Dose  Equilibration | Ending
Pressure Increment Amount Interval Pressure
(kPa) (kPa) | (mmol/g) © (kPa)
1 0.0000000 20 0.2666448
2 0.2666448 20 0.6666120
Insert
3 0.6666120 20 09332568
4 0.9332568 20 13332240 | Delete
5 1.3332240 20 3.3330600 Clear
6 3.3330600 20 6.6661200
7 6.6661200 2 133320000 | APPENC
8 | 133322400 66661200 20 59.9950800
Preparation... || Free Space... || Temperature... Dosing... Termination...
Repeat analysis
Evacuation time: | 1.00| h
Enter the dose increment for this row (0.00000 to 44.57016)
Save Close

The Pressures tables have a Starting Pressure and an Ending Pressure column. Each table row
represents a pressure interval. The Starting Pressure column is for information only and cannot be

edited.
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[M] micromeritics®

Analysis Conditions

Field or Button

Description

Absolute pressure
dosing [check box]

Specifies pressure targets in mmHg, mbar, or kPa instead of relative
pressure. If this option is selected, the Relative Pressure labels and
entries change to Absolute Pressure in the selected pressure units.

Adsorptive
[drop-down box]

Select an Adsorptive Properties file from the list of defined gases to be
used for analysis. After selection, click Edit to modify adsorptive prop-
erties.

Analysis
Conditions
[drop-down box]

Use to browse for an Analysis Conditions file that contains analysis con-
dition parameters to be used in the analysis.

Dosing [button]

Options for dosing tolerance, low pressure dosing, and dosing near
saturation pressure.

[mi Dosing Options E@

Absolute pressure tolerance: 0.6666 |kPa
Relative pressure tolerance: %

Equilibration delay:

Minimum: h
Maximum: h

Enter a value between 0.0 and 100.0.
oK Cancel

Absolute / Relative pressure tolerance. Values used to determine

how close the actual pressure must be to each target pressure from the
pressure table. At lower pressures, the relative tolerance value is lower.
At higher pressures, the absolute tolerance value is lower. For example:

Experiment 1. There might be an absolute tolerance of 5 mmHg, a
relative tolerance of 5%, and a target pressure of 40 mmHg; 5% of
40 mmHg is 2 mmHg. Since 2 mmHg (relative tolerance) is lower
than 5 mmHg (absolute tolerance), 2 mmHg is used. Therefore a
minimum pressure of 38 mmHg (40 - 2) must be attained to collect
data for a target pressure of 40 mmHg.

Experiment 2. There might be an absolute tolerance of 5 mmHg, a
relative tolerance of 5%, and a target pressure of 200 mmHg; 5% of
200 mmHg is 10 mmHg. Since 5 mmHg (absolute tolerance) is
lower than 10 mmHg (relative tolerance), 5 mmHg is used.
Therefore a minimum pressure of 195 mmHg (200 - 5) must be
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[M] micromeritics

@ Analysis Conditions for Physisorption and Chemisorp-

tion

Analysis Conditions (continued)

Field or Button

Description

attained to collect data for a target pressure of 200 mmHg.

Normally, surface area measurement points are widely spaced a
the resulting measurement is not very sensitive to the precise
location of points so wider tolerances may be used. Unnecessari
tight tolerances lengthen the analysis.

Minimum equilibration delay at p/po > = 0.995. Id The minimum

nd

ly

number of seconds required before equilibration can occur for a relative

pressure greater than or equal to 0.995. This field is not available if
Absolute pressure dosing is selected on the Analysis Conditions tab.

Low pressure equilibration delay. Delays to be used until the first
pressure in the table is reached.

Free Space [button]

How the free space is to be measured.

@i Free Space Options E@

(®) Measure

Lower dewar for evacuation

Evacuation time: h

[ ] Outgas test i Free Space Options E@
e (®) Measure after analysis
(O Enter
16.0000
Estimated analysis free space: an?
45.0000
() Enter
(O Calculate
20.0000
oK Cancel OK Cancel
Physisorption Chemisorption

Calculate. P Use to have the free space measurement calculated
using the sample and tube parameters.

Enter. Allows manual entry of free space.

Measure after analysis. Measures free space after analysis ends.
Enter the estimated free space measurements.

Measure before analysis. P Select if the free space is to be
measured before the analysis begins.
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4 Parameter Files

[M] micromeritics®

Analysis Conditions (continued)

Field or Button

Description

» Lower Dewar for evacuation. If the Dewar is to be lowered for evac-

uation, select this option and enter the length of time for evacuation
after the free space measurement in the Evacuation time field. If
using a cryostat, the operator must manually move the cryostat
assembly when prompted.

Outgas test. Checks for system leaks or sample outgassing. After
free space is measured, the Dewar is lowered and the sample evac-
uated for the specified amount of time. The leak test is performed
after evacuation. If the pressure rises more than 0.025 mmHg within
the time specified in the Outgas test duration field, outgassing is
present. If aleak is found, the leak test repeats nine times, with 30
minutes evacuation between tests. If the 10th leak check fails,the ana-
lysis stops and the operator is notified. While leak testing slightly
increases analysis time, it prevents the continuation of analysis and
collection of erroneous data if a leak occurs.

p° and Temperature
Options [button] [3

How the saturation pressure (P) is to be measured or calculated and
the analysis bath temperature.

E p" and Temperature Options IE@

p*® Options
(@ Measure pin the p® tube for each isotherm point.
") Measure p* over the sample. Enter an initial estimate for p=.

~) Measure p¥in the p* tube for each isotherm peint. Measure
peover the sample and adiust the p° tube measurements,

") Determine p? from pressure measured over the dosing source.
Note that the Adsorptive Properties must specify dosing from
Psat tube, Sample port 3, or Vapor source.

") Measure Psat of the gas specified below for each isotherm point.

Calculate p® of the adserptive from the measured Psat.

Mitrogen

") Calculate p® from the analysis temperature.
_ Enter p°.
98.6586
Analysis Temperature Options
" Enter the analysic temperature.
77.100

@) Calclate the analysis temperature from p= or Psat.

Cancel

Analysis Temperature Options. Select an option to enter analysis
temperature manually, or choose to have it automatically calculated

from p° or Py
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@ Analysis Conditions for Physisorption and Chemisorp-

[M] micromeritics o

Analysis Conditions (continued)

Field or Button

Description

p° Options. Select one option indicating how P is to be measured or
calculated. If using a cryostat, Calculate p0O from the analysis
temperature should be selected.

Psat Gas. If choosing to measure the P, for each isotherm point using a
gas other than the adsorptive, select the P gas from the drop-down list,
then click Edit to modify the Py adsorptive properties. Refer to the
Adsorptive drop-down list earlier in this table for details on editing this
window.

Preparation
[button]

Evacuation rate / time level, leak test and time values, elevator prompts,
and in situ degassing or activation.

/ To insert chemisorption tasks, see Chemisorption Tasks
for Gas Adsorption on page 4 - 13.

[ Preparation Options I
Backfill and match transducer
i prepar ool ] Nitrogen
efoac 0.67 0.67
Ba * No Selection * v
6.7e-03 0.10
Evacuation rate: 0.67 | kPa/s Unrestricted evac. from: 0.67 | kPa
Vacuum level: 6.7e-03 | kPa Evacuation time: 0.10 | hours In situ activation
Task Gas Temp. Rate  Time Pressure
[]Degas in situ (°C) (°C/min) (min)  (kPa)
30 100 EVAC 1000 100 10 iz
= EVAC 3000 100 30
. EVAC 1200 100 10
LEAK 1200 10.0 View:
Temperature | Temperature | Time Insert I
°C) RampRate | (min) Delete
(°C/min) Del
1 30 10.0 10 d
Clea
Append
Step Detail
[Jieak test 120
Elevator
(® Automatic (O Wait for operator (Do not move
oK Cancel oK Cancel

Backfill and match transducer. Backfills the sample tube to

760 mmHg at the beginning of the analysis and to recalibrate the sample
port pressure transducer scale to match the manifold pressure
transducer. Select the backfill gas to be used.

Degas in situ. P Degases the sample on the analysis port prior to
analysis.

= Evacuation Temperature. Temperature of the sample during evac-
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[M] micromeritics®

Analysis Conditions (continued)

Field or Button

Description

uation.

= Hold pressure. Pressure at which heating will stop and hold the
sample temperature approximately constant until the pressure falls
below the Hold pressure. This feature prevents damage to the
sample structure due to 'steaming,' as well as sample elutriation due
to excessive escaping gas velocity.

= Ramp Rate. Rate at which the temperature is to change when advan-
cing to the target temperature.

Elevator. ﬁ Select the appropriate elevator control option.

m Automatic. The elevator is raised and lowered automatically.

=» Wait for operator. Prompts the operator to set the elevator or ana-
lysis bath to the preferred height. When the prompt is acknowledged,
the analysis will continue. This option should be used if the analysis
bath must be placed manually in the preferred position, or the elev-
ator must be raised to a height other than the standard analysis
height.

= Do not move. Use to have the analysis proceed without pausing or
moving the elevator. This option should be used when the analysis
bath is already in position and should not be moved during analysis. If
Unit [n] > Enable CryoStat is enabled, the elevator option is auto-
matically set to Do not move.

Evacuation rate. The rate for restricted evacuation.

Evacuation time. The length of time for preliminary evacuation. If this
field is blank, the time entered in the Pre-analysis evacuation field on the
Analysis Conditions window is used.

In situ activation. m When selected, preparation steps will be
done. If not selected, the task table is disabled and analysis starts after
the preliminary evacuation.

Leak Test. P Enables the system to check for leaks or sample
outgassing before the analysis. The leak test allows sample pressure to
rise during the test. If the pressure rises more than 0.15 mmHg, the
analysis does not proceed and the operator is notified. While leak
testing slightly increases analysis time, it prevents the continuation of
analysis and collection of erroneous data if a leak exists.

Leak test duration. E Enter the duration of the leak test.
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@ Analysis Conditions for Physisorption and Chemisorp-
tion

Analysis Conditions (continued)

Field or Button

Description

Vacuum level. The pressure for unrestricted evacuation.

Unrestricted evac. from. The pressure at which unrestricted
evacuation is to begin. This option is enabled when Fast evacuation is
not selected.

Pre-analysis
evacuation time
[text box] [

Evacuation is required prior to analysis. The default setting is 30
minutes.

Preparation. Use to set the evacuation rate, unrestricted pressure, and
setpoint.

Temperature. Use to set the temperature and ramp rate.

Repeat analysis

[selection] {9

Pressure at which heating will stop and hold the sample temperature
approximately constant until the pressure falls below the Hold pressure.
This feature prevents damage to the sample structure due to 'steaming,’
as well as sample elutriation due to excessive escaping gas velocity.

Set external trigger
during data col-
lection

Select to set the external trigger signal for the mass spectrometer (if con-
nected). Chemisorption option is required.

Temperature

[button] Y}

Provides access to furnace and accessory temperature control.

=

E Temperature Options

Furnace temperature control

120.0
10.0

Accessory temperature control

50.0

OK Cancel

Furnace temperature control. Enter the analysis temperature rate.

Accessory temperature control. For user supplied temperature
control only. Enter the intended analysis temperature. The operator will
be prompted to establish the analysis temperature before analysis
begins.
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[M] micromeritics®

Analysis Conditions (continued)

Field or Button

Description

Termination
[button]

Select the backfill gas if backfill is to be done after the analysis.

If using a cryostat, deselect Backfill after analysis.

m Termination Options E@
mTerminalion Options EI@ Backfill after analysis
Backfill after analysis Nitrogen
Backfill gas: * No Selection * v
Cool to less than 50 °C
oK Cancel OK Cancel
Physisorption Chemisorption

Cool to less than 50 °C. SC Select to enable the cool down option.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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CHEMISORPTION TASKS FOR GAS ADSORPTION

File > Open > [.SMP File] > Analysis Conditions tab > Preparation > Insert

Preparation Options = @

Backfill and match transducer

Nitrogen
0.67 0.67
6.7e-03 0.10

In situ activation

Task Gas Temp. Rate Time  Pressure
(°0)  (°C/min) (min)  (kPa)

EVAC 1000 100 10
EVAC 3000 100 30
EVAC 1200 100 10 e
LEAK 1200 10.0
.|

Insert.

Delete

Clear

Step Detail

OK Cancel

To ensure safe operation and reliable results, an evacuation task should be included:

m between tasks using different gases.
m preceding a leak test.

An evacuation will be performed at the analysis temperature for the Pre-analysis Evacuation Time
after the last task and before analysis.

Chemisorption Tasks for Gas Adsorption

Task Description

Evacuation [selec-
tion]

Evacuation Task Options

Evacuate for min below kPa

Evacuation rate: kPa/s
Unrestricted evac. pressure: kPa
Temperature: °C
Temperature rate: °C/min

Enter a value between 5 and 1,440.

Evacuate for [n] min below [n] kPa or Pa. The minutes and pressure

Flex Series Operator Manual 4-13
350-42800-01 (Rev R) — Apr 2021



4 Parameter Files

[M] micromeritics®

Chemisorption Tasks for Gas Adsorption (continued)

Task

Description

for preliminary evacuation.
Evacuation rate [n] kPa/s. The rate for restricted evacuation.
Temperature [n] °C or K. The temperature to reach during evacuation.

Temperature rate [n] °C/min or K/min. Enter the analysis temperature
rate.

Unrestricted evac. pressure [n] kPa. The pressure at which
unrestricted evacuation is to begin. This option is enabled when Fast
evacuation is not selected.

Flow Task [selection]

Flow Task

Gas: Hydrogen v

Flow rate: cm? STP/min
Time: min
Temperature: °C
Temperature rate: °C/min

[ ]Set external trigger

Flow rate [n] cm?3 STP/min.The rate at which gas is to flow.
Gas. Gas used for the flow task.

Set external trigger. If selected, the contact closure used to trigger an
external mass spectrometer or Calorimeter will be activated. If
deselected, the contact closure will be deselected.

Temperature [n] °C. The temperature at which the gas will flow for the
specified time.

Temperature rate [n] °C/min. Enter the analysis temperature rate.

Time [n] min. The duration of time the sample should remain at the
specified temperature.
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Chemisorption Tasks for Gas Adsorption

Chemisorption Tasks for Gas Adsorption (continued)

Task

Description

Leak Test Task
[selection]

Leak Test Task

Outgas rate limit: 5.3e-04 | kPa/min
Temperature: °C
Temperature rate: °C/min

Enter a value between 1.3e-07 and 1.3e-02.
Outgas rate limit [n] kPa/min. If a measured leak or outgas rate

exceeds the entered value, the test will be reported as failed. Analysis
will not be canceled.

Temperature [n] °C. The target temperature for the leak test.

Temperature rate [n] °C/min. Enter the analysis temperature rate.

Soak [selection]

Soak Task
Gas: Hydrogen ~
Minimum pressure: kPa
Time: min
Temperature: oC
Temperature rate: °C/min

Gas. Gas used during the soak task.

Minimum pressure [n] kPa. The minimum pressure to be maintained
over the sample during the soak.

Temperature [n] °C. The temperature at which sample is to be soaked.
Temperature rate [n] °C/min. Enter the analysis temperature rate.

Time [n] min. The duration of time the sample is to soak at the specified
temperature.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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EVACUATION RULES FOR CHEMISORPTION

Evacuation parameters apply to all four stages of evacuation with the exception of evacuation
time. Evacuation time is set using the fields specified in the following evacuation rules.

When an analysis starts, evacuation begins at:

1. Ambient temperature before the first preparation step. This step uses the Evacuation time
field on the Preparation Options window.

2. Analysis temperature after preparation and prior to the start of the analysis stage. This step
uses the Pre-analysis evacuation time field on the Analysis Conditions window.

3. Analysis temperature before the repeat analysis if Repeat analysis is selected on the Ana-
lysis Conditions window. This step uses the Repeat Analysis / Evacuation time field.

4. Analysis temperature before the free space measurement. This step uses the Evacuation
time field on the Free Space Options window. Measure after analysis must be selected to
enable the Evacuation time field.
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I m I m icromeritics® Analysis Conditions for Dynamic Analysis

ANALYSIS CONDITIO

NS FOR DYNAMIC ANALYSIS

File > Open > [LANC File]

Analysis conditions specify the parameters used to guide an analysis.

47 C\3Flex\param\Calcium Oxalate TPD.ANC

[E=0 e ™

Analysis conditions: | Calcium Oxalate TPD

Insert... Delete
Edit... Clear

Insert Analysis Conditions...

Baseline...

Step Detail
Calcium Oxalate TPD

Ctrl + arrow key moves a step

Analysis Conditions for

Type: Temperature Programmed

Dynamic Analysis

Field or Button

Description

Analysis Conditions
[drop-down box]

Use to browse for an Analysis Conditions file that contains analysis
condition parameters to be used in the analysis.

Baseline [button]

Specifies baseline settings if a Wait step depends upon the Baseline.
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[M] micromeritics®

Analysis Conditions for Dynamic Analysis (continued)

Field or Button

Description

Baseline Detection Parameters X

Stable Baseline
A "stable baseline" is detected when the signal's slope is
below the threshold for the indicated duration.

Slope threshold: 0.010 | 9%/min
Duration: min

Change From Baseline

A "change from baseline" is detected when the signal's
acceleration exceeds the threshold for the indicated

duration.
Acceleration threshold: 0.200 | %/min2
Duration: min

Return To Baseline

A "return to baseline” is detected when the signal's
acceleration falls below the threshold for the indicated

duration.
Acceleration threshold: 0.050 | %/min2
Duration: min

Enter a value between 0.001 and 10.000.

Establishes the Slope or Acceleration threshold and Duration for
determining what constitutes a Stable Baseline, a Change From
Baseline, and a Return To Baseline. These values control whether a
particular change in the signal is significant to the current
experiment, such as defining a stable baseline.

Some Wait steps are contingent upon the values selected, such as if
the experiment contains a Wait until Baseline is stable step, the
signal is compared to these values to determine if a stable baseline
has been established. Lower slope/acceleration values and longer
durations create a more rigorous definition of these factors than
higher values and shorter durations.

Stable Baseline. [group box] Detected when the signal slope is
below the threshold for the indicated duration.

Change from Baseline. [group box] Detected when the signal
acceleration exceeds the threshold for the indicated duration.

Return to Baseline. [group box] Detected when the signal
acceleration falls below the threshold for the indicated duration.
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Analysis Conditions for Dynamic Analysis

Analysis Conditions for Dynamic Analysis (continued)

Field or Button

Description

Insert [button]

Inserts a new step into the experiment. Steps can be inserted after
the analysis has started by suspending the analysis.

See Insert Experiment Steps on the next page.

Insert Experiment Step X

Available steps

Dose

Experiment

Flow with Temperature Ramp
Gas Calibration

Gas Flow

Loop Calibration
Set Detector

Set External Trigger
Start Recording
Start Repeat
Temperature Ramp
Valves

Wait

Cancel

To ensure safe operation and reliable results, a chemically inert gas
flow should be inserted between flows of two chemically reactive
gases such as hydrogen and oxygen.

Insert Analysis
Conditions [button]

Click to load an entire list of steps, baseline parameters, and peaks
parameters from the selected dynamic analysis conditions file.

Step Detail [group box]

Displays summary information about the highlighted experiment
step.

/

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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INSERT EXPERIMENT STEPS

Experiments can be customized to control the analysis reaction. When an experiment is inserted,
the initial conditions are specified first, then the individual steps.

1. Onthe Analysis Conditions tab, click Insert to insert an experiment.

2. Select the experiment step in the box.

3. Click Edit to modify settings. An analysis set is created by inserting up to 99 experiments in

the sample file.

To edit steps that have not started, the analysis must be suspended.

m Upcoming steps - display as black or blue

m Current step - step is highlighted and displays as light blue

m Completed steps - display as light green

/ The DDE Command step and Wait for synchronization message option in the Wait

step are no longer supported.

Insert Experiment Step

Available steps

Dose

Experiment

Flow with Temperature Ramp
Gas Calibration

Gas Flow

Loop Calibration
Set Detector

Set External Trigger
Start Recording
Start Repeat
Temperature Ramp
Valves

Wait

only applicable to analyzers that have the Loop option. Do not select these for

/ Note that Loop Calibration, Loop Gas, Inject loop gas, and Loop Valve selections are

analyses to be performed on an instrument without the Loop option.

N

Data from one experiment are not available for editing until the next experiment in the
analysis has begun recording.
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Insert Experiment Steps

Experiment Fields

Field or Button Description
Dose Dose X
Injection Type
(®) Inject loop gas
() Manual injection
After Injection
(®) Wait for minutes.
() Wait for 2.00 minutes, then wait for a return to baseline.
(O) Wait for change from baseline or 2.00  minutes, then wait for a return to baseline.
Cancel
Injection Type:
= Inject loop gas [button]. Automatically injects the contents of the
loop into the path that leads to the sample. The contents of the
loop are pushed out of the loop by the carrier gas.
m Manual injection [button]. Prompts the user to inject a dose of
gas into the septum using a syringe.
After Injection. Specifies the conditions for completion of this step.
Experiment Experiment X
Description: | |
Type of analysis: Temperature Programmed ~ Stoichiometry...
Initial Conditions
Enable detector Filament temperature: °C

Description [text box]. Description of the experiment.

Enable Detector [check box]. Enables the Filament temperature
field and enables the thermal conductivity detector (TCD).

Filament temperature [n] °C [fext box]. Set the filament
temperature from 20 °C to 250 °C. A temperature of 175 °C is
commonly used.

Type of analysis [drop-down box]. See Analysis Types for

TCD Analyzers on page 2 - 31. If Pulse Chemisorption is selected,
the Stoichiometry button is enabled. When modifying the Active
Metals table during the insertion of a Pulse Chemisorption
experiment, changes to the Active Metals table on the Sample
Description tab are not affected. This is useful when sequencing
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Experiment Fields (continued)

Field or Button

Description

multiple experiments and Stoichiometry is different from one
experiment to the next.

Flow with
Temperature Ramp

Flow with Temperature Ramp X
Gas: <None> ~
0.446

Temperature: °C
Temperature rate: °C/min

I:‘ Set external trigger

Flow Rate [n] mmol/min [text box]. The rate at which gas is to flow.
Gas [drop-down box]. Gas used for the flow task.

Set external trigger [check box]. If selected, the contact closure
used to trigger an external mass spectrometer will be activated at the
beginning of the experiment.

Temperature [n] °C [text box]. The temperature at which the gas will
flow for the specified time.

Temperature rate [n] °C/min. Enter the analysis temperature rate.

Time [n] min [text box]. The duration of time the sample should
remain at the specified temperature.

Gas Flow

Carrier Gas / Loop or Injection Gas [drop-down box]. Select the
gas for each set of inlet ports. The gases listed are those with defined
adsorptive properties. If manual injections are to be programmed,
the gas to be injected must be selected as Loop or Injection gas. If
loop injections are to be programmed, this gas must be connected to
a loop gas inlet and assigned in Unit [n] > Unit Configuration. See
Configure the Analyzer on page 2 - 15.

When an analysis is started, the application verifies that the selected
gases are connected to the appropriate ports. If there is a
discrepancy between a gas selected for the current sample file and
the gases indicated in the Unit Configuration window, an error
message is displayed.

Flow rate [n] mmol/min [text box]. The rate at which gas is to flow.
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Experiment Fields (continued)

Field or Button

Description

Cold trap valve. Select the status of the cold trap valve: Bypass or
Trap.

Loop valve. Select the status of the loop valve: Fill or Inject.

Loop Calibration

Use to calibrate the gas injection loop.

This experiment verifies the exact volume of the loop for use in
calculations on analyses in which the loop is used. Sample analysis
data yield signal vs. time or temperature data and peak areas. After
the analysis, select the Loop Calibration report and enter the Loop
volume from the report on the Unit Configuration window. Entering
the calibrated Loop volume on the Unit Configuration window makes
it possible for the application to convert sample data to volume
values. See Loop volume located in Specify Gas Ports on page 2
- 15.

Loop Calibration X

Description:

Calibration Gases
Carrier Gas Loop Gas
<None> N <None> v

0.446 0.446

Filament temperature: 175.0| °C []set external trigger
Loop thermal equilibration: min

Number of injections:

I

The operator will be prompted to enter the injection volume at the time of injection.

OK Cancel

Description [fext box]. Description of the experiment.

Calibration Gases. Select the carrier and loop gases to be used in
this calibration. The gases available are those specified in an
Adsorptive Properties [.ADP] file.

Flow rate [n] mmol/min [text box]. The rate at which gas is to flow.

Filament temperature [n] °C [fext box]. Set the filament
temperature from 20 °C to 250 °C. A temperature of 175 °C is
commonly used.

Loop thermal equilibration [n] min [text box]. Specify the duration
of the equilibration delay. This delay allows extra time for the
instrument to stabilize thermally after the baseline has fully
stabilized.
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Experiment Fields (continued)

Field or Button Description

Number of injections [n] [text box]. Indicate the number of gas
injections to be made into the gas stream.

Set external trigger [check box]. If selected, the contact closure
used to trigger an external mass spectrometer will be activated.

Set Detector Set Detector X

Enable detector

Filament temperature: 175.0|°C

Enable detector [check box]. Enables the Filament temperature
field and enables the thermal conductivity detector (TCD).

Filament temperature [n] °C [text box]. Set the filament
temperature from 20 °C to 250 °C. A temperature of 175 °C is
commonly used.

Set External Trigger Set External Trigger X

[ ]Set external trigger

Set external trigger [check box]. If selected, the contact closure
used to trigger an external mass spectrometer or Calorimeter will be
activated. If deselected, the contact closure will be deselected.

Start Recording Start Recording - TCD X

One measurement every: 5

0K Cancel

Enter a value between 0.02 and 10.00.

Specifies how frequently the signal reading is recorded. A Stop
Recording step is inserted in the steps automatically when a Start
Recording step is inserted. Multiple steps can be inserted between
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Experiment Fields (continued)

Field or Button

Description

the Start Recording and Stop Recording steps.

One measurement every [n] seconds. Specify the frequency of
measurements.

If a Start Recording step is immediately followed by a
step that prompts an immediate peak, peak data are
recorded before any baseline readings can be col-
lected. To collect some baseline data before the first
peak, insert a Wait for [n] minutes step after the Start
Recording step but before the step which causes the
peak.

Start Repeat

Start Repeat sequence X

O Repeat until peaks are equal or 20 times.

O Repeat until peaks are zero or 20 times.

@ Repeat times.

O Repeat until peaks match the first peak or 20 times.

Specifies the duration of the repeat sequence. Automatically inserts
a Start Repeat and a Stop Repeat in the list of steps. Multiple
experiment steps can be inserted within the Repeat loop.

Repeat until peaks are equal or [n] times. Stops repeating the
steps within the loop when the last two peaks are equal to within 5%
of the area, or when the maximum number of repeats is reached.
This option is useful when performing H, or CO pulse chemisorption
on supported metal catalysts.

Repeat until peaks are zero or [n] times. Stops repeating the
steps within the loop when the last two peaks are each less than 10%
of the area of the first peak, or when the maximum number of repeats
is reached. This option is useful when performing an N,O
decomposition for characterizing copper catalysts.

Repeat [n] times. Stops repeating the steps within the loop when
the specified number of times is reached.

Repeat until peaks match the first peak or [n] times. Stops
repeating the steps within the loop when the last two peaks each
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[M] micromeritics®

Experiment Fields (continued)

Field or Button

Description

match the first peak to within 10% of its area or when the maximum
number of repeats is reached.

Temperature Ramp

Changes the sample temperature.

Temperature Ramp X
Ramp Type
(®) Furnace ramp

() sample ramp
(C) Return to ambient

End temperature: °C
Ramp rate: °C/min
Hold time: min

End temperature [n] °C. The ending temperature for the ramping
procedure. If the CryoCooler is installed, it is automatically enabled if
an ending temperature below 20 °C is used.

Furnace ramp. Ramps the furnace temperature directly to the End
Temperature, ignoring the sample temperature.

Hold time [n] min. How long the sample is to be held at the
specified temperature before beginning to cool down.

Ramp rate [n] °C/min. The rate at which the temperature will
change while advancing to the hold temperature.

Return to ambient. Allows the furnace temperature only (not the
sample temperature) to return rapidly to a temperature to below
45 °C.

Sample ramp. Ramps the sample temperature to the End
temperature. The actual furnace temperature is adjusted to meet this
target.
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Insert Experiment Steps

Experiment Fields (continued)

Field or Button

Description

Termination

Termination X

Return to ambient temperature
Final Conditions
Carrier/reference gas Loop gas

<None> ~ | <None> v
0.446 0.446

Enable detector [ ]Set external trigger

175.0

Carrier / Reference / Loop Gas. Select the gas to be used during
the termination stage of the analysis.

Enable detector. Enables the Filament temperature field and
enables the thermal conductivity detector (TCD).

Filament temperature [n] °C. Set the filament temperature from 20
°C to 250 °C. A temperature of 175 °C is commonly used.

Flow rate [n] mmol/min. The rate at which gas is to flow.

Return to ambient temperature. Allows the furnace temperature
only (not the sample temperature) to return rapidly to a temperature
between 14 °C and 50 °C.

Set external trigger. If selected, the contact closure used to trigger
an external mass spectrometer or Calorimeter will be activated. If
deselected, the contact closure will be deselected.

Valves

Sets the cold trap valve and the loop valve as specified.

Valves X
Cold trap valve Loop valve Blend valve
(®) Bypass @ Fill (®)Bypass
(O Trap () Inject (O Blend
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[M] micromeritics®

Experiment Fields (continued)

Field or Button

Description

Wait

Specify a waiting routine.

Wait X

(® wait minutes.

(O Wait for operator:
(O Wait until baseline is stable.
(O Wait for change from baseline or 2.00  minutes.

(O Wait for return to baseline.

Wait [n] minutes. Specify the time to wait.

Wait for change from baseline or [n] minutes. Specify the time to
wait, click OK, then click Baseline to specify the settings.

Wait for operator. Enter a description of the operator task. During
an analysis, the entered message displays at the appropriate time.
The analysis continues after the operator clicks OK.

Wait for return to baseline. Waits for a return to baseline. If
enabled, click OK, then click Baseline to specify the settings.

Wait until Baseline is stable. Specify if the analysis should wait
until the baseline becomes stable, then click Baseline to specify the
settings.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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DEGAS CONDITIONS

File > Open > [.DEG File]

Or, click the Degas Conditions tab when using Advanced option presentation.

Use this option only when the Smart VacPrep is installed. Degassing is a required
step in preparation for an analysis. The Degas Conditions tab provides settings that
will be automatically applied during the degassing procedure when using the Smart
VacPrep.

The Degas Conditions tab displays only if enabled in Options > Option
Presentation > Show Degas Conditions.

The Smart VacPrep Operator Manual can be found on the Micromeritics web page
(www.Micromeritics.com).

B8 C:\3Flex II\param\000-017.DEG = o

Degas conditions: | Degas Conditions ]

Smart VacPrep Evacuation

/] Backfill sample tube

Backfill le tub
® Automatically (O Wait for operator
Automatically O Wait f t

Evacuation rate: 0.67|kPajs  Temperature ramp rate: 10.0 | °c/min
Unrestricted evac. from: 0.67 |kpa Target temperature: 30| oc
Vacuum level: 1.33e-03 | kPa Hold pressure: 133 kpa

Append

These degas conditions will be used for SmartPrep or Smart VacPrep degas. In situ degas is specified in Analysis
Conditions/Preparation Options.

Degas Conditions

Field or Button Description
Copy QuickStart Use to copy the degas conditions settings from the selected
degas conditions Smart VacPrep unit and port.

from Smart VacPrep
Unit [drop-down box]

Degas conditions Use to browse for a .DEG file that contains degas condition para-
[drop-down box] meters to be used in the analysis.
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4 Parameter Files

[M] micromeritics®

Degas Conditions (continued)

Field or Button

Description

Heating Phase [table]

This option is applicable when degassing with a Smart VacPrep .
Enter up to five stages of degas conditions.

Temperature. Temperature at which the sample is to be held while
degassing.

Time. How long the sample is to be held at the specified temperature
before beginning to cool down.

Temperature Ramp Rate. The rate at which the temperature will
change while advancing to the hold temperature.

Smart VacPrep
Evacuation
[group box]

Backfill sample tube. Indicate if the sample tube should be backfilled
automatically or wait for operator response.

Evacuation rate. Rate used for evacuation.

Evacuation time. Length of time for preliminary evacuation before
proceeding with the Heating Phase temperature schedule. The timer
starts when the vacuum level is reached.

Hold pressure. Pressure at which heating will stop and hold the
sample temperature approximately constant until the pressure falls
below the Hold pressure. This prevents damage to the sample
structure due to 'steaming' and /or elutriation due to excessive
escaping gas velocity.

Target temperature. Targeted temperature for evacuation.

Temperature ramp rate. Rate at which the temperature is to change
when advancing to the target pressure.

Unrestricted evac. from. Pressure at which the unrestricted
evacuation is to begin.

Vacuum level. Evacuation time starts when the vacuum level is
reached.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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REPORT OPTIONS

File > Open > [.RPO File]

Or, click the Report Options tab when in Advanced option presentation.
Additional reports are available using the Reports menu.

Use to specify report options for data collected from an analysis or manually entered data. Report
Options files also help in customizing report details such as axis scale, axis range, column
headings, and components of thickness curve equations. These files may contain tabular reports,
plots, or both, as well as advanced report tables.

Customized report options files can be created then loaded into a sample file, allowing quick
generation of reports.

Report Options files may be defined to include overlay options. This system allows the overlay of
up to 25 plots of different samples onto a plot of the same type or overlay one plot type onto a
different plot type from the same analysis.

... \param\n2 Si-Al Surface Area.RPO S =l BIC\....  \param\Pulse Chemisorption.RPO o

Report options: [ Nitrogen Silica Alumina BET Surface Ared ] Report options: | Pulse Chemisorpti -

Show report title ‘ ‘ [ show report title | Micromeritics Instrument Corporatior| ]

[] Show graphic  Graphic

i Graphic
Show graphic P C:\3Flex\miclogo.emf |[ Browse...
idlogo.emf
[midogo.em || srowse... Height: | 0250 |in Width: [ 2.000] in
Height: 0.250 |in Width: 2.000 |in Selected Reports
. [Jsummary
EcededRepors Pulse Chemisorption
Summary A First Order Kinetics
Overlays... Edit... Isotherm LA?:D Csah:nfrahoz
ive Surface Area
E;r muir Signal vs. Time 1 Edit...
"] Apply thermal transpiration correction omu | Temperature vs. Time -
Freundlich Signal vs. Temperature 1 Integration...
[ Temkin Active Gas Flow Rate vs. Time
t-Plot Active Gas Flow Rate vs. Temperature Overlays...

9.00 signal vs. Time 2
Signal vs. Temperature 2

Signal vs. Time 3

Signal vs. Temperature 3

Signal and Active Gas Flow Rate vs. Time
Advanced Reports

Options Report

Sample Log

Alpha-S Method

f-Ratio Method

BJH Adsorption

BIH Desorption

Dollimore-Heal Adsorption
Dollimore-Heal Desorption
Horvath-Kawazoe v

LI O RIKIS

CI T T R IRI

Save Close Save Close

Physisorption and

Chemisorption Dynamic Analysis
Report Options
Field or Button Description
Apply thermal Use to correct the temperature-induced pressure difference between
transpiration the manifold and the chilled sample tube. This option is most significant
correction for pressures less than approximately 1.0 mmHg.
[check box] ﬁ ag /aArIIV;Ie;ySse:se thermal transpiration when performing micropore
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[M] micromeritics®

Report Options (continued)

Field or Button

Description

Inside diameter of sample tube. Enabled when Apply thermal
transpiration correction is selected. Enter the inside diameter of the
sample tube used in the analysis.

Refer to the Thermal Transpiration Correction section of the
Calculations document. The Calculations document can be found on
the Micromeritics web page (www.Micromeritics.com).

Overlays [button]

PISC)

See Graph and Sample Overlays on page 7 - 34.

Report options
[drop-down box]

Browse for a .RPO file that contains report options parameters to be
used in the report.

Selected Reports
[group box]

Select the report names to include in the report. For BJH reports, BJH
pore dimension can be calculated in pore width (w), pore radius (R), or
pore diameter (D). Go to Options > Units to specify default
calculations.

Show graphic
[text box]

Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title
[check box]

Select then enter a report title to appear on the report header.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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[M] micromeritics® Sample Tubs

SAMPLE TUBE

File > Open > [.STB File]

Or, click Edit next to the Sample Tube selection on the Sample Description tab when in Advanced
option presentation.

Sample Tube files specify information about the sample tube.

§8 sample Tube EI@

Sample tube: \Sample Tube - ‘

Empty tube properties [Juse isothermal jacket
(for calculated free space)
[Juse filler rod

Ambient free space: 1.0000 | cm?
Vacuum seal I type
Analysis free space: 1.0000 | cm® @None

(O Check Seal
Load From Sample File... @immEz)
OK Cancel
Sample Tube
Field or Button Description

Ambient free space Empty sample tube gas capacity measured at room temperature.
[text box]
Analysis free space Empty sample tube gas capacity measured with the Dewar raised.
[text box]

Load from Sample Loads parameters from the selected sample file.

File [button]

Sample tube It is a good practice to label each sample tube with a unique iden-

[drop-down box] tification. Enter that information here. This information will also appear
in the Sample Tube drop-down list on the Sample Description tab.

Use filler rod Select if afiller rod is to be used in the sample tube. A filler rod reduces

[check box] the stem free space volume resulting in reduction of free space error. It

is generally a good practice to use filler rods for samples having less
than 100 square meters of total surface area.
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Sample Tube (continued)

Field or Button Description

Use isothermal jacket | Select if anisothermal jacket is to be used. An isothermal jacket main-

[check box] tains a constant temperature profile along the sample tube stem during
an extended analysis of more than 1 or 2 hours.

Vacuum seal type Select the seal type to be used.

[group box]

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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5 DEGASSING

CFR Dynamic Analysis and Chemisorption options are not applicable when the software is
Note installed in 21CFR11 environments.

Most solid materials absorb moisture and other contaminants when exposed to the atmosphere.
The sample must be clean when an analysis is performed. The degas process heats the sample
to remove the moisture and contaminants.

After the sample has been weighed, degas the sample on:

m the analysis port (see Degas in Situ on page 5 - 3),

m a Smart VacPrep. The Smart VacPrep Operator Manual can be found on the Micromeritics web
page (www.Micromeritics.com), or

m auser supplied degasser.

The Check Seal or TranSeal sample tube closures can be used with the Smart VacPrep to
minimize sample contamination when transferring the sample tube from the Smart VacPrep to the
analyzer port.

g m [fusing the TranSeal, refer to the instructions included with the TranSeal [part num-
ber 350-42803-00].

m [fusing the Check Seal, refer to the instructions included with the Check Seal [part
number 350-42802-00].
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5 Degassing [M] micromeritics®

BACKFILL PORTS

Unit [n] > Backfill Ports
Use to backfill ports with gas.

%f) Backfill Ports EI@ %f) Backfill Ports EI@
Backfill Options Backfill Options
Backfill pressure: kPa Backfill pressure: kPa
Backfill gas: N2 = Backfill gas: N2 =
Backfill Ports Backfill Ports
Ll [z [s []2
Start Cancel Start Cancel
Physisorption Chemisorption or Dynamic Analysis
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DEGAS IN SITU

Unit [n] > Sample Analysis

Most solid materials absorb moisture and other contaminants when exposed to the atmosphere.
The sample must be clean when an analysis is performed. The degas process heats the sample
to remove the moisture and contaminants.

Physisorption samples can be degassed on either the analyzer's analysis port (in situ) oron a
separate device such as a Smart VacPrep. Degassing should be performed prior to starting
analysis.

contaminants must be degassed on a separate degas system before attaching to the

/ Samples containing excessive amounts of moisture or significant amounts of other
analyzer to prevent contamination of the analyzer high vacuum system.

remove any moisture readmitted during transfer from the separate degas system to

/ Microporous samples should receive a secondary in situ degas on the analyzer to
the analyzer.

When the degas is completed, observe the temperatures on the analyzer schematic. When the
mantle has cooled, the Sample Analysis window will display a prompt to remove the degas
heating mantle, properly position the isothermal jackets and Dewar cover, then install the Dewar.

Remove the heating mantle (it is not necessary to unplug the mantle), support the bottom of the
tubes, then remove the mantle cover.

A To prevent potential burns, do not touch the sample tube or the heating mantle until
they have cooled below 45 °C.
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TRANSFER A DEGASSED SAMPLE TO AN ANALYSIS PORT

Sample Data Worksheet for Gas Adsorption on page O - 2

When degassing on a separate degasser such as a Smart VacPrep, the sample tube must be
removed from the degas port, weighed, and then installed onto the analysis port for analysis.

If the sample tube is not mounted on the analysis port immediately, leave it on the
degas port. If it is necessary to remove the sample tube and a Check Seal or TranSeal
was not used, insert a rubber stopper into the sample tube.

1. Allow the sample tube to cool to room temperature (approximately 15 minutes).

Do not touch the sample tube or the heating mantle until they have reached room
temperature. Touching the sample tube, heating mantle, or heating mantle clip before
they have cooled could result in burns.

2. Carefully remove the heating mantle clip and the heating mantle from the sample tube.

3. While holding the sample tube, loosen the port connector nut and remove the sample tube
from the degas port. If a Check Seal or TranSeal was not inserted prior to degassing, imme-
diately insert a rubber stopper into the sample tube.

4. Complete the Sample Data Worksheet.

5. Ifusing a Check Seal, ensure that the Check Seal opener is installed in the analyzer sample
port. If a rubber stopper was used, remove it from the sample tube.

6. Slide an isothermal jacket down over the sample tube stem until it touches the sample tube
bulb.

7. Place the connector nut, ferrule, and O-ring onto the sample tube stem.

On the analyzer, loosen the connector nut on the Psat tube and rotate it out of the way.

9. Position the Dewar cover so that the slot for the Psat tube is on the left between port 1 and
port 2.

®
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Iml micromeritics® Transfer a Degassed Sample to an Analysis Port

10.
11.
12.

13.
14.
15.

16.

P slot
Connector nut
Ferrule

O-ring

Dewar cover

mooOw>

Insert the sample tube through one of the holes in the Dewar cover.

Place the sample port nut, ferrule, and O-ring onto the sample tube stem.

Insert the sample tube into the analysis port and ensure it is completely in the port. Securely
hand tighten the sample port nut onto the analysis port.

Repeat all previous steps for each sample tube.

Position the Dewar cover approximately 3/4 in. (19 mm) below the sample port nut.

Slide the Psat tube into the Psat slot in the Dewar cover and retighten the Psat tube con-
nector nut.

Insert the jacket onto the Psat tube. Ensure that the Psat tube jacket is level with the sample
tube isothermal jacket.
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17.

18.

19.

20.

P\A

~—5

"

O-ring (1/4 in. from top)
Ferrule

Connector nut
Isothermal jacket

Cowz>

Attach the sample tube to the analysis port, pushing it fully up. Turn the connector nut clock-
wise and hand tighten.

If degassing a sample on the sample port, see Degas in Situ on page 5 - 3. Otherwise,
place the Dewar cover over the sample tube stem just above the isothermal jacket. Ensure
the P tube is next to the sample tube. Refer to the image in step 9.

Install the Dewar onto the elevator and place the safety shield over the sample tube and
Dewar.

Begin the analysis.
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DEGAS ON THE SMART VACPREP

Equipment Options and Upgrades on page 1 -4

The Smart VacPrep Operator Manual can be found on the Micromeritics web page
(www.Micromeritics.com).
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] [ L]
5 Degassin m t 2
gassing El micromericics
EVACUATE PORTS
Unit [n] > Evacuate Port
'b Evacuate Ports EI@ 'b Evacuate Ports EI@
Evacuation Options Evacuation Options
Evacuation rate: kPa/s Evacuation rate: kPa/s
Unrestricted evac. from: kPa Unrestricted evac. from: kPa
Vacuum level: kPa Vacuum level: kPa
Backfill gas: N2 > Backfill gas: N2 >
Evacuate Ports Evacuate Ports
(lr [z [Js []2
Start Cancel Start Cancel
Physisorption Chemisorption or Dynamic Analysis
Evacuate Ports
Field or Button Description

Evacuation Options
[group box]

Evacuation rate. Rate at which unrestricted sample evacuation
should begin.

Unrestricted evac. from. Pressure at which the unrestricted
evacuation is to begin.

Vacuum level. Evacuation time starts when the vacuum level is
reached.

Backfill Gas. Select the backfill gas from the drop-down list.

Evacuate Port[s]
[group box]

Select the ports to evacuate.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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6 PERFORM AN ANALYSIS

CFR In21CFR11 environments, users are required to login to the Confirm application to
Note start an analysis. Once the analysis window is opened, manual control is disabled

until the analysis has completed. During analysis, pausing and resuming is allowed,
however, steps cannot be skipped.

@ If using a cryostat for analysis, see CryoStat on page D - 1 prior to use.
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DEWAR PRECAUTIONS

Always handle glass Dewars with care. Any product incorporating a vacuum is a
potential safety hazard and should be treated with caution. If in doubt, contact your
safety officer.

Improper handling, disposing of, or transporting potentially hazardous materials can
cause serious bodily harm or damage the instrument. Always refer to the MSDS when
handling hazardous materials. Safe operation and handling of the instrument,
supplies, and accessories is the responsibility of the operator.

(| B>

A Do not pour liquid nitrogen directly into a sink. Doing so may cause drain pipes to
burst.

When handling Dewars containing liquefied gases or cryogenic liquids:

m Wear protective equipment:

o goggles or face shield
o aninsulated or rubber apron
o insulated gloves

m When pouring liquefied gases from one container to another:

o cool the receiving container gradually to minimize thermal shock
o pour the liquified gas slowly to prevent splashing
o vent the receiving container to the atmosphere

FOR GLASS DEWARS

m Use a plastic stirring rod when stirring substances in a Dewar containing liquefied gases (or
other materials of extremely low temperature). Do not use a glass or metal stirring rod unless it
has a protective coating.

m Do not handle heavy objects above the Dewar. If unavoidable, place a protective cover over the
Dewar opening. If an object of sufficient weight is accidentally dropped into the Dewar, shat-
tering may occur.

m Ifthe Dewar has a protective mesh covering, do not remove it. This cover minimizes the risk of
flying particles should the Dewar be knocked over, dropped, or broken.
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MixiNG AN IPA/LN, SLURRY

ﬂ An isopropyl alcohol (IPA) /liquid nitrogen (LN>) slurry is used to maintain cold trap

temperatures of approximately -80 °C. Improperly mixing an IPA/LN, slurry could
cause injury. If the mixture is not stirred continuously, gas may build up under the sur-
face, causing the liquids to splash out of the Dewar.

1.

Chill a 600 mL Dewar by rinsing it with LN,. Allow a small amount of LN to remain in the bot-
tom of the Dewar (approximately 1 cm deep).

Stirring constantly, slowly add approximately 500 mL of IPA. For greatest safety, use a
laboratory squirt bottle. Squirt the stream of IPA along the inside edge of the Dewar, close to
the top of the Dewar, allowing the IPA to flow down the inside wall of the Dewar. Do not stop
stirring the mixture in the bottom of the Dewar, even if stirring becomes difficult. As stirring
and adding IPA continues, the mixture will loosen and become easier to stir.

When all the IPA has been placed in the Dewar, slowly begin pouring LN, into the Dewar.
Approximately 1 liter is needed. Continue to stir the mixture as LN, is added. As ice chunks
form, break them up and stir them down into the mixture. Avoid splashing. Gently knock ice
chunks away from the sides of the Dewar and continue stirring. Add liquid nitrogen until the
slurry is within 25 mm (1 in.) of the top of the Dewar.

Lift the stirrer out of the slurry and observe as the slurry drips into the Dewar; the stirrer
should be thickly coated with slurry.

The goal is to achieve a slurry that has a thick, syrupy consistency without large chunks.
When the slurry is cold enough, small pieces of ice may be present (10 - 20% of the
mixture). A little ice accumulation along the sides of the Dewar is acceptable.

DYNAMIC ANALYSIS

To surround the cold trap, the Dewar must rest on a small stand. Hold the Dewar beneath the cold
trap, then raise it to slide the stand underneath the Dewar. Lower the Dewar until it rests on the
stand. Ensure the cold trap is immersed.
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6 Perform an Analysis EI micromeritics®

PREPARE FOR ANALYSIS

The steps in this topic properly prepare the equipment for an analysis. It is recommended to
perform the tasks in the provided order.

Dewar Precautions on page 6 - 2

Step 1 - Clean and Label Sample Tubes on the facing page

Step 2 - Create Sample Files on page 3 - 2

Step 3 - Determine the Sample Mass for Physisorption on page 6 - 8 or
Determine the Sample Mass for Chemisorption on page 6 - 13

Step 4 - Degas the Sample on page 6 - 20

Step 5 - Sample Tube Installation for Physisorption on page 6 - 10
Step 6 - Fill and Install the Dewar on page 6 - 21

m For dynamic analyses that include manual or loop injections of a chemically
active gas, selection of an active gas/inert gas pair is required. The gas to be injected
may be a blend of chemically active gas and inert gas, or a pure active gas. If a blend
is used for injections, the inert gas in the blend should be the same as the carrier gas.
See Adsorptive Properties on page 4 - 2 and Gas Charts on page | - 1. The inert
carrier gas should be selected to have a very different thermal conductivity from the
active gas so as to provide a large change in the thermal conductivity detector signal,
for instance helium (inert, T.C.=5.84) with carbon monoxide (active, T.C.=0.97) or
argon (inert, T.C.=0.68) with hydrogen (active, T.C.=7.07). The selected carrier gas
must be connected to one of the 12 primary gas inlets on the back panel of the
instrument. For manual injections, the gas to be injected must be connected to an
external septum (provided in the accessory kit) to allow filling the syringe. For loop
injections, the gas to be injected must be connected to one of the four loop gas inlets
on the side of the instrument. Be sure to enter the mnemonics for the connected
gases under Specify Gas Ports on page 2 - 15.
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Clean and Label Sample Tubes

CLEAN AND LABEL SAMPLE TUBES

/

The equipment images in this topic may differ slightly from your equipment;
however, the instructions are the same unless otherwise noted.

Sample tubes and filler rods must be clean and dry before samples are added and weighed. The
following table indicates which materials are needed for cleaning. The procedures following the

materials list are recommended.

Supplied by Micromeritics

Supplied by User

Filler rod

Funnel

Sample data worksheet

Sample tube

Sample tube brush

Sample tube rack

Sample weighing support (required for
chemisorption sample tubes)

stopper, or TranSeal)

m Stopper for sample tube (Check Seal, rubber

Acetone or isopropyl alcohol
Analytical balance
Detergent (such as Alconox)
Drying oven

Forceps

Insulated gloves

Pipe cleaners

Rubber gloves or clean, lint-free cloth
Safety glasses

Ultrasonic cleaning unit
Waste container

1. Preheat drying ovento 110 °C.

2. Verify that the ultrasonic cleaning unit is clean.

3. Use 5 grams of Alconox (or other suitable detergent) per 500 mL of warm water and fill the
ultrasonic unit with enough water to cover the sample tubes and filler rods (if used). If too
much detergent is used, it may be difficult to rinse from the sample tubes. Ensure the deter-
gent is dissolved before placing the sample tubes and filler rods into the water.

4. Fill the sample tubes with warm water and place them in the ultrasonic cleaning unit, then
place the filler rods in the unit. Turn on the ultrasonic cleaning unit for approximately 15

minutes.
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5. Use rubber gloves to ensure no oils or residue are transferred to the clean tubes and filler
rods, then remove the sample tubes and filler rods from the unit.

6. Clean the interior of the sample tubes with the brush supplied with the analyzer.

7. Rinse the sample tubes and filler rods thoroughly with hot water. Rinse again with isopropyl
alcohol or acetone. If isopropyl alcohol or acetone is not available, deionized water may be
used.

8. Stand the sample tubes on the sample tube rack and place the filler rods in a basket or in
the rack. Bake in a vacuum oven for two hours at 110 °C.

/ Samples tubes can also be cleaned with high purity acetone or isopropyl alcohol and
dried for about 10 minutes under heat. If using this method, continue with step 10.

9. Remove the sample tubes and filler rods from the oven and allow to cool.

/ Do not insert the filler rods at this time. Filler rods are inserted before the sample tube
is installed on the analysis port.

Flex Series Operator Manual
350-42800-01 (Rev R) — Apr 2021



Iml micromeritics® Clean and Label Sample Tubes

10. Blow out the sample tubes with oil-free compressed air.

11. Rinse the sample tube closure with isopropyl alcohol, then wipe the sample tube closure dry
with a clean, lint-free cloth.

12. Label the sample tube and stopper for identification.
13. Replace the rubber stopper, Check Seal, or TranSeal.
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DETERMINE THE SAMPLE MASS FOR PHYSISORPTION

Sample Data Worksheet for Gas Adsorption on page O - 2

/ The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

Clean, dry sample tubes are essential for accurate results. How much sample to use can be
determined best by experiment. In general, a sample providing 40 to 120 square meters of total
surface area is recommended for nitrogen analysis. Less than 40 square meters may cause
unreliable results. More than 120 square meters will extend analysis time.

Smaller quantities are required for samples having high surface areas. These samples require
careful weighing after degassing because a small error may represent a considerable percent of
total weight. Proper weighing techniques are most important in this case. Use no less than 100 mg
to reduce the effect of weighing errors.

Care should be taken when loading powders: the accessory funnel is useful for this purpose.
Large granules or chunks may be loaded with forceps.

Analysis results are expressed in units of surface area per gram of sample; therefore, it is
important to know the true sample mass.

Follow the instructions on the Sample Data Worksheet and complete all fields to find the true
sample mass.

1. Record the sample tube identification on the Sample Data Worksheet.

2. Place the sample weighing support on the balance. Tare the balance and allow it to stabilize
at zero (0).

3. Place the empty sample tube set (empty sample tube and stopper) on the sample weighing
support and place it on the balance.

4. Record the stabilized mass on the Sample Data Worksheet . Remove the sample tube set
from the balance.

/ Do not touch the sample with bare hands while performing the following steps. Doing
so could affect the accuracy of results.

Place a sample container on the balance. Tare the balance and allow it to stabilize to zero.
Slowly pour the specified amount of sample into the sample container.

Remove either the rubber stopper, Seal Frit, Check Seal, or TranSeal from the sample tube.
Use the sample tube funnel (provided in the accessories kit) and pour the sample from the
weighing container into the sample tube.

®© N oo
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Sample tube
Funnel

Straw

Weighing support

D TIP: Use a drinking straw tube (approx. 6mm [1/4in.] diameter)
/ that fits inside the sample tube to keep the inside wall of the

sample tube clean.

Balance

9. Replace either the rubber stopper, Seal Frit, Check Seal, or TranSeal.
10. Onthe Sample Data Worksheet, record the following:

m Mass of the sample tube set with the sample.
m Subtract the Mass of empty sample tube set from the Mass of sample tube set plus

sample.
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SAMPLE TUBE INSTALLATION FOR PHYSISORPTION

Sample Tube Installation for Chemisorption on page 6 - 16
Sample Tube O-ring Replacement on page 12 - 20

/ The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

Repeat the following steps for each sample to be installed.

If using... Then...
A rubber stopper Remove it.

An isothermal jacket Slide the jacket down over the stem of the sample tube until it
touches the sample tube bulb. The top of the isothermal jacket
should be aligned with the mark on the sample tube. If using sample
material, insert it into the sample tube.

A filler rod Hold the sample tube horizontally and carefully slide the filler rod into
the tube until the metal clip touches the end of the tube. If using a
hanging filler rod, the rod attaches to the Seal Frit.

Sample tube Filler rod Metal clip

Do not hold the rod vertically and drop the rod into the
tube as this could break the rod and/or tube.
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o

10.

Loosen the connector nut on the Psat tube and rotate it out of the way.

If using a Check Seal, verify that the port has the Check Seal opener installed or if using a
TranSeal, install it at this time.

Position the Dewar cover so that the slot for the Psat tube is on the left between ports 1 and

P slot
Connector nut
Ferrule

O-ring

Dewar cover

moow>»

Insert the sample tube through one of the holes in the Dewar cover.

Place the sample port nut, ferrule, and O-ring onto the sample tube stem.

Insert the sample tube into the analysis port and ensure it is completely in the port. Securely
hand tighten the sample port nut onto the analysis port.

Repeat for each sample tube.

Position the Dewar cover approximately 3/4 in. (19 mm) below the sample port nut.

Slide the Psat tube into the Psat slot in the Dewar cover and retighten the Psat tube con-
nector nut.

Insert the jacket onto the Psat tube and ensure that the Psat tube jacket is below the Dewar
cover.
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m Ifusing the TranSeal, refer to the instructions included with the TranSeal [part num-

ber 350-42803-00].
m [fusing the Check Seal, refer to the instructions included with the Check Seal [part

number 350-42802-00].
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DETERMINE THE SAMPLE MASS FOR CHEMISORPTION

Use Quartz Filter Discs for Chemisorption on the next page
Sample Data Worksheet for Chemisorption on page O - 3

powder samples in bulb tubes may cause the loose particles to go into the analyzer's

/ Bulb sample tubes are for pellets and other samples without loose particles. Using
exhaust.

1. Record the sample tube identification on the Sample Data Worksheet.

2. Place the sample weighing support on the balance. Tare the balance and allow it to stabilize
at zero.

3. Ifanalyzing a powder or sample made of fine particles, push a piece of quartz wool all the
way down into the sample tube.

4. If using quartz wool, put a second piece of quartz wool just inside the sample tube.
If using filter discs, push afilter disc down into the tube until it sits on top of the quartz wool.
Place a second filter disc just inside the sample tube.

5. Place the sample tube set (sample tube with quartz wool or filter discs and stoppers) on the
sample support. Record the stabilized mass on the Sample Data Worksheet.

6. Remove the sample weighing support and sample tube set from the balance.
7. Place the sample container on the balance and allow the balance to stabilize at zero.

/ Do not touch the sample with bare hands. Oil from hands could affect the accuracy of
results.

8. Slowly add approximately 0.5 to 1.0 gram of sample to the sample container.
9. If a second piece of quartz wool or filter disc was inserted, remove the top portion of the
quartz wool or the filter disc from the sample tube.

Flex Series Operator Manual
350-42800-01 (Rev R) — Apr 2021



6 Perform an Analysis EI micromeritics®

10. Use a funnel to slowly pour sample from the container into the sample tube on top of the
quartz wool in the tube.

/ Ensure all sample in the container is placed in the sample tube to avoid errors caused
by incorrect sample mass.

11. If using quartz wool, insert the top portion of quartz wool into the tube and press it down.
If using filter discs, insert the filter disc into the tube and press it down.

/ Ensure the disc is flat on top of the sample. A seal must be created around the edge to
prevent the sample from escaping.

12. Wipe the top of the sample tube with a clean, lint-free cloth, such as a Kimwipe®, to remove
any quartz wool that may have adhered to the surface.

13. Weigh the sample tube set containing the sample and the stoppers. Record this mass as
the Sample + tube.

Use Quartz Filter Discs for Chemisorption

/ The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

/ The use of quartz wool is not mandatory; however, it can provide extra protection for
light powdered samples.

Wear latex gloves when handling the quartz sample tube. The natural oils in human
skin can chemically damage and weaken the quartz tube. It is also important that the
sample tube and its components, as well as the sample and exhaust ports, be clean
and free of debris. Dust particles from quartz wool or the insulator disc of previous
analyses may adhere to the port and/or components, preventing a proper seal of the
sample tube.

Use quartz filter discs or quartz wool to aid in chemisorption sample preparation. Quartz filter
discs (placed both below and above powdered samples) not only provide a more uniform sample
surface but also keep the analyzer free of sample debris. The filters can be used up to 900 °C.

1. Insert a small portion of quartz wool into the sample tube to serve as a support for the
powdered sample. Use a filler rod or smaller sample tube to push the quartz wool to the bot-
tom of the sample tube.
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Top disc, powdered sample, bottom disc,
quartz wool

2. Insert a quartz disc into the sample tube and push it into the tube until it rests on top of the
quartz wool. Inspect the disc to ensure that there is a good seal and that the sample will not
go past the filter. An additional filter can be inserted if needed.

3. Insert a second filter disc on top of the quartz wool. Ensure that the filter is placed high
enough into the sample tube for easy retrieval.

4. Take the initial tube weight (with both filters).

5. Remove the top filter disc. Place it on a clean surface, then use a funnel to add the
powdered sample on the bottom filter disc.

6. Reinsert the top filter disc into the sample tube, then use a rod or smaller sample tube to
push it down until it reaches the top of the sample.

7. Toremove the quartz wool and disc after analysis, use the quartz wool extractor tool.

Insert quartz wool and disc
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SAMPLE TUBE INSTALLATION FOR CHEMISORPTION

Sample Tube Installation for Physisorption on page 6 - 10

/ The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

4 Wear latex gloves when handling the quartz sample tube. The natural oils in human
skin can chemically damage and weaken the quartz tube. It is also important that the
sample tube and its components, as well as the sample and exhaust ports, be clean
and free of debris. Dust particles from quartz wool or the insulator disc of previous
analyses may adhere to the port and/or components, preventing a proper seal of the
sample tube.

Remove the plug from the exhaust port
and sample tube port #2

1. Remove the stopper from the sample tube stem and the cap from the exhaust stem.

2. Use aclean, lint-free swab moistened with IPA and wipe the interior rims of the sample and
exhaust ports.

3. Use aclean, lint-free tissue moistened with IPA and wipe the O-ring, ferrule, and connector
nuts for the sample and exhaust tubes. Place on a clean, lint-free tissue.

exhaust ports, must be clean, therefore it is recommended that the previous steps be

/ Sample and exhaust ports, as well as all components that contact the sample and
repeated each time a sample tube is installed onto a port.
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4. Remove the stopper from the sample tube stem and the cap from the exhaust stem.

5. If using a hanging filler rod (recommended), hold the sample tube slightly tilted and carefully
place the filler rod into the tube.

&

A. Quartzfiller rod (for chemisorption analyses
B. Borosilicate glass filler rod (for physisorption analyses)

A B

The quartz filler rod can be used for both physisorption and chemisorption analyses; however,
the borosilicate glass filler rod can only be used with physisorption analyses.The quartz filler rod
can be identified by the notch across the top of the rod.

Use of the borosilicate glass filler rod in a chemisorption analysis can cause damage to the
instrument.

6. Assemble and install the sample and exhaust tube components.

D
C e (e /
o
Bj‘.&q "./
A & B A. Connector nut
" A B. Ferrule
C. O-ring
D. Fillerrod

~

Insert the assembled sample tube into the exhaust port and analysis port #2.

Slide the connector nuts up the stems and screw the nuts clockwise to secure the tube in
place.

9. Hand tighten both connector nuts until snug.

o
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10. Install clip and slide it up the sample tube.
11. Ensure the thermocouple rests on the lip on the back of the
sample tube.

12. Restthe sample thermocouple tip on the lip on the back of the sample tube and install the
sample tube clip around the sample tube and thermocouple. Ensure the clip is high enough
on the sample tube to clear the furnace disk when the elevator and furnace are raised.

13. Ensure the furnace is on the elevator shelf and manually raise the elevator. To raise the
elevator, go to Unit [n] and ensure there is a check mark to the left of the chemisorption
option. If not, select Unit [n] > [Chemical Analysis] to select it.

14. Goto Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go to Unit [n] > Show Instrument
Schematic.

i Vacuum 2
és 17 18
mmHg

€:13.9 sccm T 6 =7 Ports

Ambient
25.5 °C
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H2 14
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I:1
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Stop rjal Trigger

sample: 123.4 °C
Furnace: 24.5 °C
Target: 30.6 °C

Rate: 2.0 °C/min

15. On the schematic, right click the furnace icon and select Raise to raise the elevator. If it is
necessary to stop the elevator, right click the elevator icon again and select Stop.

16. When the elevator reaches the top, insert the two furnace disk halves on top of the furnace
opening.
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17. Place the first disk behind the sample tube and the second disk in front of the sample tube,
ensuring the clip remains above the furnace disks.
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DEGAS THE SAMPLE

Degas Conditions on page 4 - 29
Degassing on page 5 - 1
Sample Data Worksheet for Gas Adsorption on page O - 2

Start Degas, then degas the sample using menu commands and
information entered on the Degas Conditions tab. The Smart VacPrep
Operator Manual can be found on the Micromeritics web page
(www.Micromeritics.com).

/ If using the Smart VacPrep degasser, go to Smart VacPrep > Unit [n] >

After the sample has been weighed, use a degassing unit to remove any contaminants which may

have adsorbed to the surface or pores. Appropriate degassing units are available from
Micromeritics.

After degassing is complete, perform the following steps:

1. Weigh the sample tube set containing the sample. Record the mass on the Sample Data

Worksheet for Gas Adsorption on page O - 2 as Mass of Sample tube set plus sample
(After Degas).

2. Subtract the Mass of empty sample tube set (Before Degas) from the Mass of Sample tube
set plus sample (After Degas) to obtain the sample’s mass. Record this value as Mass of
sample (After Degas).
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FILL AND INSTALL THE DEWAR

Dewar Precautions on page 6 - 2

/ The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

1. Fill the Dewar with the analysis bath liquid (such as liquid nitrogen) to no higher than
21/4in. (5.7 cm) from the top. Filling the Dewar higher than this will cause an error in the
free space measurement.

/ Incorrect fluid levels can lead to measurement errors. Check the level of the bath
liquid before each analysis.

2. Insert the dipstick and check the level of the analysis bath liquid. Condensation should not
exceed the level indicator mark.
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A. Wetness or frozen
condensation
indicates bath
liquid level

B. Levelindicator
mark

For best results, if the Dewar has not been used for a while, allow approximately 30 minutes
for the temperature of the Dewar to stabilize with the bath liquid, then recheck the level of
the bath liquid. Add additional liquid if necessary.

Slide the Dewar cover to approximately 3/4 in. (19 mm) from the sample port nuts to ensure
a proper seal on the top of the Dewar.

Place the Dewar on the elevator.

Attach the safety shield to the brackets on the front of the analyzer.

6-22
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PERFORM AN ANALYSIS SEQUENCE

Unit [n] > Analysis Sequence

Refill the Dewar during Analysis on page 6 - 44.

If using a cryostat for analysis, see CryoStat on page D - 1 prior to use.

After running a chemisorption analysis, port 2 can become contaminated with use.
Clean the system by evacuating all three ports that were fitted with empty
physisorption tubes until the system vacuum level is at 9 x 10-® mmHg or lower.

Use to perform a sequence of analyses on port 2. If the Analysis Sequence option is selected and
a sequence analysis is already in progress, the program continues to run the four steps for the
analysis in progress. Files can be added and removed from the sequence while it is in progress.

The analysis sequence can run a:

= sequence of only physisorption files.

m physisorption analysis as a part of the chemisorption analysis sequence.

m physisorption file in any position in the sequence.

The physisorption live graph will be used for the physisorption analysis within a chemisorption
sequence.

Operator intervention will be required between analyses in the sequence if the temperature
control type changes. Intervention will be required if at the beginning of the analysis.
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£2 Analysis Sequence (Unit 1 - S/N: - Chemi)

View: | Operation v

(=N T =

Close Valves

Insert
Append
Edit

Delete

temperature
Analysis free space:
["] use CryoStat (Physi-only)

Note: Analyses marked with a "+" require operator intervention to establish
control.

Sample mass: | 1.0000| g Sample + tube mass: 2.0000 | g
Tube mass: 1.0000 | g Ambient free space: 20.0000 | cm?

20.0000 | cm*

. Click Close Valves.

1
2. Click Insert and select a sampile file.

3. Editthe fields below the sample file selections.

4. Click Save to save the selected files as an analysis sequence file (.SEQ) for future ana-

lyses.

5. Click Start to start the analysis. A window displays data as they are collected. A short delay
is encountered before the port status at the bottom of the window changes from the /dle

state.

6. When the analysis is complete, remove the sample tube and store (or dispose of) the
sample material as applicable.

tube O-ring or Dewar cover may snag the filler rod retaining ring. Loosen the snag

@ Use caution when removing the sample tube if using a hanging filler rod. The sample

gently; excessive force may break the tip of the filler rod.

Analysis Sequence

Field or Button

Description

Close Valves [button]

Closes all valves on the unit.

Report after analysis
[button]

Generates reports to the selected destination when the analysis is
complete.

Sample mass / Sample
+ tube mass / Tube
mass / Analysis free
space [text box]

Enter the values for the sample mass and free space.

6-24
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Analysis Sequence (continued)

Field or Button Description
Use CryoStat For cryostat use only. If using a cryostat, select and enter the Tar-
[check box] [ get Tolerance and Hold Time. The cryostat temperature will be

ramped (if ramp is enabled) to the sample analysis temperature.
Once the cryostat temperature is within the entered tolerance, the
analysis will wait for the hold time before proceeding.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

PERFORM A BLANK ANALYSIS

Unit [n] > Reference Analysis

Perform a Reference Material Analysis on page 6 - 30
Refill the Dewar during Analysis on page 6 - 44

After running a chemisorption analysis, port 2 can become contaminated with use.
Clean the system by evacuating all three ports that were fitted with empty
physisorption tubes until the system vacuum level is at 9 x 106 mmHg or lower.

The Blank Analysis is run in the same manner as a Reference Material analysis except a blank
method is selected and no sample material is placed in the sample tube.
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PERFORM A PULSE CHEMISORPTION ANALYSIS

This topic provides an example of Pulse chemisorption being performed on a sample
of Pt/Al,O5 with CO. Make the appropriate modifications for the material you are
analyzing. Platinum Alumina Reference Material can be ordered from Micromeritics.
Parts and accessories can be found online at www.Micromeritics.com.

A Pulse chemisorption analysis determines the quantity of active gas irreversibly adsorbed. By
applying pulses of known quantity of active gas to the sample, calculations of active surface area,
percent metal dispersion, and active particle size can be made for supported metals. The sample
is dosed with the analysis gas using the injection loop or a syringe until all accessible active sites
are covered. The amount chemisorbed is the difference between the total amount of active gas
injected and the amount that does not interact irreversibly with the sample.

The number of injections depends on the quantity in each pulse and total number of active sites
present.

LooP VOLUME

Environmental Defaults for TCD Analyzers on page 2 - 20

The gas quantity in each pulse is determined by active gas concentration, the loop or syringe
volume, temperature, and pressure. The loop temperature is controlled by the instrument. The
ambient (syringe) temperature and atmospheric pressure are entered by the operator. If a syringe
is used, the volume injected is determined by the operator. In general, it is desirable for the
sample to require at least two doses of gas, but no more than ten doses, before the reaction ends
(although this may vary from lab to lab). Some factors that influence the number of doses required
are sample size, the density of active sites, the concentration of active gas, and the size of the
loop.

A 0.5 cm? loop is provided with the analyzer and an optional 1 ml loop is available.
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LooP CALIBRATION

Loop Calibration for TCD Analyzers on page 10 - 15

For the most accurate determination of the injected gas quantity, a loop calibration experiment
should be performed. An independent loop calibration can be performed before or after the

analysis.

The following example assumes that the loop calibration will be performed after the analysis. A
Loop Calibration step can be included in a pulse chemisorption analysis.

Preparation

Pretreatment Degas by flowing inert gas (such as helium, argon, or nitrogen) over
the sample while ramping the temperature. Hydrogen of at least 10%
concentration is generally used for reduction.

Analysis Pulse the loop (analysis) gas over the sample until the peak area
remains constant.

Cold Trap The cold trap does not need to be cooled during the reference mater-

ial analysis. This may vary depending on application or analysis
method. The cold trap tube should remain on the instrument. Includ-
ing the cold trap in the flow path is optional.

Pressure regulator

Gas cylinders should be set to a level between 10 and 15 psig (69
and 103.5 kPag).

Furnace temperature

Select a temperature high enough to remove any contaminants or
moisture, but not so high as to cause sintering or fusing of the
sample. Ensure the Termination step is set to return the sample tem-
perature to ambient.

/ Before performing an analysis, ensure the sample and analyzer are adequately pre-
pared. See Prepare for Analysis on page 6 - 4.
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PROCEDURE

1.

2.

s

Obtain the sample mass, then install the loaded sample tube and thermocouple on the ana-
lyzer. Raise the furnace around the sample tube and install the insulator disc and shield.
Create a new sample file for this analysis. In the Analysis Conditions drop-down box, select
either Pt-Al CO Pulse Chemisorption Loop or Pt-Al CO Pulse Chemisorption Syringe and
modify the steps as needed depending on the analysis to be performed.

On the Report Options tab, select the required report options for the analysis.

Save and close the file.

Go to Unit [n] > Sample Analysis and select the sample file saved in the previous step.
Chemisorption can only be performed on port 2, therefore Port 2 is the only selection avail-
able.

Click Start to start the analysis.

When prompted, select the calibrations associated with each experiment in the sample file
(if applicable). For this example, select None. Calibration files can also be associated with a
sample file after analysis using the Peak Editor. See Peak Editor for Dynamic Analysis
on page 7 -12.

temperature. When the sample has cooled, lower the furnace and remove the sample

/ When the analysis ends, the furnace begins to lower the sample temperature to room

tube when the analysis is complete.

ﬂ Use the cotton gloves provided in the accessory kit to remove the sample tube before

it has cooled. Rubber gloves may be used to handle the sample tube when it has
cooled.
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GENERATE THE REPORT

Peak Editor for Dynamic Analysis on page 7 - 12

Open the Peak Editor and ensure that peaks are properly marked.

There are three possibilities for each dose of gas injected during:

= all of the gas is taken up by the sample,
m some of the gas is taken up by the sample, or
= none of the gas is taken up by the sample.

When Pulse chemisorption is properly performed, there will be some injections of each type.
When the data is viewed using the Peak Editor, however, only those injections in which some or
none of the gas is taken up will appear as peaks. When all of the gas is taken up by the sample,
none of it reaches the detector and, therefore, the peak area is zero. These types of peaks are
detected automatically by the application and do not require marking.

To generate the report, go to Reports > Start Report> [.SMP file created above] or click
Preview and select the signal view.
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PERFORM A REFERENCE MATERIAL ANALYSIS

Unit [n] > Reference Analysis

CFR In21CFR11 environments, users are required to login to the Confirm application to
Note start an analysis. Once the analysis window is opened, manual control is disabled

until the analysis has completed. During analysis, pausing and resuming is allowed,
however, steps cannot be skipped.

Refill the Dewar during Analysis on page 6 - 44

If using a cryostat for analysis, see CryoStat on page D - 1 prior to use.

After running a chemisorption analysis, port 2 can become contaminated with use.
Clean the system by evacuating all three ports that were fitted with empty
physisorption tubes until the system vacuum level is at 9 x 10-® mmHg or lower.

A reference material analysis is used to verify the analyzer is operating properly and producing
optimum results. These methods provide specifications for critical report quantities and reporting
of whether quantities are in or out of specification.

When running a reference material analysis, use the appropriate reference material provided in
the accessories kit to perform this analysis. The results should match those shown on the label of
the reference material bottle, within the tolerance level.

E If using a cryostat, select Use CryoStat, enter a Target Tolerance and a Hold Time. The
cryostat temperature will be ramped (if ramp is enabled) to the sample analysis temperature.
Once the cryostat temperature is within the entered tolerance, the analysis will wait for the hold
time before proceeding.

[ B8y “Fx S deme o T8 Ay Ut 1 Fex S -G (=]
- I — S
Flex Physisorption Flex Chemisorption or Dynamic Analysis
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Perform a Reference Material Analysis

£ Reference Analysis =@
View: | Operation v Close Valves
Method: Select a method v
| 4
Clear 2.0C
2. [ 1.
Clear 2,00
3. 1
2.0(
Po: 101.3250 | kPa Rath temnerature: 77.300 | K
Star Close
bor s e

5) Fde Untl Repoms Optons Window Melp

ey

[Mi micromeritics®

Iocthumn T abuka Flaport | Inctmmn Lwas Piot | BET Tatuder Maport | BET Taartom Mot | 195 T atuier apon | 190t Pt | Bt A

m If the results are within tolerance, the analyzer is operating properly. Click Close.

&2 Reference Analysis

View:  Operation

ESR AR =X

Close Valves

Method: Select a method

1.0000

=====

Q(mmolie)

[n——

Flex Chemisorption or Dynamic Analysis
If a Blank Analysis was selected, look at the Blank Analysis Report. The isotherm points should all
fall between the minimum and maximum specification lines.

Fom
e

m If the results are not within tolerance, refer to the following Cause and Action table. After per-

forming the action, perform the reference material analysis again.
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[M] micromeritics®

Cause and Action

Cause

Action

The sample was not
degassed properly.

Degas the sample again.

The gas lines are not
clean.

Perform the procedure for cleaning and verifying gas lines, then try
again.

The measured free
space is too high.

This indicates the helium is not pure enough. Use helium that is
99.999% pure, then try again.
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Perform a Sample Analysis

PERFORM A SAMPLE ANALYSIS

Unit [n] > Sample Analysis

Prepare for Analysis on page 6 - 4

Refill the Dewar during Analysis on page 6 - 44

CFR In21CFR11 environments, users are required to login to the Confirm application to

Note

start an analysis. Once the analysis window is opened, manual control is disabled
until the analysis has completed. During analysis, pausing and resuming is allowed,
however, steps cannot be skipped.

After running a chemisorption analysis, port 2 can become contaminated with use.

If using a cryostat for analysis, see CryoStat on page D - 1 prior to use.

Clean the system by evacuating all three ports that were fitted with empty
physisorption tubes until the system vacuum level is at 9 x 106 mmHg or lower.

£2 Analysis

View:  Operation

S8 B =

Close Valves

1 New...

2 New.

3. New...

S8 B =

Close Valves

New. 1.0000
Browse...

Edit

Clear

Report After Analysis....

Physisorption

Chemisorption or Dynamic Analysis

E Use to perform up to three analyses with different analysis conditions and/or report options.
Sample files can be loaded into ports 1, 2, and 3 allowing one analysis using different analysis

conditions to run on each port.

C Use to perform an analysis on port 2.

When Start is selected, the selected sample file’s analysis conditions will be compared with the
port’s hardware configuration to verify that the specified analysis is supported by the hardware:

= The minimum target pressure must be no less than the Minimum Record Pressure for the

minimum range transducer present on the port.
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m The selected sample files will be checked for matching adsorptive gases, matching Psat or
P gases if measured, and matching backfill gases. All selected gases, except those in a
precharged vapor source, must be connected to gas inlets and identified on the Unit [n]
> Unit Configuration > Gas Selections window. See Specify Gas Ports on page 2 - 15.

m If any selected sample file specifies an Adsorptive Dose Method from port 3 and a sample
file is selected for port 3, an error message displays indicating the problem and the Start
window will remain active.

m [fin-situ Degas is selected for any samples, the operator is prompted to raise the
isothermal jackets, then connect and install the degas heating mantle on the
sample tubes. If this occurs, the operator will be prompted after degas to remove
the heating mantle and properly position both the isothermal jackets and Dewar
cover.

m If Vapor Source Temperature Control is selected and the vapor heating mantle is
not connected, the operator is prompted to install and connect the vapor heating
mantle. If Degas is selected for any samples, this will occur after the prompt to
remove the degas heating mantle. Otherwise, this will occur immediately at the
start of analysis.

Click Next to schedule additional analyses after the completion of the first series of analyses. The
Next button displays after the first set of analyses is complete. Samples cannot be removed from
or added to ports until the full set of analyses has completed.

1. Click Close Valves to manually close all analyzer valves.
2. Foraselected port, either click Browse and select a sample file, or click New to create a
new sample file.

P| On port 1, up to three sample files may be selected. The files will be loaded into
ports 1, 2, and 3 in the order they appear in the file selector.

E A sample cannot be attached to port 3 if port 3 is being used as the vapor source.

[« Port 2 is the only available port.

3. Verify the information populated into the sample identification. This information is pulled
from the selected or newly created sample file. The Density value is applicable only if using
the Calculate method for the free space determination.

4. P Edit the Py and Bath temperature fields, if necessary.
5. Ifusing a cryostat, select Use CryoStat and complete the Target tolerance and Hold time

fields.
6. Click Report after analysis to generate reports automatically when the analysis is com-
plete.
6-34 Flex Series Operator Manual

350-42800-01 (Rev R) — Apr 2021



EI micromeritics® Perform a Sample Analysis

7. Onthe Report Settings window, select the report destination. Click OK to return to the pre-
vious window.

8. Click Start to start the analysis. A window displays data as they are collected. A short delay
is encountered before the port status at the bottom of the window changes from the /dle
state.

DA When running a dynamic analysis, after starting the analysis several windows
display with various warnings, messages, and prompts for the user to perform a spe-
cific task. Tasks will depend on the experiments in the current analysis — such as:
wait status, manual injections, or calibration file selection.

9. E When the analysis is complete, remove the sample tube and store (or dispose of) the
sample material as applicable.

ﬂ Use caution when removing the sample tube if using a hanging filler rod. The
sample tube O-ring or Dewar cover may snag the filler rod retaining ring. Loosen the
snag gently as excessive force may break the tip of the filler rod.

A

88 File Unitl Reports Options Window Help \ _ =)=
liew: =1 2 ¢ P
] [ Bl (] [B =

1

=

A. Suspend/Resume/Skip
buttons

B. Port report buttons
C. Live graph settings

=

Quantity Adsorbed (crrilg STF)
-

=

0

oo o1 02 03 04 05 06 o7 08 09 10
Relative Pressure (p/p%)

Port 1: Equilibrating for 4 5. Interval=0 5, Limit=0.0000 mmHg
Port 2:

Port 3:
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Sample Analysis Graph

Field or Button

Description

Live Graph Settings
[button]

Select Thermal transpiration, x-axis Quantity (relative or absolute
pressure), and the x-axis Scale (linear or logarithmic).

Report after analysis
[button]

Generates reports to the selected destination when the analysis is
complete.

Port [button]

Generates a report on data being collected . The reports are
displayed on the computer monitor only.

Resume [button]

Restarts the suspended analysis.

Skip [button]

Moves to the next step. This button is visible only when an analysis is
in progress. Select the ports to skip. In 21CFR11 environments,
steps cannot be skipped.

Status window

Displays the last point pressure and relative pressure for each port.

Suspend [button]

Suspends an analysis in progress.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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TEMPERATURE PROGRAMMED DESORPTION ANALYSIS

This topic provides an example of how to perform a Temperature Programmed
Desorption analysis using NH3 on calcium oxalate under helium with a 10 °C/min tem-
perature ramp. Make the appropriate modifications for the material being analyzed.

Temperature Programmed Desorption (TPD) analyses determine the quantity, type, and strength
of active sites available on the surface of a catalyst from measurement of the amount of gas
desorbed at various temperatures.

After the sample has been outgassed, reduced, or otherwise prepared, a steady stream of
analysis gas flows over the sample and reacts with the active sites. (Alternatively, Pulse
chemisorption can be used to react with active sites.) Programmed desorption begins when the
temperature is ramped linearly over time while a constant stream of inert carrier gas passes over
the sample.

At a certain temperature, the heat will overcome the activation energy, breaking the bond between
the adsorbate and adsorbent. The adsorbed species will then desorb. If different active metals are
present, they usually will desorb the reacted species at different temperatures. The desorbed
molecules enter the stream of inert carrier gas and are swept to the detector where the detector
response is proportional to the gas concentrations. The quantity of desorbed species, combined
with the stoichiometry factor, and the temperature at which pre-adsorbed species desorb, yield
the quantity and strength of active sites, respectively.

If TPD is performed after coverage of the active sites by flow or pulse chemisorption, additional
information about the distribution of active sites and the strength of active sites is collected.

PREPARATION

/ Before performing an analysis, ensure the sample and analyzer are adequately pre-
pared. See Prepare for Analysis on page 6 - 4.
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PROCEDURE

1.

No g s®

For NH3 on zeolite, a sample mass of 50 mg +10 mg should be used. Install the loaded
sample tube and thermocouple on the analyzer. Raise the furnace around the sample tube
and install the insulator disc and shield.

Create a new sample file for this analysis. In the Analysis Conditions drop-down box, select
Y Zeolite with nitrogen, measure freespace and modify the steps as needed depending on
the analysis to be performed.

On the Report Options tab, select the required report options for the analysis.

Save and close the file.

Go to Unit [n] > Sample Analysis and select the sample file saved in the previous step.
Click Start to start the analysis.

When prompted, select the calibrations associated with each experiment in the sample file
(if applicable). For this example, select None. See Peak Editor for Dynamic Analysis on

page 7 - 12.

/ When the analysis ends, the furnace begins to lower the sample temperature to room

temperature. When the sample has cooled, remove the sample tube when the
analysis is complete.

it has cooled. Rubber gloves may be used to handle the sample tube when it has

n Use the cotton gloves provided in the accessory kit to remove the sample tube before

cooled.

8.

Verify that the peak temperatures are consistent with specifications in the Reference Mater-
ial booklet.
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TEMPERATURE PROGRAMMED OXIDATION ANALYSIS

/ This topic provides an example of performing a TPO on WO3. Because TPRis often
used as the preparation for TPO, the TPR process was included in this example.

Temperature Programmed Oxidation (TPO) examines the extent to which a catalyst can be re-
oxidized. Generally, TPO analyses are used to measure the degree of reduction of certain oxides.

Usually the sample is pretreated and the metal oxides are reduced to the base metal. Then the
reactant gas is applied to the sample in pulses or (alternatively) as a steady stream. The analyzer
measures the uptake of the reactant gas.

TPO is often performed after TPR is performed. When the TPR experiment concludes, the sample
is returned to room temperature. Then, the analysis gas is changed to 2-5% O, + He. This gas
mixture is flowed after the sample is at ambient temperature, then the temperature is ramped up to
the same maximum temperature used for the preceding TPR analysis. The portion of the sample
that had been reduced is re-oxidized, and the degree of reduction can be calculated.

If the TPR and TPO results are different, there are several possible causes: the sample material
sintered such that only a surface oxide (and not a bulk oxide) is formed, or part of the sample was
re-oxidized at room temperature while the TCD baseline was stabilizing.

When using any mixture of gases for TPR or TPO analyses, make sure the thermal
conductivities of the two gases in the mixture are quite different for maximum
sensitivity, See Gas Charts on page | - 1.

Preparation
Pretreatment TPR

Analysis 2 to 5% oxygen/helium is flowed through the sample while tem-
perature is ramped, beginning at ambient temperature.

Cold Trap The cold trap does not need to be cooled during the reference
material analysis. This may vary depending on application or
analysis method. The cold trap tube should remain on the
instrument. Including the cold trap in the flow path is optional.

/ Before performing an analysis, ensure the sample and analyzer are adequately pre-
pared. See Prepare for Analysis on page 6 - 4.
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PROCEDURE

1.

© N o s

Obtain the sample mass, then install the loaded sample tube and thermocouple on the ana-
lyzer. Raise the furnace around the sample tube.

Create a new sample file for this analysis. In the Analysis Conditions drop-down box, select
the analysis conditions file and modify the steps as needed depending on the analysis to be
performed.

On the Report Options tab, select the required report options for the analysis.

Save and close the file.

Go to Unit [n] > Sample Analysis and select the sample file saved in the previous step.
Click Start to start the analysis.

When prompted, select the calibrations associated with each experiment in the sample file
(if applicable). For this example, select None. Calibration files can also be associated with a
sample file after analysis using the Peak Editor. See Peak Editor for Dynamic Analysis
on page7-12.

/ When the analysis ends, the furnace begins to lower the sample to room temperature.

When the sample has cooled, remove the sample tube when the analysis is complete.

10.
11.

As the temperature increases, the sample is oxidized, and the application calculates the
volume of oxygen taken up.

Allow the TCD signal to return to the initial baseline after the peak has been displayed.

When the displayed sample temperature reaches the ambient temperature, open the fur-
nace. Using gloves, remove the sample tube.

Use the cotton gloves provided in the accessory kit to remove the sample tube before
it has cooled. Rubber gloves may be used to handle the sample tube when it has
cooled.
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TEMPERATURE PROGRAMMED REDUCTION ANALYSIS

ver Oxide Reference Material can be ordered from Micromeritics. Parts and accessor-

/ This topic provides an example of how to perform a TPR analysis of silver oxide. Sil-
ies can be found online at www.Micromeritics.com.

Temperature Programmed Reduction (TPR) determines the quantity of reducing gas consumed
during reaction with the catalyst and reveals the temperature at which reduction occurs. For the
reference material analysis, hydrogen (5-10%) is the reducing gas. The following method provides
an overview of the steps to successfully analyze the reference material only. For other materials,
the sample mass, gas flow rate, temperature ramp, active gas, or active gas concentration may
need to be changed. Refer to the reference material booklet and the reference material bottle
label for the expected results.

Preparation
Pretreatment (Optional step.) Not required for reference material.

Analysis Flow 5-10% hydrogen/argon or 5-10% hydrogen/nitrogen, while ramping
the temperature. The analyzer records hydrogen consumption as a func-
tion of temperature. Nitrogen is sometimes used because it may be more
economical than argon.

Cold Trap A cooling of the cold trap is generally needed for the entire analysis.

A mixture of liquid nitrogen or dry ice and acetone or isopropanol
provides the best performance. A cooling bath with dry ice will last longer
than a cooling bath with liquid nitrogen. See step 2 in the following pro-
cedure for preparation details.

/ Before performing an analysis, ensure the sample and analyzer are adequately pre-
pared. See Prepare for Analysis on page 6 - 4.
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PROCEDURE

Create Sample Files on page 3 - 2
Peak Editor for Dynamic Analysis on page 7 - 12

1. Obtain the sample mass (refer to the Silver Oxide Reference Material booklet for proper
mass range), then install the loaded sample tube and thermocouple on the analyzer. Raise
the furnace around the sample tube and install the insulator disc and shield.

2. Place the isopropyl alcohol in a cold trap Dewar and slowly pour LN, into the Dewar while
stirring the mixture. Continue to add and stir until the mixture becomes slushy. The mixture
must be capable of achieving a temperature of approximately -90 °C.

3. Place the cold trap Dewar filled with cooling fluid around the cold trap tube. Ensure that the
cold trap Dewar contains enough coolant to immerse the lower part of the cold trap tube.

A Extreme caution should be used when mixing the IPA/LN,. See Dewar Precautions
on page 6 - 2.

s

Create a new sample file for this analysis. In the Analysis Conditions drop-down box, select
AgO TPR with H2Ar .

On the Report Options tab, select Summary in the Selected Reports list box.

Save and close the file.

Go to Unit [n] > Sample Analysis and select the sample file saved in the previous step.
Click Start to start the analysis.

When prompted, select the calibrations associated with each experiment in the sample file
(if applicable). For this example, select None. Calibration files can also be associated with a
sample file after analysis using the Peak Editor.

© 0N O

As the temperature increases, the silver oxide is reduced, the water produced by the
reaction is collected in the cold trap, and the amount of hydrogen consumed is detected.

A hydrogen consumption peak which corresponds to the reduction capacity of silver oxide is
displayed. Refer to the Silver Oxide Reference Material booklet for the maximum peak
temperature.

10. When the analysis concludes, remove the sample tube.

Use the cotton gloves provided in the accessory kit to remove the sample tube before
it has cooled. Rubber gloves may be used to handle the sample tube when it has
cooled.
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PERFORM A VAPOR ANALYSIS

/ This option is for physisorption or chemisorption only.

File > Open > [.SMP File]

After running a chemisorption analysis, port 2 can become contaminated with use.
Clean the system by evacuating all three ports that were fitted with empty
physisorption tubes until the system vacuum level is at 9 x 10 mmHg or lower.

A vapor analysis requires that a vapor source container be installed.

for analyzers with a shelf support and another method for analyzers without a shelf

/ Micromeritics offers two methods of installing a vapor source container - one method
support. See Vapor Source Container Installation on page 11-17.

1. Onthe Adsorptive Properties window, select Vapor source in the Dosing Method group box.
If running the vapor analysis on port 3, select From sample port 3 and proceed to Step 3.

2. Setthe Vapor Source Temperature to the correct value if Vapor Source is selected. If
sample port 3 is selected, the analysis bath temperature is assumed.

3. Select Controlled by instrument using heating mantle if the vapor source is to be auto-
matically heated to this temperature.

must be set to Accessory temperature control. See Temperature button in Analysis

/ If this option is selected for a chemisorption analysis, sample temperature control
Conditions for Physisorption and Chemisorption on page 4 - 5.
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REFILL THE DEWAR DURING ANALYSIS

@ Always use caution when handling Dewars. See Dewar Precautions on page 6 - 2.

/ Ensure cryogen is readily available in a suitable delivery system when using this fea-
ture. The Dewar will be lowered 2.5 cm, so space for refilling will be limited.

Recommended Tools

Tool Description

Liquid Nitrogen Transfer Unit
[part number 021-00000-00]

Cross bar
=

Dip Stick [part number 350-25901-00] This dipstick is

specially designed to easily fit within a 2.5 cm space 5
Fill level mar\ ™~ Dip stick

when the Dewar is lowered.

Parts and accessories can be found online at www.Micromeritics.com.
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Iml micromeritics® Refill the Dewar during Analysis

The Dewar refill icon allows the checking and refilling of the Dewar during an analysis. This icon is
only enabled during data collection. Itis important that the cryogen level always cover the bottom
portion of the isothermal jacket during analysis, therefore, the level should be checked within 48
hours of starting an analysis. When using this icon, the operator is prompted when the analysis is
paused, the Dewar lowered, and when the analysis resumes. The application automatically
ensures that analysis dosing and equilibration will not be disrupted by the refilling procedure.

For ease of use, Micromeritics recommends the use of their Liquid Nitrogen Transfer Unit. This
unit has a small delivery tube that easily inserts between the Dewar cover and the top of the
Dewar.

Dewar refill icon

~

(3l

88 Analysis (Unit 1 - $/N: 004) o|[®@][=
View: (operation - 1 i a 7
—— Potl  —e— Fon2  —%— Pot3

Bl
(3l

Quantity Adsorbed (ang STP)

014573 106.4513

un Time:

1631
16233
16:31

1. Tolower the Dewar elevator 2.5 cm, click the Dewar icon. The following prompt will display:

The instrument will pause the analysis and lower the Dewar for refilling. This may take up
to a minute or so. Have sufficient cryogen prepared to refill the Dewar before continuing.

[Continue Refill]  [Cancel Refill]

Continue Refill. Click to lower the Dewar elevator 2.5 cm. Continue to the next step for
instructions to refill the Dewar.

Cancel Refill. Click to close the prompt and cancel the elevator movement. Analysis will
continue. The remaining steps in this section can be skipped if this button is clicked.

2. If a sample is being dosed with adsorptive, the analysis will pause prior to elevator move-
ment. This pause may take a minute or so then the elevator will lower automatically. The fol-
lowing prompt will display:

Waiting for analysis to pause. This may take up to a minute or so. When the analysis is
paused, the Dewar will be lowered 2.5 cm to allow refill.

[Cancel Refill]
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Cancel Refill. Click to close the prompt and cancel the pause. Analysis will continue after
equilibration. The remaining steps in this section can be skipped if this button is clicked.

3. When the analysis pauses, the Dewar elevator will lower 2.5 cm. The following prompt will
display:

The analysis is paused. Remove the safety shield and refill the Dewar. When complete,
reposition the Dewar cover and safety shield. Then press [Resume Analysis]. The
analysis will wait 20 minutes after the Dewar is raised for thermal equilibration.

[Resume Analysis]

a. With the elevator lowered, remove the safety shield.

b. Check the cryogen level using the recommended dip stick. If necessary, slide the
Dewar cover upwards slightly to allow a little more room for the dip stick and cryogen
delivery tube.

i. Lay the dip stick horizontally along the top of the Dewar and to the right of the
sample tubes on ports 2 and 3.

Slide dip stick against the
right side of sample tubes
on ports 2 and 3 then pivot
dipstick downwards to
place in Dewar

ii. Pivotthe dip stick so that the end of the dip stick slides into the Dewar
against the right sides of sample tubes on ports 2 and 3. Do not try to insert
the dip stick in the middle of the sample tubes. The isothermal jackets will be
in the way.

c. Remove the dipstick and recheck the cryogen level.

d. Torefill the Dewar, insert the cryogen delivery tube into the opening between the
Dewar and Dewar cover and fill with cryogen. Check the cryogen level often. When
the level is correct, slightly lower the Dewar cover so that it is approximately 2 in.
below the top of the sample tubes. It should be low enough so that when the Dewar
rises, the lid will rest on the top of the Dewar opening.

e. When the cryogen level is correct, reinstall the Dewar safety shield.

4. Inthe application, click Resume Analysis on the analysis window. The analysis will
resume after a delay for thermal equilibration. Any equilibration that was in process ori-
ginally will restart automatically.
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7 ABOUT REPORTS

CFR Dynamic Analysis and Chemisorption options are not applicable when the software is
Note installed in 21CFR11 environments.

Reports > Close Reports

Closes all open reports. This option is unavailable if reports are being generated.
Reports > Start Report
Generates a report on a sample analysis.

Reports can be generated for data collected on a sample that has completed analysis, collected
on a sample currently being analyzed, or manually entered.
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HEAT OF ADSORPTION REPORT

Reports > Heat of Adsorption

Heat of Adsorption X

Quantites Adsorbed (mmol/g)

JSample Temp. () | 0.00000

Repart settings
Show report itle: [ Feat of Acsorption Add Samples...

Height: [ 0.250 [in  width: | 2,000 |in Clear Samples

Tabular report Edit Quantities...
Isostere plot
Heat of adsorption plot
Destination
(@) Preview
OPrint 1
OFile: C:\CONFIRM FOR TRISTAR II PLUS\DATA &

HOAReport

Report System (*.rep)

Open... Save... Report Cancel

Use to select sample files, define quantities, and generate a Heat of Adsorption report. The
isosteric heat of adsorption is an important parameter for characterizing the surface heterogeneity
and for providing information about the adsorbent and the adsorption capacity. Multiple adsorption
isotherms are obtained on the same sample using the same adsorptive but at different
temperatures to obtain the heat of adsorption.

Heat of Adsorption Report

Field or Button Description
Add Samples [button] |Adds a sample file to the table.
Clear Samples [button] | Removes all entries from the table.

Edit Quantities [button] | Specifies the range of surface coverage to include in the report.
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Heat of Adsorption Report

Heat of Adsorption Report (continued)

Field or Button

Description

Increasing gty ads: 000000 - 446.14774 mmol/g

Insert Range. Specifies the starting and ending quantities adsorbed
and number of points to insert.

Load Table. Imports values from another file.
Save Table. Saves the current table as a .QNT file.

Apply. Applies all table changes.

Heat of adsorption plot
[selection]

Generates the Heat of Adsorption data in a graphical format.

Isostere plot [selection]

Generates a graph showing quantities of gas adsorbed versus the
temperature.

Remove Sample

Removes the selected sample from the list.

[button]

Show graphic Use to show a graphic on the report header.

[check box]
Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title Select then enter a report title to appear on the report header.

[check box]

Tabular report Generates a tabular report of the included samples that contains the

[check box] numeric values contributed by each sample.

/

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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SPC REPORT FOR PHYSISORPTION

Reports > SPC Report Options

Use to generate reports with various SPC (Statistical Process Control) options. All selected
variables must be computed for each sample file used in an SPC report; therefore, it is more
efficient to select only the necessary variables.

Gas Adsorption SPC Report Options

Analysis Options Surface Area
["]sample mass []single-point BET
["]Equilibration interval []Multi-point BET
["JEvacuation time [[JLangmuir

[] Analysis temperature []t-Plot micropore
[]saturation pressure [“]t-Plot external
["] Ambient free space ["]B3H adsorption
[] Analysis free space [C]BIH desorption
[“JPort volume ["]D-H adsorption

[C]D-H desorption

OK Cancel

—_
More...

Pore Volume

[] Adsorption total

["] Desorption total

[Jt-Plot micropore

[C]BIH cumulative adsorption
[C]BIH cumulative desorption
[[]D-H cumulative adsorption
[[]D-H cumulative desorption
Pore Size

[C]BIH ads. avg. pore width 4V/A
[C]BIH des. avg. pore width 4V/A
[C]D-H ads. avg. pore width 4V/A
["]D-H des. avg. pore width 4V/A
[[] Avg. pore width adsorption
[[] Avg. pore width desorption
[[INanopartide size

Gas Adsorption SPC Report Options
BET

[C]c value

[“IMonolayer volume

[ Correlation coefficient

Langmuir

[[]B value
[IMonolayer volume
[[] Correlation coefficient

Horvath-Kawazoe

[[]Maximum pore volume
["]Median pore width

X
Dubinin-Astakhov Alpha-S
[“IMicropore surface area [“]slope
[] Limiting micropore volume []Y-intercept
Dubinin-Radushkevich DFT Pore Size
[IMicropore surface area [ Total pore area
[C]Monolayer capacity [[JTotal pore volume
MP-Method DFT Surface Area

[] Cumulative surface

[] cumulative pore volume
["] Average pore hydraulic radius

area [[]Total surface area

NLDFT Advanced PSD
[[]Total pore area
[[]Total pore volume

Cancel

The selected items display as graph variable selections in Reports > Regression Report and
graph selections in Reports > Control Chart. If report options for NLDFT Advanced PSD are

required, click More.
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Regression Report for Physisorption

REGRESSION REPORT FOR PHYSISORPTION

Reports > Regression Report

Use to generate a Statistical Process Control (SPC) Regression report to determine the
interdependency between two variables. Up to three dependent variables (y-axis) may be plotted
against a single independent variable (x-axis). The degree of correlation between the variables is

also reported.

Gas Adsorption Regression Report

[ show report title [ Regression Report

nnnnnnnnnn

miclogo.emf B
show graphic
hoge: [ 0] waan: [ 2000 m
Variable
axis variable
None
<t graph Y- b
irst graph Y-axi Vone
d graph b
econd grap! Vone
hird graph Y- b None
[ITabular rep [JRecalculate archived
[abel d Samples...

&

>
0 R R

Gas Adsorption Regression Report

Field or Button

Description

Autoscale [check box]

When enabled, allows the x- and y-axes to be scaled automatically.

Axis Range [text box]

Enter the beginning and ending values for the x- and y-axis ranges.
These fields are disabled if Autoscale is selected.

Label data [check box]

Use to label the points on the plot to correspond with the values in
the sample files.

Recalculate archived

SPC results [check box]

The first time this option is used, the time it takes to generate the
report is lengthened. The second time the report is generated, if
using the same sample files used in the initial calculation, it is
recommended that this option not be selected since the data was
recalculated previously. If a sample file is added or removed from the
report after the initial recalculation, this option should be selected
again to ensure the data from the newly added or removed sample
file is recalculated.

Report [button]

Generates the report.

Samples [button]

Select additional sample files to add to the report.

Save as Default [button]

Click to save selected report options as default report settings.
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Gas Adsorption Regression Report (continued)

Field or Button Description
Show graphic Use to show a graphic on the report header.
[check box]

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated

report.
Show report title Select then enter a report title to appear on the report header.
[check box]
Tabular report Generates a tabular report of the included samples that contains the
[check box] numeric values contributed by each sample.

X- and Y-Axis variable |Designates the x- and y-axes variables. The variables in the drop-
[drop-down box] down lists are those selected in the Reports > SPC Report Options
window. Use these options to plot the regression of up to three y-axis
variables against the x-axis variable.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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Control Chart Report for Physisorption

CONTROL CHART REPORT FOR PHYSISORPTION

Reports > Control Chart

Generates a Statistical Process Control (SPC) chart report which plots the changes in a statistic.

Gas Adsorption Control Chart Report

Field or Button

Description

Graph [n] [button]

Defines the y-axis of each graph.

Gas Adsorption Control Chart Graph 1 Options

¥ Axis
Statistic: |None

Autoscale

Center Line Limit Lines

(@ None (® None

(O Mean O +and-

(OEntered (O Entered
o] (o

X

Statistic. Displays the SPC variables selected on the Reports >
SPC Report Options window. The selected variable will be plotted
for each selected sample. This selection also becomes the y-axis

label.

Autoscale. Allows the y-axis to be scaled automatically. To specify a
range, deselect this option and enter a range in the From and To

fields.
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Gas Adsorption Control Chart Report (continued)

Field or Button

Description

Center Line. Displays placement options for the center line in the
graph. Select Entered to specify placement of the line or Mean to

place the center line at the calculated mean value for the selected
samples.

Limit Lines. Displays limiting lines options. Lines can be placed at
some multiple of the standard deviation or at specified positions
(Entered). When Entered is selected, enter the High limit and Low
limit fields with appropriate values.

Recalculate archived
SPC results [check box]

The first time this option is used, the time it takes to generate the
reportis lengthened. The second time the report is generated, if
using the same sample files used in the initial calculation, it is
recommended that this option not be selected since the data was
recalculated previously. If a sample file is added or removed from the
report after the initial recalculation, this option should be selected
again to ensure the data from the newly added or removed sample
file is recalculated.

Report [button]

Generates the report.

Samples [button]

Select additional sample files to add to the report.

Show graphic

Use to show a graphic on the report header.

[check box] _ _ _
Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title Select then enter a report title to appear on the report header.

[check box]

Tabular report Generates a tabular report of the included samples that contains the

[check box] numeric values contributed by each sample.
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Gas Adsorption Control Chart Report (continued)

Field or Button Description
X Axis Order By Select the order in which x-axis statistics are placed. Sort by:
[group box]

Time. Time the files were analyzed.
File name. Alphanumeric order.
Date. Date the files were analyzed.

Minutes. Minutes elapsed from the first file placed on the list, which
is the earliest-analyzed file.

Days. Number of days elapsed from the first file placed on the list,
which is the earliest-analyzed file.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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INTERACTIVE REPORTS

When opening a sample file that contains data from a complete or in-progress analysis, the
interactive reporting feature is enabled.

1. When opening a sample file that contains analysis data, a window with the following inform-
ation will display:

m alinear plot and log plot of the data collected during analysis.
m a summary of the analysis giving a single total pore volume and surface area.

i [E=H O O

Free Space
Isotherm Oone

(@ Measured -0.0408 cm?
1 ,_——-I—-""—'P__—_"'—"——" Oentered 0.0000
1 / O Calculated

Somple | 1819

Summary

@ Relative prassurs (@ Adsorption paint
(O pesorption point
(O surface area point

poandT...

(O Absolute pressure

Quantity Adsorbed (mmol/g)

— T — T
005 010 015 020
Relative Pressure (p/p°)

Summary
Single point adsorption

Isotherm

,/H/k’l

3

_/—‘*’/1

o

inf ea 02803 m¥g
at relative pressure: 0.139327720

Quantity Adsorbed (mmol/g)

o

T T T
0.06 008 01 02
Relative Pressure (p/p°)

Close Isotherm v Preview

2. Toview the plots in either relative or absolute pressure, select either the Relative Pressure
or Absolute Pressure option.

3. Toview the reports selected for generation during the analysis, click Preview.
4. From the view selector drop-down list at the bottom of the window, do either of the following:

m Change the option presentation of the sample description window to either Basic or
Advanced to modify certain file parameters.
m Select another plot from the list and edit the data contained in the plot.

5. When ranges are edited, the changes are reflected immediately in the plots and the sum-
mary data displayed in the window. Some editing options are:

m Drag the blue bars to increase or decrease the range of data included in the plot.
m Edit the Isotherm Linear Plot to include or omit the data point from the BET plot.
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m Right-click to display a popup menu to include reports; enable or select overlays; edit
curves, axes, legends, titles; and copy and paste the data in a graph or in tabular
format.

6. Click Save.

MICROACTIVE REPORTS

MicroActive reports are generated automatically after an analysis is performed. This feature
provides a quick and easy way to investigate and manipulate analysis data using a variety of
reporting methods.

When a sample file with a status of Complete, Analyzing or Entered is opened, a linear plot and
log plot of the data collected during analysis are displayed as well as a summary of the analysis
giving the total pore volume. Numerous reports are accessible from a drop-down menu.

When a report is opened, plots and summary data are displayed, and in some reports certain
parameters (for example, thickness curve type, pore geometry, and interaction parameters) are
also displayed. Plots may be edited by selecting the data points or data point range to be included
in the plots and modifying the parameters. When a report is edited, the results are immediately
reflected in the plots and summary data.
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PEAK EDITOR FOR DYNAMIC ANALYSIS

sample information metal table editor. Stoichiometry factors can also be set for each
pulse chemisorption experiment using the analysis conditions experiment step editor.
If required, stoichiometry factors for a completed pulse chemisorption experiment can
be viewed and modified using the peak editor’s stoichiometry settings window.

/ Analysis condition defaults for metal stoichiometry factors can be set using the

The Peak Editor feature provides the viewing and editing of up to 16 dynamic analysis
experiments. The Peak Editor options are accessed by selecting a sample file that contains at
least one experiment with signal data from the drop-down menu at the bottom of the report
window. Peaks can be defined, edited, or deleted.

Peaks are defined by a baseline. If the Find All Peaks button is clicked (enabled when Edit Peak
is selected), the Peak Editor will define baselines for all positive peaks detected according to the
Integration window accessed from the Integration button. For Pulse experiments and Loop
calibrations, peaks are found using events that occurred during the analysis — such as the time
an injection started — instead of peak detection options. The baseline can be manually defined by
double left clicking in the signal graph on the starting baseline point (this places the Peak Editor
into baseline creation mode). The ending baseline point is then defined by left clicking in the signal
graph on the ending baseline point. Baseline creation mode can be exited by right clicking in the
signal graph.
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PEAK EDITOR VIEW

Open a Sample File on page 3 -7

When a sample file with a Complete status is opened, three views are available:

= Overlay Experiments View
m Stacked Experiments View
= Peak Editor

To change the view, select the view from the drop-down list at the bottom of the graph window.
Only the Peak Editor view allows editing of the experiment.

oo =

Example of
' J ] | | Overlay Experiments view

Tme (minutes) v

Signal (a.u)

signal (a.u)

Example of
Stacked Experiments view

signal (a.u)
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s

P

S ”  Example of

Pesk LeftX RightX CenterX Heicht PeskArea % Difference

View Type

@Editpeaks ‘Sample mass: a ] .
OFt pesks Sonal: [NH3TPD — 10oC/in ][ mportms Pe a k E d i t or view

Calbration, Stoichiometry. Remove s
Find Al Peaks

Interpolate Temperatre | Range
e Clinterpolte Temperatre T

Display Options: []Zero [CJsmooth
Dckete AllPeaks ivert
[bide peak marks 5

Peak Editor -NH3TPD — 100C/min Previen

Peak Editor

Field or Button

Description

Calibration
[button] [4

TCD Calibration (B

Select the calibration to be used with this experiment or create a calibration from this
experiment,

Calibration:  rone

Experiment Information

Descripkion:  Ag0 TPR with HZar

Type of analysis: | Temperature Programmed ']

Manual Injections

1.0000
Yolume {em*) Elapsed Time {min.)
Ambient temperature: 24.0 eC 1 1.0000| 0.0000

Atmospheric pressure: 100.0 kpa

Active concentration: 100,000 %

Ok l [ Cancel l [Create Calihratinn‘.‘]

Calibration. Select a previously defined calibration file. If the
experiment and calibration gases differ, a warning displays. The system
also compares the experiment flow rate and calibration flow rate. If they
differ, a warning displays.

Experiment Information.

m Description. Enter a description of the current experiment.

m Type of analysis. Select the analysis type that most closely
describes the current experiment. This will affect what is reported as
part of the Summary report data and the available reports.

m Vapor. Select a vapor before creating or applying a vapor calibration.
This field is only visible for vapor experiments.
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Peak Editor (continued)

Field or Button

Description

m Loop volume. Displays the volume of the gas injection loop.

= Ambient temperature. Displays the ambient temperature entry from
the Options > Environmental Defaults setting. This field may be
edited.

m Atmospheric pressure. Displays the atmospheric pressure entry
from the Options > Environmental Defaults setting. This field may
be edited.

m Active concentration. Displays the percent of the gas mixture which
is composed of the reactive gas versus an inert filler. This value is
used for data reduction, including pulse chemisorption.

m Manual Injections. Displays the injection settings entered during
analysis. This table may be edited.

Create Calibration. Create a signal calibration from the currently
selected experiment.

Delete All [button] [¥
Delete All Peaks
[button]

Delete Peak [button]

Clears all peaks from the table and removes all markings from the
peaks.

To delete a single peak, select the peak from the peak table or left click
the peak to enable the Delete Peak button.

Delete All is available only when the Fit Peaks selection is enabled.

Delete All Peaks is available only when the Edit Peaks selection is
enabled.

Delete Peak is available only when the Fit Peaks selection is enabled.

Delete Baseline

Removes the baseline from the graph.

[button] [

Available only when the Fit Peaks selection is enabled.
Display Options Use to change how the data are displayed.
[group box]

Zero. Select to zero the signal (starting baseline).
Invert. Select to invert the signal (peak).
Hide Peak Marks. Select to hide all marks from peaks.

Smooth. Select to smooth the signal on the display.

m Order and Window. Enabled when the Smooth checkbox is selec-
ted. The smoothing process uses the Savitzky-Golay filter to fit a poly-
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Peak Editor (continued)

Field or Button

Description

nomial order n into size of the specified window [m].

Find All Peaks
[button]

Defines baselines for all positive peaks detected according to the
Integration window, accessed via the Integration button. Pulse
experiments and Loop calibrations do not use Integration button
settings when finding peaks.

Find All Peaks automatically detects the peaks and draws the baseline
for detection. Place the cursor over one of the baseline end points and
double left click to grab the baseline. Move the cursor to the new
position and right click. Available only when the Edit Peak selection is
enabled.

Gaussian
[drop-down box] [

Standard Gaussian curve. Available only when the Fit Peaks selection
is enabled.

Import M.S. [button]
Remove M.S. [button]

Mass spectrometer data can be imported and overlaid in the Overlay
Experiment view. In the Peak Editor view, it is saved as a separate
signal.

Import M.S. Click to import mass spectrometer data. In the bottom
right-hand corner of the pop-up window, select the type of mass
spectrometer file to import (Quadera, Quadstar, MKS, or TAMS). Select
the file, then click Open to import the signals.

A popup window prompts the user to sync the temperature data with the
current experiment temperature data.

Remove M.S. Click to remove all previously imported mass
spectrometer signals from the current experiment.

Import standard
peaks [button] [W

Imports the saved peak parameters from the Edit Peaks view.

Available only when the Fit Peaks selection is enabled.
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Peak Editor for Dynamic Analysis

Peak Editor (continued)

Field or Button

Description

Integration Options

[button] [«

r ~
Peak Detection/Integration Options @

Standard Settings
Baseline mode (@ Best fit baseline

(7 Snap to baseline
Minimum peak height: 0.25 9%F.5,
Peak smoothing: 0 points

Mumber of points for smoothing. If peak
smoothing value is 0, automatic selection is
enabled (1% of data points). Its purpose is
identifying peak edges; it does not affect
peak height or area.

Advanced Settings

Sensitivity: 0.01 %F.5.
Maximum shoulder ratio: 33 %

i Maximum group separation: 33 %
Minimum peak area: 1.00 %F.S5.-min
Maximum baseline slope: 0,10  %F.5. /min

OK ] [ Cancel ]

See Peak Detection / Integration Options on page K - 1.

Log Normal Skewed

A 4-parameter, log-normal shape that allows for skewed peaks. This is

Gaussian. Standard Gaussian curve.

[button] [« the default peak. Available only when the Fit Peaks selection is enabled.
Peak fit model Select the peak shape. Available only when the Fit Peaks selection is
[button] [« enabled.

Log Normal Skewed. A 4-parameter, log-normal shape that allows for
skewed peaks. This is the default peak.
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Peak Editor (continued)

Field or Button

Description

Sample mass

The sample mass field is auto-filled with the sample mass from the

[group box] [«

[text box] sample file being used.

Snap to Signal Places the selected baseline point on the signal curve.

[button] [«

Stoichiometry See Active Metals for Chemisorption Analyzers on page 3 - 13.
[button] [«

View Type Edit Peak. Locates peaks via signal integration over a baseline.

Fit Peaks. Locates peaks via function fitting to minimize residual over a
baseline.

x-axis
[drop-down box]

Change the x-axis to display as time or temperature.

This feature is available in Stacked Experiment view, Overlay
Experiment view, and Peak Editor view. In Peak Editor view, the Edit
Peak selection must be enabled.

Time (minutes). Select to display the x-axis as minutes.

Temperature. Select to display the x-axis as temperature.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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EVALUATE REPORT RESULTS

Analysis reports provide a record of test conditions, experimental data, and information extracted
from the experimental data by application of various reduction methods. This topic discusses the
elements of various reports presented by Micromeritics’ static volumetric physisorption analyzers
and suggests ways by which the merit of the reported information may be evaluated.

Regardless of the precautions exercised before the analysis, problems still may occur during the
analysis, or as a result of using inappropriate parameters or even inappropriate methods. The
analysis data should be inspected for evidence of experimental error. The traditional method of
confirming the quality of the experiment is to repeat the analysis. Toward that end, Micromeritics’
analyzers log and report the exact conditions of each analysis.

Analysis data can be evaluated by:

Viewing the Validation Report

Inspecting the Isotherm Plot

Evaluating the Isotherm Tabular Data Set
Reviewing Reduced Data
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VIEW THE VALIDATION REPORT

The Validation report shows whether the data collected during an analysis are within typical
ranges. Select the types of reports to include by selecting the report in the Validation Report
Options window.

{8 Validation Report Options | = || (=) |[wt:am

Isotherm

BET
[[JLangmuir
[JFreundlich
[JTemkin

[CJt-Plot

[]f-Ratio method
[C]B3H adsorption
[[]B3H desorption
[]D-H adsorption
[]D-H desorption
[[JHorvath-Kawazoe
[C]DFT pore size
[C]DFT surface energy
["]Dubinin

[CImp-Method

OK Cancel

When a selected report is generated, if errors occur, a message is displayed across the top
portion of the report and a unique symbol displays on the graph.

INSPECT THE ISOTHERM PLOT

Evaluation of data should begin with a visual inspection of the isotherm plot. The plot should be
composed of data which have not been subjected to mathematical smoothing as far as possible. If
the data describe a Type | isotherm, then the plot is best shown on a logarithmic pressure axis so
that details of the low pressure region are revealed. Data in this region are important particularly
for micropore studies. Examine the plot to determine if any points are outliers or if a region of the
isotherm exhibits characteristics (spikes, steps, etc.) which are inconsistent with the physical
process being monitored. The philosophical question of whether or not these suspected
extraneous data points should be removed from the raw data is not considered here, but it may be
appropriate to exclude an outlier from reduced data. Too many outliers can cause the integrity of
the total data set to come under suspicion.

Examine specific reported values to confirm that the isotherm data were collected under
reasonable conditions and using reasonable parameters. For example, confirm that the free
space values reported are typical for the sample holder and bath in use. A problem with either
ambient or analysis free space values may indicate a free space measurement error and affect all
calculations of quantity adsorbed.
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The raw data should be carefully examined before it is reduced. Errors that occur in raw data will
only be exacerbated in reduced data.!)

EVALUATE THE ISOTHERM TABULAR DATA SET

Another place to look for reasonableness of the data is the adsorptive uptake by the sample in the
BET range (P/Py = 0.05 to 0.30). Total uptake is the specific quantity adsorbed (cm3/g STP) times
the sample mass (g). As an example, the level of uncertainty in this range typically is less than

0.1 cm3 STP for a high performance system. Total uptake quantities should be some multiple of
this level of uncertainty. Otherwise, an unfavorable signal-to-noise ratio and unreliable data result.
The solution is to use a greater quantity of sample to increase adsorptive uptake.

Another valuable bit of information resides in the tabulated saturation pressure. This pressure is
expected to change somewhat over the duration of an analysis, but it is not expected to do so with
large or abrupt transitions. Unreasonable saturation pressures or unusual changes may indicate
that a gas different from the adsorptive was used in determining P, that the level of the cryogen
fell too far, or that the cryogen is impure or inappropriate.

With experience, obvious signs of problems can be detected by a quick inspection of the tabular
and graphical data. If the data appear satisfactory, the next step is to evaluate the reduced data.2)

REVIEW REDUCED DATA

Isotherm data may be analyzed by any one of several reduction methods depending on the
analyzer model and pressure range employed. The quality of the results depends on the quality of
the isotherm, the congruity of the data reduction parameters with experimental conditions, the
agreement of the theoretical model with the physical gas-solid system, and compliance to the
pressure range over which the method is valid. Typically, results can be appraised by examining a
few salient areas of the report as described in the following topics.3)

1) The information in this article is extracted from Analytical Methods in Fine Particle Technology,
Webb, P. and Orr, C., (1997).

2) Most of the information in this article is extracted from Analytical Methods in Fine Particle
Technology, Webb, P. and Orr, C., (1997).

3) Most of the information in this article is extracted from Analytical Methods in Fine Particle
Technology, Webb, P. and Orr, C., (1997).
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PHYSICAL PARAMETERS

The value of physical parameters which are used only in data reduction routines should be
reviewed to assure that they agree with experimental conditions. These parameters can be
changed and the experimental data recalculated if an error is discovered or if exploring an
alternate value is desired. Analysis condition values used in the calculation of quantity adsorbed
can be changed also. These are typically the manually entered free space(s), nonideality
correction factor, and bath temperature.

The area occupied by a single adsorbed molecule is a required parameter in the calculation of
surface area by the BET and Langmuir methods. The software provides a default value, but other
values are found in the literature. McClellan and Harnsberger!) provide a comprehensive review
of such values.

The volume of pores of a specific size range is calculated from the gas quantity adsorbed in them
by converting the quantity to its liquid equivalent volume. This is achieved through use of a density
conversion factor calculated from the ratio of molar densities of the condensed adsorbate at bath
temperature to the gaseous phase at STP. The necessary information is found in handbooks. The
software contains default values for common adsorptives; values for other adsorptives must be
calculated.

The terms for liquid surface tension 7, contact angle between solid and liquid phase €, molar
volume of the adsorbate 7, gas constant R, and sample temperature T are treated as one
constant, the adsorbate property factor A expressed by:

2+ cos 6

A=—%F

using which, the Kelvin equation?) reduces to

Either surface tension, contact angle, or molar volume can be revised individually to give a new
value for the factor 4, or A can simply be altered arbitrarily for exploratory purposes.

The thermal transpiration correction requires two parameters which may be adjusted from those
of the default values. The first is the inside stem (neck) diameter of the sample holder, and the
second is the hard-sphere diameter of the adsorptive molecule. The sample holder inside
diameter is available from the documentation provided with it or is measurable. Information on
hard-sphere diameters of molecules may be obtained from handbooks.

1) McClellan, A.L., and Harnsberger, H.F., Journal of Colloid and Interface Science, 23, 577
(1967).
2) Thomson, W., Phil. Mag. S., 42,448 (1871).
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EI micromeritics® Evaluate Report Results

For terms such as the interaction parameter found in the Horvath-Kawazoe calculation’ ), the
Dubinin affinity coefficient, or Astakhov exponent? ) , the default values as provided by the
software generally are adequate. A search of the technical literature is required if the analysis
involves a gas-solid system other than that covered by the default values.

The t-Plot method plots quantity adsorbed (Va) against thickness (t) derived from a thickness
equation, and the Dubinin transform plots quantity adsorbed against log(P/Pg)n. All of these data
reduction methods were first proposed for specific applications. The user must make a judgment
as to the applicability of the method to a gas-solid system.

If applied appropriately, all transform plots will exhibit a linear range and the regression analysis
must be applied only over the linear range and within the range of application. Fitting a regression
line to surface area transformation plots should yield a correlation coefficient of 0.9999 or better
and for t-plots and Dubinin plots the correlation coefficient should be 0.99 or better.

If the data reduction model does not apply to the gas-solid system under examination, then it may
be that either no linear range exists within the pressure range of validity, or that solutions derived
from the regression line of the linear range are intuitively incorrect, that is, they have no relevance
to the physical situation, such as a negative C-value from a BET transform.

BET C-VALUE

BET theory assumes uniform surface coverage with no favored adsorption sites and it also
assumes that the gas is more strongly attracted to the surface than to other gas molecules. The
typical range of BET C-values is from about 5 to well over 100. Values much less than 5 imply that
the gas-to-gas affinity is competing with the gas-to-solid affinity which conflicts with the basic
assumptions of BET theory. C-values much greater than 100 indicate very strong attraction for the
surface or preferential adsorption.

Provided the isotherm was determined with negligible error and the regression line to the BET
transformation data was fit properly, then an out-of-range C-value probably indicates that the gas-
solid interaction for the particular sample material does not conform to the BET model. An
inappropriate adsorption model may be indicated also by the coefficient of correlation of the
regression line, 0.999 being about the minimum value expected with five more or less equally
spaced points. In the case of indications of poor conformance to the BET model, the Langmuir
data reduction method should be examined.

1) Everett, D.H. and Powl, J.C., J. Chem Soc., Faraday Trans. 1, 72, 619 (1976).
2) Dubinin, M. and Radushkevich, L.V., Proc. Acad. Sci. USSR, 55, 331 (1947).
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DATA ANALYSES BY THE BJH METHOD

In general, this method visualizes the incremental decomposition of an experimental isotherm,
starting at the highest relative pressure or pore size. At each step the quantity of adsorptive
involved is divided between pore-emptying and film-thinning processes and is accounted for
totally. This computational algorithm frequently leads to inconsistencies when carried to small
mesopore sizes. If the thickness curve used is too steep, ultimately it will predict a larger
increment of adsorptive for a given pressure increment than is actually observed. The algorithm
must stop since a negative pore volume is nonphysical. Accumulated error results in the
calculation of a too large volume of (possibly nonexistent) small pores if the thickness curve used
underestimates film thinning.
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REPORT FEATURES AND SHORTCUTS

CFR In 21CFR11 environments, members of the Analyst group must click Preview on the
Note sample file window to access this screen.

Reports can be customized and manipulated using the toolbar, shortcut menus, the zoom feature,
or axis cross-hairs.

m After analysis, reports can be viewed, printed, and/or copied and pasted into other documents.

m The report zoom feature provides the viewing of fine graph details and the ability to shift the
axes.

m All reports contain a header displaying file statistics.

D E

Isalher TabuorRepar ot Linea it | g Log Flt | sahern . [isshem Lo

Mmicromepifics®

Butane at Room Temperaturef6lank Tune Analysis

>

Data display (graph or
text)

Header
Generated tabs
Graphic

Title

List box
Toolbar

Unit1 Port 1 Serial # 103 Page 1

Sample: Activated Carbon Tube N9-1 Pentane Vapor Port 1
JCH

Operator
Submitier. Wicromeritics
File: C:\\Activated Carbon with Pentane Port 1.SUP

Qu Elaps
) Adsorbed in) [ Defauitste |

(mmolig)

A 0.000026641 00017216 009833 0129

0000031957 0.0020651 019476 0207
0.000042791 0.0027652 029286 0235
0000061330 0.0039671 039016 0256

0000089904 0.0058097 048617 0310
0000130035 0.0084031 058184 0323
0.000183132 00118342 067592 0335
0.000252591 00163227 076884 0345
0000338085 0.0218475 086085 0354
0000443475 0.0286578 095172 0402
0000867694 0.0366850 104053 04:10
0000713793 0.0461261 112806 0417
0000883942 0.0671212 121304 0426
0001076657 0.0695747 120798 0436
0001295922 0.0837438 138041 04:42

0002608163 0.1685422 172473 0456 1

@mmDOOw

If configured, the report header can also contain a graphic and/or a title.

m Tabular and graphical reports contain sample and analyzer statistics such as analysis date/-
time, analysis conditions, etc.

m The headers contain notes of sample file changes occurring after analysis.

m  Summary report headers contain the same information as tabular and graphical reports with
the exception of notes.
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REPORT HEADER SHORTCUTS

Right-click in the report header to display header shortcuts.

Summary Isolherm Tabular Report |sotherm Linear Pt BET Tabular Report_BET Transform Plot

T P
[Mi micromeritics®
0.5 m"2/g Alumina

Edit
Copy header as text

Report Header Shortcuts

Field or Button Description
Copies the report header as text. Text is copied to the clipboard and
then can be pasted into other documents.

Edit Edits the report title and/or graphic in the report header.

Copy header as text
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Report Features and Shortcuts

REPORT TOOLBAR

The Report window has a toolbar on the right portion of the window and selectable tabs at the top
of the report header. To view a specific report, either select the tab or the report in the Reports list

box, then click Show.

Isatherm Tabular Report | [satherm Linear Flot | [Wgim Log ot | Isothem L [isahemLs Langr
MPmicromepitics’
Butane at Room Temperature8lank Tune Analysis A Data d iS Ia ( ra h Or
unit1Port 1 Serial # 103 Fage 1 : p y g p
F text)
B / ‘5on with Pentane Port 1.SWP. B I Ieader
"
Stareq: 972012 8:02 15410 Analysis Adsorptve: niCs
Camntotort 0071019 0442 14 i T a0 80 =2
e i : C. Generated tabs
Relative Absolute Quantity ~ ElapsedTime _ Saturation Defuitstie .
Pressure (pip) Pressure (kPa) Adsorbed (hemin) Pressure (kPa)
‘””“”“ 1 D. Graphi
sesar00a0 G . rapnic
A 0.000026641 0.0017216 0.09633 01:2
0000031857 00020051 019475 0207 .
coo0arer  oovoress  02oams 0035 E Title
0000051350 00038671 039015 025 -
0000089804 00058007 04817 0310
0000130035 00084031 058184 0323 .
oo0te3tzz  0omse 087502 0335 F L t b
0.000252591 00163227 076884 0345 . Is OX
0000338085 00218475 036085 0354
0000423475 00285578 095172 0402
0.000567694 0.0366850 1.04053 04:10 G Ib
Ooorraras  oosioer  11amos padtd . Toolbar
oo00ss3se2 00571212 121304 042
0001070557 00695747 129798 043
oo0izeez2 00837438 138041 oss2
0002608163 01685422 172473 0455 A

Field or Button

Description

Default Style [button]

Specifies default report parameters for fonts and curve properties.

Delete [button]

Deletes the selected report in the Reports list box. Deleted reports
will have to be regenerated if deleted in error.

Hide [button]

Hides (or temporarily removes) the selected report from the tabbed
view. The report name remains in the Reports list box.

Print [button]

Displays the Print window for report output.

Reports [group box]

Contains a list of all generated reports. The same reports display as
tabs at the top of the report header unless the report has been hid-
den using the Hide button.

Show [button]

Displays the selected or hidden report in the Reports list box.

For fields and buttons not listed in this table, see Common Fields and But-

tons on page 2 - 3.
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TABULAR REPORT FEATURES AND SHORTCUTS

Display tabular report shortcuts by right-clicking in the body of the tabular report. Column
shortcuts require right-clicking on the column to be modified.

Summayy: Enor | Tabular Report | Cum Vol vs Size | Ine. Vol vs Size | Diff. Vol vs Size 1 | Cum. Area vs Size | Log Diff. Vol vs Size 1 | Volume Seali |

ime: 5/11/1908 10:02:34 AM
e: 51111998 11:07:05AM
e 11/14i2016 10:45:19 AM
Renort Ranne: 100 10 1.000 NN nsia

[@i micromeritics’
MICROMERITICS INSTRUMENT CORPORATION

Serial # 379 Port 212

Tabular Report

Cumulative
olu

e Pore Volum

(mUg)

11303546
26323.00
5872692
4432532
3238388
25540.88
2115194
17163.30
1387148
1227243
1120045
9039.95
881871

0.0000
0.0003
0.0013
0.0022
0.0035
0.0048
0.0063
0.0088
0.0140
0.0170
0.0191
0.0237
0.0242

Edittitle...

Copy table as

Tabular Report Shortcuts

Field or Button

Description

Align column

Changes the column alignment to either left, right, or centered.

Copy table as text Copies the report contents to the clipboard as tab-delimited text. It
can then be pasted into another document.
Edit title Edits the report title and/or title font attributes. Click Font to modify

font attributes.

Move column

Right-click the column to be moved. Select Move column on the short-
cut menu and select Left or Right for the move.

Rename column

Right-click the column to be renamed. Select Rename column on the
shortcut menu and enter the new column name.

Resize column

Right-click the column to be resized. Select Resize column on the
shortcut menu and enter the new column width in inches.

Show column

Displays a list of all columns. Click a column to add a checkmark to
show the column or remove the checkmark to hide the column.

Table data font

Right-click in the report data. Select Table data font on the shortcut
menu.

Table header font

Right-click in the report data. Select Table header font on the shortcut
menu.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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GRAPH FEATURES AND SHORTCUTS

Right-click in the graph area to display graph report shortcuts.

Graph Shortcut Options

Field or Button

Description

Autoscale all axes

Returns the report to full view after using the zoom feature.

Copy data

Copies the report data to the clipboard. It can then be pasted into
other software programs as tab-delimited columns or copied as an
overlay onto another graph.

Delete baseline [n}2}

Deletes the baseline from the graph

Delete peak )Y

Deletes the selected peak from the table.

Edit axis

Edits the selected axis properties.

Axis Properties X
Title: | Volume (cm?) Title Font...
Scale
(®) Linear [CJinvert Scale Scale Font...
(O Logarithmic
[v] Autoscale minimum 1.389
[+/] Autoscale maximum 1.3925
Gridlines: Major: ‘ Dotted v ‘
Minor: ‘ None ~ ‘
Cancel

Gridlines. Changes how to display major / minor grid lines.

Scale.

= Autoscale minimum/maximum. To manually specify minimum /
maximum autoscale, deselect the option and enter the new
amount in the text box.

= Invert scale. Inverts the scale.
m Linear/Logarithmic. Scales the graph as linear or logarithmic.

m Scale font. Modifies the font for the scale label. Deselect Use
default font to enable font options.

Signal (a.u.). DA Converts the signal from calibrated units to
arbitrary units.

Flex Series Operator Manual
350-42800-01 (Rev R) — Apr 2021



7 About Reports [M] micromeritics®

Graph Shortcut Options (continued)

Field or Button Description

Title. Edits the selected axis label.

Title font. Modifies the font for the selected axis label. Deselect Use
default font. Select new font attributes for report data. Enable Use
default font to reset default fonts.

Edit curve Edits selected curve properties.

Curve Properties X

Title: Volume vs Cycle #
Style: Curve and Points

Curve
Interpolation: |Akima Spline v Color...

Point style: | Circle 52 Use default thickness

Solid 1

Histogram
Use default il style
Solid

Center

Color. Changes the curve color.

Curve. Changes the interpolation, point style, and pen style for the
selected curve. These options are disabled if Use default fill style is
selected in the Histogram group box.

Histogram. Enabled only if Histogram is selected in the Style drop-
down list. Specifies the type of fill, fill color, and label position for the
selected curve.

Label. Designates where the graph point labels will display (left,
right, center, etc.) on the SPC report.

Isotherm

A

Graph ??FB
labels

™~

0.0 01 nh:g_zgﬂs 04 05 06 07 0.3 09

Style. Selects another style for the collected data curve.

Title. Changes the title of the selected curve.
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Graph Features and Shortcuts

Graph Shortcut Options (continued)

Field or Button

Description

Use default thickness. Uses the default curve thickness. Deselect
to enter a new thickness number in the Thickness text box.

Edit legend

Changes the legend location and font.

Legend Properties X

(O) Do not show

(®) vertical above
() Horizontal above
O Left

() Right

() Bottom

Font...

Edit title

Changes the report title.

Enable overlays

PISC

If overlays have been selected, this option displays (or hides) the
overlays.

Hide Peak Marks o]}

Removes all peak marks from the graph.

Include report

P|SC|

When selected, places a checkmark to the left of the report in the
Select Reports list box on the Report Options tab.

Insert Peak 5]

Inserts a peak into the graph at the selected point.

Reset axis limits to
initial setting

Removes the cross-hair and returns the graph back to the initial set-
ting.

Select overlays...

PISC

Displays the option to select files to overlay onto the active graph. To
view the overlays, click Enable Overlays on the shortcut menu.

Show curve

Displays a list of all curves. Select the curve(s) to display.

/

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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AXIS CROSS-HAIR

Left-click on the graph to view the cross-hair coordinates.

AXxis cross-hair

BET Surface Area Plot
o ALUMINAREFEREMCE 004/16816/00 C1 +  MotFitted
] E / _..49"'):#/6)
] : s e
e T TPRTPYAS ROP /J&y‘- -----------------------------
CITEE ; ;
1 o
=) 1
= E (:/__,ﬂ:’ﬁ"f
o~ '
- 7//_,_,—" '
0.0 . . . I . : T T T T T T
0.0000 0.0002 0.00031 3] 0.0004 0.0006
Relative Pressure (pip™)

Example of Axis cross-hair feature

ZOOM FEATURE

Use the zoom feature to examine graph details. Click, hold, and drag the left mouse button on the
graphical area to be enlarged. A box will display in the area to be enlarged. To return to normal

view, right-click in the graph and select Autoscale all axes.
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GRAPH GRID LINES

Options > Graph Grid Lines

Graph Grid Lines
X-Axis
Linear Scale: Major
Logarithmic Scale: Major
Y-Axis
Linear Scale: Major
Logarithmic Scale: Major
Grid Line Styles
Major: (O solid
Minor: (O solid

[ IMinor
[ IMinor

DMinur
DMinur

(®) Dotted
(® Dotted

Cancel

Use to select how grid lines appear on reports. This menu option is not available if using
Restricted option presentation.

Graph Grid Lines

Field or Button

Description

Grid Line Styles

Select if the major and/or minor grid lines should appear as solid or

[selection] dotted lines.
X-Axis / Y-Axis Select major and/or minor lines to display in reports for the log-
[selection] arithmic and linear scales. Deselect this option to remove the grid

lines.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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GRAPH AND SAMPLE OVERLAYS

CFR In 21CFR11 environments, this feature is applicable to members of the Developer
Note grouponly.

Use the graph overlay functions to compare multiple graph options. Graphical lines are
differentiated by the use of varying colored symbols outlined on a legend. Overlays may be
generated in two ways:

= Multiple Graph Overlays. Overlay two different types of graphs from one sample.
= Multiple Sample Overlays. Overlay graphs of the same type with that of the current plot.

/ This feature is available only when using Advanced option presentation. Go to
Options > Option Presentation > Advanced.

GENERATE PORE SizE DISTRIBUTION GRAPH OVERLAYS

The following reports in the physisorption applications can produce graphical results for a sample
material's pore size distribution:

Two methods can be used to import and overlay report data into another interactive graph using
shortcut menu options:

= Import ASCII text data. Data can be imported from an ASCI| text file into the interactive graph.
The ASCII text file must follow certain rules.

m Copy/paste. Data can be copied from one sample file (source) and pasted into another sample
file (target).

Pore size distribution report overlays menu selections are:

Copy data

Paste data

Edit Imported Data
Display Imported Data
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IMPORT ASCII TEXT DATA

ASCII text file format rules

m The header must consist of one line to include title, two unit specifications, and distribution
type:

o Accepted pore dimension units are: A, nm, um
o Accepted pore volume units are: cm3/g, cm3/g, ml/g

o Accepted distribution types are: cumulative, incremental
Two examples of a header format:

My Title (A, cm3/g, incremental)
My Title (A, cm3/g, cumulative)

m The data must be in two columns and should be separated by a comma or white space.

m The data lines must be ordered so that pore dimensions are monotonically increasing or
decreasing.

Sample ASCII Text File

silica alumina bjh (A, cm3/g,
cumulative)

456 657 0.0133559
444 847 0.0546427
429168 0.0869924
425 419 0.119721
419629 0.132681
360.634 0.156611
340.859 0.197672
326.601 0233092

Window appearance will vary depending on the selected report. This function can be performed
on samples files with a Complete status or during an analysis.

Create the ASCI| text file using the proper format as indicated above.
In the analyzer application, go to File > Open.

Select a sample file to overlay graphs on to.

Click Open (or double-click the file name).

Right-click in the graph area and select Edit imported data.

In the Select Imported Overlays window, if the ASCII text file does not display, click Import
to locate the file.

o0k wpn =
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7. Select the ASCII text file in the Select Imported Overlays window, then click OK. If an error
message will display instead, verify that the . TXT file format is in the correct format.

8. Toinclude the overlay data in a printed report, see Print Pore Size Distribution Overlay
Data in Reports below.

OVERLAY PORE SizZE DISTRIBUTION DATA USING COPY/PASTE

1. Open a source sample file and a target sample file; both should have a Complete status.
The report will open to the interactive reports window.

In the source sample file, right-click on the graph and select Show Curve.
Deselect any differential curve data to hide them in the graph.
Right-click in the graph area again and select Copy Data.

Change to the target sample file, right-click the graph, and select Paste data. The graph
now displays overlayed data from the source sample file.

o ko

Typically, one new graph will appear showing both the cumulative and differential curves.
To show or hide individual curves, right-click the graph and select (or deselect) Display
imported data.

6. Ensure that all parameter fields are set appropriately, then click Paste.

7. Toinclude the overlay data in a printed report, see Print Pore Size Distribution Overlay
Data in Reports below.

PRINT PORE SizZE DISTRIBUTION OVERLAY DATA IN REPORTS

1. Open the sample file containing the overlay data and select Advanced from the view
selector drop-down list at the bottom of the window.

2. Click the Report Options tab.

3. Inthe Selected Reports list box, select the cumulative, differential, or incremental intrusion
graph to show the imported distribution data, then click Edit (or double-click the selected
report).

In the Overlay drop-down box, select Imported.

Click OK to close the window.

Click Preview on the Report Options tab.

Click Print in the reports toolbar section to display print options.

No ok
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OVERLAY MULTIPLE PHYSISORPTION SAMPLE FILES

CFR In 21CFR11 environments, this feature is applicable to members of the Developer
Note group only.

To overlay the same type of graph on multiple samples:

1. Goto File > Open.
2. Selecta .SMP file, then click Open. If the Isotherm plot displays, select Advanced from the
view selector drop-down list at the bottom of the window to display the tabbed window view.

3. Click the Report Options tab.
4. Inthe Selected Reports list box, highlight a report then click Edit. Use the following table to
complete the process for the selected report.

Lo =)
Sempk Deg Anal Report
Descript Condit Condit Options.
Reportoptions: | Report Options ~|
[ show report ftle | ]
Showgraphic  Graphic
Htangmir
[JFreundich
[remkin
9.53 | mm ot
[J4lpha-5 Method
[JfRato Method
[+ Adsorption
[J63+ Desorption
[Joolimore-+eal Adsorption
[Epolimore +Heal Desorpion v
Save hs Close Advanced v Previe:
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For Physisorption Reports

If overlaying this type of
report...

Then.

On the Isotherm Report Options window, select one or
more plots in the Selected Reports group box, then click

m Isotherm Options to the right of the selected plot.
b. On the Plot Options window, select Plot curve and/or Plot
points if they are to be included in the overlay. If the x-
and/or y-axes are to be autoscaled, enable Autoscale; oth-
erwise, enter the From and To points for the axes. Click
OK.
c. Onthe Isotherm Report Options window, in the Plot
Options group box, select Plot overlays. Click OK.
d. Continue to Step 5.
m Alpha-S Method
m BET Surface Area
m f-Ratio Method a. On the pop-up window, select Overlay samples. Verify
m Freundlich other fields. Click OK.
m Langmuir Surface Area b. Continue to Step 5.
m f-plot
= Temkin
a. Select the report variable from the Selected Reports
group box, then click Edit.
= BJH b. Click the down arrow on the Overlay field, then select the
= Dollimore-Heal Samples option.
» MP-Method c. Verify other fields.
d. Click OK.
e. Click OK again.
For Chemisorption Reports
If overlaying this type of Then...
report...
- leferen.oe Method a. On the pop-up window, select Overlay samples.
m Freundlich . .
= Langmuir b. Vgrlfy other fields.
= Sinfelt Method c. Click OK.
. d. Continue to Step 5.
= Temkin

5. Onthe Report Options tab, click Overlays.

6. On the Plot Overlay Sample Selection window, move up to 25 files from the Available Files
box to the Selected Files box:
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Overlay Multiple Physisorption Sample Files

Plot Overlay Sample Selection

Selecte iles:

8/10/2070 3:53:
/1012020 3:53:
/1012020 3:53:
/1012020 3:53:
/1012020 353
102020 353:

7. Click OK.

8. To view the report, click Preview.

Overlay Sample Selection

Field Description

Available Files Lists files that meet the selected criteria. Select the files to be com-

[selection] bined, then click Add. The selected files are moved to the Selected
Files list box.

Look in [button] Click the Browse icon to change the file folder location.

Selected Files Lists the files selected to be combined. Click OK to combine the files.

[selection]

Status [drop-down box] | Select the status of files to be combined.

tons on page 2 - 3.

For fields and buttons not listed in this table, see Common Fields and But-
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IMPORT ASCII PORE DISTRIBUTION DATA

IMPORT AN ASCII TEXT FILE USING GRAPH SHORTCUTS

1.
2.
3.

Create an ASCl| text file. See Manually Enter Data on page 3 - 9.
Open a report with a Complete status.

Select a pore-size distribution report from the view selector drop-down list at the bottom of
the window.

Right-click on the graph and select Edit imported data on the shortcut menu.

If the ASCII text file does not display on the Selected Imported Overlays window, click
Import.

Locate and select the file, then click Open. Header information from the ASCII text file will
appear in the Select Imported Overlays window.

Select the entry, then click OK. If an error message appears, verify that the .TXT file format
is correct.

To hide or show imported data, right-click in the graph area and use the Display imported
data option on the shortcut menu.

CoPY/PASTE AN ASCII TEXT FILE USING GRAPH SHORTCUTS

i e

o

Create an ASClI text file. See Manually Enter Data on page 3 - 9.
Copy the ASCII text data to the clipboard.
Open a report with a Complete status.

Select a pore-size distribution report from the view selector drop-down list at the bottom of
the window.

Right-click on the graph and select Paste data on the shortcut menu.

To hide or show imported data, right-click in the graph area and use the Display imported
data option on the shortcut menu.

CoPY/PASTE GRAPH DATA FROM ANOTHER GRAPH

a bk owbd-~

Open a source pore distribution data report with a Complete status.
Right-click on the graph and select Copy Data on the shortcut menu.
Open the target pore distribution data report.

Right-click on the graph and select Paste Data on the shortcut menu.

To hide or show imported data, right-click in the graph area and use the Display imported
data option on the shortcut menu.
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Report Examples

REPORT EXAMPLES

1 - - -
[Mi micromeritics’
Unit 1 Port 2 Serial # 101 Page 9
Sample: 101-12 mm Tube N2 Silica-Alumina ADS-DES with FS
Operator: AWT
Submitter: Performance Test
File: ..A101-12 mm Tube N2 Silica-Alumina ADS-DES with F...
Started: 8/17/2012 B:44:16 PM Analysis Adsorpiive: N2
Completed: 8/18/2012 6:33:42 PM Analysis Bath Temp.: -196.058 °C
Report Time: 8/30/2012 6:34:58 AM Themal Correction: Mo
Sample Mass: 0.2555¢ Warmm Free Space: 16.0907 cm® Measured
Cold Free Space: 57.0915 cm® Equilibration Interval: 10 s
Low Pressure Dose: None Sample Density: 1.000 gfem®
Automatic Degas: Yes
Sample Prep: Stage Temperature () Ramp Rate (/min) Time (min)
1 <0 10 60
2 350 10 240
BET Surface Area Report

BET Surface Area: 2171859+ 02311 m?fg
Slope: 0.019839 + 0.000021 g/em® STP
Y-Intercept: 0.000205 + 0.000003 glfem® STP
C: 97.887751
Qm: 49.8911 cmg STP
Correlation Coefficient: 0.9%99977
Molecular Cross-Sectional Area: 0.1620 nm?

Relative Cluantity Qe -1
Pressure Adsorbed
(pip”) (cmg STP)

0.077824186 48.2830 0.001748
0106574940 51.3824 0.002322
0135877231 542113 0.002901
0163237219 56.6508 0.003441
0.188535068 58.8330 0.0035944
0213852389 61.1303 0.004450
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7 About Reports

[M] micromeritics®

BET SURFACE AREA PLOT

1Qipp - 1))

H - L)
[Mi micromeritics’
Unit 1 Port2 Serial # 101 Page 10
Sample: 101-12 mm Tube N2 Silica-Alumina ADS-DES with FS
Operator: AWT
Submitter: Performance Test
File: ..1101-12 mm Tube N2 Silica-Alumina ADS-DES with F..
Started: 8/17/2012 8:44:16 PM Analysis Adsorptive: N2
Completed: 8/18/2012 6:33:42 PM Analysis Bath Temp.: -196.058 °C
Report Time: 8/30/2012 6:34:58 AM Thermal Cormrection: No
Sample Mass: 0.2555¢g ‘Warmm Free Space: 16.0907 cm® Measured
Cold Free Space: 57.0915 cm® Equilibration Interval: 10 s
Low Pressure Dose: Mone Sample Density: 1.000 g/em?®
Automatic Degas: Yes
Sample Prep: Stage Temperature () Ramp Rate {fmir) Time (min)
1 %0 10 60
2 350 10 240
BET Surface Area Plot
101-12 mm Tube N2 Silica-Alumina ADS-DES with FS 4+  Not Fitted 3
0.42_
0.35
0.30 ]
0.25
0.20 ] =
0.15
4 +
0.10 - T
1 +
] qE
il i
0.0 s
] e
1, ok eaalor i t—f—r—t—
Loy e e AL I e e
0.0 D. 02 0.2 0.4 0.5 0.8 0.7 08 0.8 1.0
Relative Pressure (p/p°)
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[M] micromeritics®

BJH Desorption

: Cumulative Pore Volume

BJH DESORPTION: CUMULATIVE PORE VOLUME

[Mi micromeritics’

Unit 1 Port 2 Serial # 101 Page 24

Sample: 101-12 mm Tube N2 Silica-Alumina ADS-DES with FS
Operator: AWT
Submitter: Performance Test
File: ..1101-12 mm Tube N2 Silica-Alumina ADS-DES with F...

Started: 8/17/2012 8:44:16 PM
Completed: 8/18/2012 6:33:42 PM
Report Time: 8/30/2012 6:34:58 AM
Sample Mass: 0.2555¢g
Cold Free Space: 57.0915 cm®
Low Pressure Dose: None
Automatic Degas: Yes

Analysis Adsorptive: N2
Analysis Bath Temp.: -195.058 °C
Thermal Correction: No
Wam Free Space: 16.0907 cm® Measured
Equilibration Interval: 10 s

Sample Density: 1.000 gicm?®

Sample Pn;ep: Stage Tempesrigture () Ramp Rﬁ]te (fmin} Time (min)
2 350 10 240

BJH Desorption Cumulative Pore Volume (Larger)

Harkins and Jura : Faas Comection
—— 101-12 mm Tube M2 Silica-Alumina ADS-DES with FS
- e
06 q'b;%_
1 ok
] %
o5 *—i%
3 1
1 +
G +
= b b
B ] ;1
- ] +
2 0 b
> +
g ] *
" ] ¥
: :
b T
J +
0.1 T
] it
.
i oy,
i e
- i e S P B .
.0 T — T T T T T T T t
50 100 500 1.000
Pore Width (&)
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7 About Reports

[M] micromeritics®

BJH ADSORPTION: CUMULATIVE PORE VOLUME

Pore Volume (cm?ig)

Sample: 101-12 mm Tube N2 Silica-Alumina ADS-DES with FS

[Mi micromeritics®

Operator: AWT

Submi

Started:

Completed:

Report Time:
Sample Mass:

Cold Free Space:
Low Pressure Dose:
Automatic Degas:

Sample Prep: Stage
1

2

itter: Performance Test

File: .1101-12 mm Tube N2 Silica-Alumina ADS-DES with F._.

81712012 8:44:16 PM
8182012 6:33:42 PM
83012012 6:34:58 AM
0.25559g

57.0915 cm®

Mone

Yes

Temperature ()
90

350

BJH Adsorption Cumulative Pore Volume (Larger)

Analysis Adsomplive:
Analysis Bath Temp.:
Thermal Correction:
‘Warm Free Space:
Equilibration Interval:

Sample Density

Ramp Rate (fmin)
10

Serial # 101 Page 16
N2
-196.058 “C
Mo
16.0907 con® Measured
10s
- 1.000 g/em®
Time (min)
€0
240

10

Harkins and Jura : Faas Comrection
—— 101-12 mm Tube M2 Silica-Alumina AD'S-DES with F5

0.

g +H—+-0-+‘+>_+

A

X
:
5
3

0.0 T T

Pore Width (A4)
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[M] micromeritics®

Isotherm Linear Plot

ISOTHERM LINEAR PLOT

Operator: AWT
File: ..\101-12

Sample Mass: 0.2555g
Cold Free Space: 57.0915 cnm®
Low Pressure Dose: None
Automatic Degas: Yes

Sample Prep: Stage
1

o

Started: 8/17/2012 8:44:16 PM
Completed: 8/18/2012 6:33:42 PM
Report Time: 8/30/2012 6:34:58 AM

[Mi micromeritics®

Unit 1 Port 2 Serial # 101

Sample: 101-12 mm Tube N2 Silica-Alumina ADS-DES with FS

Submifter: Performance Test

mim Tube N2 Silica-Alumina ADS-DES with F._.

Analysis Adsorptive: M2
Analysis Bath Temp.: -196.058 °C
Thermal Correction: Mo

Page 8

‘Warm Free Space: 16.0907 em® Measured

Equilibration Interval: 10 s
Sample Density: 1.000 g/em?®

Temperature (} Ramp Rate {/min}
90 10
350 10

Isotherm Linear Plot

—— 101-12 mm Tube N2 Silica-4lumina ADS-DES with FS - Adsorption
—&— 101-12 mm Tube N2 Silica-Alumina ADS-DES with FS - Desomption

Time (min)
60

240

400

350

300

250

200+

150

Quantity Adsorbed (cm¥g STP)

Relative Pressure (pip°)

100
50 = .
1 =2°
E T T 1T LU LI L L L LU L UL L
00 0.1 02 03 04 05 0.6 0.7 0a 08
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7 About Reports [M] micromeritics

LooP CALIBRATION

3Flex Version 4.00 Page 1
Serial #Unit 1 Serial #528
Sample: 528-014 Loop Cal 9-17-15
Operator. Michael Sterling
Submitter: wbc
File: CA3Flex\datal C28N528 SMP
Started: 9M17/2015 10:56:17 AM Sample Mass: 1.0000g
Completed: 917/2015 12:29:41 PM Report Time: 10/5/2015 10:27:38 AM
Comments: COHe
TCD Signal (a.u.) vs. Time
—— TCD Signal (a.u.} - Loop Cal 9-15-15
-0.00747 -1.0044 -0.00743
0.330
b noko -0.00678 -0l00466 -0j00§72 -0J006p9 -0.006F7
-0). 00526
0.325
0.320-
3
Z
=
c
=)
@ 031
=}
o
-
0.310
| | |
| | | S | 1
0.30%
| | | | | 1 | [
| y | \ y } ! \
o J B
e -2 =5
0.300
5 10 15 20 25 30 35 40
Time (Minutes)
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t-Plot Report

®

micromericics

[mi

T-PLOT REPORT

eritics’

[ microm
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7 About Reports

[M] micromeritics®

TCD SIGNAL VS TEMPERATURE

—— TCD Signai (a.u.) - 10 C/min
—A— TCD Signal (a.u.) - 2 C/min
—&— TCD Signal (a.u.) - 30 C/min

Unit 1 Serial # 256 Page 1.
Sample: NH3 TPD -- ZSM-5
Operator:
Submitter:
File: C:\...\DATA\NH3_HOD.SMP
Started: Sample Mass: 0.1100g
Completed: Report Time:

Comments: Heat of Desorption experiment using ZSM-5 and ammonia.

[M] micromeritics’

Micromeritics Instrument Corporation

TCD Signal (a.u.) vs. Temperature

—©— TCD Signal (a.u.)- 5 C/min  —<— TCD Signal (a.u.) - 20 C/min
—7— TCD Signal (a.u.) - 15 C/min  —3- TCD Signal (a.u.) - 7 C/min

—%— TCD Signal (a.u.) - 4 C/min

TCD Signal (a.u.)

T T T
300 350
Temperature (°C)
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[Mj micromeritics’ 7D Signalvo Time

TCD SIGNAL vS TIME

[M] micromeritics®
Micromentics Instrument Corporation

3Flex Version

Serial # Unit1 Senal # 315

Sample: 315-303 COHe in He 50 scem Loop Calibration
Operator: whe
Submitter:

File: C:\3Flex\damalexamples\CDN315-303 COHe in He 50 seem Loop Calibration SMP

Started: 12M17/2015 6:54:45 AM Sample Mass: 10000 g
Completed: 12M17/2015 7:42:39 AM Report Time: 122/2016 9:08:05 AM

TCD Signal (a.u.) vs. Time

= TCD Signal (a.u.) - C0He in He 50 scem Loop Calibration

-0.30
| @ Q (0} @ ®
= -031
s
=
5
o B
[m]
2 |
-0.32
-0.3%
_$L-GG|- &—¢ 64 & = A

0 5 10 13 20 23 30 35

Time {minues)
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7 About Reports

[M] micromeritics®

TCD SIGNAL vS TIME

—— TCD Signal (a.w) - Calcium Owalate TFD

Sample: 315-306 Calcium Oxalate TPD
Operator: whe

File: C:\3Flex\damlexam ples\CDN315-306 Caleium Oxalzte TPD SMP

Stared: 12117/2015 2:45:31 PM Sample Mass: 00203 g
Completed: 1217/2015 4:26:30 PM

[Mj micromeritics
Micromeritics Instrument Corporation

3Flex Version
Senal# Unit1 Senal £ 315

Report Time: 1/22/2016 9:08:04 AM

TCD Signal (a.u.) vs. Time

-0.20
3 i
:,.] A
& 025
(=]
E .

-0.30 /

_C A= = ‘J k O
T T T T T T T T T T T T T T T T T T T T
20 30 40 50 &0 70
Time (minutes)
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[M] micromeritics®

TCD Signal vs Time

TCD SIGNAL vS TIME

[M] micromeritics’
Micromeritics Instrument Corporation

3Flex Version
Senal # Unit1 Senal # 315

Sample: 315-058 A0 TPR with H2Ar
Operator: whe

Submitter:
File: C'3Flex\dam'exam plesiCDAg0 TPR with H2A SMP

Started: 902015 9:54:57 AM Sample Mass: 00495 ¢g
Completed: 9A0/2015 10:37:47 AM Report Time: 12272016 9:08:00 AM

Comments: LN2/IPA slurry

TCD Signal (a.u.) vs. Time
= TCD Signal (a.u.) - g0 TPR with HZAr

11.10831

IZ.:'.: { \

TCD Signal (a.u)

| . _

02— — — — — — — —
[ 8 10 12 14 16 18
Time {minutes)
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7 About Reports [M] micromeritics®

TCD SIGNAL VS TIME

[M] micromeritics
Micromeritics Instrument Corporation

3Flex Version
Seral # Unit1 Senal # 315

Sample: 315-317 P+-Al H2 Pulse Chemisorption Loop
Operator: whe
Submiitter:
File: C:\3Flex\datz'examples\CON315-317 P+-Al HZ Pulse Chemisorpton Loop. SMP

Stared: 12/23/2015 7:24:36 AM Sample Mass: 08520 g
Completed: 12/23/201511:13:04 AM Report Time: 122/2016 9:08:01 AM

TCD Signal {a.u.) vs. Time
— TCD Signal (2.u.) - P-8 H2 Pulse Chemizomption Loop

0.195
0.190 q
. q
- i
5 i
Tu_
S 0185
ur -
a
'f:-" |
0180
0175
o ~ L " P = —
e & S T F
rryrrrryrrrrjyrrrr{rrrr|jrrrrjyrr1rr|rrrr|rroror{rrrr|irrrrjrrrryrrT T TJrTTT|TITT
2 3 4 5 B ! 8 9 10 11 12 13 14

Time {minutes)
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[Mj micromeritics’ 7D Signalvo Time

TCD SIGNAL VS TIME

[Mj micromeritics’
Micromeriticz Instrument Corporation

3Flex Version

Seral # Unit1 Senal # 315

Sample: 315-332 Pt-Al CO Pulse Chemisorption Loop
Operator: whe
Submitter:
File: C:\3Flex\dzta\exam ples\CDWP1-Al CO Pulse Chemisorption Loop SMP

Staned: 1/5/2016 10:07:52 AM Sample Mass: 07648 g
Completed: 1/5/2016 1:07:54 PM Report Time: 12272016 5:07:57 AM

Comments: Reweigh afier analysis

TCD Signal (a.u.) vs. Time

= TCD Signal (z.u.) - Pt-A1 CO Pulse Chemisorption Loop

TCD Signal {a.u))

Time {minutes)
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[M] micromeritics
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[Mj micromeritics’ 6 Seleced Reports

8 SELECTED REPORTS

CFR Dynamic Analysis and Chemisorption options are not applicable when the software is
Note installed in 21CFR11 environments.

/ To edit reports, open the Sample file then select the Report Options tab. Highlight the
report name in the Selected Reports list box and click Edit.

(@]

Report Name DA

Advanced Reports - Python Module on page A - 1

Alpha-S Method Report on page 8 - 3

BET Surface Area Report on page 8 - §

BJH Adsorption/Desorption Report on page 8 -7

DFT Pore Size Report on page 8- 13

NNIANIENIENIENIENE -

DFT Surface Energy Report on page 8 - 15

Difference Method Report on page 8 - 16 v

AN

Dollimore-Heal Adsorption/Desorption Report on page 8 - 19

<\

Dubinin Report on page 8 - 24

f-Ratio Method Report on page 8 - 29 v

First Order Kinetics Report on page 8 - 31 v

Freundlich Report on page 8 - 32 vV

Graph Report Options on page 8 - 35 v

TCD Concentration vs Time

TCD Signal and TCD Concentration vs Time
TCD Signal vs Temperature

TCD Signal vs Time

Temperature vs Time

Horvath-Kawazoe Report on page 8 - 38 v

<
<

Isotherm Report on page 8 - 42

Langmuir Report on page 8 - 44 v | v

Loop Calibration Report on page 8 - 47 v
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& Selected Report [M] micromeritics

Report Name P |  C | DA
MP-Method Report on page 8 - 48 v

NLDFT Advanced PSD Report on page 8 - 52 v

Options Report on page 8 - 56 vivi| Vv
Pulse Chemisorption Report on page 8 - 57 v
Sample Log Report on page 8 - 60 ViV VY
Sinfelt and Difference Methods on page 8 - 61 v
Summary Report on page 8 - 62 v
Summary Report for Dynamic Analysis on page 8 - 63 4
t-Plot Report on page 8 - 64 v

Temkin Report on page 8 - 67 vV
Validation Report on page 8 - 70 4

Flex Series Operator Manual
350-42800-01 (Rev R) — Apr 2021




[M] micromeritics’ Apha-S ethod Report

ALPHA-S METHOD REPORT

The Alpha-S plot converts the standard adsorption isotherm into a dimensionless isotherm using
the quantity adsorbed at a relative pressure of 0.4.

£ Alpha-s Method =8 =R ==
Reference Isotherm
[ Open...
Relative Alpha-5 [ savess.. J
Pressur re
k) [ insert
1 0.000000001] 0.0001 e
| clear
[ aopend |
Ref. surface area:
0.0000 Mg
Select Range for Alpha-5 Fit
0.0000 o 1,000.0000
Select Reports
[#] Tabular report
[#] Alpha-S plot
"] Overlay samples
From T
Autoscale x-axis 0.000(
(V] Autoscale y-axis 0.0000
Select Pressures Included in Report
Pressures...
Enter strictly increasing relative pressures up to @ maximum of 10
oK Cancsl

One predefined curve is located in the Reference file directory. Use the table buttons to enter
relative pressure and the Alpha-S values.

Alpha-S Method Report

Field or Button Description

Open [button] Use to import values from an existing thickness curve (.ALS).

The table to be imported must be saved as ASCII text with a .ALS file
extension. It must have a two-column format with the relative
pressures in the first column and the alpha-s values in the second
column. Columns must be separated by a space or a tab.
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8 Selected Reports

[M] micromeritics®

Alpha-S Method Report (continued)

Field or Button

Description

Pressures [button]

Use to select a pressure range for report calculations and points for
exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Ref. surface area
[text box]

Enter the surface area from the reference curve. This value is used
to calculate the sample surface area.

Select Range
for Alpha-S Fit
[group box]

Enter minimum and maximum relative pressures to determine the fit.

Selected Reports
[group box]

Alpha-S Plot. Use to plot data in graph format.

m Autoscale x-axis. The x-axis field shows the relative pressure.

m Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

m Overlay samples. Use to overlay sample files on the plot.

Tabular Report. Use to have a tabular report of data generated.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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EI micromeritics® BET Surface Area Report

BET SURFACE AREA REPORT

8 BET Report Options =R
Select Pressure Range for BET Fit

0.050000000|  to 0.300000000| p/pe.

Select Reports
Tabular report

BET Transform plot

[J overlay samples

From To
[/] Autoscale x-axis 0.00000000 1.00000000
[ Autoscale y-axis 0.00000 | 2,241.40998
[C]BET Isotherm plot
Overlay samples
From To
Autoscale x-axis 0.000000000 | 1.000000000
Autoscale y-axis 0.00000 446.14773
Select Pressures Induded in Report
Presstres...

Enter a value between 0.000000000 and 1.000000000.
oK Cancel

The BET calculation obtains the sample surface area value by determining the monolayer volume
of adsorbed gas from the isotherm data. BET uses a multilayer model.

BET Surface Area Report

Field or Button Description

Pressures [button] This option is available when the sample file has a status of Ana-
lyzing or Complete. Use to enter a range of pressure points to be
included in the report or to modify table values for pressure points.

X
Absolute Relative Quar Exclud Gy nge
rrrrrrrrrrrrrr Adsorbed
3] ©p) | @mojg) s EEP
f sssmon| oowssts]  1aums| [ I -
2 7375024 oo7tisz01|  vazsss| [
3 9730074 00ssmeree7|  vas2e7] [
+ 12.361%4| _0.1241885%7|  1.4878) []
5 12.8080733| 0.14870449)  1s3s3s| [
5 17.3061878| _0.473767776| _ 1.50%65| []
7 19.8402248| 0.109258182|  1.64880| []
s 223903148 022esaso7s| 17122 [
B 2482017 029028006 17530 [ Iiosl
1 27.3504691| 0.274815744 181455 [] Exdlude All
1 29.8154199| 0.299612489)  1e7374] [
[use Interpoiation
ve InsertPredefined
o
) Insert

1

2 0.125000000 Delete

B 0200000000 [

4 0.273000000

s 0.350000000 | Aspend

Cancel
Enter a value betueen 0.000000000 and 1.000000000.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table if not using the Use
Interpolation option.

Exclude All. Select to exclude all pressure points in the table.
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8 Selected Reports

[M] micromeritics®

BET Surface Area Report (continued)

Field or Button

Description

Include All. Select to include all pressure points in the table.

Insert Predefined. Click to insert a predefined (default) set of points
into the report. Use Interpolation must be selected to enable this
button. This button displays for BET reports only.

Use Interpolation. Use to indicate if the system should use the table
or interpolated data. This option is available for BET and Langmuir
reports only.

Select Pressure Range
for BET fit [fext box]

Enter values to indicate the fitted pressure range.

Selected Reports
[group box]

BET Isotherm plot. Uses BET monolayer volume and constant to
produce an isotherm.

m Autoscale x-axis. Linear x-axes begin at zero. The x-axis field
shows the relative pressure for BET.

m Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

m Overlay samples. Use to overlay sample files on the
BET isotherm plot.

BET Transform plot. Use to generate a traditional BET surface
area plot used to determine monolayer volume and BET C constant.

m Autoscale x-axis. Linear x-axes begin at zero. The x-axis field
shows the relative pressure for BET.

m Autoscale y-axis. The y-axis field shows BET transformation.

m Overlay samples. Use to overlay sample files on the
BET transform plot.

Tabular report. Use to have a table of measured and calculated
values generated.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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Iml micromeritics® BJH Adsorption/Desorption Report

BJH ADSORPTION/DESORPTION REPORT

The BJH calculation determines the mesopore volume/area distribution, which accounts for both
the change in adsorbate layer thickness and the liquid condensed in pore cores. Reports can be

generated from both adsorption and desorption data. The fields for both BJH Adsorption Report

Options and BJH Desorption Report Options are identical unless otherwise specified.

/ An incomplete pore distribution may be generated if a thickness curve selection is not
a good match for the sample being analyzed.

[ BJH Adsorption Report Options =l E [
Thickness Curve Pores
O Reference Minimum BJH width: A
O krukcJaroniec-Sayari Maximum BIH width 3,000.000 | &

Halse Fraction of pores open at - - . .
EASN G v Gl " ) Circled selection is applicable to BJH
() Broekhoff-de Boer -

(O carben Black STSA. Cumuttive Regt:a,ge, O smaller A dsorp tlon only
Edit..
Adsorptive Options
BJH Correction Adsorptive...
(O standard
(O Kruk-Jaroniec-Sayari
®Facs [smecth differentials

Select Reports

[]B3H Tabular Report
| Cumulative Pore Vol
|dvidw
%dwd\ug
Cumulative P rea
[|devd Pere Area
[Jda/diog(w) Pore Area

lume

Select Pressures Included in Report

Pressures,

oK. Cancel

BJH Adsorption/Desorption Report

Field or Button Description

Adsorptive [button] Displays the Adsorptive Options window. The recommended adsorpt-
ives and their values are shown. Up to eight adsorptive and
adsorbate property factor combinations may be specified.
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8 Selected Reports

[M] micromeritics®

BJH Adsorption/Desorption Report (continued)

Field or Button

Description

= Dubinin Adsorptive Options === @

Affinity
Adsorptive Coefficient

(beta)
L N2 0.33000
2 (ar 0.26700
3 [coz 0.46100
0.00000

0.00000
0.00000
0.00000

@ N & o &

[l

0.00000

BJH Correction
[group box]

Select the type of correction to apply to calculations. The selected
type will display in the report header.

Faas. Good for statistical thickness curves.
Kruk-Jaroniec-Sayari. Good for reference thickness curves.

Standard. Uses original BJH models.

Cumulative Reports
[group box]

Larger. Use to report the total volume found in pores larger than the
current pore size.

Smaller. Use to report the total volume found in pores smaller than
the current pore size.

Pores [group box]

Enter the minimum and maximum diameter (radius or width) of pores
to include in the BJH reports.

Fraction of pores open at both ends. This field is not available for
the BJH Desorption Report Options window.

During adsorption calculations, the analysis program assumes that
all pores are closed at one end. Occasionally, a percentage of pores
may be open at both ends causing disagreement in the adsorption
and desorption data or in the values for total volume and total BJH
pore volume. Enter the fraction of pores open at both ends to
compensate for this error.
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Iml micromeritics® BJH Adsorption/Desorption Report

BJH Adsorption/Desorption Report (continued)

Field or Button

Description

Pressures [button]

Use to select a pressure range for report calculations and points for
exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Select Reports
[group box]

Select the report names to include in the report. Highlight the report
name, then click Edit to modify report parameters.

Smooth differentials

Use to smooth all differential calculations, thus eliminating variations

[check box] in the differential computation caused by noise in the input data.
Thickness Curve Select the thickness curve, then click Edit to modify the values in the
[group box] equation for the selected curve. The Frenkel-Halsey-Hill thickness

curve can be applied using the Halsey option.

Kruk-Jaroniec-Sayari / Halsey / Harkins and Jura / Broekhoff-
de Boer / Carbon Black STSA. Select the thickness curve option,
then click Edit. Modify the equation for the selected curve as
needed.

Reference. Select Reference, then click Edit to define a t-curve by
entering both the relative pressure and thickness values. One
predefined curve is shipped with the analysis program and is found in
the Reference directory.
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8 Selected Reports

[M] micromeritics

BJH Adsorption/Desorption Report (continued)

Field or Button Description
[ Entered t-Curve (o®]=]
Neme:  User-Defined
i Thu:(lin)ess P
®hb?)
1 0.000000001 1.0000 Deete |
Gear
[ towend |
« "
o]

To import values from an existing thickness curve (.THK file), click
Open, then select the file containing the values. The table to be
imported must have a .TXT or .THK file extension and have a two-
column format with the relative pressures in the first column and the
thickness values in the second column. Columns must be separated

by a space or a tab.

/

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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[M] micromeritics®

BJH Adsorption/Desorption Report

EemH Adsorption Cumulative Pore Area Options EI@
Plot curve Plot points
X-Axis
() Linear (@ Logarithmic
Autoscale 10.0 | t 10.0 | &
Y-Axis
Variable: ICumuIah‘ve Pore Area 'I
Overlay: [None V]
Autoscale 0.000 ] 1,000.000 | 3/t

The fields for all plot options are identical for specifying plotting methods and customizing plots.
Highlight any plot option in the Selected Reports list box in the BJH Report Options window, then

click Edit.
BJH Plot Report

Field or Button

Description

Autoscale [check box]

When enabled on the report parameters windows, allows the x- and
y- axes to be scaled automatically. Autoscale means that the x- and
y- ranges will be set so that all the data is shown. If Autoscale is not
selected, the entered range is used.

Plot curve / Plot points
[check box]

Select to plot points on the graph.

X-Axis [group box]

Use to have the x-axis on a logarithmic or linear scale.

Y-Axis [group box]

Variable. Select a variable.

Overlay. Select an option to overlay onto the current report.

tons on page 2 - 3.

/ For fields and buttons not listed in this table, see Common Fields and But-
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[M] micromeritics®

8 Selected Reports

BJH TABULAR REPORT

£ eH Adsorption Tabular Report EI@
Tabular data defined by
() Fixed pore size table
@) Collected paints Table...

Highlight BJH Tabular Reportin the Selected Reports list box on the BJH Adsorption Report
Options window, then click Edit to specify the method of data reduction.

BJH Tabular Report

Field or Button

Description

Collected points
[selection]

Use to include all relative pressure points collected. Refer to the
Columns button below.

Columns [button]

Select the data types to include in the report. Column [n] indicates
the column order and data contents for the report.

[E BIH Adsorption Tabular Report Column Options [ = | = |[55]
Column 1: [ Width Interval -
Column 2: | Average Width -
Column 3: | Incremental Pore Volume -
Column 4 | cumulative Pare Volume -
Column 5: |1 cremental Pore Area -
Column &: | cumulative Pare Area -

Fixed pore size table
[selection]

Use to specify exact pore sizes for volume or area data. Click Table
to modify the fixed pore size table. Refer to Table and Columns but-
tons elsewhere in this table.

Table [button]

The fixed pore size table must contain a minimum of two points. The
points must be strictly decreasing. Enabled only when Fixed pore
size table is selected.

For fields and buttons not listed in this table, see Common Fields and But-

tons on page 2 - 3.

/
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[M] micromeritics’ OFT Por Size Repor

DFT PORE SiZE REPORT

The DFT Pore Size report contains the results of pore size distribution analyses using a non-local
DFT range of micro and mesopore ranges.

BB DFT Pore Size Report Options =ofvEl
Type: DFT v
Geometry: siit >
Model: v
Regularization: 0.00000 v 0.20000 VErSiDI’\ 2 deconvolution
Select Reports

~
Isotherm Table

Cumulative Area Graph

Incremental Area Graph

dA/dW Area Graph

dA/dlog(W) Area Graph

Cumulative Volume Graph v

Edit...

JRIRRIKR]

Select Pressures Included in Report

Pressures...

OK Cancel

DFT Pore Size Report

Field or Button Description

Geometry Select the pore shape.
[drop-down box]

Model [drop-down box] |Lists the models that meet the specified criteria and match the
adsorbate and temperature of the sample data. If no models appear,
no models meet the selected criteria. One model must be selected.

Pressures [button] Use to select a pressure range for report calculations and points for
exclusion from calculations.

=
‘ Aosolite | Felatve | Quentiy | Excuce Calaason o

rrrrrrrr e | e

s o | o | s mnmum 00000000 P/P°
T v.ooomes oooovienea| ooz L e—— Loo000000 /o
2 | 0.0005261) 0.000031943| 0.00s20| [
5| o0007m3] o.ovonsses| o077 LI
4 | 0.0010505) 0.000064118| 0.01033) [
5 | 0.0013708| 0.000083820) o0.01200] [
o | ooourss|oooniorres| 00w L1
7 | 0.0022816) 0.000139447| 0.01801] [
8 | 0.0029543 0.000180788| 0.02057] [
5 | o.003m30.000zsme1s| ooz [
0| _o.00328| 0.00030153| o0.0255] [
11| o.0ves1s] o.ovosssaes| o.0m17| L A

Concdl

Place a check-mark next to pressures to be excluded from reports calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.
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8 Selected Reports

[M] micromeritics®

DFT Pore Size Report (continued)

Field or Button

Description

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Regularization
[drop-down box]

Select the extent of smoothing to apply to the data. If 0.20000 (user)
is selected, enter a number in the text box giving a relative weight for
the smoothing during deconvolution. Larger values produce more
smoothing.

Select Reports

Select the reports to generate. To edit graph details, highlight the

[group box] graph option and click Edit. The Log Goodness of Fit and Goodness
of Fit graphs cannot be edited.
Edl—\/dlog(\l\f] Area Graph Options E@
Plot Type Autoscale Options
(® Curve Autoscale x-axis
O Histogram Autoscale y-axis
Overlay: Samples >
Axis Range
Fmrg‘m IOT,;OO‘OO
oK Cancel
Autoscale Options. Use to autoscale the x-axis and/or y-axes.
Axis Range. From/To fields are enabled when Autoscale options
are not selected. Enter the starting and ending values for the x-
and/or y-axes.
m Xx-axis. Shows the pore size.
m y-axis. Shows the area.
Overlay. Select an overlay for the report.
Plot Type. Select the method for data display.
8-14 Flex Series Operator Manual
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- | | | | | ] ®
Iml mlcromerltlcs DFT Surface Energy Report

DFT Pore Size Report (continued)

Field or Button Description

Type [drop-down box] Classical. Model based on the Kelvin equation and thickness for
determining the pore size distribution. See DFT Models on page F -
1.

DFT. Model based on the density functional theory.

Version 2 If enabled, adds improved performance for nonzero values of the
deconvolution DFT regularization. The DFT results will be slightly better than when
[check box] the checkbox is not selected and when using a regularization

parameter. When the checkbox is not selected, the legacy behavior
of the DFT calculation used by earlier versions of the application is
produced.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

DFT SURFACE ENERGY REPORT

DFT Pore Size Report on page 8 - 13

The DFT Surface Energy report contains the results of surface energy distribution analyses.

BB DFT Surface Energy Report Options =R <

Type: DFT v

Model: 2

Regularization: 0.00000 v 0.20000

Select Reports

[&lsurface Energy Table
VI ble

Isother

KIKKRIKIE]

Select Pressures Induded in Report

OK Cancel

DFT Surface Energy Report Options fields and buttons are identical to the DFT Pore Size Report
Options.
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8 Selected Reports

[M] micromeritics®

DIFFERENCE METHOD REPORT

The Difference Method Report and the Sinfelt Method Report windows are identical unless

otherwise specified.

(B3 Difference Report Options.

Select Reports

Select Pressures Included in Report
Pressures...

[V] Analysis summary
[] Analysis Repeat Difference
[V] Tabular report
[V]plot data
[/] Analysis [V]Repeat [V Difference
[ overlay samples
From o
[ Autoscale x-axis 0.0000000  133.3224000
[] Autoscale y-axis
[IPlot curve [/ Plot points

The y-intercept quantity adsorbed (Qg) is used for several calculations in the Difference and
Sinfelt reports. This value can be determined in two ways. If one point is selected, Qg is the
quantity adsorbed for that point.

Difference Method. The repeat isotherm data are subtracted from the primary isotherm. Qg is the
y-intercept of a straight line through the difference data.

Sinfelt Method. Both the primary and repeat isotherms are fitted to a straight line. Qg is the
difference between the y-intercepts of the fit lines.

Difference and Sinfelt Report

Field or Button

Description

Analysis summary
[selection]

Analysis. Generates a summary of the following for the first
analysis:

Percent metal dispersion
Metallic surface area
Volume adsorbed

Slope

Correlation coefficient

Difference. Generates a summary of the differences between the
following information for the first and repeat analyses:

m Percent metal dispersion
m Metallic surface area
m Average difference volume
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[M] micromeritics®

Difference Method Report

Difference and Sinfelt Report (continued)

Field or Button

Description

Repeat. (Sinfelt report only.) Generates a line fit plot for the
secondary analysis.

Plot data [selection]

Analysis. Includes a line fit plot for the primary analysis.

Autoscale x-axis / Autoscale y-axis. Select to have the x- and/or
y- axes automatically scaled. The application uses the highest
values collected during analysis as the ending points for an axis
range. X-axis shows the pressure. Y-axis shows the quantity of gas
adsorbed.

Difference. Plots the difference between the analysis and repeat
analysis lines.

Overlay samples. Overlays data from the current sample with that
of other samples. Click Overlays on the Report Options window to
choose other sample files.

Plot curve and Plot points. Use to specify how to plot data. Plot
data as a curve, points, or both.

Repeat. Includes a line fit plot for the secondary analysis.

Pressures [button]

Use to enter a range of pressure points to be included in the report or
to modify table values for pressure points.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.

Exclude All. Select to exclude all pressure points in the table.
Include All. Select to include all pressure points in the table.

Line fit pressure range. Enter the minimum and maximum
pressures for line fit.
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8 Selected Reports EI micromeritics’

Difference and Sinfelt Report (continued)

Field or Button Description
Tabular report Select to have a report of the pressure points generated.
[selection]

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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I m I m icromeritics® Dollimore-Heal Adsorption/Desorption Report

DoLLIMORE-HEAL ADSORPTION/DESORPTION REPORT

BJH Adsorption/Desorption Report on page 8 - 7 for additional information on field and

buttons for this report.

The Dollimore-Heal Adsorption Report Option and the Dollimore-Heal Desorption Report Option
generate reports from both adsorption and desorption data.

(O Carbon Black STSA
Adsorptive Options

Edit...

[Jsmaath different

Select Reports

[]cumulative Pare Valume
[C]dv/dw Pare valume
[]dv/dlog(w) Pore Volume

[ ]cumulative Fare Area
[]da/dw Pare Area
[ 1da/diog(w) Pore Area

Select Pressures Included in Report

Pressures...

oK

m (= [EEg]
Thickness Curve Pores
O reference Minimum Pore width: A
ORUIomecSont i ore vt %
(O Halsey
(@) Harkins and Jura Cumulative Reports
() Broekhoff-de Boer @Larger (O Smaller

Adsorptive...

tials

Cancel

Dollimore-Heal Adsorption/Desorption Report

Field or Button

Description

Adsorptive [button]

Displays the Adsorptive Options window. The recommended adsorpt-
ives and their values are shown. Up to eight adsorptive and
adsorbate property factor combinations may be specified.

= Dubinin Adsorptive Options E@
Affinity
Adsorptive Coefficent
(beta)
L N2 - 0.33000
a0
3 |coz2 - 0.46100
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8 Selected Reports

[M] micromeritics®

Dollimore-Heal Adsorption/Desorption Report (continued)

Field or Button

Description

Cumulative Reports
[group box]

Larger. Use to report the total volume found in pores larger than the
current pore size.

Smaller. Use to report the total volume found in pores smaller than
the current pore size.

Pores [group box]

Enter the minimum and maximum diameter (radius or width) of pores
to include in the BJH reports.

Pressures [button]

Use to select a pressure range for report calculations and points for
exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Select Reports
[group box]

Select the report names to include in the report. Highlight the report
name, then click Edit to modify report parameters.

Smooth differentials
[check box]

Use to smooth all differential calculations, thus eliminating variations
in the differential computation caused by noise in the input data.

Thickness Curve
[group box]

Select the thickness curve, then click Edit to modify the values in the
equation for the selected curve. The Frenkel-Halsey-Hill thickness
curve can be applied using the Halsey option.

Kruk-Jaroniec-Sayari / Halsey / Harkins and Jura / Broekhoff-
de Boer / Carbon Black STSA. Select the thickness curve option,
then click Edit. Modify the equation for the selected curve as
needed.

Reference. Select Reference, then click Edit to define a t-curve by
entering both the relative pressure and thickness values. One
predefined curve is shipped with the analysis program and is found in
the Reference directory.

8-20
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I m I m icromeritics® Dollimore-Heal Adsorption/Desorption Report

Dollimore-Heal Adsorption/Desorption Report (continued)

Field or Button Description

= Entered t-Curve e Er=]

Name: User-Defined

Relative Thickness
Pressure @ Insert
®hb?)

1 0.000000001 1.0000 Delete J
[ ow )

T

[oc )

To import values from an existing thickness curve (.THK file), click
Open, then select the file containing the values. The table to be
imported must have a .TXT or .THK file extension and have a two-
column format with the relative pressures in the first column and the
thickness values in the second column. Columns must be separated
by a space or a tab.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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8 Selected Reports EI micromeritics’

DoLLIMORE-HEAL DESORPTION PLOT OPTIONS

BJH Plot on page 8 - 11

[ Dollimore-Heal Desorption Cumulative Pore ... \EI@
Plot curve Plot points
X-Axis
(O Linear (@ Logarithmic
[“] Autoscale 10.0 10.0
Y-Axis
Variable: Cumulative Pore Volume »
Overlay: None ~
[] Autoscale 0.000 1,000.000
oK Cancel

The fields for all plot options are identical for specifying plotting methods and customizing plots.
Highlight any plot option in the Selected Reports list box in the Dollimore-Heal Report Options
window, then click Edit. The fields and buttons for these reports are identical to the BJH Plot
Report Options.
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I m I m icromeritics® Dollimore-Heal Adsorption/Desorption Report

DoLLIMORE-HEAL TABULAR REPORT OPTIONS

BJH Tabular Report on page 8 - 12

@ Dollimore-Heal Adsorption Tabular Report E@

Tabular data defined by Columns....
(O) Fixed pore size table

(® Collected points Table...

OK Cancel

Dollimore-Heal Tabular Report Options are identical to the BJH Tabular Report Options.
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8 Selected Reports EI micromeritics’

DUBININ REPORT

The Dubinin method provides pore volume distributions for microporous materials by making use
of an expression for the adsorption potential.

[ pubinin Report Options (= E
Report Type Fitted Relative Pressure Range
[ Radushkevich Radushkevich:|  0.000100| g 0.050000
[] Astakhov
Astakhov: 0.000100 to 0.050000

Optimize exponent
2.0000 Adsorptive Options

Adsorptive...

Select Reports

[[Dubinin Tabular Report
[ITransformed Isotherm Edit...
[ dvrdw Pore valume

Select Pressures Included in Report

Pressures...

oK Cancel

Dubinin Report

Field or Button Description
Adsorptive [button] Displays the Adsorptive Options window. The recommended adsorpt-
ives and their values are shown. Up to eight adsorptive and
adsorbate property factor combinations may be specified.
E Dubinin Adsorptive Options E@@
) Afﬁnjy
Adsorptive Co(ifeﬁ;)ent
B 0.53000
2 0.26700
o S——T
s ] oo
s -] oo
L )
s -] oo
Fitted Relative Enter the minimum and maximum limits for Radushkevich or Astak-
Pressure Range hov relative pressures included in the line fit.
[group box]
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[M] micromeritics’ Dutinin Report

Dubinin Report (continued)

Field or Button Description

Pressures [button] Use to select a pressure range for report calculations and points for
exclusion from calculations.

1 o o o

Place a check-mark next to pressures to be excluded from reports calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Report Type Select report types. If Astakhov is selected, either select Optimize
[group box] exponent or enter an appropriate exponent value in the text box.
Select Reports Select the reports to generate. Highlight the report, then click Edit to
[group box] modify report options.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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8 Selected Reports

[M] micromeritics®

DUBININ PORE VOLUME REPORT OPTIONS

In the Dubinin Report Options window, highlight dV/dw Pore Volume in the Selected Reports list

box, then click Edit.

This option plots differential pore volume as a function of pore width.

= Dubinin dV/dw Pore Volume Options === @
Plot curve
Plot points
[Tl overlay samples
Autoscale x-axis 0.0 | to 1.0 |4
Autoscale y-axis 0.0000 1,000.0000 |crmdfg

Dubinin Pore Volume Report

Field or Button Description

Autoscale x-axis / Select an option to have the x- and/or y-axes scaled automatically.
Autoscale y-axis Both axes begin at 0; the system uses the highest values collected
[check box] during analysis as the ending points for axis ranges.

Enable to enter beginning and ending values manually.

[selection]

Overlay samples Use to overlay sample files on the plot.

[selection]

Plot curve / Plot points |Select to plot points on the graph.

tons on page 2 - 3.

/ For fields and buttons not listed in this table, see Common Fields and But-

8-26
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[M] micromeritics’ Dutinin Report

DUBININ TABULAR REPORT OPTIONS

In the Dubinin Report Options window, highlight Dubinin Tabular Report in the Selected Reports
list box, then click Edit. Column [n] indicates the column order and data contents for the report.

[= Astakhov Tabular Report Column Options E@@
Column 1: [Absoluhe Pressure v]
Column 2: [Relaﬁve Pressure v]
Column 3: [Quanh‘ty Adsorbed v]
Column 4: [Log Quantity Adsorbed v]
Column 5: [Log (©°/o)*n v]
Column &: [dvfdw Pore Volume v]

Log (p®/p )*n. The value for [n] is the optimized exponent if Optimize exponent is selected on the
Dubinin Report Options window. If not, then the value for [n] is the entered exponent value.
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8 Selected Reports EI micromeritics’

DUBININ TRANSFORMED ISOTHERM PLOT OPTIONS

Highlight Transformed Isotherm in the Selected Reports list box in the Dubinin Report Options
window, then click Edit.

The transformed Dubinin isotherm is the logarithm of quantity adsorbed as a function of the log of
relative pressure raised to a power. Isotherms for which the Dubinin method is applicable produce
straight lines when transformed in this way.

= Dubinin Transformed Isotherm Plot Options =0 @
[Tl overlay samples
Autoscale x-axis 0.000000 1.000000
Autoscale y-axis -1.35052 1.64948

Dubinin Transformed Isotherm Plot Report

Field or Button Description

Autoscale x-axis / Select an option to have the x- and/or y-axes scaled automatically.
Autoscale y-axis Both axes begin at 0; the system uses the highest values collected
[check box] during analysis as the ending points for axis ranges.

Deselect to enter beginning and ending values manually.

Autoscale x-axis. Shows the quantity of gas adsorbed at standard
temperature and pressure.

Autoscale y-axis. Shows the log of relative pressure.

Overlay samples Use to overlay sample files on the plot.
[check box]

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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El micromeritics® f-.Ratio Method Report

F-RATIO METHOD REPORT

The f-Ratio report uses the measured isotherm and normalizes it using a reference isotherm.

[= f-Ratio Method (=N Eeh <=
Reference Isotherm
Select Reports
Tabular report
f-Plot
[Tl overlay samples
From To
Autoscale x-axis 0.000000000 || 1.000000000
Autoscale y-axis 0.0000 1,000.0000
Select Pressures Induded in Report
f-Ratio Report
Field or Button Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

‘ Roste | Featve | Quentity | Excuce
ey e |
(kPa) b9 (mmol /g)
AR
2| o.oons2e1| 0000031943 oosn| 1
5| o.ov07ms| nosonssess|voo7rs|
< | o005 o.oonoe1s| 00w 1
s | ooorsma| nosonssex| vorse|
o | o.cou7ss1]o.oontorms| oowss] I
7| o.oo2sts v.ooniseer| oomor| 1
5 | o025 v.oonssorss| oo 1
s | o.00mm3|0.00023s618| o023 1
10| o.00a528| nosomres| vozses|
11| o.oves1sa| n.ovosmsaes| v.ozmrz| 1
Concdl
Place s check mark next o pressuresto be sxcluded from reports clculations

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
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8 Selected Reports

[M] micromeritics®

f-Ratio Report (continued)

Field or Button

Description

Reference isotherm
[group box]

Browse to select a sample file to use as a reference for the isotherm.
Select a file containing an isotherm measured from a non-porous
sample of the same material as the current sample.

Selected Reports
[group box]

Tabular Report. Use to have a tabular report of data generated.

f-Plot. Use to generate a normalized isotherm.

m Autoscale x-axis. The x-axis field is dimensionless in units of f-
ratio.

m Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

m Overlay samples. Use to overlay sample files on the f-plot.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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Iml micromeritics® First Order Kinetics Report

FIRST ORDER KINETICS REPORT

(3 First Order Kinetics [=a@]=]

Selected Experiment ts
All TPx and Other experiments selected.

[¥] Tabular Report
[ZIPiot

Cancel

First Order Kinetics Report

Field or Button Description

Plot [check box] Select to have the report formatted in a graph format.

Selected Experiments | Displays all related experiments in the current file. Only experiments
[group box] with collected data are shown.

Tabular Report Select to have report formatted in table format.

[check box]

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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8 Selected Reports EI micromeritics’

FREUNDLICH REPORT

The Freundlich Isotherm is an empirical isotherm used to model low pressure adsorption data. It
can also be applied to model some micropore isotherms. In the Selected Reports list box, highlight
Freundlich, then click Edit.

reundlich Repor ions =
[ Freundlich Report Opti (=)
Calculations
B8 Freundlich Report Options ) i .
@ First analysis [] Specify the monolayer capacity.
[ Specify monolayer capacity [JRepeat analysis 0.04461
0.04461 [ Difference
Select Reports Select Reports
[ Tabular report [V] Tabular report
| Freundlich Transform plot | Freundlich Transform plot
[V]Freundlich Transform plot Freundlich Transform plot
[]Overlay samples From To [J Overlay samples From To
[] Autoscale x-axis -5.87510 2.12490 Autoscale x-axis -5.87510 2.12490
[V] Autoscale y-axis -5 2.6495 Autoscale y-axis -5.3505 2.6495
reundlich Isotherm plof reundlich Isotherm plot
Freundlich Isotherm plot Freundlich Isotherm plot
Overlay samples From . Overlay samples From To
Autoscale x-axis 0.0000000 0.1333224 Autoscale x-axis 0.0000001 133.3224000
Autoscale y-axis 0.00000 44.61477 Autoscale y-axis 0.00000 446.14774
Select Pressures Included in Report Select Pressures Included in Report
Pressures... Pressures...
oK Cancel oK Cancel

Physisorption Chemisorption

Freundlich Report

Field or Button Description
Calculations [group box] | Select from the various calculation options.

[«

Difference. Plots the difference between the analysis and repeat
analysis lines.

First Analysis. Includes a line fit plot for the primary analysis.

Repeat Analysis. Includes a line fit plot for the secondary analysis.

Pressures [button] [ Use to select a pressure range for report calculations and points for
exclusion from calculations.

=
‘ Apsolute | Relative | Quantity | Excude B
rrrrrrrr Pressure Adsorbed

@a) ©p9) | @iy 0.000000000 kg
T .00 voo0rsiez|  oooaso L1 e oot
2| o0.0005261| 0.000031343) o.00s20) []
5 | o.0007703| 0.000046893| 0.0077s| [
4 | o0.0010505 0.000064118| 0.01033 []
5 | 0.0013708| 0.000083820| 0.01200| [
6 | 0.0017651|0.000107785| o0.015%| []
7| 0.0022816|0.000139447] 0.01801 [
8 | 0.00295480.000180788| 0.02057 []
5 | o.003m3|0.000z3se18| 0.02313) ]
10| 0.0025] 00000197 _oi0ases| L
11| c.ons31s8] 0.co03msses| ooasrr| [ A

Ganal
Place a check-mark next to pressures to be excluded from reports calculations
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[M] micromeritics’ Freundich Report

Freundlich Report (continued)

Field or Button

Description

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Pressures [button] [§

Use to enter a range of pressure points to be included in the report or
to modify table values for pressure points.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.

Exclude All. Select to exclude all pressure points in the table.
Include All. Select to include all pressure points in the table.

Line fit pressure range. Enter the minimum and maximum
pressures for line fit.
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8 Selected Reports

[M] micromeritics®

Freundlich Report (continued)

Field or Button

Description

Select Reports
[group box]

Freundlich Isotherm plot. Plots the absolute pressure vs quantity
adsorbed. Shows best fit line.

m Autoscale x-axis. Linear x-axes begin at zero. The x-axis field
shows the absolute pressure.

m Autoscale y-axis. y-axes begin at zero. The y-axis field shows
the quantity of gas adsorbed.

m Overlay samples. Use to overlay sample files on the Freundlich
isotherm plot.

Freundlich Transform plot. Plots the log(P) vs log(Q) and the best
fit.

m Autoscale x-axis. The x-axis field shows the absolute pressure.

m Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

m Overlay samples. Use to overlay sample files on the Freundlich
transform plot.

Tabular report. Select to include pressure points included in the
report.

Specify monolayer
capacity [selection]

Select and enter the monolayer capacity of the sample.

Tabular report
[selection]

Use to have a report of the pressure points generated.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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[M] micromeritics’ Graph ReportOptons

GRAPH REPORT OPTIONS

m TCD Signal vs. Time m TCD Concentration vs. Time
m Temperature vs. Time m TCD Concentration vs. Temperature
m TCD Signal vs. Temperature m TCD Signal and TCD Concentration vs. Time
oo s

——

Show peak marks | options...

Do notplotmore than 1,000 points

X-Axis

T)Time (@) Temperature

Autoscale -100.0000 1,100.0000

¥-Axis

@) Linear () Logarithmic

Wariable {mwts.gna\z | Overlay |None -

[¥] Autoscale -200.0000 | to 1,200.0000

Cancel

Any signal (the detector signal or the 1 or 2 auxiliary signal) may be plotted against time or
temperature. Any signal can be overlaid onto the primary signal.

For color output to a monitor or printer, signals are displayed in different colors. For black and
white output, different symbols are used.

Graph Report Options

Field or Button Description
Do not plot more than | Specifies a maximum number of points to plot. Plot speed may be
[n] points [text box] affected when a higher resolution is entered.

Mass spec [group box] |Autoscale. When enabled on the report parameters windows,
allows the x- and y- axes to be scaled automatically. Autoscale
means that the x- and y- ranges will be set so that all the data is
shown. If Autoscale is not selected, the entered range is used.
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8 Selected Reports

[M] micromeritics®

Graph Report Options (continued)

Field or Button

Description

Options [button]

Enabled when the Show peak marks option is selected.

Lists the peaks for the results of the highlighted experiment. Select
any (or all) peaks to include in the graph.

Peak Selection =]

Available Peaks

Temperature
@ MNone

o

Select the peak labels to display on the graphs.

Overlay [group box]

Specify overlay options to include in the report.

Selected Experiments
[group box]

Displays all related experiments in the current file. Only experiments
with collected data are shown. This option is disabled for new files.

Show peak marks
[check box]

m Enables the Options button to specify the peaks to include in the
experiment.

m Displays the areas and baselines on the graph.

m Draws a straight baseline between the selected peaks.

X-axis [group box]

Specify Time or Temperature for the x-axis variable.

Autoscale.\WWhen enabled on the report parameters windows, allows
the x- and y- axes to be scaled automatically. Autoscale means that
the x- and y- ranges will be set so that all the data is shown. If
Autoscale is not selected, the entered range is used.
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[M] micromeritics’ Graph ReportOptons

Graph Report Options (continued)

Field or Button Description

Y-axis [group box] Specify Time or Temperature for the y-axis variable.

Autoscale. When enabled on the report parameters windows,
allows the x- and y- axes to be scaled automatically. Autoscale
means that the x- and y- ranges will be set so that all the data is
shown. If Autoscale is not selected, the entered range is used.

Overlay. Select to overlay another variable with the current one.

Variable. Select a y-axis variable from the drop-down list.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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8 Selected Reports EI micromeritics’

HORVATH-KAWAZOE REPORT

The Horvath-Kawazoe method plots individual peaks for different pore sizes even if the difference
between one pore size and the next is only one angstrom (0.10 nm) or less.

= Hervath-Kawazoe Report Options == =

Pore Geometry Interaction Parameter

) slit {original H4) (@ Computed
@ Cylinder (Saito-Foley) 3.49e-043 erg-an”4
() sphere () Entered
3.490e-043
[] Apply Cheng-Yang correction

Smooth differentials

Select Reports

[#]Cumulative Pore Volume
[]dv/dw Pore Volume

Select Pressures Incuded in Repart

Pressures...

Horvath-Kawazoe Report

Field or Button Description

Apply Cheng-Yang Use to apply the Cheng-Yang correction to the pore size analysis.
correction [selection] This correction substitutes the Langmuir equation of state for Henry’s
Law in the Horvath-Kawazoe derivation.

Interaction Parameter | Use to determine which interaction parameter will be used in the
[group box] report. These options are disabled if Sphere is selected in the Pore
Geometry group box.

Computed. Use to calculate using the parameters on the Horvath-
Kawazoe Physical Properties window (click Properties to display
the Physical Properties window). The interaction parameter is
recalculated each time a parameter in the Physical Properties
window is edited.

Entered. Calculates using the value entered in the text box.

Pore Geometry Select the option that best represents the physical geometry of the
[group box] micropores in the sample material. When Sphere is selected, options
in the Interaction Parameter group box are disabled.
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EI micromeritics® Horvath-Kawazoe Report

Horvath-Kawazoe Report (continued)

Field or Button

Description

Pressures [button]

Use to select a pressure range for report calculations and points for
exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Properties [button]

Click to view or edit the constants describing the physical properties
of the adsorbent and adsorptive.

Adsorbent. Contains the parameters for the sample. If using
Computed for the interaction parameter, all fields are enabled. If
using Entered, only the values in the Diameter and Diameter at zero
energy text fields may be edited.

Density. Enter the density per unit area of the sample. *
Description. Select the name of the sample used in the analysis.
Diameter. Enter the diameter of the sample atom.

Diameter at zero energy. Enter the diameter of an atom at zero
interaction energy: (2/5)1/6 x diameter.

m Magnetic susceptibility. Enter the magnetic susceptibility of the
sample. *

m Polarizability. Enter the polarizability of the sample. *

Adsorptive. Contains the parameters for the adsorptives. If using
Computed for the interaction parameter, all fields are enabled. If
using Entered, only the values in the Diameter and Diameter at zero
energy text fields may be edited.

m Density. Enter the density per unit area of the adsorptive. *
m Diameter. Enter the diameter of the gas phase atom.
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8 Selected Reports EI micromeritics’

Horvath-Kawazoe Report (continued)

Field or Button Description

m Diameter at zero energy. Enter the diameter of an atom at zero
interaction energy: (2/5)1/6 x diameter.

m Magnetic susceptibility. Enter the magnetic susceptibility of the
adsorptive. *

m Mnemonic. Selectthe mnemonic of the adsorptive gas in use.
m Polarizability. Enter the polarizability of the adsorptive. *

* Option is disabled if Entered is selected in the Interactions
Parameter group box.

Select Reports Select the types of reports to generate. Highlight the report, then
[group box] click Edit to modify report parameters.

Smooth differentials Use to smooth all differential calculations, thus eliminating variations
[selection] in the differential computation caused by noise in the input data.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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EI micromeritics® Horvath-Kawazoe Report

HORVATH-KAWAZOE PLOT

See BJH Plot on page 8 - 11 for additional information on fields and buttons for this report.

£ Horvath-Kawazoe Cumulative Pore Volume Options | =
Plot curve Plot points
X-Axis
Autoscale 0.0 1.0
Y-Axis
Variable: [CUmulative Pore Volume > ]
Overlay: [dv/dw Pore Volume e ]
Autoscale 0.0000 1,000.0000

Highlight a plot option in the Selected Reports list box in the Horvath-Kawazoe Report Options
window, then click Edit to customize the plotting method.

HORVATH-KAWAZOE TABULAR REPORT

[= HK Tabular Report Column Options | = || & |[s5]
Column 1: | Absolute Pressure -]
Column 2: [ Relative Pressure ~|
Column 3: [Quan1it5-I Adsorbed ']
Column 4: [Pore Width ']
Column 5: [Cumulaﬁve Pare Volume ']
Column & [d\u'fdw Pore Volume ']

Highlight H-K Tabular Report in the Selected Reports list box in the Horvath-Kawazoe Report
Options window, then click Edit. Select the data types to include in the report. Column [n]
indicates the column order and data contents for the report.
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8 Selected Reports

[M] micromeritics®

ISOTHERM REPORT

The Isotherm report indicates adsorption (up to saturation pressure) and desorption (down from
saturation pressure) of a gas by a solid held at constant temperature.

m Isotherm Report Options

=R

Select Reports
Tabular report

Linear plot

Logarithmic plot

Linear absolute plot
Logarithmic absolute plot

Pressure composition plot

Quantity Adsorbed

Options...
Options...
Options...
Options...

Options...

(®Per gram  (O) Per BET Surface Area

Tabular Options
[CJweight %

Elapsed time
[JTime between points
Plot Options

Plot adsorption

Plot desorption
[Plot overlays

(O Per other Surface Area

1.0000

[ isotherm Report Options

el

Tabular report

Plot data
Analysis Plot curve
Repeat analysis Plot points
[Joverlay samples
X-Axis
@Linear (7 Logarithmic

From

To

Autoscale x-axis 0.0000000 | 133.3224000
Autoscale y-axis 0.00000 446.14774

oK Cancel OK Cancel
Physisorption Chemisorption

Isotherm Report

Field or Button

Autoscale [check box] Autoscale x-axis. Linear x-axes begin at zero. Logarithmic x-axes

SC] begin at an appropriate value. The x-axis field shows the relative or
absolute pressure.

Description

Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

Click to display related linear plot options. All plot windows contain
identical fields.

Options [button] [

Autoscale x-axis. Linear x-axes begin at zero. Logarithmic x-axes
begin at an appropriate value. The x-axis field shows the relative or
absolute pressure.

Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

Plot curve / Plot points. Select to plot points on the graph.
Select each option to include in the final report.

Plot Data [check box]

SC|
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[M] micromeritics®

Isotherm Report (continued)

Field or Button

Description

Plot Options [group box]

Select the types of isotherm to plot.

Quantity Adsorbed
[group box] [&

Select how to report the quantity adsorbed.

= per gram (cm3/g) STP
m per BET Surface Area (cm3/m?2) STP or mmol/g
m per other Surface Area (cm3/m2) STP or mmol/m?

Selected Reports
[group box] [d

Select each option to include on the final report. Click the Options
button of a selected item to include plot curve, plot points, and to
autoscale x- and y-axes.

Tabular Options
[group box] [&

Select the options to include on the report.
Elapsed time. Time elapsed during the analysis.

Time between points. Time elapsed between points during the
analysis.

Weight %. Enter the mass percentage when plotting pressure
composition.

Tabular Report
[group box] Y™

Select to include tabular data in the report.

X-axis [group box] e

Indicate if the x-axis should be in linear or logarithmic format.

/

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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8 Selected Reports

[M] micromeritics®

LANGMUIR REPORT

This report is for physisorption and chemisorption analyses only.

The Langmuir calculation determines the surface area of a sample by relating the surface area to
the volume of gas adsorbed as a monolayer. Langmuir uses a single layer model.

=% EoN ==
Select Pressure Range for Langmuir Fit [ L angmuir Report Options =B
0L 1 1013250240 ¥Pa Calculations
[v| First analysis Dissodiative chemisorption
[V]First analy
Repeat analysis
Select Reports Llren &
[IDifference
| [abular report
Select Reports
7] Langmuir Transform plot [ Tabuar report
Qverlay samples
From To []Langmuir Transform plot
) Autoscale x-ais 0.000000 0.133322 [ overtay samples
Fi T
¥ Autoscale y-axis rom o
[ Autoscale x-axis 0.0000000 | 133.3224000
- 0.00C 9
Langmuir Isotherm plot [“] Autoscale y-axis 0.000 298,830.158
T [JLangmuir Tsotherm plot
Overlay samples
From To
Aute 0.0000000 133.3224000
Autc 0.00000 446.14774
Select Pressures Induded in Report
Eressures... Select Pressures Included in Report
Pressures...
Enter a value between 0.0000000 and 1333224000,
[ | cancel oK Cancel

Calculations [group box]

[«

Select one or more of the calculation options to be used for analysis.

Pressures [button] [

Use to enter a range of pressure points to be included in the report or
to modify table values for pressure points.

Calculation pressure range. Enter the minimum and maximum
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[M] micromeritics’ Langrir Repor

Langmuir Report (continued)

Field or Button

Description

pressures to be used in the pressure table.
Exclude All. Select to exclude all pressure points in the table.
Include All. Select to include all pressure points in the table.

Line fit pressure range. Enter the minimum and maximum
pressures for line fit.

Pressures [button] [d

This option is available when the sample file has a status of
Analyzing or Complete. Use to enter a range of pressure points to be
included in the report or to modify table values for pressure points.

X

Calaiation pressure range:

Minimum; 0.312116350 | plp*

Maximu: [ 0312116350 | pho®

absolute Relatve | Quantty | Excde|~
Adsorbed
(mmoljg)

Pressure
©p9)

48620979 0048861426 1.31239
73755024 0.074152801|  1.37386|

8736073 0099261497 1.43247

1
2

3

4 1236156%| _0.124189567) 148788
s 190089733 0.19877040|  1.53535
6

7

s

B

17.3061878| _0.173767776| __ 1.59265,
19.8902298|  0.199258182|  1.64880)

2303198 0.2059%| 170122

2502017 0.209780028| 175560 Indiude Al

Exclude Al

100000000000

10 | 2735091 oz7siszaa|  Lessss|
1

2.8154199| 0.29%12485| 187374,

[Juse Interpolation

Reltive
Pressure.
o)
1 0.050000000]
2 0125000000
3 0.200000000
4 0.275000000
s 0.350000000

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table. To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.
Include All. Select to include all pressure points in the table.

Use Interpolation. Use to indicate if the system should use the table
or interpolated data. This option is available for BET and Langmuir
reports only.

Select Pressure Range
for Langmuir fit

[group box] [{

Enter values to indicate the fitted pressure range.
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8 Selected Reports

[M] micromeritics®

Langmuir Report (continued)

Field or Button

Description

Select Reports
[group box]

Langmuir Isotherm Plot. Uses the Langmuir monolayer volume
and constant to produce an isotherm.

m Autoscale x-axis. Linear x-axes begin at zero. The x-axis field
shows the absolute pressure for Langmuir.

m Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

m Overlay samples. Use to overlay sample files on the Langmuir
isotherm plot.

Langmuir Transform Plot. Use to generate a traditional Langmuir
surface area plot used to determine monolayer volume constant.

m Autoscale x-axis. Linear x-axes begin at zero. The x-axis field
shows the absolute pressure for Langmuir.

m Autoscale y-axis. The y-axis field shows Langmuir trans-
formation.

m Overlay samples. Use to overlay sample files on the Langmuir
transform plot.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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EI micromeritics® Loop Calibration Report

LooP CALIBRATION REPORT

(3 Loop Calibration Report Option o= ][ =
Selected Experimen its
All Loap Calibration experiments selected.
Cancel

Loop Calibration Report

Field or Button Description
Selected Experiments | Displays all related experiments in the current file. Only experiments
[group box] with collected data are shown.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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8 Selected Reports

[M] micromeritics®

MP-METHOD REPORT

The MP-Method Report provides pore volume distributions for microporous materials by
correlating quantity adsorbed with the thickness of the adsorbed layer as determined from a user-
selected thickness curve. Pore size can be expressed in angstroms or nanometers. Go

to Options > Units to specify the unit.

= MP-Method Report Options

Thickness Curve Select Reports

(@ Harkins and Jura 7 MP Tabular Report
() Halsey []Cumulative Pore Volume
[]dv/dw Pore Volume

[]Cumulative Pore Area

[CldA/dw Pore Area

Select Pressures Induded in Report

MP-Method Report
Field or Button Description

Pressures [button]

Use to select a pressure range for report calculations and points for
exclusion from calculations.

=

Relative Calcuiation pressure range

©h)

Quantity | Exdude ‘

Minimum: 0.000000000  P/P®

Adsor
(mmolja)

e T
0i0005261] 0.0000319%| _0.00520
0.0007703] 0.0o0usesss|_o.00776

Maximum: 1.000000000  PIP°

0.0010505 0.000054115| 001033

0.0013708| 0.000083820] _ 0.01250

0.0017651| 0.000107785] _ 0.015%

0.0022516( 0.000139447] 001801

olo|x|ofo|sfw|n -

0.0028548| 0.000180788| 002057

0.0038493 0.000235613 002313
0| 0.0048325| 0.000301939| 0.02565
1| 0.0063188| 0.000386868|  0.02817)

100000000000

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
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[M] micromeritics’ MP-tethod Repor

MP-Method Report (continued)

Field or Button Description

Select Reports Select the reports to generate. Highlight the report, then click Edit to
[group box] modify report options.

Thickness Curve Select the thickness curve, then click Edit to modify the values in the
[group box] equation for the selected curve.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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8 Selected Reports

[M] micromeritics®

MP-METHOD PLOT REPORT

In the MP-Method Report Options window, highlight a plot option in the Selected Reports list box,
then click Edit to customize the plotting method.

= MP-Method dV/dw Pore Volume Options [ = |[ & |[23]
Plot curve Plot points
X-Axis
Autoscale 0.0 | ¢ 10| &
¥-Axis
Variable: [dv/dw Pore Volume 'I
Overlay: [None - I
Autoscale 0.0000 | to | 1,000.0000 | cmifgé

MP Method Plot Report

Field or Button

Description

Overlay [drop-down box]

Select an option to overlay on the current report.

Plot curve / Plot points
[selection]

Select to plot points on the graph.

Thickness Curve
[group box]

Select the thickness curve, then click Edit to modify the values in the
equation for the selected curve.

X-Axis [check box]

Use to have the x-axis autoscaled or enter beginning and ending
values.

Y-Axis [group box]

Autoscale. Use to have the y-axis autoscaled or enter beginning
and ending values.

Overlay. Select an option to overlay on the current report.

Variable. Select a variable.

/

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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[M] micromeritics’ MP-tethod Repor

MP-METHOD TABULAR REPORT

In the MP-Method Report Options window, highlight MP Tabular Report in the Selected Reports
list box, then click Edit. Column [n] indicates the column order and data contents for the report.

r
E MP Tabular Report Column Options \ = H =] || 2 \
Column 1: Pore Hydraulic Radius Interval
Column 2:  Average Pore Hydraulic Radius
Column 3; [Incrememal Pare Volume V]
Column 4: [Curnulaﬁve Pare Volume "]
Column 5: [dld[dw Pore Wolume ']
Column &: [Inn'ernemal Pore Ares "]

/ The MP Method reports hydraulic radius only. If Pore size in diameter is selected on
the Unit Selection window, pore size in radius will be reported.
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8 Selected Reports EI micromeritics’

NLDFT ADVANCED PSD REPORT

The NLDFT Advanced PSD report allows for more advanced computation of the pore size
distribution of a material using two separate analyses and two non-local DFT models.

The NLDFT Advanced PSD report option provides the same calculations as the DFT Pore Size
report option and more. The NLDFT report compares two sample files. The models that can be
selected are restricted to only those models which have the same analysis temperature and
analysis gas as the sample file that is open. For instance, if the sample file was analyzed with N2
at 77 degrees Kelvin, then only the N2 DFT models at 77 degrees Kelvin will be available in the
Model drop-down list.

Cumulative Pore Volume vs. Pore Width © Sample: carbon 1012with CO2 @0 €

The model curve fit is shown in the lower right quadrant along with the adsorption isotherm. This
curve fit is updated each time the calculation parameters change (selection of isotherm data
points, choice of model, choice of regularization parameter).

A second sample file and second model is used to compute a more accurate pore size distribution
(PSD), which is shown in the upper left quadrant. Typically, the second sample file will have used
the same sample material as the first sample file yet will have used a different analysis gas and
temperature.

In general, the isotherm for this second sample will be different than the first sample. The
advanced DFT calculation takes the data from both sample files and combines all this data into a
more accurate calculation of the pore size distribution. More accurate means getting the pore
distribution at smaller pore sizes (a few Angstroms) as well as larger pore sizes (one thousand
Angstroms).
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|m| micromeritics NLDFT Advanced PSD Report

using the Select button. A second model must also be selected. Use the options next
to the two sample file names to select the isotherm data points for each sample. After
selecting an option, the blue bars in the isotherm graph will be toggled to select either
the red points or the green points. Once these selections have been done, the results
will appear in the left-hand plots and a second isotherm will appear in the isotherm
plot (lower right) as well as a second curve-fit. As the selection of points is adjusted,
the DFT editor will recalculate the PSD results and also recalculate the two model
curve fits.

/ To make a successful Advanced calculation, a second sample file must be selected

BB NLDFT Advanced PSD Report Options =

000-016
Geometry: [sit

Model:

Nofile selected.

siit Select... | Edit

0.20000 [ Version 2 deconvolution

oK Cancel

NLDFT Advanced PSD Report

Field or Button Description

Geometry Select the pore shape.
[drop-down box]

Model [drop-down box] Lists the models that meet the specified criteria and match the
adsorbate and temperature of the sample data. If no models appear,
no models meet the selected criteria. One model must be selected.

Regularization Select the extent of smoothing to apply to the data. If 0.20000 (user)

[drop-down box] is selected, enter a number in the text box giving a relative mass for
the smoothing during deconvolution. Larger values produce more
smoothing.

Select Reports Use to select the second sample file.

[group box]

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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8 Selected Reports EI micromeritics’

To run the NLDFT report:

1. Goto File > Open. Select a sample file with a Complete status, then click Open.

2. Inthe view selector drop-down list at the bottom of the window, select NLDFT Advanced
PSD. Graphs for the first sample file display and the sample description shows as the first
group box title in the upper right corner of the window.

Cumulative Pore Volume vs. Pore Width [@J Sample: Sica Aumina - 215m2

0
eeeeeeeee < A ’
£ [ O sampie: No fe selected.
= B

A. First selected sample file
B g B. Second selected sample file

——
T
lig)

a. Select the Geometry and Model from the drop-down lists for the first sample file.

b. To select isotherm data points for calculation for the first sample file, ensure the option
to the left of the first sample file description is selected. Slide the two blue bars on the
isotherm graph to select data points. Without a second sample selected, the report will
perform a single model DFT calculation and show the results in the two left-hand result
windows.

3. To calculate data from the second sample file, click Select to locate and open the second
sample file with a Complete status. Graphs for the second sample file display and the
sample description will display as the second group box title in the upper right corner of the
window.

a. Select the Geometry and Model from the drop-down lists for the second sample file.

b. To select isotherm data points for calculation for the second sample file, ensure the
option to the left of the second sampile file description is selected. Slide the two blue
bars on the isotherm graph to select data points. Data are automatically calculated for
both sample files.

c. Click Edit to make any necessary modifications to the second sample file.
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|m| micromeritics NLDFT Advanced PSD Report

T () Sample: C-1012 Nitrogen micropore 77K

R ==
:

ER (V2@ 77.0n Corbon it Pores by NBET =)

e ——)
5,
:
e
!

y-Bidu) aLun d MPIAP

Regularization: | 9,00000 4

o
=
=

I8

1
Pore Width (A)

‘Goodness of Fit vs. Regularization Isotherm
15 01 15 points calculated

a)
G\
\

Flex Series Operator Manual

350-42800-01 (Rev R) — Apr 2021 8-95



8 Selected Reports EI micromeritics’

OPTIONS REPORT

Physisorption

Lists the conditions used to perform the analysis such as:

Adsorptive properties

Analysis conditions

Analysis method

Degas conditions

Free space

Saturation pressure (Py) and temperature

/ Options reports cannot be edited.

Chemisorption

Produces a printed report of a predefined collection of sample file parameters. If Automatically
collected is selected in the Type of Data group box on the Sample Description tab, the following
information is reported:

Task Summary. Lists conditions specified for each task selected.

Analysis Task Options. Details conditions specified for the analysis task.

Experiment Log. Identifies actual conditions under which each task transpired.

Leak Test Results. Identifies outgas rates and the outcome for each leak test performed.

Dynamic Analyses

Produces a printed report of predefined collection of sample file parameters.
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[M] micromeritics®

Pulse Chemisorption Report

PULSE CHEMISORPTION REPORT

(3 Pulse Chemisorption Report Options o=

Selected Experiment its

All Pulse Chemisarption experiments selected.

Area to Volume Conversion:
@ Calaulated (default)
Usethelast 1 peaks for saturation.

) Calibrated

Cancel

Pulse Chemisorption Report

Field or Button

Description

Area to Volume
Conversion
[group box]

Calculated. Uses the standard calculation and the raw signal.

Calibrated. Uses selected peaks for the conversion. A calibration

step must be included in the experiment to use this method.

Selected Experiments
[group box]

Displays all related experiments in the current file. Only experiments

with collected data are shown.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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Quantity Adsorbed Formulas

Situation 1

Pulse adsorption experiment, no calibration applied in peak editor, report
option is Calculated.

L—(Lx —2=_)

_ Avg1astN
Qadsx T Massmpie

Situation 2

Pulse adsorption experiment, no calibration applied in peak editor, report
option is Calibrated.

Report displays an error message that calibration is not found, and uses the
formula from Situation 1.

Situation 3

Pulse adsorption experiment, calibration is applied in peak editor, report
option is Calculated.

Qadsw — Qend_Qa:

Masszampie

Situation 4

Pulse adsorption experiment, calibration is applied in peak editor, report
option is Calibrated.

Qads, = =%

Massgample

Situation 5

Pulse reaction experiment, no calibration applied in peak editor, report option
is 'Calculated.

( Ag ( Aend

X pu—
Q a ds _ AvgfirstN ) AvgfirstN
r Mass sample

Situation 6

Pulse reaction experiment, no calibration applied in peak editor, report option
is Calibrated.

Report displays an error message that calibration is not found, and uses the
formula from Situation 5.

Situation 7

Pulse reaction experiment, calibration is applied in peak editor, report option
is Calculated.

Qads, = =2t

Masszampie

Situation 8

Pulse reaction experiment, calibration is applied in peak editor, report option
is Calibrated.

Qads, = _Q:—00

Massgample

where
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Iml micromeritics® Pulse Chemisorption Report

Aend
AX

AVGfirstN

AVQastiN
L

Mas ssamp/e

Qads,

Qend

Area of the last peak, shown as Peak Area in peak editor
Area of peak #X, shown as Peak Area in peak editor
Average of first N peak areas

Average of last N peak areas

Loop quantity calculated from the injection volume, ambient
temperature, ambient pressure, and active gas concentration.

273.15 Pomp Coactive
Ty +273.15 760mmHg 100.0

V:inj X

Sample mass (grams)

Use the last N peaks for saturation in the Pulse Chemisorption Report
Options. For pulse reaction experiments (where gas is emitted by the

reaction and peak areas decrease over time) this is actually the first N
peaks.

Quantity Adsorbed per gram for peak #X, shown in the Pulse Chemisorp-
tion Report's peak table. The report sets negative values to 0.0. To get
total quantity adsorbed, multiply by Massg,yp1e @and sum across peaks.

Quantity of the last peak, shown as Peak Quantity in peak editor.
Quantity of peak #X, shown as Peak Quantity in peak editor
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SAMPLE AUDIT TRAIL REPORT

CFR

For 21CFR11 environments only.
Note or en y

This report lists all changes and comments that have been applied to sample files with a Complete
status.

SAMPLE LOG REPORT

/ Not applicable to 21CFR11 environments. See Sample Audit Trail Report above.

/ Sample Log reports cannot be edited.

Inserts a log of sample operations in the reports.

This report provides information on:

m Manual control operations performed during analysis.
= Information entered using Add Log Entry on the sample file editor.
m Warnings and/or errors which occurred during analysis.
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Iml micromeritics® Sinfelt and Difference Methods

SINFELT AND DIFFERENCE METHODS

Difference Method Report on page 8 - 16

The Difference Method Report and the Sinfelt Method Report windows are identical unless
otherwise specified.
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[M] micromeritics®

SUMMARY REPORT

The Summary Report for physisorption analyses provides a condensed summary of selected data

results.

Summary Report Options

4 am. desorpton

Dubiin Radushesih
@

9] Moncayer cpacity

In the Pore Volume group box, if Adsorption total or Desorption total is selected, the p/po field is
enabled. Enter the relative pressure used to calculate the total pore volume.

Summary Report

Field or Button

Description

Item [n] [selection]

Use to enable the first Pass/Fail item. Until the Summary Report is
selected, S A Single-point BET will be displayed by default. When
selected, click Pass/Fail, then select pass/fail criteria options.

Pass/Fail [n]. Click to display the Pass/Fail Options window for
selection of pass/fail criteria.

Pass/Fal Options
Surface Area Pore Volume
© Single-point 8ET ‘dsorptin total

Mut-point BET

DH desorption ava.
pore width (4V/4)

S A: Single-point BET. Use to enable Pass/Fail [n] in the ltem [n]
group box.

Upper/Lower. Specify upper and lower limits for the selected
parameter. A range can be left open by not selecting the limit. In the
text box to the right of Upper/Lower, enter operator instructions to
be displayed if a failure is encountered.
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EI micromeritics® Summary Report for Dynamic Analysis

Summary Report (continued)

Field or Button Description
Select All / Deselect All | Selects (or deselects) all options.
[button]

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

SUMMARY REPORT FOR DYNAMIC ANALYSIS

The Summary Report for dynamic analyses provides a condensed summary of the peaks and
selected analysis parameters.
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[M] micromeritics®

T-PLOT REPORT

The t-Plot calculation allows quantitative analysis of the area and total volume ascribed to
micropores. Matrix area (the area external to micropores) is directly determined and often proves
to be a valuable way of characterizing complex mixed materials.

oo s

1.2 1t Repet Ot

SelectReperts
[7] Tabudar report.
|t
[Cloverlay samples.
7] Actosc:
V] avtosc:

Seisct Pressures Induded inRport

Precauree..

Cox )

t-Plot Report

Field or Button

Description

[text box]

Fitted thickness range

Enter the minimum and maximum thicknesses (in angstroms or nano-
meters) to include in the thickness curve. Go to Options > Units to
specify default units.

Pressures [button]

Use to select a pressure range for report calculations and points for
exclusion from calculations.

=

Absolute
rrrrrrrr

Relative

[5)

Quantity

(mmol/g)

Exclude

0.0005261

.0002963 0 cooossez |

0.000031943

0.00250
0.00520

0.0007703

0.00004589%

0.00776

0.0010505

0.000064119

0.01033

0.000083520

0.0120

0.000107785

0.015%

0.00013947

0.01801

1
2

3

2

5 | o.0013708
s

7

8 | o.00254
s

0.000150758

0.02057|

0.0038493

0.000235619

0.02313

0.00030193%

0.02565

10| o.004328
1

0.0063188

0.000386368

0.02817|

o o o o o

Caleulation pressure range

0.000000000  P/P®

1000000000 P/P°

Place a check-mark next to pressures to be excluded from reports calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
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t-Plot Report

t-Plot Report (continued)

Field or Button

Description

Selected Reports
[group box]

Tabular Report. Use to have a tabular report of data generated.

t-Plot. Use to have a graphical representation of data generated.

m Autoscale x-axis. The x-axis field shows the statistical thickness
of the adsorbed film.

m Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.
m Overlay samples. Use to overlay sample files on the t-plot.

Surface area correction
factor [fext box]

Enter the value to correct for surface areas that are not smooth. This
brings the values for BET surface area and micropore surface area
into accordance. For most samples, the default value of 1.000 is
adequate.

Surface Area
[group box]

Select the surface area value used for thickness calculations. BET is
the most commonly used option.

Thickness Curve
[group box]

Select the thickness curve, then click Edit to modify the values in the
equation for the selected curve. The Frenkel-Halsey-Hill thickness
curve can be applied using the Halsey option.

Kruk-Jaroniec-Sayari / Halsey / Harkins and Jura / Broekhoff-
de Boer / Carbon Black STSA. Select the thickness curve option,
then click Edit. Modify the equation for the selected curve as
needed.

Reference. Select Reference, then click Edit to define a t-curve by
entering both the relative pressure and thickness values. One
predefined curve is shipped with the analysis program and is found in
the Reference directory.

E entered t-Curve = =] =]
Name: User-Defined
Relative Thickness
Pressure ® dnsart
®p?)
1 0.000000001 1.0000 S
[ Gear
==
Open. |
Save As |
oK Cancel
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[M] micromeritics®

t-Plot Report (continued)

Field or Button

Description

To import values from an existing thickness curve (.THK file), click
Open, then select the file containing the values. The table to be
imported must have a .TXT or .THK file extension and have a two-
column format with the relative pressures in the first column and the
thickness values in the second column. Columns must be separated
by a space or a tab.

t-Plot [check box]

Use to have a graphical representation of data generated.

Autoscale x-axis. The x-axis field shows the statistical thickness of
the adsorbed film.

Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

Overlay samples. Use to overlay sample files on the t-plot.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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[M] micromeritics’ Teriin Report

TEMKIN REPORT

The Temkin isotherm is used to model adsorption data where the heat of adsorption drops linearly
with increasing coverage.

i femkin Report Options =l i femkin Report Options ==
" v Calculations
[ specify monolayer capacity X § ["] Specify monolayer capacity
First analysis
0.04461 0.04461
["]Repeat analysis
[ Specify differential heat of adsorption at zero surface coverage [Cpifference [ Spefy differential heat of adsorption at zero
surface coverage
1.000
1.000
Select Reports Select Reports
[] Tabular report [] Tabular report
[/] Temkin Transform plot [] Temkin Transform plot
[[]overlay samples [[] overlay samples
From To From To
Autoscale x-axis -2.01499 -1.01499 Autoscale x-axis -14.01499 4.98501
Autoscale y-axis 0.00000 44.61477 Aum;ca|e y-axis 0.00000 446.14774
[] Temkin Isotherm plot [] Temkin Isotherm plot
Overlay samples C a) S
I . Overlay samples Hrom T
Autoscale x-axis 0.0000000 0.1333224 Autoscale x-axis 0.0000000 | 133.3224000
Autoscale y-axis 0.00000 44.61477 Autoscale y-axis 0.00000 446.14774
Select Pressures Induded in Report Select Pressures Induded in Report
Pressures... Pressures...
oK Cancel oK Cancel

Physisorption Chemisorption
Temkin Report

Field or Button Description

Calculation [group box] | Select one or more of the calculation options to be used for analysis.

Pressures [button] [ Use to select a pressure range for report calculations and points for
exclusion from calculations.

==
Absolute Relative Quantity | Exclude T e IR EER

‘ = | | EE - s.00000000 o
T .00 voo0rsiez|  oooaso L1 e L onnooono afe"
2| c.oo0sas1 v.ovosiss| ocosm| [
3 | 0.0007703] 0.0000468%5| o0.00776| [
4 | o.0010505] 0.000064118| 0.01033) [
5 | 0.0013708| 0.000083820) o0.01200] [
6 | 0.0017651 0.000107785| 0.015%| [
7| c.oozzsis o.ovorssrr| oomar| I
8 | 0.002954s| 0.000180788| 0.02057] [
5 | o.003m3|0.000z3se18| 0.02313) ]
10| o.0vs528| o.covmr9s| oozses| [
11| c.ons31s8] 0.co03msses| ooasrr| [ i

Concel
e b e

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.
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[M] micromeritics®

Temkin Report (continued)

Field or Button

Description

Include All. Select to include all pressure points in the table.

Pressures [button] [§

Use to enter a range of pressure points to be included in the report or
to modify table values for pressure points.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.

Exclude All. Select to exclude all pressure points in the table.
Include All. Select to include all pressure points in the table.

Line fit pressure range. Enter the minimum and maximum
pressures for line fit.

Select Reports

Tabular Report. Generates a tabular report of the included samples

[group box] that contains the numeric values contributed by each sample.
Temkin Isotherm plot. Overlays the Temkin isotherm with the
analysis data.

m Autoscale x-axis. Linear x-axes begin at zero. The x-axis field
shows the absolute pressure.

m Autoscale y-axis. y-axes begin at zero. The y-axis field shows
the quantity of gas adsorbed.

m Overlay samples. Use to overlay sample files on the isotherm
plot.

Temkin Transform plot. Plots a linear form of the Temkin

transform plot.

m Autoscale x-axis. The x-axis field shows the logarithm of pres-
sure (In).

m Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

m Overlay samples. Use to overlay sample files on the transform
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Temkin Report (continued)

Field or Button Description
plot.
Specify differential heat | Select and enter the differential heat of adsorption at zero surface
of adsorption coverage. This allows inclusion of all Temkin constants.
[check box]
Specify monolayer Select and enter the monolayer capacity of the sample.

capacity [check box]

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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VALIDATION REPORT

This report allows data to be examined by the analysis program to determine if the results are
within typical ranges. If the data for any reports selected for validation are determined to be out of
range, a warning will display and suggestions are given for corrective action.

mVﬂlidalion Report Options E@

Isotherm

BET

D Langmuir

[ Freundiich

[ Temkin

[ t-Plot

[F-Ratio method
[C]BIH adsorption
[C]BIH desorption
[1D-H adsorption
["1D-H desorption
[ Horvath-Kawazoe
["1DFT pore size
["1DFT surface energy
[ bubinin

[ IMP-Method

oK Cancel
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9 DIAGNOSTICS

Unit [n] > Diagnostics

Use to display diagnostic readings, start and schedule diagnostic tests, and open saved
diagnostic reports. Each test generates a file to the default directory name and path of
...\...\Service\userdiag unless another directory name was specified. These reports can be sent to
a Micromeritics Service Representative for examination.

START DIAGNOSTIC TEST

Unit [n] > Diagnostics > Start Diagnostic Test

Provides a method to start a diagnostic testimmediately. Upon completion of the diagnostic test,
the file is saved as a .REP file which can be retrieved by going to Reports > Open Report and
selecting the report file.

Test to run unattended on a weekly basis. These tests check for system leaks and
require no operator intervention.

The PO Port Leak Test should only be run if the Psat tube is attached. If a vapor
source is attached, this test should not be run.

[E=REcE ]

/ It is recommended to schedule the Analysis Manifold Leak Test and the PO Port Leak

Opesator: Sequence:
Comments

Start Diagnostic Test

Field or Button Description

Comments [text box] Displays comments from the selected diagnostic test.

Estimated time (min.) | Approximate time for test completion.

File [group box] Shows a status bar of steps complete once the test begins.
Next [button] Starts the next test.
Flex Series Operator Manual 9-1
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9 Diagnostics EI micromeritics®

Start Diagnostic Test (continued)

Field or Button Description

Operator [text box] Enter information to identify the person running the service test.
Repeat [button] Repeats the selected diagnostic test.

Report after test Automatically generates reports to the selected destination when the
[check box] testis complete.

Sequence Sequence number assigned to the test.

Start [button] Starts the diagnostic test.

Test [drop-down box] Select the diagnostic test to be performed.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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SCHEDULE DIAGNOSTIC TESTS

Unit [n] > Diagnostics > Schedule Diagnostic Tests

Allows the specification of one-time or periodic running of a sequence of diagnostic tests. A
separate list of tests is saved for each of the possible test frequencies. Tests are categorized and
flagged as requiring intervention or not. If tests requiring intervention are scheduled, the operator
has the option of omitting the tests if the operator does not respond within a specified time after an
initial prompt is displayed and before the test is started. Events are logged in the analyzer log for
all starting, ending, and omitted tests.

X

Schedule Diagnostic Tests

Test Frequency
Once (Today)

") Daily
©) Weekly Day: |sunday
Start test sequence if instrument is idle any time between

00:00:00 + and 00:00:00

Available Tests: | A st o o b - v | [ Insert

Test Sequence

File Identification Est. Time (min.) Intervention Regq.

Marked tests require operator intervention to run.
[T skip these tests if the operator does not respond within | 15 minutes,

Itis recommended to schedule the Analysis Manifold Leak Test and the PO Port Leak
Test to run unattended on a weekly basis. These tests check for system leaks and
require no operator intervention.

The PO Port Leak Test should only be run if the Psat tube is attached. If a vapor
source is attached, this test should not be run.

Schedule Diagnostics Test Frequency

Field or Button Description

Available Tests Select one or more tests to run unattended.

[drop-down box]

Insert [button] Inserts the selected test in the Available Tests drop-down list.
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[M] micromeritics®

Schedule Diagnostics Test Frequency (continued)

Field or Button

Description

Skip these tests if the
operator does not
respond within [n]
minutes [check box]

Check this option if any test requiring operator intervention should be
omitted if the operator does not respond within the specified time.

Start test sequence if
instrument is idle any
time between 00:00:00
and 00:00:00 [text box]

Enter a from and to time for an unattended test to begin if the instru-
ment is idle at any time during the entered time frame.

Test Frequency
[selection]

Select how often the test is to run unattended.

Test Sequence
[group box]

Provides the test file identification and estimated run time. A
checkmark in the Intervention Required column indicates that
operator intervention is required.

To remove a test from the sequence, select the test, then click
Delete.

To add a test to the test sequence, highlight a row in the Test
Sequence box, select a test from the Available Tests list, then click
Insert.

/

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

DIAGNOSTIC TEST REPORT

Unit [n] > Diagnostics > Diagnostic Test Report

Displays previously run diagnostic service tests. Separate directories store tests run once, daily,
weekly, and monthly. Diagnostic test report files have a .SVT file extension and are stored in the

...\Service directory.
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Save Files for Problem Diagnosis

SAVE FILES FOR PROBLEM DIAGNOSIS

Unit [n] > Diagnostics > Save Files for Problem Diagnosis

Use to compress pertinent diagnostic information into a single zip file. This file can be sentto a
Micromeritics Service Representative for problem resolution.

User information

Save Files for Problem Diagnosis X

Name:

Address:

Include fles:

2.
3.

Complete the form. A default file named Diagnostics-[date].zip is created unless another file
name is specified.

Add any files that are related to the problem — such as sample files — and save the file.
Send an email to Service.Helpdesk@Micromeritics.com for instructions on how to transfer
the .ZIP files to Micromeritics.

Save Files for Problem Diagnostics

Field or Button

Description

Problem description
[text box]

resentative.

Enter information that would be helpful to the Micromeritics rep-
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[M] micromeritics®

Save Files for Problem Diagnostics (continued)

Field or Button

Description

Include Files

Add. Click to select additional files to send with this problem
diagnosis.

Delete. Select the file in the Include Files box, then click Delete to
remove the file from the list.

Clear. Click to clear all files from the Include Files box.

Save As [button]

Click to specify the name and location of the compressed file. Make a
note of the file name and location. This file will need to be sent to
your Micromeritics representative for problem resolution.

Micromeritics rep-
resentative [text box]

Enter the name of your Micromeritics representative. This inform-
ation will remain on the window each time files for problem diagnosis
need to be submitted (can be modified as necessary).

User Information
[text box]

Enter information for the person to be contacted by a Micromeritics
representative. This information will remain on the window each time
files for problem diagnosis need to be submitted (can be modified as
necessary).

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

SHow ALL READINGS

Unit [n] > Diagnostics > Show All Readings

The Show All Readings window displays the calibrated and nominal readings of all sensors in the
system.

2 All Readings.

Manifold Pressure

1000 mmHg:
10 mmHg:
Firani:

Cold Cathodk:

1000 mmHg:
10 mmHg:

Port 1

1000 mmHg:
10 g
0.1 mmHg:

Port3
1000 mmHg:
10 mmtig:
0.1mmHg:

Blectrorics

apct
Temperature:

a2
Temperature:

Signal
75.520
0.59328
2.8%-001
4130001

High-Speed Pressure

Signal
75,757
0.72661

Signal
75,121

0.18332
0.0016453

Signal
75,387

0.45996
0.2682907

0.5

315

059328
2000001 K2
467001 K2

019332 ka
00016455 kea

045996 ka2
02682007 kpa

« Analog 5V;

Digital 5V:

« Analog 5V;
Digital 5 V:

Ambient:
Upper Cabinet:

Mantie:
Target:
Ramp Rate:

Port2.

1000 mimHg:
10 mntg:
0.1mmHg:

Po

1000 mmHg:

0.000 v
0.000 v

+15V;

0.000 v
0.000 v

+15V;
-15V.

0.000 v +15V;

0,000 v

15V

15V

s
75

032664
0.1343683

Sign:
75.654

0.000 v
0.000 v

0.000 v
0.000 v

0.000 v
0,000 v

%5
06
20

0
444 448444

El

el Nominal
254
0.3264 kP2
0.1349683 kP2

al Nominal
75654 ke

24V 0.000 v
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[M] micromeritics® 10 Gaibraton

10 CALIBRATION

Unit [n] > Calibration

CFR Dynamic Analysis and Chemisorption options are not applicable when the software is
Note installedin 21CFR11 environments.

accessories. It is not necessary to recalibrate the system unless it seems out of

/ A calibration file was created specifically for the analyzer and included with the
calibration.

Disabled calibration menu options can be accessed only with the assistance of an authorized
Micromeritics Service Representative. Calibrations can be saved to a file and reloaded later.

To review calibration details of the analyzer, go to Unit [n] > Unit Configuration.

Generally, it will not be necessary to change the data in the calibration file. However, if a condition
occurs during the operational verification that requires changes to the calibration data, changes
should be saved in a file. Calibration data files are retained in the analyzer history file and can be
reloaded in the event that calibration data becomes corrupt.
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10 Calibration

[M] micromeritics®

GAS FLow CALIBRATION

Unit [n] > Gas Flow Calibration
Gas Charts on page I - 1

Gas Flow Constant Calibration

1. Use the Instrument Schematic (in Manual Mode) to flow the gas to be
calibrated through the Carrier gas MFC and sample tube.

2. Connect a flow meter to the exhaust, and measure the actual flow rate.
3. Select the gas being flowed below.
4. Enter the actual flow rate below to compute the mass flow constant.

5. Click Accept to change the mass flow constant in the Adsorptive Properties
for the gas to the computed value.

Gas: | <None> w

Actual flow: mmol/min

Mass flow constant: 0.713

Accept Close

Use the Gas Flow Constant Calibration option to determine a constant used by the analyzer to
ensure accurate gas flows through each Mass Flow Controller (MFC). The Mass Flow Controllers
were calibrated before shipping and calibration is typically not necessary.

1. Goto Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go to Unit [n] > Show Instrument
Schematic. Flow the gas to be calibrated through the Carrier gas MFC and sample tube.

2. Connect a flow meter to the exhaust and measure the actual flow rate.

3. Inthe Gas drop-down box, select the gas to be flowed. In the Actual flow field, enter the
actual flow rate to compute the mass flow constant.

4. Click Accept to change the mass flow constant in the Adsorptive Properties for the gas to

be the computed value.

10-2
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Iml micromeritics® Mass Flow Controller Calibration

MASS FLow CONTROLLER CALIBRATION

Gas Charts on page I - 1

The analyzer uses a Mass Flow Controller (MFC) to control the flow of gases. The MFC requires a
conversion constant for each gas or gas mixture to compensate for variations in gas flows
resulting from variations in the gas properties.

In most cases, the default MFC conversion constant yields accurate data. A new conversion
constant may be used if:

A unique gas mixture is used.

The gas to be used is not included in the table.

A higher precision calibration of the MFC for a given gas is required.
Unexpected analysis data lead you to believe that the default value is in error.

FLOwW MEASUREMENT

An external device that measures the flow of gas from the analyzer’s exhaust is used during MFC
calibration. A soap bubble burette is shipped with the analyzer. For even more precise calibration,
use another type of flow meter and follow these instructions for obtaining a new conversion
constant, substituting your flow meter for the soap bubble burette.

Flex Series Operator Manual
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10 Caiibration [M] micromeritics

INSTALL THE SOAP BUBBLE BURETTE

If using another type of flow meter, follow the meter manufacturer’s assembly and

/ These instructions are for assembling and using the burette supplied by Micromeritics.
operation instructions.

1. Carefully unwrap the glass tube and the rubber bulb.

2. Attach one end of the flexible tubing to the side arm of the glass tube.

3. Attach the metal tubing provided with the bubble burette to the other end of the flexible
tubing.

A. Exhaust port
B. Flexible tubing
C. Bulb filled with leak detector

4. Locate the exhaust port that corresponds to the MFC to be used for this calibration.

5. Remove external plumbing from that port and attach the bubble burette using the connector
provided with the burette. The soap bubble burette must be held in an upright position. For
example, if using the Carrier Flow Controller, attach the bubble burette to the carrier gas
exhaust port.

6. Attach the bulb to the bottom of the glass tube.

10-4 Flex Series Operator Manual
350-42800-01 (Rev R) — Apr 2021



H n -y = ® Determine the Gas Flow Constant for Individual
[Mi micromeritics

Gases

DETERMINE THE GAS FLOW CONSTANT FOR INDIVIDUAL GASES

Unit [n] > Gas Flow Calibration

1. Goto Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the

menu item. If the analyzer schematic does not display, go to Unit [n] > Show Instrument
Schematic.

2. Flow the gas to be calibrated through the Carrier gas MFC and sample tube
a. Attach the gas to be calibrated to an inlet port for the MFC to be used during calibration.

b. On the analyzer schematic, right-click the Flow Controllericon. Select Set Flow Rate,
then enter the flow rate. Click OK.

Gas Flow Constant Calibration

1. Use the Instrument Schematic (in Manual Mode) to flow the gas to be
calibrated through the Carrier gas MFC and sample tube.

2. Connect a flow meter to the exhaust, and measure the actual flow rate.
3. Select the gas being flowed below.
4. Enter the actual flow rate below to compute the mass flow constant.

5. Click Accept to change the mass flow constant in the Adsorptive Properties
for the gas to the computed value.

Gas: | <None> w

Actual flow: mmol/min

Mass flow constant: 0.713

Accept Close

3. Enter the actual flow rate in the Actual flow field to compute the mass flow constant.

4. Click Accept to change the Mass flow constant field in the Adsorptive Properties for the gas
to the computed value.

Set Mass Flow Controller X

Automatically setisolation valves

O Open

() Close

(®) set flow rate: scom

Mass flow controller constant: 1,000

Cancel
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10 Calibration EI micromeritics®

MATCH TRANSDUCERS

Unit [n] > Calibration > Match Transducers

m This process should not be performed when the main transducer reading is abnor-
mal.

m All transducers must be checked.

Use to evacuate the system and zero the pressure transducers, then adjust the scale to match
them to the manifold transducer near full scale pressure.

/ A blank sample tube or small plug must be installed on each selected port prior to start-
ing this process.

e (el ([FEE]
e :
// 0.1 Torr transducer
P is not shown

.

1. Install a blank sample tube or small plug on each applicable port.

2. Ensure that all applicable transducers are selected, then click Start. The window closes
when the operation is complete. Click OK when the process is complete.

Match Transducers

Field or Button Description

1000 mmHg Transducers Select the ports.

10 mmHg Transducers Select the ports. Enabled only for ports with 10 mmHg trans-
ducers present.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Flex Series Operator Manual
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[M] micromeritics’ Pressure Offse

PRESSURE OFFSET

Unit [n] > Calibration > Pressure Offset

This procedure evacuates the system and zeroes the pressure transducers. This calibration

should only be performed by qualified service personnel. In order to perform this procedure,
sample tubes must be attached to each port.

B8 calibrate Pressure Offset ol =)=
1000 mmHg Transducers 10 mmHg Transducers 0.1 mmHg Transducers
[¥] Manifold Manifold [¥] sample Port 1
[¥] sample Port 1 Sample Port 1 [¥] sample Port 2
[¥/]sample Port 2 Sample Part 2 [¥] sample Port 3
[¥] sample Port 3 Sample Port 3

[#]Pa Part

After selecting the transducers, press the start button. This procedure wil
evacuate the system and zero the pressure transducers.

Warning: The selected ports must have sample tubes attached.

Start Cancel |

1. Install a blank sample tube or small plug on each applicable port.

2. Ensure that all applicable transducers are selected, then click Start. Click OK when the pro-
cess is complete. The current pressure readings and operation status messages display.
Pressure Offset

Field or Button Description

1000 mmHg Transducers Select the manifold and/or ports.

10 mmHg Transducers Select the manifold and/or ports. Enabled only for the man-
ifold and ports with 10 mmHg transducers present.

0.1 mmHg Transducers Select the ports. Enabled only for ports with 0.1 mmHg trans-
ducers present.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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10 Calibration EI micromeritics®

CHECK PRESSURE TRANSDUCER SCALE CALIBRATION

Do not change the pressure calibration unless absolutely necessary. Consult with
Micromeritics Norcross, GA prior to changing calibration settings.

Ambient

o
| Vacuum : 1.23e-002 _25.5 C
mmHag
é B 47 18 Manifold
4.4500 23.5°C
mmHa
© 13 sccm 6 7 Ports
T: 14 sccm
5 24.5°C
® U - > s
11 } §25.360 mmHg é é
(D 14
567.45 0.012346 2.4500 3.4500
12 (D mmHg mmHg mmHg ™ mmHg
m 15
13 .—(D- 9
m 16 E
21 ._(D.
- . | 1]
22 ._(D.
25
23 =
[E 26

. Goto Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the

menu item. If the analyzer schematic does not display, go to Unit [n] > Show Instrument
Schematic.

Ensure valves 6, 7, and 8 are closed.

Open valves 1 through 5 and the N, gas valve.

Set the servo to dose automatically to 760 mmHg by right clicking the servo valve, select
Set > Dose > Automatic, then enter 760 mmHg.

Remove one of the port plugs. The pressure on all transducers will read atmospheric pres-
sure.

Check all transducer readings against the external pressure gauge. If the readings are
within 2 mmHg, do not change the transducer’s calibration.

To calibrate, go to Unit [n] > Calibration > Pressure Scale.
Use a pressure gauge to determine atmospheric pressure.

10-8
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EI micromeritics® Check Pressure Transducer Scale Calibration

9. Select the appropriate transducer.

X5

@ 1000 mmHg
() 10 mmHg

(0.1 mmHg

(@) Match to entered pressure
760.00 | mmHg

() Reset to nominal

Manifold

Sample Port 1

Sample Port 2

Sample Port 3

Po Port

Warning: Changing the calibration information will affect

the performance of the instrument, Only gualified service
personnel should do this,

[ OK J [ Cancel

Enter a value between 500,00 and 1,000.00.

10. Enter the pressure from the pressure gauge in the Match to entered pressure field.
11. Click OK to close the window.
12. A confirmation message is displayed. Click OK.

/ The 10 mmHg and 0.1 mmHg transducers should not be calibrated at this time.

Flex Series Operator Manual
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10 Calibration EI micromeritics®

RESET PRESSURE CALIBRATION

Unit [n] > Calibration > Reset Pressure Calibration

This procedure resets the pressure calibration to the factory default settings.

Reset Pressure Calibration @

‘ Are you sure you want to reset the pressure to factory defaults?

Yes ] [ Mo ]

performed. The pressure transducer should be calibrated before starting this pro-

/ The servo valve should always be recalibrated after a pressure calibration has been
cedure.

SERVO VALVE

Unit [n] > Calibration > Servo Valve

Use to calibrate the servo valve to the manifold pressure transducer. The servo valve should
always be recalibrated after a pressure calibration has been performed. The pressure transducer
should be calibrated before starting this calibration procedure.

cedure. Go to Unit [n] > Unit Configuration and view the calibration information.

/ Ensure the pressure transducer has been calibrated before performing this pro-
Contact your Micromeritics Service Representative if calibration dates are not listed.

B8 calibrate Servo |E=2ESH =

This procedure wil calbrate the servo valve o the main pressure
transducer.

Make sure that the pressure transducer was calbrated before starting.

Click Start. The window closes when the calibration is complete.

Click Cancel to stop the calibration process.

Flex Series Operator Manual
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I m I m icromeritics® Signal Calibration for Dynamic Analysis

SIGNAL CALIBRATION FOR DYNAMIC ANALYSIS

Unit [n] > Signal Calibration
Analyses yield data on signal reading, peak area, temperature, and time. These data are sufficient
for many applications, however volume data may also be needed.

It is not necessary to perform a calibration if volume data are not needed. If volume data are
needed, calibration may be performed either before or after the analysis.

sure. The correct values for these quantities must be entered under Unit [n] > Unit
Configuration and Options > Environment Defaults before starting an analysis
that uses them to determine the quantity of gas in an injection.

/ This does not apply to loop calibration, ambient temperature, and atmospheric pres-

A group of automatic calibration routines are provided in the form of specialized experiment steps.
A calibration run is an analysis using one of these experiment steps. The calibration run can be
performed before or after the sample analysis and can be included as a step within the analysis, or
it can be performed as a separate analysis.

After the sample data and calibration data are collected, the calibration file is associated with the
sample file, and the sample data are converted to volume. A single calibration run can be
associated with an unlimited number of sample data files. For example, TPR yields peak area and
the temperature at which maximum reduction occurs. To obtain the volume of gas uptake, a
calibration file must be associated with the analysis file, then reports are created in which the area
data are converted to volume data.

A calibration file can be associated with a sample file by doing the following:

m Going to Unit [n] > Signal Calibration > Defaults and selecting a default calibration file for
each experiment type.

m Using the default file or choose a different file in the Unit [n] > Sample Analysis window.

= Clicking Set Calibration on the Peak Editor window and select from a list of calibration files
that were created after the sample file was used in an analysis.
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10 Calibration EI micromeritics®

CREATE A NEW SIGNAL CALIBRATION FILE

Unit [n] > Signal Calibration > New

When selecting a Signal Type and Type of Calibration, only those options used in the original
analysis are enabled on the right side of the window.

1. Select the sample file to be used for the new signal calibration file.

2. Select the Signal Type and Type of Calibration options to include in the new calibration file.
As these selections are made, the experiments from the selected analysis file display on the
right side of the window. Only those experiments applicable to the selected signal type and
calibration type are enabled. Click OK.

3. If prompted, enter the active gas concentration in the carrier gas and in the loop gas. Click
OK.

4. Delete (or edit) data in the Peak Table as appropriate. Click Save.

oo s

gggggggg
samole Experiment Peak Pek Quantity
Fie D aea (e sTP)

aaaaaaa

Signal Calibration

Field or Button Description

Degree [drop-down box] | Select the power to display in the Coefficients list.

Delete Peak [button] Removes a peak from the peak table. Select the peak and click
Delete Peak.

Description [text box] Enter a description of the file.

Include origin Enables or disables the original in the graph.

[check box]

Load Calibration Data Use to enter calibration data from a selected file.
[button]

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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[M] micromeritics®

Signal Calibration for Dynamic Analysis

CREATE A SIGNAL CALIBRATION REPORT

Unit [n] > Signal Calibration > Report

Report Settings

Destination:
@ Preview
7 Print [
_ File:
File name:

File type: |Report System (*.rep)

OK Cancel

Select a previously defined signal calibration file from the drop-down list, then select the print

destination.

]
TCD Calibration

3FlexVersion 4.00 3FlexVersion 4.00 Page 1
Serial # Unit 1 Serial # 528

D Type  Description

3500_0003 Level H210%inAr4s
scom Gas

Calibration

oth st 2nd d 4t 5t

Coeficients: 081 7.9 181 014 218 0.00

{

OPEN A SIGNAL CALIBRATION FILE

Unit [n] > Signal Calibration > Open

Select a previously defined signal calibration file from the drop-down list. If a calibration file
already exists, select the serial number from the drop-down serial number list. When a new
calibration file is saved using a new serial number, the new serial number displays in the Serial

Number drop-down list.

If this is the first calibration file to be saved, the Serial Number drop-down will not display until the

first calibration file is saved.
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[M] micromeritics®

LIST SIGNAL CALIBRATION FILES

Unit [n] > Signal Calibration > List

Select Instrument &J

OK ] [ Cancel ]

Displays a list view of previously defined signal calibrations for the selected serial number.

T File Listing [==]f=]
Fie Listng
uuuuuu
ie Listing
Calibration Directory - S/N 528
File Listing
No File Name Date Time File Identiication
13500_0003TCD  2015-08-1010:16:30AN  §
2 3500 0004TCD 2016-09-100247:42PM  §
-
Defauit styie
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I m I m icromeritics® Loop Calibration for TCD Analyzers

LooP CALIBRATION FOR TCD ANALYZERS

Septum on page 11-13

Each calibration loop must be calibrated prior to its first use to determine its precise volume under
local conditions. Calibration consists of:

m Determining the average area of a series of peaks generated by injections of a known volume
of gas through the analyzer septum using a syringe.

m Determining the average area of a series of peaks generated by injections of the same gas
using the analyzer’s internal loop.

m Calculating the volume of the loop by comparing the average peak area generated by the loop
injections with that generated by the syringe injections.

m Entering the calculated loop volume under Unit [n] > Unit Configuration.

STEP 1: UPDATE AMBIENT PRESSURE AND TEMPERATURE

Options > Environmental Defaults

Environmental Defaults for TCD Analyzers on page 2 - 20

Ambient pressure and temperature at the time of the analysis affect the results of a loop
calibration. In calculations, the analyzer uses the ambient pressure and temperature recorded
in Environmental Defaults. Check and update the Environmental Defaults before beginning a
loop calibration.

STEP 2: CREATE A SAMPLE FILE

Create the sample file and insert a Loop Calibration experiment on the Analysis Conditions
tab.

carrier gas, flow rate, and loop gas that will commonly be used for sample ana-

/ A loop calibration must be created for each loop. For Loop Calibration, select a
lyses.
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10 Calibration EI micromeritics®

STEP 3: PERFORM THE ANALYSIS

Powobd-~

Install the correct injection loop.

Go to Unit > Sample Analysis and select the sample file for the loop calibration.
Click Next to accept the default values, then click Start.

Follow the prompts to make the selected number of injections. Use a volume that is
close to the volume of the loop being calibrated. For example, if calibrating the 1 cm3
loop, use a 1 cm?3 syringe and inject as close to 1 cm3 of gas as possible.

/ Pay close attention to the instructions provided in each prompt and perform the

steps in the order given. Most accurate data results from keeping injection size as
consistent as possible. Injection errors may be evident in the data and may make it
necessary to repeat the experiment.

After the last manual injection, the analyzer automatically makes the same number of
injections using the loop.

STEP 4: GENERATE THE REPORT

Peak Editor for Dynamic Analysis on page 7 - 12

When properly performed, each manual and automatic injection results in a peak. When the
Results view of the Start Analysis window is selected, each peak can be viewed as it is
collected. The area under the peak corresponds to the amount of gas injected.

1.
2.

3.
4.

In the Peak Editor, open the sampile file to ensure the peaks are properly marked.
Goto File > Open > [.SMP] and open the .SMP file containing the calibration exper-
iment and verify (or correct) the defined peaks using the Peak Editor.

On the Reports tab, select only the Loop Calibration report option.
Go to Unit > Unit Configuration. In the Loop volume field, enter the Loop Volume.

/ Verify that the Loop Volume and Environmental Default values are correct prior to

starting an analysis with injections.

10-16
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EI micromeritics® Load Calibration from File

LoAD CALIBRATION FROM FILE

Unit [n] > Calibration > Load from File

Use to load a previously saved calibration file.

It is recommended that the current calibration settings be saved using Unit [n] > Calibration >
Save to File prior to loading another calibration file. When loading a previously saved calibration
file, a backup of the current file is created and saved as [SN]last.cal. The backup file is overwritten
each time a new one is created.

/ Changing the calibration may affect the analyzer’s performance.

SAVE CALIBRATION TO FILE

Unit [n] > Calibration > Save to File

Use to save the current calibration settings to a backup file which can later be reloaded using the
Unit [n] > Calibration > Load from File menu option.

The default file naming convention for calibration files can be used or the file name can be
changed. The default file name of 0217-2013-04-25.CAL is interpreted as:

0217 Analyzer serial number

2013-04-25 Date the calibration file was saved

.CAL File name extension
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EI micromel‘itics® 11 Hardware

11 HARDWARE

CFR Dynamic Analysis and Chemisorption options are not applicable when the software is
Note installed in 21CFR11 environments.

Parts and accessories can be found online at www.Micromeritics.com.
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11 Hardware EI micromeritics®

CoLD TRAP TUBE

C
D
/ A. Connector nut
=
B \@ B. Ferrule
C. Sample port
/;y@ D. O-ring
A e E. Sample tube

To remove the cold trap tube

1. Loosen the connector nut on each stem of the cold trap tube.

2. Gently pull down on the cold trap tube to remove it from the ports. The connector nut and fer-
rule will remain on the cold trap tube stems. If the O-ring remains on the cold trap tube stem,
examine the O-ring to ensure it is still in good condition prior to re-inserting it into the port.
Replace the O-ring, if necessary. If the O-ring remains in the port, it may be gently pried out
for replacement.

To Install the cold trap tube

1. Reassemble the cold trap tube. On each stem, assemble the connector nut, a ferrule (large
side pointing toward the port), and an O-ring.
2. Slide each stem fully into the port, then tighten the connector nuts.
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EI micromeritics® Enable Manual Control

PREPARE THE COLD TRAP FOR IDLE PERIODS

If the analyzer is to be inoperative or unattended long enough for the liquid nitrogen in the cold trap
Dewar to evaporate (or the dry ice to evaporate from the dry ice acetone slurry), remove the
Dewar and U-tube so that impurities are not released into the system. Install a clean, dry U-tube. If
additional U-tubes are unavailable, clean the current tube and allow to dry; then reinstall at the
cold trap port.

If the analyzer is to be inoperative or unattended for a few days, reduce the gas flow to
approximately one-quarter of its normal value and leave analyzer powered ON. The gas loss and
power drain are very low and the analyzer will be immediately ready for use.

Regardless of how long the analyzer is to be idle, keep a sample tube installed at both
sample ports. This ensures the integrity of the system for gas flow and prevents
infusion of water and other vapors.

ENABLE MANUAL CONTROL

Unit [n] > Enable Manual Control

Show Instrument Schematic on page 2 - 24

Use to enable the manual control of certain system valves and pump components on the analyzer
schematic.

When this option is enabled, a checkmark appears to the left of Unit [n] > Enable Manual
Control.

If the analyzer schematic is not immediately visible, go to Unit [n] > Show Instrument
Schematic.
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FURNACE INSTALLATION FOR CHEMISORPTION

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

The furnace uses the same supply of compressed air as the instrument. There is an internal
regulator that has been set at the factory for the correct flow rate of cooling air to the furnace.

Furnace power outlet
Cooling air connector
Furnace thermocouple connector
Sample thermocouple connector

Sample thermocouple clipped to
sample tube

F. Tygon tubing

moOow>»

NOTE: This photo is shown without the
safety shield. The safety shield should
always be installed prior to running an
analysis.

1. If the heating mantle is installed, it must first be removed and replaced with the furnace. To
remove the heating mantle, unplug the heating mantle thermocouple connector and heating
mantle power source from the front panel of the instrument.

2. Place and center the furnace on the elevator tray.
3. On the front of the analyzer, connect cables in the following order:
a. Furnace thermocouple
Furnace cooling air connector
Furnace power connector
Install the sample thermocouple.
Insert the sample thermocouple connector into the thermocouple outlet
Secure the thermocouple cable into the p-clip.

-~ D o 0 T
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EI micromeritics® Secure Furnace to Elevator Tray

SECURE FURNACE TO ELEVATOR TRAY

/ This is an optional procedure for securing the furnace to the elevator tray in areas
prone to earthquakes.

Replace the screw that holds the black plastic base to the furnace and replace it with a 8-
32 x 1.51in. screw [part number 004-28622-00].

1. Invert the furnace and remove the screw that holds the black plastic base to the bottom of
the furnace. Save the lock washer and use it when inserting the longer screw.

~ Remove screw and lock washer. Save the lock washer for
the next step.

2. Place the black plastic base onto the elevator aligning the hole in the base with the hole in

the elevator.
3. Position the furnace on top of the black plastic base aligning the hole in the furnace bottom

with the hole in the furnace base.
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A. Lock washer
B. 8-32x1.5in. screw

4. Raise the elevator. Position the lock washer in the hole in the elevator tray. Insert the
8-32 x 1.5 in. screw through the lock washer, the hole in the elevator, the black plastic base,
and into the furnace.
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HEATING MANTLE INSTALLATION

Pivot Shelf Installation on page 11-11

/ The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

Shelf locking mechanism
Shelf track

Heating mantle lid
Heating mantle

Heating mantle shelf

moow>»

o'clock position when resting on the shelf surface. Ensure that the bottom of all
sample tubes are in full contact with the bottom of the heating mantle interior surface
only and DO NOT touch the thermocouple located on the bottom surface of the
mantle’s interior. A single sample tube must be installed on port 2.

/ If using less than three sample tubes, position the heating mantle cable in the 8

A. Place cable in 8 o'clock position
B. Thermocouple
C. Sample tube positions
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1. Place the mantle around the sample tube bulbs. Ensure that the isothermal jackets are
pushed up against the Dewar cover to avoid damage to the jackets.

2. While supporting the heating mantle with one hand, slide the shelf locking mechanism into
the shelf track.

3. Raise the shelf on the track until the heating mantle rests securely on the shelf and the
sample tubes touch the bottom of the inside of the heating mantle.

4. Turn the locking mechanism clockwise to secure the shelf.

5. Slide the heating mantle cover between the sample tube bulbs and the bottom of the iso-
thermal jackets so that the sample tubes fit within the slots of the mantle cover.
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@ Do not to apply force to the tubes while installing the lid.

6. Secure the heating mantle tabs onto the hook and loop fasteners of the heating mantle
cover. Ensure there is atleast a 1/2 in. (12 mm) gap between the top of the mantle cover
and the bottom of the isothermal jackets. This will prevent damage to the jackets. Replace
any damaged jackets.

7. Insert the mantle thermocouple and the mantle power plug into the analyzer’s front panel.

A. Thermocouple connector
B. Mantle/furnace power connector

6. Acknowledge the prompt on the Sample Analysis window. The degas will proceed. When
the degas is completed and the mantle has cooled below 45 °C, the Sample Analysis win-
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dow will submit a prompt to remove the degas heating mantle and shelf, properly position
the isothermal jackets and Dewar cover, and install the Dewar.

A To prevent potential burns, do not touch the sample tube or the heating mantle until
they have cooled.

7. Toremove the heating mantle, take off the heating mantle cover, support the bottom of the
heating mantle, then lower the shelf. The shelf must be removed prior to installing the
Dewar.

PARTS AND ACCESSORIES

Parts and accessories can be found online at www.Micromeritics.com.
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PIVOT SHELF INSTALLATION

Heating Mantle Installation on page 11-7

A pivot shelf is used to support the vapor source container or the heating mantle. It can be pivoted
for installation, removal, or height adjustment.

INSTALL THE PIVOT SHELF

A. Slide rail
B. Pivottray
C. Lever

1. Hold the pivot shelf in your left hand and the pivot block and lever (underneath the shelf)
with your right hand.

2. Pivot the shelf to the left to expose the block and lever.
3. Insert the slide block into the slide rail on the front of the analyzer.

4. Totighten the shelf into position, start with the lever to the right, push and turn the lever
clockwise.

5. Release the lever, then move the lever back to the right position and again push and turn
the lever clockwise.

6. Continue this process until the pivot shelf is snug in the slide rail.
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REMOVE OR ADJUST THE PIVOT SHELF

1. Pivot the pivot shelf to the left to expose the pivot block and lever underneath the shelf.
2. Hold the pivot shelf in your left hand and the pivot block lever with your right hand.

3. Toloosen the tension on the pivot shelf, start with the lever to the left, push and turn the
lever counterclockwise.

4. Release the lever, then move the lever back to the left position and again push and turn the
lever counterclockwise.

5. Continue this process until the pivot shelf can move on the slide rail.
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SEPTUM
PROPER USE OF THE SEPTUM

The septum is used to inject quantities of gas into the analyzer.

—— un l|grnme‘

Septum port

@ Do not use the septum at pressures above ambient. Gas may escape at elevated pres-
sures.

Accuracy of data is diminished when poor techniques are used for injecting gas through the
septum.

Injecting the gas through the septum causes a peak to appear, but it also causes a perturbation in
the flow of gas through the analyzer. This perturbation is visible in the peak data. To minimize this
perturbation, inject the gas more slowly into the septum. Prolonging the injection causes the peak
to spread.

An injection method should be developed to balance the need to minimize the perturbation with
the need for sharper peaks. See Peak Editor for Dynamic Analysis on page 7 - 12 to adjust
peak data to reduce the effects of perturbation.

m Always hold the syringe by its metal parts away from the needle. Holding the syringe by the
glass allows body heat to affect the volume of gas in the syringe.

m Afterfilling the syringe, allow the syringe to lie on a room temperature surface for about a
minute. This ensures that the syringe and its contents are at room temperature.
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m Ifthe gas used is lighter than air, do not allow the filled syringe to remain in a vertical position
(needle up) — the gas will diffuse out and the total volume will be reduced.

To fill the syringe:

Empty the syringe completely.
Insert the syringe into a septum accessory installed on the gas regulator.
Draw the syringe plunger back until the syringe is completely filled with gas.

Remove the syringe from the septum and allow it to return to room temperature as
described previously.

5. Press the plunger into the syringe until the correct amount of gas is contained in the syringe.

i

An alternate method to fill the syringe with nitrogen (evaporating from
liquid nitrogen):

Empty the syringe.

Hold the tip of the needle just above the surface the liquid nitrogen.

Draw the syringe plunger back until the syringe is filled with nitrogen gas.

Allow the syringe to stabilize at room temperature.

Push the plunger into the syringe until the correct amount of gas is contained in the syringe.

a bk owbd-~

To inject gas into the analyzer:

The system must be at atmospheric pressure to safely use the septum. Attempting to
use the septum at a higher pressure may cause the septum to eject from the analyzer,
resulting in damage to the septum and, possibly, bodily injury.

1. Turn the septum closure cap counter-clockwise to loosen, then remove the nut.
2. Insert the needle fully into the septum.

3. Press the plunger into the syringe completely to ensure that the entire quantity of gas is
injected from the syringe.

4. Remove the syringe.
5. Replace the septum cap and tighten finger tight.
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SEPTUM REPLACEMENT

— au uurome‘

Septum port

The septum usually requires replacing after approximately 100 injections when using the 1 mL
syringe.

1. Turn the knurled nut counterclockwise and remove it from the injection port.
2. Tap the nutinto the palm of your hand to remove the septum and discard the used septum.

3. Ifthe washer came out when the septum was removed, place the washer back into the
knurled nut first. Place a new septum into the knurled nut.

4. Place the knurled nut back onto the injection port. Turn the nut clockwise to finger tighten.

Do not use a wrench to tighten the septum retaining nut. Do not overtighten the retain-
ing nut. Doing so may damage the septum or the fitting.
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TCD ASSEMBLY

The filaments in the thermal conductivity detector assembly are heated to high temperatures and
may be exposed to corrosive gases, therefore they may eventually need to be replaced.
Symptoms that the TCD filaments may need replacing:

m A stable TCD baseline cannot be maintained.

m Data collection results in very high or very low peaks that are inconsistent with previous exper-
ience.

m During a data collection, no TCD signal is displayed on the main display or the application indic-
ates that no TCD signal is present.

CLEAN THE TCD ASSEMBLY

In some instances, contamination of the thermal conductivity detector filaments will produce the
symptoms described above. To clean the filaments, set the filament zone to 150 °C and flow an
inert gas through the analyzer for several hours. Contact your Micromeritics service
representative if necessary.
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VAPOR SOURCE CONTAINER INSTALLATION

Vapor Purification on page M - 1

Your equipment may differ slightly. The photos in this section use View A; however,
View B is installed in the same manner as View A. If using View B, the Vapor Source
Mantle will be slightly shorter than shown in this section.

This device has been designed to be used for sample analysis via the analyzer control
panel. Any other use may damage this device or the analyzer. Each time the Psat
tube or vapor source container is replaced, a new gasket is required. Do not touch the
sealing surfaces, the port fitting, or gasket with bare hands.

For chemisorption only the vapor mantle or the sample furnace can be connected at
the time of analysis.

View A View B

1. Use an appropriate wrench to loosen the connecting nut from the port fitting by turning the
connecting nut counter-clockwise while using a second wrench to hold the port fitting sta-
tionary.
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A. Portfitting
B. Gasket
C. Connecting nut

2. Remove the connecting nut and the attached assembly. After removal, the existing seal or a
tight-fitting plastic cap can be used to protect the sealing surface assembly from scratches.
Prior to reassembly, remove the existing seal or cap, then insert a new seal.

3. Install the vapor source container with a new seal by attaching the connecting nut to the port
fitting.

4. Hand tighten the connecting nut by turning clockwise. Use an appropriate size wrench to
tighten the assembly an additional 1/8 to 1/4 turn beyond finger tight, while using a second
wrench to hold the port fitting stationary on the analyzer.

Turn on the vapor source isolation valve to
adjust the vapor flow

5. Use the manual controls on the analyzer schematic, evacuate the space above the vapor
source by opening valves 4 and 6 with all other valves closed. Then close valve 4 before
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turning the vapor source isolation valve to the vertical (open) position. The Py/vapor port
pressure reading on the instrument schematic will show the vapor pressure.

Mantle power source
Thermocouple connector
Vapor source mantle
Hook and loop strap
Vapor source mantle shelf
Shelf locking mechanism
Shelf track

@mmooOw>

Slide the vapor source mantle over the vapor source container.

Extend the blue knob through the circular hole. Secure the hook and loop strap.
Insert the thermocouple plug into the connector labeled Thermocouple.

Insert the power plug into the outlet labeled Mantle/Furnace Power.

If using a support shelf, slide the shelf locking mechanism of the vapor source mantle shelf
into the shelf track on the front of the analyzer.

10. Raise the shelf until the vapor mantle is pushed as close as possible to the underside of the
upper cabinet.

11. Totighten the shelf, turn the locking mechanism clockwise.

© 0N O
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12 MAINTENANCE

A

Improper handling, disposing of, or transporting potentially hazardous materials can
cause serious bodily harm or damage the instrument. Always refer to the MSDS when
handling hazardous materials. Safe operation and handling of the instrument,
supplies, and accessories is the responsibility of the operator.

Do not modify this instrument without the authorization of a Micromeritics service per-
sonnel.

When lifting or relocating the instrument, use proper lifting and transporting devices
for heavy instruments. Ensure that sufficient personnel are available to assist in
moving the instrument. The Flex weighs approximately 103 - 106 kg (227 - 234 Ib)
depending on configuration.

IR 4lle

Use of a power cord or power supply not provided with the instrument could cause
personal injury or damage to the equipment. If a replacement is needed, contact your
Micromeritics Service Representative. Detachable power supply cords with an
inadequate rating could cause significant instrument damage or physical harm.

Do not add anything between the power cord and the power source that would
compromise the earth ground.

Do not remove or disable the grounding prong on the instrument power cord.

If the equipment needs to be relocated, check with your Micromeritics service
representative. The equipment must be position such that the mains supply is not
obstructed and is easily accessible to disconnect the equipment from the AC main
power supply.

-

Prior to moving the instrument, disconnect and remove all glassware from the
instrument. Ensure all gas shut-off valves on the gas cylinder have been closed and
gas lines disconnected from the instrument . Contact your Micromeritics Service
Representative.
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The analyzer has been designed to provide efficient and continuous service; however, certain
maintenance procedures should be followed to obtain the best results over the longest period of
time. When unexpected results occur, some common operational problems not indicated on the
window and their respective causes and solutions are provided.

The following can be found on the Micromeritics web page (www.Micromeritics.com).

Error Messages document (PDF)

Parts and Accessories

Smart VacPrep Operator Manual (PDF)
Vacuum Pump Guide (PDF)
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SAFE SERVICING

A Do not modify this instrument without the authorization of a Micromeritics service per-
sonnel.

To ensure safe servicing and continued safety of the instrument after servicing, service personnel
should be aware of the following risks:

Product specific risks that may affect service personnel:

m Electrical. Servicing or repair could require opening the outer panels and exposing ener-
gized electrical components.

m Liquid nitrogen. See Dewar Precautions on page 6 - 2.

m Elevator. Could pose a pinching hazard when lowering. Maintenance may require the elev-
ator screw to be greased. The service engineer can use a manual switch on the elevator
assembly to cycle the elevator to distribute the grease to permit safe servicing and con-
tinued safety of the equipment after servicing.

Protective measures for these risks:

m Electrical. The majority of electrical components operate at low voltage (24V or less) and
pose low risk when energized. Maintenance, troubleshooting, and repairs should be per-
formed with the instrument de-energized whenever possible, in accordance with standard
electrical safety guidelines.

m Elevator. Moves very slowly. It is normally operated from the computer attached to the
instrument so the operator is physically distanced from the instrument. The safety shield
door of the instrument should be closed during elevator operation. Use of the manual switch
on the instrument requires particular attention and care by the service personnel.

Verification of the safe state of the instrument after repair:

m Elevator must be in the down position.

m Sample tubes must be removed to prevent accidental breakage. Ports should be capped
(recommended).

m Safety shield door is closed (recommended).
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GUIDELINES FOR CONNECTING GASES

each type of gas used. Expansion kits or other accessories may be used in the lab. If
S0, special consideration should be given to these configurations when installing the
gas lines.

/ These instructions refer to the installation of a gas line, regulator, and gas cylinder for

cause serious bodily harm or damage the instrument. Always refer to the MSDS when
handling hazardous materials. Safe operation and handling of the instrument,
supplies, and accessories is the responsibility of the operator.

/ Improper handling, disposing of, or transporting potentially hazardous materials can

m Place gas cylinders within 6 feet (2 m) of the gas inlets of the analyzer. Place the cylinders
close enough to allow for proper connection at the analyzer inlet.

Using gas line extenders on gas cylinders located in remote areas may degrade gas quality
and reduce pressure. Gas lines are typically five to six feet long.

Long gas lines, such as those used with gas cylinders placed in remote areas, must be
evacuated for an extended period of time to remove ambient gases. When possible, avoid
placing gas cylinders in remote locations. It is always best to have gas cylinders located near
the analyzer

m Use aretaining strap (or other appropriate tether) to secure the gas cylinder.

m Always use the gas lines provided with the analyzer. It is very important that proper gas lines
are used with the analyzer.

o Do not use polymer tubing for the gas line.

o Do not use flexible gas lines. Some flexible lines may appear to be appropriate, such as
those with a herringbone covering, but the line may be coated internally with a polymer.

= Carefully route the gas lines from the cylinder to the analyzer avoiding overlapping or
entangling gas lines. This will help avoid confusion when maintenance is required.
m Label the gas line at the analyzer inlet for proper identification and maintenance.

m Replace gas cylinders before gas is depleted. It is best to replace a gas cylinder when the pres-
sure reads approximately 500 psi (3500 kPa) on the high pressure gauge. Contaminants
absorbed to the walls of the cylinder will desorb as the pressure decreases.

m Ensure the gas cylinder is closed before connecting to the analyzer.

To use oxygen, the analyzer must be equipped with an oxygen-compatible vacuum
pump that uses Fomblin (or a suitable equivalent) pump oil or a dry forepump. Failure
to use the proper vacuum system could result in hazardous conditions, including fire
and personal injury.

Flex Series Operator Manual

12-4 350-42800-01 (Rev R) — Apr 2021



[M] micromeritics®

Clean and Verify the Gas Line

CLEAN AND VERIFY THE GAS LINE

Unit [n] > Diagnostics > Start Diagnostic Test

Always clean the gas lines and verify there are no leaks at the connections after a gas cylinder is
connected. This test examines the gas line from the analyzer to the gas cylinder, then from the
analyzer to the regulator shut-off valve. A report is generated at the completion of the test to verify
that it has passed or failed. Causes and corrective action for a failure are provided.

Before beginning, confirm that the state for valves and the low pressure gauge are as follows:

Operator:
mmmmm

[JReport after test

A.
B. Gas regulator shut-off valve -

Gas tubing to instrument

OPEN

Low pressure gauge - 14-15
psig

High pressure gauge

Gas cylinder shut-off valve -
CLOSED

Regulator connecter nut

Regulator control knob -
OPEN

Brass reducer fitting

1. Select Clean and Verify Analysis Gas Line [n] Test Rev [n]in the Test field. The length of
time a test will run is also indicated on the window. The Sequence field indicates the file cre-

ated as a result of this test.

2. Inthe Operator field, enter either the name or initials of the operator performing this test.
3. Resize the window (if necessary) to display the Report after test option, then select Preview

as the destination. Click Start.
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4. From the View drop-down list, select either Operation, Instrument Log, or Instrument

Schematic.

5. The following series of prompts display on the window requiring operator response:

a. Thisisthe gas line clean and leak check test for inlet port [n]. Inlet ports being tested
must be connected to a gas cylinder according to the user manual. A Nupro isolation
valve should be installed on the line between the analyzer and the regulator.

b. The test starts with a manual leak check (requires Snoop or equivalent, and IPA), then
the line and regulator are evacuated for 20 minutes for cleaning. Next, the leak rate of
the gas line is determined.

c. With the regulator set to 15 psig, open the cylinder, regulator shut-off valve, and isol-
ation valve. Check each joint for bubbles with Snoop or equivalent. If a joint is leaking,
attempt tightening (without over-tightening) or replace ferrules.

d. When there are no leaking joints, use IPA to remove water from each joint, then wipe
dry.

e. Close the gas cylinder valve. Leave the regulator shut-off and isolation valves open.

f. User will be needed in 30 minutes to close the isolation valve. Click OK to begin auto-
mated testing.

6. A popup window indicates the test is complete. Click OK. The reports display.

£8 [F\Service Testing\userdiag\G510500001.5VT] [E=E= =
W) File Unitl Reports Options Window Help NEE
Gas Line to nlet Port § Test 1 -1 | Gas Line to Iniet Port 5 Test 2- 2 | Gas Line to Inket Port 5 Test 3- 3

Reports
Gas Line to Inlet Port 5 Test 1-
Gas Line to Inlet Port 5 Test 2 -

Service Test Report
E| | GasLine to Inlet Port 5Test 3 -

3Flex Unit 1 Serial No. 105 Page 1

Test Clean and Verify Gas Line 5 Test Rev. -

Op!
File: FASenvice Testingluserdiag\G510500001.8VT

Gas Line to Inlet Port 5 Test 1 Fide_)

Actual = 0.00958 mmHg / min,
Fail if above 0.10000 mmHg / min

Gas Line to Gas Bottle Test t
Man Xducer Vac ve. Time, Datasel
Rate of change: Passed,
(0 Defait Style

Close

7. Click each tab across the top of the window and look for a reading of Passed. A Passed
reading indicates all valves are in a proper state for operation. If any test shows a Failed
reading, refer to the following table to help determine the location of the gas leak.
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Clean and Verify the Gas Line

Tab Test If Failed status, then...

Gas Line to Inlet Gas Line to Gas Bottle | This test will show a reading of Failed if any of the
Port [n] Test other tabs has a Failed reading. Correct the

Test 1 failed connection and rerun the test.

Gas Line to Inlet Gas Line to Isolation | Check for a leak between the gas line and the
Port [n] Valve Test isolation valve. Correct the problem and rerun
Test 2 the test.

Gas Line to Inlet Isolation Valve To Check for a leak between the isolation valve and
Port [n] Bottle Leak Rate the gas cylinder. Correct the problem and rerun
Test3 the test.

If the Fail if above field indicates Failed, one or more valves is not in the proper position. Set
the valves, then ensure the appropriate pressure is displayed on the low pressure gauge.

If re-running the test, close the gas cylinder valve before starting the test.
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REPLACE A GAS CYLINDER

A These instructions apply to working with inert gases only. When working with
hazardous gases, follow the safety procedures established by your lab.

A power failure or loss of cryogen can result in dangerous pressures in the sample
chamber. When using toxic or flammable gases, additional venting of the cabinet may
be required.

Gas tubing to instrument
Gas regulator shut-off valve
Low pressure gauge

High pressure gauge

Gas cylinder shut-off valve
Regulator connecter nut
Regulator control knob
Brass reducer fitting

ITOMmMOO >

Disconnect a Depleted Gas Cylinder

1. Close the regulator shut-off valve and gas cylinder shut-off valve by turning the knobs clock-
wise.

2. Disconnect the gas line from the regulator. Gas will be vented from the line. Itis not neces-
sary to disconnect the gas line from the analyzer inlet if the cylinder will be replaced imme-
diately with one of the same type.

3. Open the gas regulator shut-off valve by turning the knob counter-clockwise. Gas will be
vented from the regulator.

4. Turn the regulator control knob clockwise to open and vent any remaining gas. Both gauges
should read at or near zero. If not, make sure the gas regulator shut-off valve is open.

5. Close the regulator by turning the control knob counter-clockwise.

6. Use an appropriate wrench to loosen the nut at the regulator connector nut then remove the
regulator from the cylinder.

7. Replace the protective cap on the depleted cylinder. Disconnect the retaining strap and
move the cylinder to an appropriate location.
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Connect a Gas Cylinder

Regulator Pressure Settings

Analyzer Gauge should indicate
Flex 15 psig (103 kPag)

A Exceeding the maximum recommended air pressure could cause personal injury or
damage the instrument.

Move the replacement cylinder close to the analyzer and tether it into place.

1. Use an appropriate cylinder wrench to remove the protective cap from the replacement gas
cylinder.

2. Place the protective cap in a secure location. It will be needed to recap the gas cylinder
when itis depleted and replaced.

3. Attach the gas regulator to the gas cylinder connector. Hand tighten the nut, then use an
appropriate wrench to tighten an additional 3/4 turn.

Over-tightening the fitting may cause a leak.

4. Check for leaks at the high pressure side of the regulator and in the connector.
a. Turn the regulator control knob fully counter-clockwise.
b. Slowly open the gas cylinder shut-off valve, then quickly close it.
c. Observe the pressure on the high pressure gauge for approximately one minute.

m If the pressure is stable, proceed with the next step.

m If the pressure decreases, tighten the regulator connector nut until it becomes
stable. If the pressure does not remain stable, remove the regulator and clean all
contacts at the regulator connection, then reinstall the regulator.

5. Purge the air from the lines by doing the following:

/ Purge the regulator before proceeding to prevent contamination of the analysis gas
supply.

Open the gas cylinder valve to pressurize the regulator, then close the valve.

Adjust the Pressure Control knob to approximately 5 psi.

c. Turn the regulator Shut-off valve counter-clockwise to open. Allow gas to flow until both
gauges read approximately zero.

d. Close the regulator Shut-off valve to stop gas flow.

oo
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e. Reconnect the gas line to the regulator.

f. Usetwo 7/16in. (11 mm) wrenches to tighten the gas line connection. Hold one wrench
fitting steady and the other to tighten the connector nut.
6. Setthe analyzer pressure by doing the following:
a. Turnthe Regulator Control knob clockwise until the low pressure gauge indicates the

appropriate pressure. See the Regulator Pressure Settings table in Connect a Gas
Cylinder on the previous page.

b. Open the regulator Shut-off valve.
c. Open the gas cylinder Shut-off valve and flow gas for 10 to 30 seconds.
d. Close the gas cylinder Shut-off valve.
e. Close the gas cylinder valve.
7. Ifthe gas line to the instrument inlet was previously disconnected, reconnect it now.
12-10 Flex Series Operator Manual
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CLEAN THE POWER SUPPLY AIR FILTER

Two power supply air filters are located on the lower rear panel of the analyzer and should be
cleaned or replaced every 30 days (more often in environments with increased levels of dust).

1. Use aflat blade screwdriver to pry the air filter cover from the base. Do not remove the
screws. Use caution when removing the cover to avoid breakage.

- -
- SR

L

=

2. Use an air compressor to remove the dust, or rinse with tap water and dry thoroughly.
3. Replace the filter and cover by pressing the cover back into the base.
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PREVENTIVE MAINTENANCE

Perform the following preventive maintenance procedures to keep the analyzer operating at peak
performance. Micromeritics also recommends that preventive maintenance procedures and
calibration be performed by a Micromeritics Service Representative every 12 months.

Maintenance Required

Frequency

Dewar

Check and clean weekly.

Power supply air filters

Clean and replace every 30 days (more often in envir-
onments with increased levels of dust).

Analyzer exterior

Clean a needed or every 6 months.

Vacuum pump diaphragm(s)

Replace every 12 months.

Port gasket

Replace every 3 to 6 months (depending on the types of
analyses that were run).

Sample tube O-ring

Replace as required or every 3 to 6 months.

Test analyzer for leaks

As required or every 12 months.

Septum Inspect and replace every 6 months or after every 150
runs. Replace every 12 month or 300 runs.

TCD Inspect and clean every 3 months or after every 75 runs.
Replace every 12 month or 300 runs.

CryoStat See Preventive Maintenance for the CryoStat on
page D - 12.
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CHECK AND CLEAN THE DEWAR

A When handling Dewars, follow the precautions outlined in Dewar Precautions on
page 6 - 2.

potential safety hazard and should be treated with caution. If in doubt, contact your

ﬂ Always handle glass Dewars with care. Any product incorporating a vacuum is a
safety officer.

Ice and suspended frost particles may accumulate in the bottom of the analysis port Dewar.
Particles or deposits exceeding 1/4 in. in depth may jam between the bottom of the sample tube
and the bottom of the Dewar, causing the Dewar not to raise fully.

Accumulations of fine particles impede liquid nitrogen circulation around the bottom of the sample
tube. This causes the sample temperature to be slightly higher which, in turn, can cause pore
volume measurement errors in those samples exhibiting high isotherm slope above 0.97 relative
pressure.

Accumulated ice is likely to melt and form a pool of water in the Dewar if all liquid nitrogen
evaporates. The water must be removed, otherwise it will solidify when liquid nitrogen is added
and could press on the bottom of the sample tube causing breakage.

To ensure problems do not develop due to ice accumulation, check the Dewar after each use.
Clean on a weekly basis.

1. Remove the Dewar from the analyzer.
2. Pour out liquid nitrogen into an appropriate cryogenic container. Do not re-use liquid nitro-
gen.

Do not pour liquid nitrogen directly into a sink. Doing so may cause drain pipes to
burst.

3. Rinse the Dewar with warm water to melt any remaining ice accumulation which may
remain. Dry thoroughly.
4. Replace the Dewar.
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CLEAN THE INSTRUMENT

The exterior casing of the instrument may be cleaned using a clean, lint-free cloth dampened with
isopropyl alcohol (IPA), a mild detergent, or a 3% hydrogen peroxide solution. Do not use any type
of abrasive cleaner. It is not necessary to remove knobs, screws, etc. while cleaning.

Do not allow liquid to penetrate the casing of the instrument. Doing so could result in
damage to the unit.

LUBRICATE THE ELEVATOR DRIVE ASSEMBLY

The elevator screw is lubricated before it leaves the factory and should not require lubricating. If
the elevator starts to vibrate or becomes noisy when traveling, contact a Micromeritics Service
Representative for disposition.

Should lubrication become necessary, apply a light coat of TRIGEL grease [Micromeritics part
number 004-16166-00] to the elevator screw, accessed from the rear of the instrument, as
needed.
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POWER INSTRUMENT ON AND OFF

DO NOT connect or disconnect cables when the instrument is powered ON.

If a Smart VacPrep is used, it is recommended that the power to the Smart VacPrep remain ON
when the analyzer is powered on. If it does become necessary to power off the Smart VacPrep,
exit the analyzer program first. Restart the analyzer program, then power on the Smart VacPrep.

Power ON the equipment in the following order:

Computer, monitor, and printer.
External vacuum pump.
Analyzer.

Degasser.

hwn =

Power OFF the equipment in the following order:

1. Exit the analysis program. Failure to do so could result in loss of data. If an analysis is in pro-
gress when closing the application, the following message is displayed:

2459 - An Instrument is busy. A delay in restarting this application
could result in loss of new data. Continue program exit? Yes / No

Yes. Closes the program. The analysis continues and data continue to be collected. The
data will be restored when the application is restarted. Reports queued in the print
manager will print. If a power failure occurs and an uninterruptible power supply (UPS) is
not attached to the analyzer, the data collected after exiting the analysis program are lost.

No. The program remains open and the analysis continues to run.

Computer, monitor, and printer.
Analyzer.

External dry forepump.

Smart VacPrep.

o koo
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REPLACE THE PSAT FITTING GASKET

A gasket is attached to the Psat fitting. See Replace the Psat Tube Ferrules below.

Each time the Psat tube or vapor source container is replaced, a new gasket is
required. To avoid degassing problems, do not touch the sealing surfaces of the port
fitting or gasket with bare hands.

@

REPLACE THE PSAT TUBE FERRULES

Over an extended period of time, pivoting the Psat tube may cause wear on the nylon
and teflon ferrules housed in the Psat tube nuts. If the recommended weekly sched-
uled PO Port Leak Test detects a leak by reporting Failed on the Evacuated or Pres-
sured report, the first time a leak is detected, tighten the Psat nuts 1/2 turn and rerun
the test. If the leak is still present, replace the nylon and teflon ferrules.

It is recommended that the VCR connector not be removed from the port fitting for this
process.

Two ferrule sets are located in the upper and lower Psat nuts. Both sets should be
replaced. Additional ferrule sets were included in the analyzer’'s accessory Kkit.

N @ N

1. Ensure the Psat tube is filled at atmospheric pressure with gas before loosening the Psat
nut.

2. Toremove the lower Psat nut, use a 7/16 in. (11 mm) wrench to loosen the Psat nut by turn-
ing the nut counter-clockwise.

A. Teflon ferrule
B. Nylon ferrule
C. Lower Psat nut
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w

11.

12.
13.

Remove the Psat tube from the Psat elbow.

Remove the nut from the Psat tube and remove the set of teflon and nylon ferrules from
inside the nut. Position the ferrules as shown with the cone pointed out of the nut.

Insert the Psat nut onto the Psat tube, followed by a nylon ferrule, then a teflon ferrule.
Insert the Psat tube into the Psat elbow.

Hand tighten the Psat nut by turning the nut clockwise. Then use an appropriate size
wrench to tighten the nut an additional 3/4 turn while holding the elbow so it does not move.
To remove the upper Psat nut, use a 7/16 in. (11 mm) wrench to loosen the Psat nut by turn-
ing the nut counter-clockwise.

VCR connector
Upper Psat nut
Nylon ferrule
Teflon ferrule
Lower Psat nut

moOow>»

Remove the Psat tube from the VCR connector.

. Remove the nut from the Psat tube and remove the set of teflon and nylon ferrules from

inside the nut.

Reinsert the Psat nut onto the VCR connector, followed by a nylon ferrule, then a teflon fer-
rule. Orient the ferrules as shown with the cone pointed out of the nut.

Insert the Psat elbow into the upper Psat nut.

Hand tighten the upper Psat nut by turning the nut clockwise. Then use a 7/16 in. (11 mm)
wrench to tighten the nut an additional 3/4 turn while holding the elbow so it does not move.

Flex Series Operator Manual
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SAMPLE PORT FRIT REPLACEMENT

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

/ The chemisorption port frit is changed in the same manner as the sample port frit.

A fritis located in the connecting nut attached to each analysis port. If the frit becomes
contaminated, the contaminant may adsorb or desorb during analysis, affecting the results. A
contaminated frit on the analysis port may be indicated as a leak or a free space reading much
lower than normal.

Use the proper size frit for the sample port. The analyzer will not operate properly if an
incorrect size is used.

1. Goto Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go to Unit [n] > Show Instrument
Schematic.

2. Right click on the valve of the appropriate port. If the valve is open, click Close to close the
valve.

3. Use a wrench to remove the connecting nut from the sample port while using a second
wrench to hold the port fitting stationary. Remove and discard the used frit.
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Iml micromeritics® Sample Port Frit Replacement

To avoid degassing problems, the frit should be clean and should not be touched with
bare hands.

4. Place a new frit into the connecting nut.

A. Frit
B. Connector nut
C. Sample tube fitting

5. Attach the connecting nut to the sample port fitting and finger tighten. Use a wrench to
tighten the nut 1/8 to 1/4 turn past finger tight while using a second wrench to hold the port
fitting stationary.
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SAMPLE TUBE O-RING REPLACEMENT

/ The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

It is important to maintain a vacuum-tight seal near the top of the sample tube stem. If an O-ring
becomes worn or cracked, it does not provide a good seal and will need to be replaced.

/ Before removing (or installing) a sample tube, ensure that the port valve is closed.
Observe the analyzer schematic to verify valve status.

1. Carefully remove the Dewar from the analyzer. Take care not to bump the sample tube
bulbs with the Dewar during this process. Place the Dewar aside.

2. Hold the sample tube firmly with one hand, loosen the sample tube connector nut by turning
counter-clockwise.

3. Carefully pull the sample tube down until it is free from the port. It may be necessary to
grasp the sample tube with both hands.

Py slot
Connector nut
Ferrule

O-ring

Dewar cover

moow>»

4. Remove the O-ring from the top of the sample tube and replace it with a new one.

accessory kit [tool part number 004-54618-00] or use a pair of tweezers or needle-

/ If the O-ring remains inside the sample port, use the O-ring removal tool from the
nose pliers to remove it.

5. After the new O-ringis in place, insert the sample tube back into the sample port until it is
fully seated.

Flex Series Operator Manual
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EI micromeritics® Sample Tube O-ring Replacement

6. Slide the sample tube connector nut up the tube until it comes in contact with the port fitting
(the ferrule and O-ring will move along with the connector nut). Then, turning clockwise,
hand tighten the connector nut to the sample connector.

Open the TranSeal

Unit > Open TranSeal

Outlines the process of safely opening one or more TranSeals on sample ports.

n [E=8EeR 55)
Sample ports to open

[CJPort 1 [Crort2 [CIport3

) Samples are NOT under vacuum
Backfil sample ports with | he before opening TranSeals.

© Samples ARE under vacuum
Evacuate sample ports before opening TranSeals.
Caution: Damage to the instrument can occur if this option is selected and the samples are not under vacuum,

/ Damage may occur to the analyzer if the samples are not under vacuum and the
Samples ARE under vacuum option is selected.

Fields and Buttons Table

Field or Button Description

Sample ports to open |Select the ports to open during analysis.

[group box]

Samples are NOT Select if samples are NOT under vacuum and specify the amount of
under vacuum backfill and adsorptive to be used prior to opening TranSeals.
[selection]

Samples ARE under Select if the samples ARE under vacuum. This option evacuates
vacuum [selection] sample ports prior to opening TranSeals. Do not select this option if
the samples are not under vacuum as analyzer damage may occur.

Start [button] Opens the TranSeals. The selected sample port will be either
backfilled or evacuated as specified. The user will be prompted to
open the TranSeals. For each selected port, an event is recorded in
the Instrument Log file with the port pressure before and after opening
the TranSeal.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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PURGE THE SYSTEM

PURGE AIR OR GAS

See Guidelines for Connecting Gases on page 12 - 4 when connecting a new gas cylinder to
one of the 12 primary gas inlets on the back of the analyzer for use as a carrier gas. After
connecting a new gas cylinder to one of the four loop gas inlets on the side of the analyzer, open
the gas inlet valve and allow gas to flow for a period of time to purge the gas line before using that
gasin an analysis.

Changing the Gas Flow During an Analysis

When gases are changed during an analysis, allow the new gas to flow for a period of time before
creating conditions that cause the experiment to begin (such as elevating the temperature). To
avoid undesirable combinations of gases within the analyzer, purge one gas (by flowing an inert
gas for a period of time) before starting to flow another gas.

To flow an inert gas between incompatible gases, insert a Gas Flow step (in which an inert gas is
flowed for a period of time) and a Wait step (to wait for the inert gas to purge the analyzer)
between other steps that involve incompatible gases.

When gas flows are changed while the analyzer is recording data, the gas flow is briefly disturbed.
This may result in a brief period of noise or other visible disturbances on the peak data. Either
disregard the disturbance or insert a Wait for stable baseline step immediately after changing gas
flows.

Flex Series Operator Manual

12-22 350-42800-01 (Rev R) — Apr 2021



EI micromeritics® 13 Troubleshooting

13 TROUBLESHOOTING

CFR Dynamic Analysis and Chemisorption options are not applicable when the software is
Note installedin 21CFR11 environments.

Most operational problems are caused by:

Leaks (commonly found at the sample tube O-ring at the analysis port)
Sample weighing errors

Use of too much analysis bath fluid in the Dewar at the start of an analysis
Entry of incorrect system volume for analysis

Impure gas supply

When unexpected analysis results occur, check the above first. Some common operational
problems not indicated on the window and their respective causes and solutions are provided
below:

Elevator cannot be raised or lowered.
Cause: Dewar elevator stuck.
Action: Check for possible obstruction to elevator movement.
Elevator is noisy.
Cause: The elevator screw may need greasing.
Action: Contact your Micromeritics Service Representative.
Sample is not within specifications.

Cause A:  There may be a manifold leak.
Action A: See Start Diagnostic Test on page 9 - 1.

Cause B: Gas may be contaminated.

Action By perform a blank analysis. If results are good, perform a reference material

analysis.
m Replace tank.
m Check for line leak, which could cause contamination.
m Flush the lines occasionally to help prevent contamination.
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13 Troubleshooting EI micromeritics®

Cause C: Incorrect type of gas line.

Action C: Ensure the gas line is all metal. Itis best to use the one shipped with the ana-
lyzer. Do not use polymer gas lines or flexible gas lines that may be coated
internally with a polymer.

High vacuum pump indicator light does not come on.

Cause: No power to the high vacuum pump.

Action: Remove the lower panel on the front of the instrument. Check the power sup-
ply plug to the pump. Power off the high vacuum pump, then power it back on.

Vacuum gauge shows reading above 20 mmHg even after extended pumping through
unrestricted valve with analysis or degas ports closed.
Cause A: Portfilter is dirty.
Action A: Replace the port filter.
Cause B: No power to the vacuum pump.
Action B:  Check the pump power plug, power switch, and line circuit breaker.
For oil-based pumps:
Cause A: Portfilteris dirty.
Action A:  Replace the port filter.

Cause B: Vacuum pump oil is low causing ineffective evacuation.

Action B: Add or change vacuum pump oil. Add oil to proper level according to the
pump's indicator window.

Cause C: Aluminain the oil vapor trap is holding moisture because it was not sufficiently
dried before being added to the trap.

Action C: Replace or dry the alumina.

For oil-free pumps:

Cause A: High vacuum pump may have timed out.

Action A: Remove the lower front panel from the analyzer. Power off the high vacuum
pump, then power it back on.

Cause B: The pump diaphragm(s) is worn or damaged.

Action B: Contact your Micromeritics Service Representative.

Vacuum pump is noisy.
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Cause A:
Action A:
Cause B:
Action B:
Cause C:
Action C:
Cause D:
Action D:
Cause E:
Action E:

Sample tube connector is loose.
Tighten fitting. Replace O-ring.
Sample tube O-ring is worn or cracked.

Replace O-ring. See Sample Port Frit Replacement on page 12 - 18.

Sample tube is cracked.

Replace with new sample tube.

No sample tube loaded on a selected port.
Install plug or empty sample tube.

Gas inlet valve open while vacuum valve open.

With manual control enabled, use the instrument schematic to close gas inlet
valve.

Vacuum pump system makes loud continuous noise.

Cause A:
Action A:
Cause B:
Action B:
Cause C:
Action C:
Cause D:
Action D:
Cause E:
Action E:

Cause F:
Action F:

Sample tube connector nut is loose.

Turn the connector nut clockwise to tighten.
Sample tube fitting is loose.

Tighten the fitting using a wrench.

Sample tube O-ring is worn or cracked.
Replace sample tube O-ring.

Sample tube is cracked.

Replace the sample tube.

No sample tube is loaded on selected port.

Ensure the port valve is closed. Install a plug or empty sample tube on the
port.

A gas inlet valve is open while the vacuum valve is open.

Enable manual control then use the analyzer schematic to close the gas inlet
valve. See Show Instrument Schematic on page 2 - 24.

Valves cannot be operated.

Cause A:
Action A:

Cable from computer to the instrument is loose.

Reconnect the cable.
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Cause B:
Action B:

Circuit was opened by the circuit breaker.

Press the Breaker button located on the side of the analyzer near the power
entrance. Contact your Micromeritics Service Representative if the button will
not stay depressed.

A stable TCD baseline cannot be maintained.

Cause A:
Action A:

Cause B:
Action B:

TCD filaments are contaminated or need to be replaced.

See TCD Assembly on page 11-16 to clean the TCD filaments. Contact
your Micromeritics service representative if necessary.

Possible leak in reference / carrier path.

Perform leak test in the reference / carrier path. See Perform a Leak Test on

page 13 - 7.

Data collection results in very high or very low peaks that are inconsistent with previous

experience.
Cause A:

Action A:

Cause B:
Action B:

TCD filaments are contaminated or need to be replaced.

See TCD Assembly on page 11-16 to clean the TCD filaments. Contact
your Micromeritics service representative if necessary.

A different (lower) TCD filament temperature is being used.

Repeat the analysis using a higher filament temperature.

During data collection, a TCD signal of zero is recorded, or no peaks are seen.

Cause A:
Action A:

Cause B:
Action B:

TCD filaments are contaminated or need to be replaced.

See TCD Assembly on page 11-16 to clean the TCD filaments. Contact
your Micromeritics service representative if necessary.

TCD temperature was not reset after a run automatically suspended.

Re-enable the TCD after all run suspensions.

13-4
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POWER

The Flex is designed to operate with a universal input power supply (100/115/230VAC) at 50/60
Hz. Noise-free power of the correct voltage and frequency, with a safety earth ground, should be
available through a standard wall receptacle. The power outlet should be able to supply 15 amps
@ 100 or 115VAC +£10% or 7.5 amps @ 230VAC +10%. These requirements can be checked by
using a circuit analyzer (available at most hardware or electronic supply houses) or a multimeter.
There should also be sufficient outlets for the analyzer, Smart VacPrep (if purchased), dry
roughing pump, computer, monitor, printer, and any other peripheral devices.

The instrument should be connected to a switch which meets relevant requirements of IEC 60947-
3 or a circuit breaker which meets the relevant requirements of IEC 60947-2.

The analyzer and peripheral devices must be installed on their own dedicated power
line. Other devices — such as motors, generators, or ovens — should not be placed

on the same power line.

/ Replacement power supply cords must be rated for the specifications stated above.

OIL-BASED VAcUUM PumpP

The Vacuum Pump Guide can be found on the Micromeritics web page (www.Micromeritics.com).

Flex Series Operator Manual

350-42800-01 (Rev R) — Apr 2021 13-5


http://www.micromeritics.com/

13 Troubleshooting EI micromeritics®

O-RING COMPATIBILITY

O-ring selection for chemisorption measurements is based on temperature, time, and chemical
compatibility. Chemical compatibility should be the first consideration when selecting an
appropriate O-ring. The time at which the furnace, and subsequently the sample cell, is at
elevated temperature can also affect the performance of the O-rings and should be a secondary
consideration. Common O-ring materials include Buna-N (nitrile), Viton (fluoroelastomer), and
Kalrez (perfluoroelastomer). Kalrez has historically been used extensively for chemisorption
measurements due to compatibility with a wide range of chemicals and temperatures and should
be suitable for all applications of the chemisorption option. Viton or Buna-N may also be suitable
for analyses similar to the reference material example file. The ability to re-use Buna-N or Viton O-
rings may be limited, while the re-use of Kalrez O-rings should be more broad. Frequency of use
and, potentially, several other factors affect the duration of O-ring use, so rigid rules cannot be
specified for these materials. Leak rate and ultimate vacuum levels may be used as indicators for
O-ring performance.
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Perform a Leak Test

PERFORM A LEAK TEST

Unit [n] > Diagnostics > Start Diagnostic Test

A Micromeritics Service Representative may request that a leak test be performed to determine if
there is a system leak and may also require a copy of the report generated by this test.

The test provides:

m Prompts on preparing the analyzer for the test.

m Approximate time period of the test.

m Prompts in which an operator response is required.

View:  [pperation ~

Test:  [Ports Leak TestRev. P

Operator: Sequence: PLODO01
Comments

Estimated time: | 168 min.

Close

Select the test to run.

Click Start.

o~

for each test run.

5. Click Save As to save the test file results.

Select Report After Test and choose Preview as the destination.

Verify all tests have a Passed status by selecting the tabs and looking for the Passed status
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PNEUMATIC PRESSURE

The compressed air supply for the pneumatically actuated, hard seal valves and furnace cooling
must be set to 100 psi £20 psi for proper operation. Ensure that the regulator for the compressed
air supply is correctly set. If a portable air compressor is used, perform maintenance as instructed
in the air compressor manual.

RECOVER FROM A POWER FAILURE

The analyzer saves entered and collected data in case of power failure. File parameters and any
other data entered will still be present when power is restored. If an analysis was in progress when
the power failure occurred, it will be canceled when the analyzer restarts. Any data collected
during the analysis will still be present, but the analysis should be restarted in order to produce
complete results.
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EI micromeritics® A Advanced Reports - Python Module

A ADVANCED REPORTS - PYTHON MODULE

CFR In a 21CFR11 environment, the Advanced reports feature is applicable to members
Note ofthe Developer group only.

The mic Python module is automatically imported when running a user supplied script. The
module provides access to primary and overlay isotherm data and provides support for summary,
tabular, and graphical reports.

= Summary reports. Consist of summary sections, each containing a two-column table of label
and value pairs. Summary reports are created with the mic.summary call.

m Tabular reports. Consist of one or more tables each containing one or more labeled columns
of data. Tabular reports are created with the mic.table call.

m Graphical reports. Consist of a single graph with one or more curves on one or two y-axes.
Graphical reports are created with the mic.graph call.

Calls for accessing the sample file data can be found in the Mic Module Python Calls section of
this appendix. More advanced example python scripts are included in the analyzer software.
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ADVANCED REPORT OPTIONS

Up to five Advanced reports, each with up to 10 summary reports, 10 tabular reports, and 10
graphical reports can be created. To use this feature, a file containing a Python script that imports
a "mic" Python module must be created. See MicModule Python Calls on page A - 22 for an
example of a Python script and functions for the "mic" Python module.

N

. Create the Python script and save it in the Scripts directory.

. Open a sample file with a Complete status.

Select Advanced in the view selector drop-down list at the bottom of the window to return to
the tabbed view.

On the Report Options tab, select Advanced in the Selected Reports list box, then click
Edit.

5. Onthe Advanced Report Options window, click Add in the Available Scripts group box to
locate and select the Python script. Repeat for each script to be added.

w N

B

8 Advanced Report Options =

Select Reports

1: User-Defined Report
2:  User-Defined Report

3:| User-Defined Report

<l ¢ < ¢

4: | User-Defined Report

HNERERERE

g 18| (8] |8 |

2013 3] |2 [B
2 3 |B

5: | User-Defined Report

Al Saipts These options are not available for
it dynamic analysis

OK Cancel

6. Inthe Selected Reports group box, click the drop-down arrows to select up to five Python
scripts previously added in the Available Scripts box.

7. Onthe Report Options tab, click Preview. The Python Reports will be included on the tabs
across the top portion of the Reports window.

Flex Series Operator Manual
350-42800-01 (Rev R) — Apr 2021



EI micromeritics® Advanced Report Options

Advanced Reports

Field or Button Description

Advanced Report 1 Use the drop-down lists to select currently-defined functions used to
through 5 define the report calculations and output.

[drop-down box]

Available Scripts Lists the available reports and provides the option to add, replace,
[group box] edit, or remove reports.

Overlay samples (if Use to overlay samples as defined by the function.

shown) [check box] P|C|

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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SCRIPTS

Run a Script

© g hwWDN =

7.
8.
9.

Open a sample file with a Complete file status.

Select Advanced in the view selector drop-down list at the bottom of the window.

Select the Report Options tab.

Highlight Advanced in the Selected Reports list box, then click Edit.

On the Advanced Report Options window, click Add.

Locate and select one or more python scripts then click Select. The selected scripts
become a part of the drop-down list in the Available Scripts section of the Advanced Report
Options window.

In the Select Reports section, select up to five Advanced reports in the drop-down lists.
Click OK.

Click Preview on the Report Options tab to view all reports selected in the previous window.

Remove a Script

Select the script in the Available Scripts box then click Remove. The script is removed from the
application however, the original .py text file is not affected.
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Edit a Script

Field or Button

Description

Add [button]

Adds one or more scripts to the Available Scripts box. The added
scripts then become available as options in the Selected Reports
section.

Edit [button]

Edits the script stored within the application but does not affect the
original .py text file.

Overlay samples
[check box]

Select to enable the overlay sample files process.

Pressures [button]

Select to include or exclude pressures from the report.

m Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.

Cancel. Discards any changes or cancels the current process.
Exclude All. Select to exclude all pressure points in the table.
Include All. Select to include all pressure points in the table.
OK. Saves and closes the active window.

Remove [button]

Removes the script from the Available Scripts box but does not affect
original .py text file.

Replace [button]

Replaces the contents of the selected script however, the script
name remains the same.
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350-42800-01 (Rev R) — Apr 2021




A Advanced Reports - Python Module EI micromeritics®

PYTHON REPORTS

Graphic Report

This script is an example of the mic module producing a graph with two curves:

import mic

import numpy as np

mic.graph( 'My Graph', 'X', "F(X)' )
myx = np.array( [0.1, 0.2, 0.3, 0.4, 0.5, 0.6, 0.7, 0.8, 0.9, 1.0 ] )

mic.graph.add( 'X2', myx, myx*myx, marker='o' )

N o o un A W N R

mic.graph.add( 'sin(X)', myx, np.sin(myx), marker='"" )

The results are:

User-Defined Report : My Graph

2, ///
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Summary Report

This script produces a summary report with two summaries:

1| import mic
2 | import numpy as np
3
4 | mic.summary( "My Summaries" )
5| mic.summary.add( "Summary A",
6 ["Label 1:", "Label 2:", "Label 3:"],
7 ["vall", "val2", "val3"] )
8 | mic.summary.add( "Summary B",
9 ["Label 4:", "Label 5:", "Label 6:"],
10 ["val4", "val5", "vale"] )
The result is:
Summary A
Label 1: vall
Label 2: val2
Label 3. val3
Summary B
Label 4. vald
Label 5. vals
Label 6. valG
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[M] micromeritics®

Tabular Report

If more than one column is required, the call mic.table is employed. This script produces a tabular
report consisting of two tables.

/

This script uses the Python package "numpy" and c-style formatting of the numerical

values.

11| import mic

12 | import numpy as np

13

14 | mic.table( "My Tables" )

15| mic.table.addtable( "My Set A" )

16 | mic.table.addcolumn( "X", ["1.0", "2.0", "3.0"] )

17 | mic.table.addcolumn( "Y", ["0.5", "1.0", "1.5"] )

18| x1 = 0.2

19| x2 = 0.5

20 | x3 = 3.14159/2

21 | mic.table.addtable( "My Set B" )

22 | mic.table.addcolumn( "X", ['{:8.3f}'.format(x1),

23 "{:8.3f}' . format(x2),

24 "{:8.3f}" . format(x3)] )

25| mic.table.addcolumn( "sin(X)", ['{:8.3f}'.format(np.sin(x1)),

26 "{:8.3f}".format(np.sin(x2)),

27 "{:8.3f}".format(np.sin(x3))] )

28 | mic.table.addcolumn( "cos(X)", ['{:8.3f}'.format(np.cos(x1)),

29 "{:8.3f}".format(np.cos(x2)),

30 "{:8.3f}".format(np.cos(x3))] )
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Python Reports
The result is:
My Set A
x Y
10 05
20 1.0
30 15
My Set B
X sinX) cos(X)
0.200 0.199 0.930
0.500 0479 0878
1571 1.000 0.000
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ACQUIRE BASIC INFORMATION

Physisorption

To acquire the adsorption isotherm and other basic information about the sample being edited, the
calls mic.isotherm, mic.sample_information, and mic.adsorptive data are applied.

This script produces a graph of the adsorption and desorption isotherms for both relative and
absolute pressure, and prints summaries of the sample information and the adsorptive properties.

1| import mic

2

3| prel, gads, n_ads, warm_fs, cold fs, mass, desc = mic.isotherm('rel’)

4 | mic.graph( 'Graphical Report 1', 'Relative Pressure (P/Po)', 'Quantity
Adsorbed (cm3/g STP)' )

5| mic.graph.add( 'Sample Isotherm', prel, gads )

6

7 | pabs, gads, n_ads, warm_fs, cold fs, mass, desc = mic.isotherm("abs")

8 | mic.graph( 'Graphical Report 2', 'Absolute Pressure (mmHg)', 'Quantity

Adsorbed (cm3/g STP)' )
9 | mic.graph.add( 'Sample Isotherm', pabs, qads )

10

11 | mass = mic.sample_information('sample mass')

12 | Tanl = mic.sample_information('analysis temperature')
13 | dens = mic.sample_information('sample density')

14

15 | mic.summary( "Sample Information" )

16 | mic.summary.add( "Sample Information",

17 [ "Number of adsorption points:",
18 "Warm free space:",
19 "Cold free space:",
20 "Sample mass:",
21 "Description:",
22 "Analysis temperature:",
23 "Sample density:" ],
A-10 Flex Series Operator Manual
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24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43
44

[ "{:d}'.format(n_ads),
"{:8.3f}" . format(warm_fs) + ' cm?’,
"{:8.3f}".format(cold_fs) + ' cm?',
"{:8.3f}".format(mass) + ' g,
desc,

"{:8.3f}".format(Tanl) + ' K",
"{:8.3f}".format(dens) + ' g/cm3*' ] )

csa, hsd, dcf, mol_weight, analysis_gas = mic.adsorptive_data()

mic.summary.add( "Adsorptive Data",

[ "Cross sectional area:",
"Hard sphere diameter:",
"Density conversion factor:",
"Molecular weight:",

"Analysis gas:" ],

[ '{:8.3f}'.format(csa) + ' nm?"',
'{:8.3f}'.format(hsd) + ' A',
"{:8.3f}"'.format(dcf),
"{:8.3f}".format(mol_weight),

analysis_gas ] )

Note the calls to mic.isotherm and mic.adsorptive _data above are each returning results as a list
with elements of varying return type.
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Chemisorption

This script produces a graph of the primary, repeat, and difference isotherms, and prints
summaries of the sample information and the adsorptive properties.

To acquire the adsorption isotherm and other basic information about the sample being edited, the
calls mic_chem.isotherm, mic.sample_information, and mic.adsorptive data are applied.

Note the calls to mic_chem.isotherm and mic.adsorptive_data above are each returning results as
a list with elements of varying return type.

1| import mic

2

3 | p_primary, g_primary = mic.chem_isotherm( 'primary")

4 | p_repeat, g_repeat = mic.chem_isotherm('repeat")

5| p_difference, q_difference = mic.chem_isotherm('difference")

6 | mic.graph('Graphical Report 1', 'Absolute Pressure (mmHg)', 'Quantity
Adsorbed (cm3/g STP)')

7 | mic.graph.add('Primary’, p_primary, q_primary)

8 | mic.graph.add('Repeat’, p_repeat, q_repeat)

9 | mic.graph.add('Difference’, p_difference, q_difference)

10

11 | mic.summary("Sample Information")

12 | mic.summary.add( "Sample Information",

13 [ "Ambient free space:",

14 "Analysis free space:",

15 "Sample mass:",

16 "Description:",

17 "Analysis temperature:",

18 "Sample density:" ],

19 [ "{:8.3f}'.format(mic.sample_information('ambient
freespace')) + ' cm3',

20 "{:8.3f}'.format(mic.sample_information('analysis
freespace')) + ' cm3',

21 "{:8.3f}'.format(mic.sample_information('sample mass')) +
S g,

22 mic.sample_information('sample description'),
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23

24

25
26
27
28
29
30
31
32
33
34
35
36
37
38

"{:8.3f}' .format(mic.sample_information('analysis tem-
perature')) + ' K',

"{:8.3f}' . format(mic.sample_information('sample density'))
+ ' g/em’ 1)

csa, hsd, dcf, mol_weight, analysis_gas = mic.adsorptive data()

mic.summary.add( "Adsorptive Data",

[ "Cross sectional area:",

"Hard sphere diameter:",
"Density conversion factor:",
"Molecular weight:",
"Analysis gas:" ],

[ '{:8.3f}'.format(csa) + ' nm?',
'{:8.3f}'.format(hsd) + ' A',
"{:8.3f}'.format(dcf),
"{:8.3f}".format(mol_weight),

analysis _gas ] )
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ACQUIRE REPORT RESULTS FOR PHYSISORPTION

Sample file report results may be accessed using the mic.report call. This script prints a summary
of the results of the t-plot and BET reports.

1| import mic

2

3| sa = mic.report("bet", "surface area")

4| ¢ = mic.report("bet", "bet constant")

5| vm = mic.report("bet", "monolayer capacity")

6 | esa = mic.report("tplot", "external surface area")
7| vol = mic.report("tplot", "micropore volume")

8

9 | mic.summary( "BET and T-plot Results" )

10

11 | mic.summary.add( "Report Results",

12 [ "BET surface area:",

13 "BET constant:",

14 "BET monolayer capacity:",

15 "T-plot external surface area:",

16 "T-plot micropore volume:" ],

17 [ '{:10.5f}".format(sa) + ' m?/g"',

18 '{:10.5f}"'.format(c),

19 '{:10.5f}"'.format(vm) + ' cm3/g"’,

20 '{:10.5f}"'.format(esa) + ' m2/g',

21 '{:10.5f}".format(vol) + ' cm3/g' ] )
The resultis:

Report Results
BET surface area: 215971368 m¥qg
BET constant. 111.7350%
BET monolayer capacity: 49.60593 cmilg
T-plot external surface area: 210.36208 mig
T-plot micropore volume:  0.00727 cm®ag
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Acquiring the results from a pore-distribution report such as the BJH method is done in a similar
way as in the previous script except the return values from the mic.report call are slightly different
since they involve lists of data. For example:

1| import mic
2 | import numpy as np
3
4| xdat, ydat, desc = mic.report( 'bjhads', 'incremental distribution' )
5 if not (np.isnan(xdat[@]) or np.isnan(ydat[©])):
6 mic.graph( 'BJH Adsorption/Desorption', 'Pore Diameter (A)', 'Incremental
Volume (cm3/g)"' )
7 mic.graph.add( desc, xdat, ydat )
The result is:
User-Defined Report : BJH Adsorption/Desorption
100 200 300 400 500 600 Puye7D?ame‘ey(A] 200 900 1,000 1,100 1,200 1,300 1.400
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ACQUIRE OVERLAY SAMPLE DATA FOR GAS ADSORPTION

Physisorption

The call to obtain overlay sample data is similar to the calls for the primary sample. This script
involves two overlay sample files.

The calls to obtain adsorptive data and report results for an overlay sample file using mic.report
and mic.adsorptive_data have a very similar interface as the mic.overlay call, and a summary of
their usage is shown in the example in this topic.

1| import mic

2

3/ p, g, n, fsw, fsc, mass, desc = mic.isotherm('rel")

4 pl, g1, nl, fswl, fscl, massl, descl = mic.overlay( 1, 'rel')
5! p2, 92, n2, fsw2, fsc2, mass2, desc2 = mic.overlay( 2, ‘rel")
6

7 | mic.graph( 'Three Sample Isotherms',

8 'Relative Pressure (P/Po)‘',

9 'Quantity Adsorbed (cm3/g STP)' )

10

11 | mic.graph.add( 'Primary Isotherm', p, q )

12 | mic.graph.add( 'Overlay Isotherm 1', pl, q1 )
13 | mic.graph.add( 'Overlay Isotherm 2', p2, g2 )
14

15 | mic.summary( "A Summary Report" )

16

17 | mic.summary.add( "Two samples”,

18 [ "Primary sample:",
19 "Overlay sample 1:",
20 "Overlay sample 2:" ],
21 [ desc,
22 descl,
23 desc2 ] )
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The results are:

User-Defined Report - Three Sample Isotherms

—— Primary lsotherm —&— Overlaylsotherm 1 —#— Overlay Isotherm 2

e

Quantity Adsorbad (cmg STF)

00 01 02 03 04 06 07 08 08 10

Two samples

Primary sample: 12 mm Tube N1 Silica-Alumina ADS-DES with F35
Crverlay sample 1; Activated Carbon Tube C4 Butane Port 3
Cverlay sample 2: Activated Carbon Hexane Dosed from Port 3 - 2

To enable the use of overlay data in the Advanced reports, the following two actions must be
taken prior to running the script:

m Sample files to overlay must be selected, and
m The Overlay samples checkbox on the Advanced Report Options window must be selected.
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Chemisorption

The call to obtain overlay sample data is similar to the calls for the primary sample. This script
involves two overlay sample files.

The calls to obtain adsorptive data and report results for an overlay sample file using mic.report
and mic.adsorptive_data have a very similar interface as the mic.chem.overlay call, and a
summary of their usage is shown in the example in this topic.

1| import mic

2

3| p9, g0 = mic.chem_isotherm('primary")

4| por, gor = mic.chem_isotherm('repeat")

5| pl, q1 = mic.chem_overlay(1l, 'primary")

6| plr, gqlr = mic.chem_overlay(1l, 'repeat')

7| p2, 92 = mic.chem_overlay(2, 'primary")

8| p2r, g2r = mic.chem_overlay(2, 'repeat')

9 | mic.graph('Graphical Report 1', 'Absolute Pressure (mmHg)', 'Quantity

Adsorbed (cm3/g STP)')

10 | mic.graph.add('Primary 0', p@, g0)
11 | mic.graph.add('Repeat ©0', per, ger)
12 | mic.graph.add('Primary 1', pl, ql)
13 | mic.graph.add('Repeat 1', plr, qilr)
14 | mic.graph.add('Primary 2', p2, q2)
15 | mic.graph.add('Repeat 2', p2r, q2r)

16

17 | mic.summary("A summary report")

18

19 | mic.summary.add("Sample and Two Overlays",

20 ["Primary sample:",

21 "Overlay sample 1:",

22 "Overlay sample 2:"],

23 [mic.sample_information('sample description'),

24 mic.sample_information('sample description', 1),
25 mic.sample_information('sample description', 2)])
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ENABLE THE USE OF OVERLAY DATA

1. Onthe Report Options tab, click Overlays.

2. Onthe Plot Overlay Sample Selection window, to move a file from the Available Files list
box to the Selected Files list box, either double-click a file name in the Available Files list
box or click one or more files in the Available Files list box then click Add.

[E=N RN |
sample Deg nalysis Report
escrption Condi Conditons Optons
pic  Graphic
C2020\MICLOGO EVF r
Height: 0250 n i
( [ J Lookin: |G
[¥] Apply thermal transpiration correction
Insice dameter of sanpie tube: i (use crlamon tomove the
%5 |mm Avaiable Files: Sekcted Fes: selected e up/donr)
Fie Name D
000-000 S 000-000
alming 000-118.5WP  Aumina Reference Matera (1)
1000 106.5F  Siica Aumina Reference Material
colte000-1145WP  Y-Zeolite N2
r==m
v
#dd Remove
P

Click OK.

On the Report Options tab, highlight Advanced in the Selected Reports list box.
Click Edit.

Select the Overlay samples checkbox to the right of the selected report.

Click OK.

Run the script using the instructions found in Scripts on page A - 4.

© N Ok

folfa s
Somple Degas Anlyss Report
Desapton Candtons Condions Optons

Report Options:

[¥] Show report title
Dishongraphic  Graphic ==~
CARIMIA00 B
Wt 029 0w 200

SelectReports

1 Advanced Report overlays -] (Pressures ) 7] Overay sanpies

i [ ) (] Yot
[¥] Apply thermal transpirAlign Cliog —
Inside diameter of sample * = None o Pressures. [s ples.

9.53 mm

Avaiable Scrpts

reports
summary-table-graph Add...

3 Concel
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ACQUIRE METAL COMPOSITION DATA FOR CHEMISORPTION

The call to obtain information about active metals in a chemisorption sample is mic.metal _
composition. Specifically, this call provides access to the data shown in the table of the Active
Metals window. With no arguments specified, the call returns a list of all the active metals in the
sample. When called with a metal specified, the method returns an associative array (python
dictionary) of the metal's properties. With both the metal and property specified, the call returns
the value for the specified metal property. The following example script illustrates these three
usage patterns.

1| import mic
2 | import pprint as pp
3
4
5
6 | mnames = sorted(mic.metal_ composition())
7 | mic.summary("Metal Composition: " + pp.pformat(mnames))
8
9
10
11 | mprops = sorted(mic.metal composition(mnames[@]).items())
12 | mkeys = []
13 | mvals = []
14 | for k, v in mprops:
15 units = "'
16 if 'atomic weight' in k:
17 units = ' amu'
18 elif 'cross sectional area' in k:
19 units = ' nm?’
20 elif 'density' in k:
21 units = ' g/cm?®’
22 elif 'percent of sample mass' in k or ‘'percent reduced' in k:
23 units = "%’
24 mkeys.append(k + ':")
25 mvals.append('{:8.3f}"'.format(v) + units)
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26
27
28
29
30
31
32

33

mic.summary.add("Properties for " + mnames[0], mkeys, mvals)

# With both first two arguments the method returns a single value for the
# specified property.

mweights = []

for mname in mnames:

mweights.append('{:8.3f}"'.format(mic.metal composition(mname, 'atomic
weight')))

mic.summary.add("Active Metals and Atomic Weight (amu)", mnames, mweights)
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MicMoDULE PYTHON CALLS

TABLES

Available Mic Python calls for tables:

m Create a new tabular report
= Add acolumn
= Add atable

Add a Table

This script adds a table to the last created tabular report:

1| mic.table.addtable( name )
2
3 | Keyword arguments:
4
5

name --- the table name

Add a Column

This script adds a column to the last created table:

1| mic.table.addcolumn(header, values, align='r'):
2
3 | Keyword arguments:
4
5 header --- column header; must be a string (or convertible)
6 values --- column values; must be a list of strings (or convertible)
7 align --- column alignment; 'r', 'l', 'c' for right, left, and center jus-
tified
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Create a New Tabular Report

mic.table( title='User Table' )

Keyword arguments:

i D W N R

title --- the tabular report title (default = 'User Table')
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SUMMARY REPORTS

Add a Summary Section

This script adds a summary section to the last created summary report:

(or convertible) and the same length as values

values --- column of values; must be a list of strings

1| mic.summary.add(name, labels, values):

2

3 | Keyword arguments:

4

5 name --- summary section name

6 labels --- column of labels; must be a list of strings
7

8

9

(or convertible) and the same length as labels

Create a New Summary Report

1| mic.summary( title='User Summary' )
2
3 | Keyword arguments:
4
5

title --- the summary title
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GRAPHIC REPORTS

Add a Curve

This script adds a curve to the last created graphical report:

O 00 N O U p W N P

=
(]

11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27

mic.graph.add(name, x, y, yyaxis=False, color=None, linestyle='-"',

marker="a', graphtype='both', interpolation="akima'):

Keyword arguments:

yyaxis ---

color ---

linestyle ---

marker ---

the curve name
list of x values; must be a list of floats
(or convertible) and the same length as y
list of y values; must be a list of floats
(or convertible) and the same length as x
place this curve on the yy-axis if True
otherwise place on the y-axis (default = False)
RGB color as an HTML hex string (e.g., '#4169el")
or a three-element list or tuple (e.g., [65,105,225]);
if None, color is automatically selected (default = None)
line style; (default = '-")
= : solid
fost : dash
o : dot
et : dash dot
"oo0 " : dash dot dot

marker shape; (default = 'a')
"+ : plus
‘o' or '0" : circle
"x' . cross
At : up triangle
‘v : down triangle
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28 's! : square

29 d' : diamond

30 '8’ : hourglass

31 't : horizontal hourglass
32 "' or None : no marker

33 ‘a' : automatically selected
34 graphtype --- graph type; (default = 'both")

35 ‘curve' or 'c' : curve

36 ‘points’ or 'p' : points

37 "both’ or 'b' : curve-and-points
38 'hist' or 'h' : histogram

39 interpolation -- linear or akima spline interpolation (default='akima')
40 ‘akima' use akima spline

41 ‘linear' use linear interpolation

Add a Curve Using the Second Y-Axis

This script adds a curve to the last created graphical report using the second y-axis:

mic.graph.addyy(name, xx, yy):

1
2
3| Add a curve to the last created graphical report using the second
4

y-axis. The arguments to this call are the same as to mic.graph.add.
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Create a New Graphical Report

O 00 N O U1 A W N B

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29

mic.graph(title="User Graph', xlabel='X axis', ylabel='Y axis',

yylabel="YY axis',

xlinear=True, ylinear=True, yylinear=True,

xinvert=False, yinvert=False, yyinvert=False,

xrange=None, yrange=None, yyrange=None, xbars_id='"):

Keyword arguments:

title so=
xlabel coc
ylabel ---
yylabel ---

xlinear ---

ylinear ---

yylinear ---

xinvert ---

yinvert ---

yyinvert ---

xrange  ---

yrange  ---

yyrange ---

xbars_id ---

the graphical report title (default = 'User Graph')

x-axis label (default "X axis")

y-axis label (default

'Y axis')

yy-axis label (default = 'YY axis')

x-axis linear scale; if false, use log scale
(default = True)

y-axis linear scale; if false, use log scale
(default = True)

yy-axis linear scale; if false, use log scale

(default = True)

Invert x-axis if true (default = False)

Invert y-axis if true (default = False)
Invert yy-axis if true (default = False)
None, or two values giving the min and max
range of the axis.

None, or two values giving the min and max
range of the axis.

None, or two values giving the min and max
range of the axis.

None, or the id of an xbar control created

via the mic.control() object
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GET PRIMARY ISOTHERM DATA

Physisorption
1| mic.isotherm(press_type='rel', sample number=0, item='"):
2
3 | Get isotherm data.
4
5| Keyword arguments:
6
7 press_type --- the pressure basis; use ‘rel' for relative pressure,
8 "abs' for absolute (default = 'rel'). This is ignored
9 if the 'item' argument is also used.
10
11 sample_number --- Sample to retrieve
12 0 : current sample file (default)
13 1 through 8 : corresponding overlay sample file
14
15 item --- string identifying the item to be returned.
16 For example; 'absolute pressure', or ‘'quantity adsorbed'’
17 The default is an empty string for which the return
18 value is the below list of quantities
19
20 | Usage for specified item:
21 prel = mic.isotherm(sample_number=0, item='relative pressure')
22
23 | Usage with tuple returned:
24 p, gqads, n_ads, warm _fs, cold fs, mass, desc = mic.isotherm('rel")
25
26 p --- array of pressure (relative or absolute)
27 gads --- array of cumulative quantity adsorbed
28 num_ads --- number of points in the adsorption curve
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Get Primary Isotherm Data

warm free-space
cold free-space
sample mass

sample description

mic.chem_isotherm(branch="primary', item=None):

Get primary, repeat and difference isotherm data.

branch --- Specifies which analysis to get isotherm data;

use ‘primary’ for the first analysis,
‘repeat’ for the repeat analysis
and ‘'difference' for the difference of these two
only get the specified item. Allowed values are None
or 'sample temperature'. No argument means

to return p,q

chem_isotherm('primary')
chem_isotherm('repeat')

chem_isotherm('difference")

.chem_isotherm(branch="primary',item="sample temperature")

--- array of absolute pressures

--- array of cumulative quantity adsorbed

29 warm_fs ---
30 cold fs ---
31 mass sos
32 desc soc
Chemisorption
1
2
3
4
5| Keyword arguments:
6
7
8
9
10
11 item ---
12
13
14
15 | Usage:
16
17 p, q = mic.
18 p, q = mic.
19 p, q = mic.
20
21 temp = mic
22
23 p
24 q
25 temp

--- array of sample temperatures
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GET OVERLAY ISOTHERM DATA

Physisorption
1| mic.overlay(overlay _number=1, press_type='rel'):
2
3 | Get overlay isotherm data.
4
5 Keyword arguments:
6
7 overlay number --- the overlay number (1 through 8; default = 1)
8 press_type --- the pressure basis; use 'rel’' for relative pressure,
9 'abs' for absolute (default = 'rel')
10
11 | Usage:
12
13 p, gads, num_ads, warm_fs, cold fs, mass, desc = mic.overlay(l, 'rel’)
14
15 p --- array of pressure (relative or absolute);
16 empty-array if overlay is unavailable
17 gads --- array of cumulative quantity adsorbed;
18 empty-array if overlay is unavailable
19 num_ads --- number of points in the adsorption curve;
20 0 if overlay is unavailable
21 warm_fs --- warm (ambient) free-space; 0.0 if overlay is unavailable
22 cold _fs --- cold (analysis) free-space; 0.0 if overlay is unavailable
23 mass --- sample mass; 0.0 if overlay is unavailable
24 desc --- sample description; empty-string if
25 overlay is unavailable
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Chemisorption

1| mic.chem_overlay(overlay_number=1, branch='primary', item=None):

2

3 | Get overlay isotherm data.

4

5| Keyword arguments:

6

7 overlay number --- the overlay number (1 through 8; default = 1)
8

9 branch --- Specifies which analysis to get isotherm data;
10 use ‘primary’ for the first analysis,
11 ‘repeat’ for the repeat analysis
12 and 'difference' for the difference of these two
13 item --- only get the specified item. Allowed values are None
14 or 'sample temperature'. No argument means

15 to return p,q

16 | Usage:

17

18 p, q = mic.chem_overlay(1l, 'primary")

19 p, q = mic.chem_overlay(1l, 'repeat')

20 p, q = mic.chem_overlay(1l, 'difference')

21

22 temp = mic.chem_overlay(branch="primary',item="sample temperature"')
23

24 p --- array of absolute pressures

25 q --- array of cumulative quantity adsorbed

26 temp --- array of sample temperatures
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GET ADSORPTIVE DATA FOR EACH SAMPLE

1| mic.adsorptive data(sample_number=0):
2
3 | Get adsorptive data for each sample
4
5| Keyword arguments:
6
7 sample_number --- Identifier for the adsorptive data to retrieve
8 ) : current sample file (default)
9 1 through 8 : corresponding overlay sample file
10
11 | Usage:
12
13 csa, hsd, dcf, mol weight, analysis_gas = mic.adsorptive data()
14 csa, hsd, dcf, mol weight, analysis_gas = mic.adsorptive data(®)
15
16 csa --- cross sectional area (nm”2)
17 hsd --- hard sphere diameter (angstroms)
18 dcf --- density conversion factor (dimensionless)
19 mol_weight --- molecular weight
20 analysis_gas --- mnemonic for the analysis gas species
21 (e.g., 'CO", "H2")
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GET SAMPLE INFORMATION ITEM

O 00 N OO U o W N P

=
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11
12
13
14
15
16
17
18

mic.sample information( item, sample_number = 0 ):

Keyword arguments:

item --- string identifying the item to be returned.
For example; 'sample mass', or 'sample description’
The default is an empty string for which the return

value is a list of all available keywords
sample_number --- Sample to retrieve
0 : current sample file (default)

1 through 8 : corresponding overlay sample file

Usage:

all keywords = sample_information()

mass

sample_information('sample mass')

mass sample_information('sample mass',@)
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GET REPORT RESULTS FOR PHYSISORPTION

This script gets report results for the indicted report and sample:

1| mic.report(report_name='"', result="", sample number=0):

2

3 | Get report results for the indicated report and sample

4

5| Keyword arguments:

6

7 sample_number --- Identifier for the sample data to retrieve.

8 0 : current sample file (default)

9 1 through 8 : corresponding overlay sample file

10

11 | Usage:

12

13 sa = mic.report('bet', 'surface area')

14

15 porew, incvol, desc = mic.report('bjhads’,

16 "incremental distribution')

17

18 | The available report keywords, result keywords and a corresponding

19 | description of the result is listed in the table below

20

21 Report Result Description

P B e

23 bet surface area Surface area (m"2/g)

24 bet bet constant BET constant (dimensionless)

25 bet monolayer capacity Monolayer capacity (cm”3/g)

26 tplot external surface area External surface area (m"2/g)

27 tplot micropore volume Micropore volume (cm”3/g)

28 bjhads incremental distribution  Incremental Distribution

29 bjhdes incremental distribution  Incremental Distribution
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30
31
32
33
34
35
36
37
38
39
40
41
42
43

dhads incremental distribution Incremental Distribution
hk incremental distribution Incremental Distribution
dft incremental distribution Incremental Distribution
nldft incremental distribution Incremental Distribution

where the incremental pore distribution result above (for those

reports which return this) is a list with three components being,

porew --- array of pore dimension boundaries (angstroms);
empty-array if unavailable.

incvol --- array of incremental pore volumes (cm”3/g);
empty-array if unavailable.

desc --- Name of data set; empty-string if unavailable.
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GET IMPORTED PORE DATA

1| mic.imported pore_data(import_number=1):

2

3 | Get imported pore data.

4

5| Keyword arguments:

6

7 import_number --- the import number (1 through 8)

8

9 | Usage:
10
11 porew, incvol, desc = mic.imported pore data(l)
12
13 porew --- array of pore dimension boundaries (angstroms);
14 empty-array if unavailable.
15 incvol --- array of incremental pore volumes (cm”3/g);
16 empty-array if unavailable.
17 desc --- Name of data set; empty-string if unavailable.
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GET METAL COMPOSITION FOR CHEMISORPTION

1| mic.metal composition(metal=""', metal property='"', sample_ number=0):
2

3 | Get information about the active metals in this sample

4

5| Keyword arguments:

6

7 metal --- the metal to return information about

8 if '" or None, then return a list of the

9 active metals
10
11 metal property --- the specific property to return information on
12 if "' or None, then return all the properties
13 for the specified metal (requires metal to be
14 specified)
15
16 sample_number --- Identifier for the metal data to retrieve
17 0 : current sample file (default)
18 1 through 8 : corresponding overlay sample file
19
20 | Usage:
21
22 metal list = mic.metal composition()
23 copper_prop = mic.metal_composition( ' copper')
24 copper_perc = mic.metal composition('copper',
25 "percent of sample mass')
26
27 | In the above first usage case, the list of active metals is returned.
28 | In the above second usage case, a python dictionary type
29 | is returned which includes all the properties of the metal

30 | available and their corresponding values. The last case returns
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31 a single value (int, float, or string) for the specified property.
32
33 | The metal_property keywords which one can use are
34
35 atomic weight
36 oxygen atoms
37 density
38 percent of sample mass
39 metal atoms
40 cross sectional area
41 percent reduced
42 stoichiometry GASNAME
43
44 | where in the last keyword one substitutes the desired gas name to
45 | obtain its stoichiometry factor. One can also make the call
46 | metal composition(metalname) without any metal_property keyword
47 | provided to see the whole dictionary of keywords and values.
A-38 Flex Series Operator Manual

350-42800-01 (Rev R) — Apr 2021



Iml micromeritics® B Atomic Weights and Cross Sectional Areas

B Atomic WEIGHTS AND CROSS SECTIONAL AREAS

CFR Dynamic Analysis and Chemisorption options are not applicable when the software is
Note installedin 21CFR11 environments.

Atomic Weights and Cross-sectional Areas for Selected Metals

Metal Symbol Atomic Weight Cross-sectional Density (g/ml)
(g/mole) Area (sq nm)

chromium Cr 51.996 0.0635 7.19
cobalt Co 58.933 0.0662 8.9

copper Cu 63.54 0.0680 8.96
gold Au 196.967 0.08696 18.9
hafnium Hf 178.490 0.0862 13.3
iridium Ir 192.220 0.0769 224
iron Fe 55.847 0.0613 7.89
manganese Mn 54.938 0.0714 7.43
molybdnum Mo 95.940 0.0730 10.22
nickel Ni 58.710 0.0649 8.9

niobium Nb 92.906 0.0806 8.57
osmium Os 190.220 0.0629 22.6
palladium Pd 106.400 0.0787 12.02
platinum Pt 195.090 0.0800 21.45
rhenium Re 186.2 0.0649 21.02
rhodium Rh 102.905 0.0752 121

tuthenium Ru 101.070 0.0613 12.4
silver Ag 107.868 0.0869 10.5
tantalum Ta 180.947 0.0800 16.6
thorium Th 232.038 0.1350 11.7
tin Sn 118.710 0.1082 4.54
tungsten w 183.850 0.0741 19.3
vanadium \Y 50.942 0.0680 6.11

zirconium Zr 91.220 0.0877 6.51
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C Calculate Free Space Values for Micropore Ana-

[M] micromeritics® he-

C CALCULATE FREE SPACE VALUES FOR MICROPORE
ANALYSES

Many microporous materials, such as zeolites and activated carbons, trap and hold helium in their
complex pore structures for many hours after being exposed to helium. Helium trapped in
micropores can interfere with the analysis at low pressures, causing an “S”-shaped curve at the
lower end of the isotherm. For this reason, it is recommended that you enter the ambient and
analysis free space volumes when performing micropore analyses, therefore avoiding exposure
of the sample to helium. Two techniques can be used for determining ambient and analysis free-
space values.

The first method is to perform a short analysis on the sample after partial degassing (one pressure
point with no incremental dosing), but prior to final sample preparation. Measure the free space
during this analysis. The measured free space values will be printed on the report and may then
be entered into the sample file after more thorough sample preparation.

The second method requires prior tests using empty tubes that will be employed later for the
sample analyses. The measured free space data can be used thereafter on every analysis
performed using these sample tubes. This small initial investment of time will save considerable
time later. Perform an empty tube analysis on each sample tube you intend to use for micropore
analysis. Measure the free space of each sample tube, taking only one pressure point

1. Create a sample tube file from each empty tube test.

2. Use the Load from Sample File button to read in the measured free space from the empty
tube tests.

3. Inthe sample file for the sample analysis, pick the appropriate sample tube from the sample
tube list.

4. Enter the mass and density of the sample.
5. Select Calculate in the free space options in the analysis conditions.
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D CRYOSTAT

The cryostat elevator is manually operated, however the analyzer elevator must first
be disabled to prevent damage to the analyzer.

A CryoStatis an available option. Parts and accessories can be found online at
www.Micromeritics.com.

Unit [n] > Enable CryoStat

When selected:

m Unit [n] > Disable Elevator is automatically selected
m applicable cryostat fields within the application will be enabled

Unit [n] > Disable Elevator

When selected, the analyzer elevator will not move until this option is deselected.
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CRYOSTAT OPERATING INSTRUCTIONS

The cryostat provides automatic analysis temperature control over a wide range of sub-ambient
temperatures.

m Read and fully understand this entire section prior to carrying out operations on the
system.

= All system components must be powered ON in the sequence provided in this sec-
tion.

m Pay attention to all local safety systems and requirements and consider the spe-
cifics of the experiment when operating the system.

1. Perior to starting any analysis on the system, ensure the following:

m Goto Unit [n] > Enable CryoStat and ensure a checkmark displays to the left of the
menu option. A checkmark indicates the item has been selected and disables the elev-
ator during an analysis when using the cryostat.

m The cryostat is correctly mounted and held firmly in place by the metal retaining bands.

m Release the brake on the cryostat cradle and move the system upwards to check that
the sample well and the analyzer sample port is correctly aligned.

m Check that the vacuum connection, helium connection, and wired connections to the
compressor and temperature controller are in place and correctly fitted.

2. Prepare the samples.

m Samples can be prepared in-situ using the analyzer heating mantle (if the heating
mantle fits with the cryostat installed). See Degas in Situ on page 5 - 3. This will
depend on the type of heating mantle used.

m The cryostat can be prepared to run analyses in the DOWN position while the samples
are being prepared. Leave the insulating cover for the cryostat sample well in place
while doing this.

3. Turnon the helium supply and adjust the rotameter to scale position 55. This corresponds
to a flow rate of approximately 5 ml/min. See Rotameter Scale Readings on page D - 8.

4. Allow the helium to purge the sample well for fifteen minutes. This purge procedure
removes water vapor from the sample well and prevents water vapor from freezing when
the system is in use at sub-ambient/ cryogenic temperatures.

5. Power ON the compressor by flipping the first switch of the circuit breaker to the UP pos-
ition. The compressor will now start to pump.

6. Pressthe ALL OFF button to power ON the temperature controller. Set the required tem-
perature on the temperature controller or in the analysis application. If using the tem-
perature controller, refer to the temperature controller manual supplied by the
manufacturer.
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7.

10.
11.

12.

13.

14.

Create a sample file (see Create Sample Files on page 3 - 2). There are settings specific
to physisorption analyses using a cryostatin Analysis Conditions for Physisorption and
Chemisorption on page 4 - 5.

With the sample tubes in place, preparation completed, and the tubes cooled to ambient
temperature, slide the insulating cover up the sample tubes so that the cover fits snug
against the mouth of the raised cryostat.

Remove the insulating cover from the top of the cryostat sample well. When prompted by
the analyzer application, raise the cryostat.

Allow the samples to thermally equilibrate before starting the analysis.

When prompted by the analyzer application, lower the cryostat and place the insulating
cover over the sample well of the cryostat.

If the sample tubes are to be removed, use Unit [n] > Backfill Ports or use the manual con-
trol option and pressurize the sample tubes to 760 mmHg at ambient temperature.

Weigh the samples after analysis and enter the sample weight into the sample file. The cryo-
stat can now be used to analyze more samples at the same temperature or change the set
point temperature.

Power OFF the compressor, vacuum pump, helium supply, and temperature controller. The
cryostat should remain powered ON unless it will be unused for a long period of time. If it is
necessary to power OFF the cryostat, set it to ambient temperature and allow it to come up
to room temperature.
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SAMPLE FILE CONFIGURATION FOR FLEX

1. Start the analysis program and open a sample file or create a new one.
2. Select the Analysis Conditions tab then use the Analysis Conditions Buttons table to com-
plete the sample file.
Analysis Conditions Buttons

Button Enter....

Preparation ESERE

Backfil and match transducer

et g

Evacuationrate: 0.67 kPals Unrestricted evac. from:  0.67 kPa

Vacwumlevel:  6,7e-03 kPa Evacuation tme: 0,10 hours

[|Degas in situ

30 10.0

Temperature | Temperature | Time
€] Ramp Ra
=C fmi

[Leak test 120

Elevator
(©) Automatic (@) Wait for operator () Do not move

Cancel

In the Elevator section, select Wait for Operator. Click OK.

Free Space [l Free Space Options EI@
(®) Measure
Lower dewar for evacuation
Evacuation time: h
[ ]Outgas test
180
() Enter
16.0000
45.0000
() Calculate
OK Cancel

Depending on the sample and proposed analysis, the free space can
be entered, measured, measured after analysis, or calculated. If the
free space is to be measured, then this can be done in the normal
manner, but with the operator manually moving the cryostat
assembly when prompted.
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Sample File Configuration for Flex

Analysis Conditions Buttons (continued)

Button

Enter....

pland T

E p* and Temperature Options = a2

p° Options

@) Measure p®in the p® tube for each isotherm paint.
() Measure p* ever the sample, Enter an initial estimate for p*.
98.6585

“) Measure p°in the p° tube for each isotherm paint. Measure:
p=over the sample and adjust the p° tube measurements.

) Determine p from pressure measured over the dosing source,
Note that the Adserptive Properties must specify dosing from
Psat tube, Sample port 3, or Vapor source.

(7 Measure Psat of the gas specified below for each isotherm point
calaate p° of the adsorptive from the mezsured Psat.

Nitrogen

() caladate p* from the analysis temperature.
) Enter p®.
98.6585
Analysis Temperature Options
(7 Enter the analysis temperature.
77.100

@ Calculate the analysis temperature from p® or Psat.

In the Analysis Temperature Options section, select Calculate the
analysis temperature from pO0 or Psat. Click OK.

Termination

=N o

[~ Backfill after analysis

Mitrogen

Deselect Backfill after analysis.

3. Goto Unit [n] > Sample Analysis.
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4. Select Control CryoStat, enter a Target Tolerance and a Hold Time. The cryostat tem-
perature will be ramped (if ramp is enabled) to the sample analysis temperature. Once the
cryostat temperature is within the entered tolerance, the analysis will wait for the hold time

before proceeding.

INSTALL SAMPLE TUBE FOR THE CRYOSTAT

Sample Tube Installation for Physisorption on page 6 - 10

Sample tubes for the cryostat are installed in the same manner as the sample tubes for the

analyzer.
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REMOVE THE CRYOSTAT FROM THE ANALYZER

To run a normal analysis, the cryostat must be removed.

Move the cryostat to the DOWN position.

Place the brake in the bottom position.

Remove the 1/8 in. nylon helium tube.

Close vacuum valve.

Remove the 1/4 in. flexible stainless steel evacuation hose at the Swagelok valve.
Remove the large hose clamps and lift the entire cryostat off the cradle.

Lay the assembly on an adjacent bench so that other hoses do not need to be dis-
connected.

8. Close the helium purge supply, close the vacuum valve, power OFF the vacuum pump and
compressor, turn OFF the temperature controller.

No gk owdh-~

special safety shield (supplied with the cryostat kit) should be used. This shield has

/ It is not necessary to remove the carriage assembly from the analyzer; however, the
been modified to reach over the cryostat panel and hook onto the analyzer.
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ROTAMETER SCALE READINGS

The rotameter scale corresponds approximately to flow rates:

I

ke

N

|

il
L
=~
,-;'

A. Adjustment knob
B. Brake

Rotameter Scale to Flow Rate

Scale Reading

Flow Rate (ml/min)

65 5.8
55 3
45 4.3
35 3.3
25 25
15 1.8
5 1.3
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TROUBLESHOOTING THE CRYOSTAT

Frost or ice accumulates around the outside of the cryostat in the area of the sample well

Cause:

Action:

The internal vacuum is degrading and must be re-evacuated.

Effective re-evacuation can be done only when the cryostat is warm, such as
after an analysis. It is recommended that the vacuum pump always remain
powered ON.

Elevator tries to rise

Cause:

Action:

Analysis program is not set to enable the cryostat.

In the analysis program, go to Unit [n] > Enable CryoStat and ensure that
this option is selected. Failure to do so will cause the P port to be evacuated
and the elevator will try to rise.

Valve motor in cryostat cold head does not start when the compressor starts

Cause A:
Action A:
Cause B:
Action B:

Cause C:
Action C:
Cause D:
Action D:

Cold head cable is not connected.
Stop the compressor. Connect the cable.
Open circuit in the cold head cable.

Disconnect the cold head cable. Check each conductor for continuity.
Replace the cable if necessary.

Defective valve motor.
Contact your Micromeritics Service Representative.
Blown fuse in the compressor's electrical box.

Refer to the manual supplied by the compressor manufacturer.

Valve motor in cryostat cold head hums but does not start

Cause A:
Action A:

Cause B:
Action B:

Cause C:

Valve disk has stalled.

Check the operating pressures on the compressor. Contact your Micro-
meritics Service Representative.

Defective valve motor.
Contact your Micromeritics Service Representative.
Open circuit in the cold head cable.
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Action C: Disconnect the cold head cable. Check each conductor for continuity.
Replace the cable if necessary.

Valve motor on the cryostat cold head runs but there is no cooldown

Cause A: No insulating vacuum.

Action A:  Check the vacuum system for operation and leaks.
Cause B: Gas line couplings are not fully engaged.

Action B: Ensure all couplings are fully engaged and torqued.
Cause B: Gas lines are connected incorrectly.

Action C: Reconnect the gas lines. Refer to the manual supplied by the compressor
manufacturer.

Cause D: Compressor output is inadequate.

Action D: Troubleshoot the compressor. Refer to the manual supplied by the com-
pressor manufacturer.

Shroud is sweating or abnormally cold

Cause: Loss of insulating vacuum.

Action: Check the vacuum system for operation and leaks.

Abnormally noisy operation after a sustained period of five to fifteen minutes

Cause A: Incorrect compressor pressures.

Action A:  Troubleshoot the compressor. Refer to the manual supplied by the com-
pressor manufacturer.

Cause B: Contaminants in the gas.

Action B: Perform Gas Cleanup and Recharging procedure on the cold head, com-
pressor, and the gas lines. Refer to the manual supplied by the compressor
manufacturer.Contact your Micromeritics Service Representative.

Intermittent operation

Cause: Compressor is cycling on and off.

Action: Troubleshoot the compressor. Refer to the manual supplied by the com-
pressor manufacturer.

Temperature is cycling
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Cause:

Action:

Contaminated gas is causing a cold head freezing-thawing cycle.

Perform Gas Cleanup and Recharging procedure on the cold head, com-
pressor, and the gas lines. Refer to the manual supplied by the compressor
manufacturer.Contact your Micromeritics Service Representative.

Sudden loss of refrigeration capacity

Cause A:
Action A:
Cause B:
Action B:

Loss of insulating vacuum.
Check the vacuum system for operation and leaks.
Compressor malfunction.

Troubleshoot the compressor. Refer to the manual supplied by the com-
pressor manufacturer.
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PREVENTIVE MAINTENANCE FOR THE CRYOSTAT

The preventive maintenance procedures can be located in the documents supplied by the cryostat
manufacturer.

Maintenance Required Frequency

Cold head Every 13,000 hours

Compressor (absorber) Every 30,000 hours
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CRYOSTAT CALIBRATION

The cryostat temperature reading does not necessarily reflect the temperature at the sample. The
discrepancy is large enough to cause significant differences between data taken with a cryogenic
bath and data taken with the cryostat set to the temperature of the bath.

One solution is to modify the voltage-to-temperature curve stored in the temperature controller so
that the reading accurately reflects the temperature of the sample. This option requires additional
interaction with the temperature controller to download, upload, and select the voltage-to-
temperature curves. However, this is straightforward with the Lakeshore controller and their Curve
Handler software.

REQUIRED ITEMS

m A Flex analyzer equipped with an installed Micromeritics cryostat unit.

m A selection of adsorptives to cover the temperature range to be calibrated — such as nitrogen,
argon, methane, ethane, and propane. Choose adsorptives whose saturation pressure is less
than 800 mmHg at the measurement temperatures.

m The Lakeshore Curve Handler software (free download): http://www.lakeshore.-
com/products/Pages/curvehandler.aspx.

m An empty sample tube for the Micromeritics gas adsorption analyzer being used.

m A spreadsheet application. Knowledge of how to load a .TXT file containing tabular data into a
spreadsheet application is beneficial.

CALIBRATION PROCEDURE

1. Inthe analysis application, go to the Unit menu. Ensure there is a checkmark to the left of
Disable Elevator and no checkmark to the left of Enable CryoStat. The cryostat will be adjus-
ted manually.

2. Install a blank sample tube into the gas adsorption analyzer. Note that only one tube is
required for the Flex.

3. Raise the cryostat and lock it in place following the general cryostat procedure.

4. Setthe cryostat to the required temperature. On the LakeShore temperature controller,
press SETPOINT, enter the temperature (in kelvin), then press ENTER.

Flex Series Operator Manual
350-42800-01 (Rev R) — Apr 2021


http://www.lakeshore.com/products/Pages/curvehandler.aspx
http://www.lakeshore.com/products/Pages/curvehandler.aspx

b Cryostat [M] micromeritics®

Measured temperature
Probe signal voltage
Setpoint button

Enter button

Set temperature

moOOoOw>»

5. Wait until the cryostat reaches the entered temperature. The time varies depending on how
big the temperature jump is. For example, going from 200 K to 215 K may take 15 to 20
minutes; going from 298 K to 77 K might take 90 minutes. Once the cryostat has reached
the operating temperature, record the set temperature, the measured temperature, and the
cryostat signal probe voltage.

6. Create a sample file to measure saturation pressure.

The analysis is to run in the absolute pressure dosing mode with an upper pressure limit of
950 mmHg. Increment volume dosing is to be employed using a dose volume of
20 cm3/g STP with a 5 second equilibration time. In Analysis Conditions:

a. Select the Absolute pressure dosing option.
b. Select the adsorptive to be used.
c. Enterthe pressure settings shown in the Pressure Settings for Flex table below.

Pressure Settings for Flex

Starting Pressure Dose amount | Equilibration Ending

Pressure Increment (cm3g STP) | Interval(s) | Pressure

(mmHg) (mmHg) (mmHg)
Line 1 0.000000 5 100.000000
Line 2 | 100.000000 20.0000 5 900.000000

7. Once the analyzer is set up and the temperature for the first data point has reached
equilibrium, start the analysis defined by the sample file. The analyzer will dose the sample
tube with 20 cm3/g STP of adsorptive . Once the tube pressure reaches the adsorptive
saturation pressure, the generated isotherm will climb straight up. Take several points at
this saturation pressure, then pause the analysis and set the cryostat to the next
temperature.

Once the cryostat has reached the set temperature and has equilibrated a few minutes,
record the cryostat temperature and the probe signal, then resume the analysis. Perform
this cycle for the number of temperature points required for the adsorptive being used.
Typical isotherms are shown below. Note that the temperature labels are for clarity and are
not a part of the normal report.
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Additional adsorptives will allow the calibration to be extended. A set of local fits may be
needed to cover a wide temperature change.

Depending on the selected adsorptive, a warning message may be given indicating

/ that 950 mmHg is not the saturation pressure for the temperature being used. This is
a normal message and will not interfere with the experiment. Click OK and continue
with the analysis.

These analyses will not end and will have to be terminated manually by stopping the
/ analysis window. To terminate the analysis, click Cancel, then wait a few seconds
and click Cancel again (do not double-click the Cancel button).

The analysis will end abruptly with adsorptive in the sample tube. The sample tube
must be manually evacuated before the cryostat is lowered.

Manually close all valves. Go to Unit > Evacuate Ports to evacuate the sample
tube(s) used for the measurement.

The cryostat can be lowered once the sample tube has been completely evacuated.

This saturation pressure data can either be read from the graph or an isotherm report can
be made and the saturation pressure read from the report:

5 Reperts - C\lsers_\SHELB BLD 1IMAYTE CryoCal Naregen & SMP

Bt s g |t Tt gt e Lo Pt e

[Mi micromeritics*

Teme Between  Samsnton st
Poriafmin)  Presmuse

28

EEEER

8. Place the data in table format using a spreadsheet application.
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Temperature and Saturation Pressure Values

Set Tem- CryoStat Signal Measured Sample Tube
perature (K) | Temperature Probe Saturation Temperature
(K) Voltage Pressure (K)
(mmHg)
65 64.999 1.04878 137.833 65.317
67.5 67.498 1.04474 206.334 67.778
70 69.999 1.04066 301.792 70.294
73 72.996 1.03572 454.217 73.239
73 72.996 1.03572 456.148 73.271
Nitrogen 73 72.998 1.03571 452.139 73.239
75 75.002 1.03240 584.063 75.189
75 75.002 1.03245 587.793 75.240
77 76.993 1.02896 743.094 77.165
77 76.995 1.02897 742.343 77.156
78 78.002 1.02737 832.533 78.165
140 139.999 0.91437 111.175 142.470
Ethylene 145 144.999 0.90456 168.125 147.470
150 150.000 0.89477 245.617 152.350
Set Temp Cryostat temperature setting, in kelvin.
CryoStat Temperature Temperature reported by the temperature con-

Signal Probe Voltage
Measured Saturation
Pressure

Sample Tube
Temperature

troller.
Signal probe voltage reading.

Equilibrium pressure measured by the instru-
ment when the isotherm is vertical.

Sample tube temperature calculated from the
measure saturation pressure using NIST’s
REFPROP program (bundled with the Micro-
meritics applications).
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CryoStat Calibration

w 2: nitrogen: Saturation points: (at equilibrium)

=
Liquid | Vapor | Ligquid | Wapor | Liquid | Wapor

Temperature | Pressure| Density | Density | Enthalpy| Enthalpy| Entropy | Entropy

® {mmHg) | (ka/m?) | (kg/m?) | (kdkg) | (kdkg) |(k)fkg-K) | (k)/kg-K)
1 75.037 57300 | 81651 | 3.5555 | -126.76 | 75345 | 27724 | 54658
2| 75497 BO7.00 | 81445 | 37492 | -12582 | 75713 | 27848 | 54542
3 76472 684.00 | 810.08 | 41852 | -123.83 | 76.479 | 28108 | 54302
4] 76664 700.00 | 809.21 | 4.2753 | -123.43 | 76628 | 28159 | 54255
5  76.4957 725.00 | 80789 | 4.4159 | -122.83 | 76.854 | 28237 | 54185
6| 77.254 751.00 | 80654 | 45617 | -122.23 [ 77.081 | 28315 | 54114
7| 77663 786.00 | 80468 | 47687 | -121.33 | 77391 | 28423 | 54017

g

Screenshot from REFPROP
software

The spreadsheet data can be graphed in the REFPROP spreadsheet program. Plot the
REPROP to determine temperature versus the Cryostat reading. Fit the data points:
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Additional adsorptives will allow the calibration to be extended. The following graph
contains data for nitrogen combined with data from ethane:
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9. The REPROP determined sample tube temperatures, combined with the signal probe
voltages read from the LakeShore controller are then used to construct a cryostat
calibration curve.

The LakeShore Curve Handler program (shown below) is used for this operation. (Refer to
the LakeShore Curve Handler manual for communications information.) Connect the
cryostat to the computer via an Ethernet connection.
,: o e New Curve
D-18 Flex Series Operator Manual
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CryoStat Calibration

10. Click Connect to establish communication with the LakeShore Temperature Controller.
Once communication is established, all the calibration curves in the LakeShore

Temperature Controller will be listed.

p—————

i EE.

Ho%

gles
“nn

DT-670-adj

Hakin

11. The ColdEdge Cryostat/LakeShore Model 336 Temperature Controller uses the DT-670
silicon diode as the temperature sensor according to ColdEdge Micromeritics Interface
Owner’s Manual. Select the curve for the DT-670 temperature probe. Click Save As and
save the DT-670 curve with a different name (i.e., DT-670-xx). Note that all calibration
curves are stored as ASCI! files in the Documents library with the file extension .curve.
There will be a DT-670.curve file and a DT-670-xx.curve file.
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Sensor model : oT-670
serial sumber: STaNDAR
pata Formar: 2

serPoint Limit: +500.000
Measurement (volts) Ten
7. 964 e -02 5. 0300E+D
9, 057 00:0e -02 5. DD00E+D2
1.10240:0-04 4. 21 JD00e+02
1. 365600 -01 4. 795000e+02
1. 791 800 -01 4. 61 5000e+02
2. 653000€ -01 4. 255000e+02
3. 495200 -01 1. eQ00E+02
4, 52E000e -01 1. 460000E+02
5.133000e-01 3. 200000 +02
5. 631 300e-01 2. GRS000E+D2
6. 07E500e -01 2. 7 000E+02
6. 487 200 -01 2. G10D00E+02
6. BES4 e -01 2. 440000E+02
7. 225100 -01 2. 2B0000E+02
7. 53534 000 -01 2.1 3 D00E+O2
7. BEOON{E -01 1. GRSOO0E+D2
8. 170200€ -01 1. B4 5000E+02
8. 4454 00€ -01 1. 715000e+02
8. 695E00E -01 1. 555000E+02
8. 932300 -01 1. 480000 +02
9. 144 70dE -01 1. 37 5000E+02
9. 343600€ -01 1. 27 5000E+02
9. 520000€ -01 1. 180000E+O2
9. 701 30 -1 1. 0S)Q00E+O2
9. BEOT e -01 1. 60S000E+O2
9. SRS 00E -01 9. 350000+ 01
1. 010640E«00 E. 70:0000E+O1
1. 021 250€«00 E. 10:0000E + 01
1. 031670€«00 7. S000E+O1
1. 041 BG0E «00 6. G000E + 01
1. 051620« 00 E. 30:0000E + 01
1. 0627 70E«00 & BL0000E+O1
1. 0747 206400 4 GOO00E +01
1. 0911 B0E 00 1. BT OO00E + 01
1. D9E0H0E«00 1. 5T 0000E+01
1. 1000 406 00 1. 330000E 01
1. 103530600 1. 1200008 + 01

o
(woltsmelvind

(K}

The LakeShore Curve Handler instruction manual provides several methods of entering
user created calibration. The following process uses a file copy of a modified version of

the DT-670 curve previously saved.

12. Produce a modified calibration curve by applying the fit from step 8 to the temperatures in
DT-760 curve.

13. Start the LakeShore Curve Handler program and establish communication with the

LakeShore Temperature Controller.
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I — DT-670

14. Click Open and select the modified DT-670-xx.curve. Place this curve in the first empty bin.
User curve bins start at Number 21.

15. The new curve should now be able to be loaded into the LakeShore Curve Handler
program. Click the User’s Curve tab in the lower left side of the window.

DT-670-ad

Hakin

16. Note in this example the modified curve DT-670-xx.curve is in bin 22 (left column) and the
curve is displayed on the right. The values should be reviewed and any changes made.
Click Save if changes have been made. Click Write to load the new curve into the
LakeShore Temperature Controller. Exit the LakeShore program.

17. To selectthe new curve, on the temperature controller, press the Input command (key 7),
select the Input channel (usually A), use the arrows to navigate to the curve menu, press
Enter, then select the curve. Use curve 22 in this example. Press Enter once more, then
press Escape. The new, modified curve is now in place. More details can be found in the
LakeShore Model 336 Temperature Controller User’s Manual.

The table below shows the effect of the new curve:
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Temperature and Saturation Pressure Values

Set Cryostat Measured Uncalibrated Calibrated % Error
Temp Temperature Saturation Sample Tube | Sample Tube (Calculated
(K) (K) Pressure Temperature | Temperature Vs
(mmHg) (K) (K) Uncalibrated)
73 72.997 473.450 73.553 73.250 -0.414
75 74.996 615.020 75.603 75.215 -0.517
77.3 77.002 786.618 77.648 77.029 -0.804
D22 Flex Series Operator Manual
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E Data Logging

E DATA LOGGING

The Flex has the added capability to collect, access, and use real time transient data (pressures,
temperatures, quantities adsorbed, etc.) during adsorption and desorption measurements. Data
are collected every half second. Data logging can also be performed from a Smart VacPrep
degasser attached to the analyzer. The Smart VacPrep Operator Manual can be found on the
Micromeritics web page (www.Micromeritics.com).

This document provides :

m installation instructions for the PUTTY client and outlines how to access and use the data file,
and

m installation instructions for Python components and outlines how the captured data can be
handled using Python scripts.

INSTALL THE PUTTY CLIENT

PuTTY is an open source SSH and telnet client that can be used to access the transient data
output by the Flex analyzer. No additional Micromeritics application is required. The PuTTY .exe

file runs directly from a desktop shortcut. Download the PuTTY application using the following
URL (only save the putty.exe file):

http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html

To connect to the Flex analyzer:

1. Inthe Flex application, go to Unit [n] > Unit Configuration and make a note of the ana-
lyzer IP address.

Gas Selections
1P addr : 192.168.77.101
| P ( aceress ] Valve 11gss: N2
Valve 12gas:  Ar
Change IP... | [ BoardD...
address Vave 13gas: e
Software Versions Valve 14 gas:
MICBIOS:  Demo Boot Block Valve 15 gas:
Controler:  Demo Application Valve 16 gas:
Application:  3Flex
Options
Micropore: Port 1, Port 2, Port 3
Chemisarption: No Callbrations...
oK Cancel

2. Inthe PuTTY Configuration window:

a. Enterthe analyzer IP address (from Step 1) into the PuTTY application.
b. Enter 54000 in the Port field.

c. Select Raw as the connection type.
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#2 PuTTY Configuration

X

Category:

[=)- Session
Logging
(=) Temminal
Keyboard
- Bel
- Features
- Window
- Appearance
Behaviour
~ Translation
Selection
- Colours
(=l Connection
Data
- Prosy
Telnet
- Rlogin
- S5H
Serial

Basic options for your PuTTY session

Specify the destination you want to connect to
Host Name for P address) Port

Connection type

@ Faw (O) Telnet () Rlogin (7) SSH (7 Serial

Load. save or delete a stored session
Saved Sessions

Default Settings Load

Close window on exit:

) Mways (0 Never @ Only on clean exit

3. To save the settings (optional):

== £8 PuTTV Configurati ? ||
Category:
[ Basic options for your PuTTY session 2~ Session Options controlling session logging

Croe i e e T ¢ - Logging

& Teminal
Host Name (or IP address) Fot - © Piirtabie output

i opal o output SSH packets

- Features ) 55H packets and raw data
SSH O Seral i Logfie name:
SemplcFie log

i Tenet
A

logi
SSH
Serial

and &P for port number)

Mot [ Hep |

a. Inthe Category box, select Session > Logging.
In the Session logging group box, select All session output.

=

c. Inthe Log file name group box, click Browse to select the destination and enter a .txt
file name. It may be helpful to name this file the same as the sample file to be analyzed.

4. Click Open to start collecting the data.

The PuTTY application can be started before the Flex analyzer starts collecting data
— it will be waiting until data output from the analyzer begins.

Flex Series Operator Manual
350-42800-01 (Rev R) — Apr 2021



Iml micromeritics® Data File Column Descriptions

ACCESS THE DATA LOG FILE

The text file created in the previous section (Step 3c) contains the transient data and can be
accessed using any means that accepts tab separated value such as Notepad, Microsoft Excel (or
other spreadsheet software), or programming languages that read .txt or .xIs files such as

MATLAB, Octave, and Python. MATLAB has the x/sread() function and Octave has the textread()
function.

DATA FiLE COLUMN DESCRIPTIONS

When the data file is viewed in a spreadsheet program, the following columns display:
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Flex Data File Column Descriptions

B. 'manifold volume (cc); AE. 'port 2 quantity adsorbed (cc STP)';
C. 'manifold temperature (K)'; AF. 'port 2 has manifold ?";
D. 'time (ms)’; AG. 'port 2 valve open 7
E. 'port 1 pressure (Torr)’; AH. 'port 2 data points taken’;
F. 'port 1 volume (cc)’ Al. 'port 2 current pressure table index’;
G. 'port 1 temperature (K)" AJ. 'port 2 last data point elapsed time
H. 'port 1 ambient temperature (K)'; '(ms)l; ' '
I. "port 1 analysis temperature (K): AK. 'port 2 last data point pressure Torr)';
J. 'port 1 warm freespace (cc STP): AL. 'port 2 last data point quantity dosed (cc
K. 'port 1 cold freespace (cc STP)', 'STP) ; . .
L. 'port 1 quantity dosed (cc STP): AM. 'port 2 last data point quantity adsorbed
- . . (cc STP)"
'\'\/jl' 'po:tt 1 guantlty idijo;l?_ed (cc STP)' AN. 'port 2 last data point Po (Torr)';
O. 'port 1 als maniio ,?._' ’ AO. 'port 3 pressure (Torr)';
P. 'port 1 \c;atve or.)etnt. ,k ) AP. 'port 3 volume (cc)';
Q. 'porH ata pct)m s ent, ble index: AQ. 'port 3 temperature (K)';
R. 'porﬂ Icurtr(e;ntpres.sijrel @ Zl? X . AR. 'port 3 ambient temperature (K)’;
- port T astcaa po!n elapsed time (ms); AS. 'port 3 analysis temperature (K)';
S. 'port 1 last data point pressure Torr)'; AT. 'port 3 warm freespace (cc STP)'
T. g%rbt; last data point quantity dosed (cc AU. 'port 3 cold freespace (cc STP)'
U. 'port 1 last data point quantity adsorbed AV. “port 3 quant!ty dosed (cc STP);
(cc STPY; AW. 'port 3 quantity adsorbed (cc STP)';
V. 'port 1 last data point Po (Torr)’; AX. :port 3 has manifolfc)i'.?';
W. 'port 2 pressure (Torr)" AY. 'port 3 valve open ?";
X. 'port 2 volume (cc); AZ. 'port 3 data points taken';
Y. 'port?2 temperature,(K)" BA. 'port 3 current pressure table index’;
Z. 'port 2 ambient temperature (K)’; BB. 'port 3 last data point elapsed time
AA. 'port 2 analysis temperature (K)'; '(ms) ’ _ '
AB. 'port 2 warm freespace (cc STP): BC. 'port 3 last data point pressure (Torr)’;
o . BD. 'port 3 last data point quantity dosed (cc
AC. 'port 2 cold freespace (cc STP); STP):
BE. 'port 3 last data point quantity adsorbed
(cc STP)';
BF. 'port 3 last data point Po (Torr);
E-4 Flex Series Operator Manual
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INSTALL PYTHON COMPONENTS

To operate Python to view real time data, three components should be installed in the following
order:
1. Install PYTHON

m Download URL: https://www.python.org/downloads/
m Download Python version 3.2 or later

Depending on the computer operating system, download file versions may vary, however, the
.msi file should be compatible with computers that operate the Flex analyzer.
2. Install NumPY (for numerical functions)

m Download URL: http://sourceforge.net/projects/numpy/files/NumPy/1.6.2/
m Download file: numpy-1.6.2-win32-superpack-python3.2.exe

NumPY contains numerous numerical functions and libraries needed to properly handle the
transient data extracted from the .txt file collected during an analysis. NumPY version 1.6.2
should be download to be compatible with the installed version of Python.

3. Install MatPlotLIB (for graphical display of the data)

m Download URL: http://www.Ifd.uci.edu/~gohlke/pythonlibs/#matplotlib
m Download file: matplotlib-1.2.1rc1.win32-py3.2.exe

MatPIotLIB version 1.2.1 is compatible with NumPY from Step 2.
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SAMPLE PYTHON CODE

The following code was used to produce the data in this section. This is basic code for viewing
transient data. More detailed scripts can be created to compare pressure or quantity adsorbed
between ports, generate a separate figure for each port, etc. Contact Micromeritics’ applications
specialists to discuss and support creating custom scripts for individual applications.

import numpy as np
import matplotlib.pyplot as plt

myFile = 'carbon.txt'
data = np.genfromtxt (myFile, skip header=2, skip footer = 1)

# Time (minutes)
x=datal[:, 3]
x = x/1000/60

# Sample pressure PORT 1 (Torr)
y=datal:,4]

plt.plot (x,y, 'ko")

plt.ylabel ('Pressure (Torr)')
plt.xlabel ('time (minutes)')
plt.show ()

SAMPLE CODE EXPLANATION

import numpy as np
import matplotlib.pyplot as plt

Import is needed to load the modules containing functions to be used — in this case, numerical
and plotting functions. Coding is easier if abbreviations such as np and plt are used.

myFile = 'carbon.txt'
data = np.genfromtxt (myFile, skip header=2, skip footer = 1)

MyfFile is a variable name for the .txt file to be read. As long as the .txt file and the script file are in
the same directory, the script file can run automatically by double-clicking the script file after the
correct file has been hard-coded.

The genfromtxt() function allows for the text file to be converted into a numerical matrix.

The skip_header setting allows for the first 2 rows of data to be excluded from the matrix. As
shown in the following figure, the first row of data is ASCII art created by the PuTTY program, and
the second row of data are the column labels — neither of which are numerical data.
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The skip_footer setting is needed because, when the .txt file is read in real time, the entire last row
of data may not be complete. This causes problems for creating the matrix and needs to be
excluded. This means that the last half-second of data is not displayed when the data are viewed
in real time.

—Fie Felit_Faesr e bein =
Fmmnmmnmmmnmnmnmnmn= PUTTY 109 2013,03.20 13152335 mmmnmmmnmmmnmmmnmmmnmnm a
#MANPress Man vol mMan Tmp Time msec sml Press sml vol smiTprt smiTamb smiTanl smiwvwrm smivcld smlqQtotal
38.1576 318.141 12503436 330858860 3208751 318.141 298.000 77.243 8.7520 28.7111  5.4058
38.1527 318,140 12503937 330858468 328751 318.140 298.000 0 28.7111  5.4058
381765 318.141 12504438 331860375 328751 318.141 208.000 0 28.7111  5.4058
3817086 3180140 12504939 330857608 3208751 318.140 298.000 0 28.7111  5.4059
384927 3181141 12505420 33856757 3218751 318.141 298.000 0 28.7111  5.4059
39.4111 3180141 12505041 330858051 3218751 318.141 298.000 0 28.7111  5.4059
0. 0607 318,141 12506442 330855361 328751 318.141 298.000 0 28.7111  5.4060
40.7737 318.141 12506943 33859719 328751 318.141 298.000 0 28.7111  5.4058
413004 318,142 12507444 331856569 3208751 318.142 298.000 0 28.7111  5.4059 .
4117920 318,141 12507945 331858093 328751 318.141 298.000 0 28.7111  5.4059 Exclude the flrst
4211689 318.142 12508446 33.858620 328751 318.142 298.000 0 28.7111  5.4058
4204838 318.143 12508947 33.860833 328751 318.143 298.000 0 28.7111  5.4058
4218262 318.141 12500448 331859203 328751 318.141 208.000 0 28.7111  5.4058
4310319 318.141 12509049 33.858824 328751 318.141 208.000 0 28.7111  5.4058 two rows Of data
4312091 318.141 12510450 330858203 3208751 318.141 208.000 0 28.7111  5.4059
4314578 318.142 12510051 33857045 328751 318.142 208.000 0 28.7111  5.4059
4314992 318.143 12511452 330853973 3208751 318.143 298.000 0 28.7111  5.4080
4305372 70 318,143 12511953 330854884 328751 318.143 208.000 0 28.7111  5.4060
4305765 3181142 12512451 330855488 3208751 318.142 208.000 0 28.7111  5.4080
4305810 3181142 12512955 33855403 328751 318.142 298.000 0 28.7111  5.4080
4305809 70 3181142 12513456 33855701 3218751 318.142 298.000 0 28.7111  5.4060
4305448 3180141 12513957 33850083 3208751 318.141 298.000 0 28.7111  5.4058
4305505 318,142 12514458 33854918 328751 318.142 298.000 77. 17520 287111 5.4060
4315672 318,141 12514959 33.854527 328751 318.141 298.000 77. 17520 287111 5.4060
4305565 318,142 12515460 33.854978 3208751 318.142 298.000 77.243 B8.7520 28.7111  5.4060
« i v

Sample of Transient Data

# Time (minutes)
x=datal[:, 3]
x = x/1000/60

Data File Column Descriptions on page E - 3 identifies the columns of data recorded. The
fourth column of data contains time in milliseconds, however, the first index in Python is 0;
therefore,

data[:,3] captures all of the rows (:) in the fourth column.

plt.plot (x,y, 'ko")

plt.ylabel ('Pressure (Torr)')
plt.xlabel ('time (minutes)')
plt.show ()

The above code shows the syntax for plotting. The label 'ko'indicates filled black circles.
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DEGASSING AND CHEMISORPTION TEMPERATURE RAMP DATA

The same information provided above applies to capturing Flex data during degassing and during
chemisorption temperature ramping, except:

DEGAS DATA

This data is available during programmed in situ degas sent once per second. Connect to port
54100 (rather than port 54000 ) for in situ degas data (see Data Logging on page E - 1). The
data columns are:

time (ms)

manifold pressure (Torr)
manifold vacuum (Torr)
port 1 pressure (Torr)
port 1 temperature (C)
port 2 pressure (Torr)
port 2 temperature (C)
port 3 pressure (Torr)
port 3 temperature (C)

— T OMMOO >

CHEMISORPTION TEMPERATURE RAMP DATA

Flex data can be captured during chemisorption analyses by connecting to port 54200 (see Data
Logging on page E - 1). Time and sample temperature are sent every half second when the
external trigger is set to ON. This is typically done during a flowing preparation temperature ramp.
The data columns are:

= Time(s)
m Sample temperature (°C)

The External Trigger in the analyzer application must be enabled for this data to be available.

m To manually set the trigger go to Unit [n] > Enable Manual Control, right-click the External
Triggericon and select ON. The box is dark when enabled.

m Enable the Set external trigger box in a Preparation Flow Task in the Analysis Conditions to col-
lect temperature data that is synchronized with an external mass spectrometer or other
detector to be started by the external trigger signal.
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F DFT MODELS

Theories are developed by scientists in an attempt to explain a class of observed behavior. In the
experimental physical sciences, theories are often expressed in terms of a model that can be
visualized and described mathematically. Early models of physisorption were quite simple, both
conceptually and mathematically. For very practical reasons, hand computations were required.
Today we can explore complex models that describe adsorption systems on the atomic scale of
size and sub-picosecond time frame. This is not because scientists are smarter, but because of
available tools. The DFT models are created by classical approaches to adsorption as well as
models based on modern statistical thermodynamics.

MODELS BASED ON STATISTICAL THERMODYNAMICS

Included in this group are methods that model the adsorption system in terms of forces acting
between individual molecules.

THEORETICAL BACKGROUND

Traditional adsorption theories attempt to describe experimental adsorption isotherms with an
isotherm equation containing a small number of parameters. At a minimum, these parameters
include the extent of the surface, such as the monolayer capacity (V,,), and the molar intensity of
the gas-surface interaction, such as the Langmuir “K” constant or the BET “C” constant. In some
equations, additional parameters take into account the lateral interaction of adsorbed molecules
with each other. Other theories, such as the Dubinin-Astakhov approach, also include parameters
for the effect of adsorbent porosity.

Instead of this classical kinetic or phenomenological approach, we can use a molecular-based
statistical thermodynamic theory that allows us to relate the adsorption isotherm to the
microscopic properties of the system: the fluid-fluid and fluid-solid interaction energy parameters,
the pore size, the pore geometry, and the temperature.

The following example is given so that you may understand how such a theory is constructed:

A clean sample of a solid material containing slit-shaped pores of a single width is placed in an
evacuated space. ltis kept at a fixed temperature as a known quantity of pure argon gas is
admitted into the space surrounding the sample. The pressure within the space is recorded
over time. In this situation, the pressure falls rapidly from its initial value and gradually
approaches a steady reading, called the equilibrium pressure. The amount adsorbed
corresponds to the quantity of gas effectively removed from the gas phase by the solid
surface. A graph that plots amount adsorbed versus equilibrium pressure is called an
adsorption isotherm.
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Under such conditions, the argon atoms that randomly enter the pore space feel the presence
of the solid surface as the action of an external attractive force (the dispersion forces or Van
der Waal’s forces) and spend more time near the surface. As a result, the space near the
surface acquires a greater average density of argon atoms than regions farther removed.

If the equilibrium distribution of the gas atoms near the surface could be described as a
function of pressure and the molecular properties of the components of the system, then a
model could be constructed for the adsorption isotherm for the system. Modern physical
chemistry provides several ways to calculate this distribution. All these methods are based on
the fundamental thermodynamic law that such a system adopts a configuration of minimum
free energy at equilibrium. Also needed is a description of the pairwise interaction energy
between atoms, U(s), commonly given by a Lennard-Jones potential:

U(s) =4e(5)"? — (3)°
where

€ = a characteristic energy of the adsorptive,
o = the diameter of the adsorptive molecule, and
s = the separation distance.

MOLECULAR SIMULATION METHODS

Two simulation techniques are commonly used to determine the distribution of gas moleculesin a
system in equilibrium: the molecular dynamics method and the Monte Carlo method. Both of these
are used as reference methods because their results are considered exact.

MoLECULAR DyNAMICS METHOD

In the molecular dynamics method, the position and velocity of individual gas particles are
calculated over time at very short intervals. This method takes into account both the forces acting
between the gas particles themselves and those acting between the gas particles and the atoms
of the simulated surface. As the simulated particles collide with each other and with the surface,
the average concentration of particles in the space near the surface is calculated; this calculation
yields the amount of gas adsorbed.

This method can be thought of as a way to determine the chronological record of the movement of
each particle in the system using time steps of 10-14 seconds. Although the mathematics are
simple, the number of calculations required for a system of even a few hundred particles is
astronomical and challenges even the fastest computers.

Flex Series Operator Manual
350-42800-01 (Rev R) — Apr 2021



Iml micromeritics® Models Based on Statistical Thermodynamics

MONTE CARLO METHOD

In the Monte Carlo method, determination of the system equilibrium distribution begins with an
assumption (which may be only approximate) about the initial configuration of particles in the
system. The system is “equilibrated” through a process of randomly selecting one particle and
conditionally moving it a random distance in a random direction.

If the move results in a configuration of lower total energy, then the move is completed and
another particle is randomly selected to be moved.

If the move results in a configuration of higher energy, a probability for that event is calculated,
and a random number between zero and one is generated. If the generated number is smaller
than the probability of the event, then the move is accepted; otherwise, another particle is selected
and the process is repeated. This process continues until the average total energy of the system
no longer decreases; at this point, average configuration data are accumulated to yield the mean
density distribution of particles in the system.

Monte Carlo simulations require considerably less computation time than molecular dynamic
simulations and can yield the same results; however, neither method provides a really practical
way to calculate complete isotherms.

DENSITY FUNCTIONAL FORMULATION

Density functional theory offers a practical alternative to both molecular dynamic and Monte Carlo
simulations. When compared to reference methods based on molecular simulation, this theory
provides an accurate method of describing inhomogeneous systems yet requires fewer
calculations. Because the density functional theory provides accuracy and a reduced number of
calculations, it is the basis embodied in the DFT models.

The system being modeled consists of a single pore represented by two parallel walls separated
by a distance H. The pore is open and immersed in a single component fluid (adsorptive) at a fixed
temperature and pressure. Under such conditions, the fluid responds to the walls and reaches an
equilibrium distribution. In this condition (by the definition of equilibrium), the chemical potential at
every point equals the chemical potential of the bulk fluid. The bulk fluid is a homogenous system
of constant density; its chemical potentiall) is determined by the pressure of the system using
well-known equations. The fluid near the walls is not of constant density; its chemical potential is
composed of several position-dependent contributions that must total at every point to the same
value as the chemical potential of the bulk fluid.

1) Chemical potential may be thought of as the energy change felt by a probe particle when it is
inserted into the system from a reference point outside the system. It can also be defined as the
partial derivative of the grand potential energy with respect to density (or concentration).
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As noted previously, at equilibrium, the whole system has a minimum (Helmholtz) free energy,
known thermodynamically as the grand potential energy (GPE). Density functional theory
describes the thermodynamic grand potential as a functional of the single-particle density
distribution; therefore, calculating the density profile that minimizes the GPE yields the equilibrium
density profile. The calculation method requires the solution of a system of complex integral
equations that are implicit functions of the density vector. Since analytic solutions are not possible,
the problem must be solved using iterative numerical methods. Although calculations using these
methods still require supercomputing speed, the calculation of many isotherm pressure points for
a wide range of pore sizes is a feasible task. The complete details of the theory and the
mathematics can be found in the papers listed under DFT Model References on page F - 17.

The following graphs and accompanying text illustrate the results of using density functional
theory to predict the behavior of a model system.

Figure 1 shows the density profile for argon at a carbon surface as calculated by density functional
theory for a temperature of 87.3 K and a relative pressure of about 0.5.

0.2 Density (particle A-3)
0.15 -
0.1 4 Figure 1. Density Profile for Argon on
] Carbon at 87.3 K and a Relative
1 Pressure of 0.5
0.05
0 |/ T T |\||/|\| T T T T T T T
0 5 10 15 20
Distance from wall in A

This figure represents a cross-section of the region near the surface. Note the layerwise
distribution of adsorbate; the first monolayer is sharply defined and a third layer can be
distinguished. The area under the profile curve represents the amount adsorbed per unit area at
this pressure. The positions of the maxima are separated by a distance determined by the size of
the adsorptive atom.
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Given the density profile, the amount adsorbed at the stated pressure can be easily calculated as
the integral over the profile. Repeating this calculation over a range of pressures yields the
adsorption isotherm for the model. If the value of H is very large, the isotherm obtained
corresponds to that of an external, or free, surface. If H is smaller, a range of pressures is reached
where two minima exist for the grand potential, showing the presence of two metastable phases
having different density distributions but the same chemical potential. The phase with the lower
GPE is the stable one. As the pressure is increased, a point is reached where the other phase
becomes the stable one. This phase transition reflects condensation of adsorbate in the pore; the
pressure at which it occurs is called the critical pore-filling pressure. This pressure is analogous to
the condensation pressure predicted by the Kelvin equation in the classical model of pore filling.

Figure 2 shows how the profiles change with pressure for a model pore with H = 40 angstroms.
The inset shows the density profiles for the corresponding points of the isotherm.

Volume Adsorbed (em? STP ni?)

J d'd/

] Figure 2. Model Isotherm for Argon at
87.3 K in a 40 A Slit in a Carbon
Substrate

T
0.01 0.1 1 10 100 1000

Pressure in Torr

The profiles show the density distribution from one wall to the center of the slit; the other half of the
distribution is a mirror image of the profile shown.

As the pressure is first increased from zero, almost all the adsorbed atoms occupy a position close
to the surface.

m Inset a shows the profile corresponding to point a on the isotherm where the surface is about
half covered.

m At point b, the first layer is so full that it is more favorable for atoms to start a new layer.

= At point ¢, a third layer is forming. Point ¢, for this size slit, is the critical pore-filling pressure. In
inset ¢, the profile shows the density decreasing to near zero (actually the bulk gas density) at 4
or 5 molecular diameters from the surface.

= Inset d shows the profile converging on a density similar to that of bulk liquid argon in the center
of the pore, indicating a phase transition.

Flex Series Operator Manual
350-42800-01 (Rev R) — Apr 2021



F DFT Models

[M] micromeritics®

Note that the adsorption isotherms for pores larger than the one shown in the previous graph is
identical up to point ¢. The lower branch of the isotherm simply continues to a higher pressure for
larger pores. This trend is illustrated in the Figure 3, where isotherms for some larger size pores
are shown. Itis clear that pore size is uniquely characterized by a corresponding critical pore-
filling pressure. At large pore sizes, density functional theory produces results for the critical filling
pressures that are in good agreement with those produced by the Kelvin equation.

Volume Adsorbed (em3 STP m2)
90 ] 543.7 A
15 4
104 25244 | |
5 11714 n
] 54.3A |
] 25.2A L
0 T T T T T T T
0 100 200 300 400 500 600 700
Pressure in Torr

Figure 3. Model Isotherms for Some
Larger Pore Widths Argon on Carbon at
87.3K

Figure 4 shows model isotherms for pores in the micropore size range. Note the logarithmic scale

for pressure.

Volume Adsorbed ( cm?® STP mi®)
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T
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Figure 4. Model Isotherms in the
Micropore Size Range of Pore Width
Argon on Carbon at 87.3 K
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Pores of 4 A width, barely larger than the argon atom (3.38 A), fill at pressures below 1 millitorr.
Pores below 15 A fill before a monolayer is completed on the surface of the larger pores. In the
micropore size range, the pore volume fills more gradually with pressure and the total shape of the
isotherm is important in characterizing the pore size.

Models Included

Non-Local Density Functional Theory with Density-Independent Weights

N2 - DFT Model
AR - DFT Model

Geometry: Slit

Substrate: Carbon (graphite)
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Using the methods of non-local density functional theory, two sets of isotherms have been
calculated to serve as kernel functions for the characterization of porous solids from adsorption
data. The model isotherms are stored in binary format files. These models assume a slit-like pore
geometry. The pore size range from 4.0 to 4000 A is covered in 91 classes in a geometric
progression. The class intervals are rounded to the nearest 0.02 molecular diameters. A model for
the free or external surface is included to account for unfilled pores. Each of the 92 model
isotherms has been calculated at 181 pressure points from near 1x10 to near 1.00 relative
pressure.

These models are identical to those supplied with the original DOS version of DFT software.
Some slight difference from the DOS results may be noted when they are applied to the same
data due to improvements in the deconvolution algorithm and better regularization of the current
software.

Non-Local Density Functional Theory with Density-Dependent Weights

N2 - Modified Density Functional

Geometry: Free surface
Substrate: Surface energy
Method: Nitrogen at 77K
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Using the modified Tarazona prescription described by Olivier (see DFT Model References on
page F - 17 [items 3 and 4]), model isotherms were calculated for a wide range of adsorptive
energies to a relative pressure of 0.6. The model makes no provision for pore filling in the
micropore region. If the sample solid contains small mesopores, the isotherm data should be
truncated (using the Select Data Points window) to a suitably low relative pressure to avoid trying
to fit this region; mesopore filling reports as a large area of low energy in the calculated distribution
of adsorptive potential.

The surface energy is reported in terms of the effective Lennard-Jones interaction parameter, i.e.,
for the adsorptive / adsorbent pair divided by Boltzmann constant. The units are therefore Kelvin.

N2 - Cylindrical Pores - Oxide Surface
AR - Cylindrical Pores - Oxide Surface

Geometry: Cylinder

Substrate: Oxide
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K

Model isotherms were calculated using a combination of statistical mechanical calculations and
experimental observations for macroporous silicas and MCM-41 mesoporous silicas as well as
zeolites. The pore-filling pressures were determined as a function of the pore size from adsorption
isotherms on MCM-41 materials characterized by X-ray and other techniques. The variation of the
pore fluid density with pressure and pore size has been accounted for by density functional theory
calculations. The N2 model reports pore sizes ranging from 3.8 to 387 A and the AR model from
3.8 to over 500 angstroms.

References: M. Jaroniec, M. Kruk, J.P. Olivier, and S. Koch, “A New Method for the
Accurate Pore Size Analysis of MCM-41 and Other Silica-Based Meso-
porous Materials,” Proceedings of COPS-V, Heidelberg, Germany (1999).

N2 - Cylindrical Pores — Pillared Clay Surface (Montmorillionite)

Geometry: Cylinder
Substrate: Crystalline Silicate
Category: Porosity

Method: Nitrogen at 77K

Model isotherms were calculated using a combination of statistical thermodynamic Non-Local
Density Functional Theory (NLDFT) calculations and experimental isotherms for reference
samples of montmorillionite. The construction method for the hybrid models was analogous to that
described in the first reference below (Jaroniec et al,1999). The additional references add
additional theoretical details as well as examples of the application of the model to pillared clay
catalysts. This model reports pore widths from 3.8 to 387 angstroms.
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References:

C02 - DFT Model

Geometry:
Substrate:
Category:
Method:

Mietec Jaroniec, Michal Kruk, James P. Olivier and Stefan Koch, “A New
Method for the Characterization of Mesoporous Silicas,” Proceedings of
COPS-V, 1999, Studies in Surface Science, Vol 128, Characterization of
porous Solids V', Unger, et al, Eds, Elsevier, Amsterdam, 2000.

James P. Olivier and Mario L. Occelli, “Surface Area and Microporosity of
a Pillared Interlayered Clay (PILC) from a Hybrid Density Functional
Theory (DFT) Method,” The Journal of Physical Chemistry B; 2001, 105
(3), 623-629.

M. L. Occelli, J. P. Olivier, J. A. Perdigon-Melon, and A. Auroux, “Surface
Area, Pore Volume Distribution, and Acidity in Mesoporous Expanded
Clay Catalysts from Hybrid Density Functional Theory (DFT) and
Adsorption Microcalorimetry Methods,” Langmuir 2002, 18, 9816-
9823.9b.

James P. Olivier, “The Importance of Surface Heterogeneity in
Developing Characterization Methods.” 61" International Symposium on
the Characterization of Porous Solids, Studies in Surface Science and
Catalysis 144, Elsevier, 2002.

James P. Olivier and Mario L. Occelli, “Surface Area and Microporosity of
Pillared Rectorite Catalysts from a Hybrid Density Functional Theory
Method,” Microporous and Mesoporous Materials 2003, 57, 291-296.

Slit

Carbon

Porosity

Carbon dioxide at 273 K

Model isotherms were calculated using the non-local prescription of Tarazona, employing
molecular parameters derived from the known bulk properties of carbon dioxide.

AR - Modified Density Functional Model

Geometry:
Substrate:
Category:
Method:

Free surface
Any

Surface energy
Argon at 87K

This model was produced in the same manner as the N2 Modified Density Functional model listed
earlier, except applicable to argon adsorbed at 87.3 K.

N2 - Tarazona NLDFT, Esf = 30.0K
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Geometry: Cylinder

Substrate: Oxide
Category: Porosity
Method: Nitrogen at 77K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and a cylindrical pore geometry. The wall potential used is k = 30 K, typical for
a silica or alumina surface.

This model file is particularly useful for sizing zeolites or zeolite containing materials that have
substantial micropore volume. The reported pore size range is 3.8 to 387 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

N2 - Carbon Slit Pores by NLDFT
Ar - Carbon Slit Pores by NLDFT

Geometry: Slit

Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and a slit-like pore geometry. These models are slightly different from N2-DFT
and Ar-DFT models that were calculated using NLDFT with density independent weighting
functions.

The reported pore size range is from 3.5 to 1000 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

N2 - Carbon Finite Pores, As=6, 2D-NLDFT
Ar - Carbon Finite Pores, As=6, 2D-NLDFT

Geometry: Finite Slit

Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K
F_10 Flex Series Operator Manual
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Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions assuming 2D model of finite slit pores having a diameter-to-width aspect ratio
of 6.

This model is particularly useful for microporous carbon materials. The reported pore size range is
from 3.5 to 250 angstroms.

References: Jacek Jagiello and James P. Olivier. “A simple two-dimensional NLDFT
model of gas adsorption in finite carbon pores. Application to pore
structure analysis.,” The Journal of Physical Chemistry C, 113(45):19382-
19385, 2009.

N2 - Carbon Finite Pores, As=12, 2D-NLDFT
Ar - Carbon Finite Pores, As=12, 2D-NLDFT

Geometry: Finite Slit

Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K

Model isotherms were calculated using the same methods and assumptions that were used in the
model above except in this model, the aspect ratio is equal to 12.

These two finite pore models may be used as a research tool in conjunction with independent
analytical techniques such as high-resolution transmission electron microscopy (HRTEM) and/or
X-ray diffraction (XRD) to obtain comprehensive information about the structure of studied carbon
material.

References: Jacek Jagiello and James P. Olivier. “A simple two-dimensional NLDFT
model of gas adsorption in finite carbon pores. Application to pore
structure analysis.,” The Journal of Physical Chemistry C, 113(45):19382-
19385, 2009.

N2 - Carbon Cylinder, single-wall nanotube by NLDFT
Ar - Argon Cylinder, single-wall nanotube by NLDFT

Geometry: Cylinder

Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K
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Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gas molecule and the graphitic surface of an
infinitely long cylinder.

This model is particularly useful for characterizing carbon single-wall nanotubes. The reported
pore size range is from 3.5 to 1000 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

N2 - Carbon Cylinder, multi-wall nanotube by NLDFT
Ar - Argon Cylinder, multi-wall nanotube by NLDFT

Geometry: Cylinder

Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gas molecule and multiple concentric graphitic
surfaces of infinitely long cylinders.

This model is particularly useful for characterizing carbon multi-wall nanotubes. The reported pore
size range is from 3.5 to 1000 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987)

Ar - Zeolites H-Form by NLDFT

Geometry: Cylinder
Substrate: Zeolite
Category: Porosity
Method: Argonat77 K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gas molecule and the oxide surface of an
infinitely long cylinder.
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This model is particularly useful for characterizing oxides and H+ and (NH4)+ exchanged zeolites.
The reported pore size range is from 3.5 to 300 angstroms.

Ar - Zeolites Me-Form by NLDFT

Geometry: Cylinder
Substrate: Zeolite
Category: Porosity
Method: Argonat77 K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gas molecule and the oxide surface of an
infinitely long cylinder.

This model is similar to the model above, but it more appropriate is for characterizing alkali metal
exchanged zeolites. The reported pore size range is from 3.5 to 300 angstroms.

MoODELS BASED ON CLASSICAL THEORIES

Both surface energy distribution and pore size distribution may be evaluated using classical
approaches to model kernel functions for use with equation (1) of the DFT Theory. The
Calculations document can be found on the Micromeritics web page (www.Micromeritics.com). Be
aware that the deconvolution method only provides a fitting mechanism; it does not overcome any
inherent shortcomings in the underlying theory.

SURFACE ENERGY

The use of classical theories to extract adsorptive potential distribution is mostly of historical
interest. At a minimum, the equation must contain a parameter dependent on adsorption energy
and another dependent on monolayer capacity or surface area. This is sufficient to permit the
calculation of the set of model isotherms that is used to create a library model. The Langmuir
equation has been used in the past, as have the Hill-de Boer equation and the Fowler-
Guggenheim equation. All of these suffer from the fact that they only describe monolayer
adsorption, whereas the data may include contributions from multilayer formation.
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PORE SIZE

It is well established that the pore space of a mesoporous solid fills with condensed adsorbate at
pressures somewhat below the prevailing saturated vapor pressure of the adsorptive. When
combined with a correlating function that relates pore size with a critical condensation pressure,
this knowledge can be used to characterize the mesopore size distribution of the adsorbent. The
correlating function most commonly used is the Kelvin equation. Refinements make allowance for
the reduction of the physical pore size by the thickness of the adsorbed film existing at the critical
condensation pressure. Still further refinements adjust the film thickness for the curvature of the
pore wall.

The commonly used practical methods of extracting mesopore distribution from isotherm data
using Kelvin-based theories, such as the BJH method, were for the most part developed decades
ago and were designed for hand computation using relatively few experimental points. In general,
these methods visualize the incremental decomposition of an experimental isotherm, starting at
the highest relative pressure or pore size. At each step, the quantity of adsorptive involved is
divided between pore emptying and film thinning processes and exactly is accounted for. This
computational algorithm frequently leads to inconsistencies when carried to small mesopore
sizes. If the thickness curve used is too steep, it finally will predict a larger increment of adsorptive
for a given pressure increment than is actually observed; since a negative pore volume is non-
physical, the algorithm must stop. Conversely, if the thickness curve used underestimates film
thinning, accumulated error results in the calculation of an overly large volume of (possibly
nonexistent) small pores.

The use of equation (1) represents an improvement over the traditional algorithm. Kernel
functions corresponding to various classical Kelvin-based methods have been calculated for
differing geometries and included in the list of models.

MODELS INCLUDED

Kelvin Equation with Halsey Thickness Curve

N2 - Halsey Thickness Curve

Geometry: Slit
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The kernel function is calculated using the Halsey equation with standard parameters:

1/3
_ —5.00
t=3.54 (—ln(P/PO) )

The nitrogen properties used in the Kelvin equation are:
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Surface tension= 8.88 dynes cm"’
Molar density = 0.02887 gcm™

N2 - Halsey Thickness Curve

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The calculation is the same as above except that cylindrical geometry is assumed.

Reference: G. Halsey, J. Chem. Phys 16, 931 (1948).

Kelvin Equation with Harkins and Jura Thickness Curve

N2 - Harkins and Jura Thickness Curve

Geometry: Slit
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The kernel function is calculated using the Harkins and Jura equation with standard parameters:

1/2
_ 13.99
t=3.54 ( 0.034—log(P/Py) )

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm™!
Molar density = 0.02887 gcm
Geometry: Cylinder

Substrate: Average

Category: Porosity

Method: Nitrogen 77 K

The calculation is the same as above except that cylindrical geometry is assumed.

References: W. D. Harkins and G. Jura, J.A.C.S. 66, 1366 (1944).
J. H. DeBoer et al., J. Colloid and Interface Sci. 21, 405 (1966).
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Kelvin Equation with Broekhoff-de Boer Thickness Curve

N2 - Broekhoff-de Boer Model

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The kernel function is calculated using the Broekhoff-de Boer equation with standard parameters:
_ _ t
log (p/po) _ 1:;.11 1 0.1682-01137
The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm™!
Molar density = 0.02887g cm™

N2 - Broekhoff-de Boer Model

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The calculation is similar to the above except that cylindrical geometry is assumed, and the film
thickness depends on pore size (see reference).

References: Specifically, equations 20 and 21 in: J.C.P. Broekhoff and J.H. de Boer,
“The Surface Area in Intermediate Pores,” Proceedings of the Inter-
national Symposium on Surface Area Determination, D.H. Everett, R.H.
Ottwill, eds., U.K. (1969).
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DFT MODEL REFERENCES

The papers listed below provide additional information on DFT models:

1. “Determination of Pore Size Distribution from Density Functional Theoretic Models of
Adsorption and Condensation within Porous Solids,” J.P. Olivier and W.B. Conklin, Micro-
meritics Instrument Corp; presented at the International Symposium on the Effects of Sur-
face Heterogeneity in Adsorption and Catalysts on Solids, Kazimierz Dolny, Poland (July
1992).

2. “Classification of Adsorption Behavior: Simple Fluids in Pores of Slit-shaped Geometry,”
Perla B. Balbuena and Keith E. Gubbins, Fluid Phase Equilibria, 76, 21-35, Elsevier
Science Publishers, B.V., Amsterdam (1992).

3. “Modeling Physical Adsorption on Porous and Nonporous solids Using Density Functional
Theory,” J.P. Olivier, Journal of Porous Materials, 3, 9-17 (1995).

4. “The Determination of Surface Energetic Heterogeneity Using Model Isotherms Calculated
by Density Functional Theory,” J.P. Olivier; presented at the Fifth International Conference
on the Fundamentals of Adsorption, Pacific Grove, CA (1995).
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EI micromeritics® G Exported Data Example

G EXPORTED DATA EXAMPLE

This exported data has been truncated for this manual.

Sample Information

Method: $
Sample: Pt-Al Ref Matl with CO Run 1
Operator: jch
Submitter:
Mass type: Calculated
Empty tube: 34.6494 g
Sample + tube: 35.3873 g
Sample mass: 0.7379 g
Density: 1.000 g/cm3
Type of data: Automatically collected
Instrument type: 3500 Chemi
Original instrument type: 3500 Chemi
Comments:
Active Metals Table
Percent
of Percent
Atomic Cross
Sect Density Sample Reduced Mx0y Mx0y
Element Atomic Weight Area (nm2?) (g/cm3) Mass (%)
(%)XY
chromium 51.9960 0.0635 7.190 0.00 -
100.00 1 0
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Adsorptive Stoichiometry
Hydrogen 2.000
Oxygen 2.000
Carbon Monoxide 1.500
Helium 1.000
cobalt 58.9330 0.0662 8.900 0.00 -
100.00 1 0
Adsorptive Stoichiometry
Hydrogen 2.000
Oxygen 2.000
Carbon Monoxide 1.500
Helium 1.000
copper 63.5400 0.0680 8.960 0.00 =
100.00 1 0
Adsorptive Stoichiometry
Hydrogen 2.000
Oxygen 2.000
Carbon Monoxide 1.500
Helium 1.000
molybdenum 95.9400 0.0730 10.220 0.00 :
100.00 1 0
Adsorptive Stoichiometry
Hydrogen 2.000
Oxygen 2.000
Carbon Monoxide 1.500
Helium 1.000
nickel 58.7100 0.0649 8.902 0.00 -
100.00 1 0
Adsorptive Stoichiometry
G-2 Flex Series Operator Manual
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G Exported Data Example

Hydrogen

Oxygen

Carbon Monoxide
Ethylene

palladium 106.4000

100.00 1 0
Adsorptive
Hydrogen
Oxygen
Carbon Monoxide
Helium

platinum 195.0900

100.00 1 0
Adsorptive
Hydrogen
Oxygen
Carbon Monoxide
Helium

rhenium 186.2000

100.00 1 0
Adsorptive
Hydrogen
Oxygen
Carbon Monoxide
Helium

rhodium 102.9050

100.00 1 0
Adsorptive

Hydrogen

2.000
2.000
1.500
1.000

0.0787

Stoichiometry
2.000
2.000
1.500
1.000

0.0800

Stoichiometry
2.000
2.000
1.000
1.000

0.0649

Stoichiometry
2.000
2.000
1.500
1.000

0.0752

Stoichiometry

2.000

12.020 0.00 =
21.450 0.50 =
21.020 0.00 :
12.410 0.00 :
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Oxygen
Carbon Monoxide

Helium

silver 107 .8680
100.00 1 0

Adsorptive
Hydrogen

Oxygen

Carbon Monoxide

Helium

Analysis Conditions

Analysis conditions:
Pre-analysis evacuation time:
Repeat analysis:

Repeat analysis evacuation time:

Equilibration time:

Adsorptive:

Maximum manifold pressure:

Therm. tran. hard-sphere diameter:
Molecular cross-sectional area:
Adsorbate molecular weight:

Mass flow constant:

Thermal conductivity:

2.000
1.500
1.000

0.0869 10.500

Stoichiometry
2.000
2.000
1.500
1.000

Pt-Al Ref Matl with CO
0.50 h
Yes

1.00 h

Carbon Monoxide (CO)
123.323 kPa

3.5900 A

0.125 nm?

28.01

1.000

1.00

0.00
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G Exported Data Example

Gas blend:
Fluid properties:

Dosing method:

No

T:\fpilversion 3\carbon monoxide.fpi

Normal

Pressure Table

Starting Pressure Dose
Pressure Increment Amount

(kpa) (kPa) (mmol/g)
0.0000000

13.3322400 6.6661200

Preparation Options

Equilibration

Interval (s)

20
20

Backfill and match transducer: Yes
Backfill gas: Nitrogen
Evacuation rate: 6.67 kPa/s
Unrestricted evac. from: 4.00 kPa
Vacuum Level: 6.7e-03 kPa

Evacuation time:

0.10 h

Analysis Task 1 - Evacuation

Evacuate for 30 min

Evacuation rate:

Unrestricted evacuation pressure:
Temperature:

Temperature rate:

Analysis Task 2 - Flow

below 2.7e-03 kPa.

6.67 kPa/s
4.00 kPa
110.0 °C
10.0 °C/min

Ending
Pressure

(kPa)

13.3322400
59.9950800
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Gas: Hydrogen
Flow rate: 50.0 cm3® STP/min
Time: 10 min
Temperature: 100.0 °C
Temperature rate: 10.0 °C/min
Set external trigger: No

Analysis Task 3 - Flow

Gas: Hydrogen
Flow rate: 50.0 cm3® STP/min
Time: 30 min
Temperature: 400.0 °C
Temperature rate: 10.0 °C/min
Set external trigger: Yes

Analysis Task 4 - Evacuation

Evacuate for 30 min

Evacuation rate:

Unrestricted evacuation pressure:
Temperature:

Temperature rate:

below 2.7e-03 kPa.
6.67 kPa/s

4.00 kPa

400.0 °C

10.0 °C/min

Analysis Task 5 - Evacuation

Evacuate for 10 min

Evacuation rate:

Unrestricted evacuation pressure:
Temperature:

Temperature rate:

below 2.7e-03 kPa.
6.67 kPa/s

4.00 kPa

35.0 °C
100.0 °C/min
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Analysis Task 6 - Leak Test

Outgas rate 1limit: 1.3e-03 kPa/min
Temperature: 35.0 °C
Temperature rate: 10.0 °C/min

Free Space Options

Free space type: Measure after analysis
Evacuation time: 1.00 h

Estimated ambient free space: 12.2664 cm?

Estimated analysis free space: 12.1432 cm?

Temperature Options

Temperature control: Furnace
Analysis temperature: 35.0 °C
Temperature rate: 10.0 °C/min

Dosing Options

Absolute pressure tolerance: 0.6666 kPa
Relative pressure tolerance: 5.0 %
Low pressure equilibration delay
Minimum: 0.00 h
Maximum: 999.00 h

Termination Options

Backfill after analysis: Yes
Backfill gas: Nitrogen
Cool to < 50 °C: Yes
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Report Options

Report options:

Show report title: No

Show graphic: No

Use thermal transpiration correction: Yes
Inside diameter of sample tube: 9.000 mm

Isotherm: Yes

Tabular report selected:

Plot report selected:

X-axis scale:

Plot analysis:

Plot repeat analysis:

Isotherm Plot Options

Plot curve:

Plot points:
Overlay samples:
Autoscale X axis:

Autoscale Y axis:

Difference Method: Yes

Yes
Yes
No

Yes

Yes

Yes
Yes
Linear
Yes

Yes

Pt-Al Ref Matl with CO
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H FREE-SPACE CORRECTION

Free space is that volume of the sample tube which is unoccupied by the sample. The quantity of
gas dosed into the sample tube is calculated from the difference in pressures in the manifold
before and after the dose is delivered. The quantity of gas adsorbed by the sample is calculated
by subtracting the quantity of gas remaining in the free space of the sample tube after equilibrium
is established from the quantity of gas originally dosed into the sample tube. Free space must be
determined accurately to obtain a precise value for quantity adsorbed.

Static-volumetric systems consist basically of a gas manifold joined to a sample tube by an
isolation valve. The manifold section has connections for an absolute pressure transducer, a
temperature gauge, and a vacuum system. It also has inlets for the adsorptive gas and helium. A
Dewar flask containing a cryogenic liquid (usually LN, at approximately 77 K) is situated so that it
can be raised to immerse most of the sample tube. Two temperature zones exist within the
sample tube when immersed in the cryogenic bath: a warm zone (the volume above the liquid
level and near ambient temperature) and a cold zone (the volume below the liquid level at
cryogenic temperature). Not only must the total free space volume be determined, but it also is
necessary to determine the quantity of gas residing within the “cold” zone since a nonideality
correction must be applied to only that quantity of gas.

The total quantity of gas in the partly immersed sample holder cannot simply be determined using
n = PV/RT because temperature is not constant over the total volume, but instead is distributed as
two temperature zones with a steep temperature gradient between them. A convenient method for
resolving this problem is to derive two factors which, for the existing temperature profile, can be
multiplied by the prevailing pressure to reveal the molar volume of gas contained in the cold zone
and the total quantity residing in the free volume of the immersed sample holder (the analysis free
space).

The analyzer provides the following methods for free space determination:

m Measure
m Calculate
m Enter

MEASURE

Generally, this method, although requiring a little more time (approximately 10 minutes), is the
most preferred one for determining free space. It is simple, automatic, requires very little
information, and essentially is error-proof. With this method, the instrument first evacuates the
manifold and sample tube (containing sample), then isolates the sample tube by closing the valve.
Then the manifold is charged with helium, the pressure measured, and the valve opened allowing
the helium to expand into the sample tube at ambient temperature. Again the pressure is
measured.
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The Dewar is raised and the sample tube is cooled to cryogenic temperature. Again pressure
drops; when pressure has equilibrated, the value is recorded. Ambient and analysis free spaces
are calculated from (1) system volume, (2) system, ambient, and bath temperatures, and (3)
measured pressures. From these, the value of the portion of analysis free space at cryogenic
temperature which requires correction for nonideality can be determined.

This method may be undesirable if:

= Helium is unavailable. Free space determination by the analyzer requires the use of helium.

m Analysis speed is a major factor. A helium free space measurement of 10 to 15 minutes is
required.

m The sample tends to absorb and retain helium for a prolonged period of time or if it adsorbs
helium.

CALCULATE

This method is the most rapid and efficient way of compensating for free space. Ensure the
following is accomplished:

Perform a blank analysis on the sample tube.

Load the blank analysis file data into the sample tube file.

Enter the analysis bath temperature (found on the p° and Temperature window).
Enter the sample mass and density (found on the Sample Description tab).

ENTER

This method allows for entering predetermined values for the ambient and analysis free spaces.
The values to enter may be obtained in one of two ways:

m A pre-analysis free space calibration of the sample tube containing sample.
m The total free space of an empty sample tube is measured and the displacement of the sample
calculated from its mass and density and subtracted from the total free space.

In either procedure, ensure that the level (or, in cases where the Isothermal Jacket is used, the
effective level) of the cryogen bath on the sample tube is the same when the analysis is performed
as it was when gathering data for free space calculations.
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| Gas Charts

I GAS CHARTS

RELATIVE THERMAL CONDUCTIVITY OF GASES

Name Chemical Formula | Conductivity (Relative to Air)
Air 1.00
Ammonia NH3 0.92
Argon Ar 0.68
Butane C4H1o 0.60
Carbon Dioxide CO, 0.62
Carbon Monoxide CO 0.97
Ethane CoHg 0.79
Helium He 5.84
Hydrogen Ho 7.07
Krypton Kr 0.37
Methane CHy 1.29
Neon Ne 1.87
Nitric Oxide NO 0.99
Nitrogen Ny 1.00
Nitrogen Dioxide NO, or NoOy 1.51
Nitrous Oxide N,O 0.65
Oxygen O, 1.02
Sulfur Dioxide SO, 0.38
Water Vapor H,O 0.67

Flex Series Operator Manual
350-42800-01 (Rev R) — Apr 2021




| Gas Charts [M] micromeritics®

TyPICAL GASES USED

Flow Rate of 50 cm3/min

Test Preparation Carrier Loop Other
Gas Gas Gas
TPR Experiment Argon 10% Hy in N/A
Calibration N/A Argon Argon TCD Level Calibration
Helium or
TPD Ammonia 15% NH3 in N/A
Helium Helium
o NH3in o
Calibration N/A : TCD Level Calibration
Helium
p :
TPD Hydrogen 10A/;’ Eﬁ n N/A Calibration
9 Argon 10% Ho
Calibration N/A cM21N 1 1¢p Level Calibration
Argon
10% O5in
TPD Oxygen Helium . N/A
Helium 10% On i
Calibration N/A ° 22N 10D Level Calibration
Helium
TPO Experiment Helium 10% _02 in N/A
Calibration N/A Helium Helium | TCD Level Calibration
H; Pulse Araon 10% Hy in
Chemisorption 10% H, in g Argon
CO Pulse Argon . 10% COin
. . Helium )
Chemisorption Helium
Calibration | Not Required
BET Surface Area Helium
30% N2in N/A User-defined manual injec-
Calibration N/A Helium tions of N5 (0.5, 1.0, 1.5,
and 2.0 cm?)
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GAS CONVERSION CONSTANTS

Dynamic analysis uses a Mass Flow Controller (MFC) to control the flow of gases. The MFC
requires a conversion constant for each gas or gas mixture to compensate for variations in gas
flows resulting from variations in the properties of gases. A default gas table containing MFC
conversion constants is included on the Options menu. The following table provides a more
complete list of gases and their conversion constants.

Gas Conversion Constants for the MFC

Gas Symbol MFC C()(r;l\;e;s:%ra (()Zi)onstant
Acetylene CoHy 0.6535
Air (mixture) 0.9901
Allene C3Hy 0.4752
Ammonia NH3 0.7822
Argon Ar 1.3861
Arsine AgH3 0.7525
Boron Trichloride BCl; 0.4356
Boron Trifluoride BF3 0.5743
Bromine Pentafluoride BrFs 0.2871
Bromine Trifluoride BrF4 0.4356
Butane C4Hqg 0.2871
Butene CyHg 0.3267
Carbon Dioxide CO, 0.7723
Carbon Monoxide CO 0.9802
Carbon Tetracloride CCly 0.3465
Carbon Tetrafluoride CF4 0.4752
Carbonyl Fluoride COF, 0.2673
Carbonyl Sulfide Cos 0.6733
Chlorine Cly 0.8218
Chloroform CHCl3 0.4356
Chlorine Trifluoride CIF3 0.4257
Cyanogen CoNy 0.4950
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Gas Conversion Constants for the MFC (continued)

Gas

Symbol

MFC Conversion Constant

(H, =1.000)
Cyclopropane C3Hg 0.5050
Deuterium D, 0.9901
Diborane BoHg 0.5446
Dichlorosilane SiH,Cl, 0.4356
Dimethylamine (CH3)oNH 0.6634
Dimethylether (CH3),0 0.5842
Ethane CoHg 0.5446
Ethyl Chloride C,H5Cl 0.2871
Ethylene CoHy 0.6139
Ethylene Oxide CoH40 0.5842
Fluorine Fs 0.9208
Fluroform CHF3 0.5644
Freon 11 CCl3F 0.3762
Freon 12 CCl5F, 0.3861
Freon 13 CCIF4 0.4257
Freon 13 B1 CBrF3 0.4059
Freon 14 CF4 0.4703
Freon 21 CHCI,F 0.4554
Freon 22 CHCIF, 0.5050
Freon 23 CHF3 0.5644
Freon 113 CCI,F-CCIF, 0.2277
Freon 114 CCIyF4-CCIF, 0.2554
Freon 115 CCIF,-CF3 0.2713
Freon 116 CF3-CF4 0.2277
Germane GeHy 0.6436
-4 Flex Series Operator Manual
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Gas Conversion Constants for the MFC (continued)

Gas Symbol MFC C()(r;l\;e;s:%ra (()Zi)onstant
Helium He 1.3762
Hexamethyldisizane HMDS 0.1386
Hydrogen Ho 1.0000
Hydrogen Bromide HBr 0.9703
Hydrogen Chloride (Dry) HCI 0.9802
Hydrogen Fluoride HF 0.9901
Hydrogen lodide HI 0.9505
Hydrogen Selenide HoSe 0.8317
Hydrogen Sulfide H,S 0.8416
Isobutane C4Hqg 0.3069
Isobutylene CyHg 0.3366
Krypton Kr 1.3762
Methane CHy 0.8020
Methylamine CH3NH, 0.5644
Methyl Bromide CH3Br 0.6436
Methyl Chloride CH3Cl 0.6832
Methyl Fluoride CH3F 0.7525
Methyl Mercaptan CH4S 0.5842
Neon Ne 1.3861
Nitric Oxide NO 0.9901
Nitrogen Ny 0.9950
Nitrogen Dioxide NO, 0.7525
Nitrogen Trioxide N,O3 0.4356
Nitrogen Trifluoride NF3 0.5446
Nitrous Oxide N,O 0.7426
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Gas Conversion Constants for the MFC (continued)

Gas

Symbol

MFC Conversion Constant

(H2 = 1.000)
Oxygen O, 0.9802
Ozone O3 0.7327
Pentaborane BsHg 0.2871
n Pentane CgHq2 0.2376
Perchloryl Fluoride CIOsF 0.4455
Phosgene COCl, 0.5050
Phosphine PH3 0.7822
Phosphorous Pentafluoride PFg 0.3465
Propane C3Hg 0.3861
Propylene (Propene) C3Hg 0.4653
Silane SiHy 0.6733
Silicon Tetrachloride SiCly 0.3168
Silicon Tetrafluoride SiF4 0.3960
Sulfur Dioxide SO, 0.7228
Sulfur Hexafluoride SFg 0.2970
Trichlorosilane Cl3HSi 0.3267
Trimethylamine (CH3)3N 0.3168
Tungsten Hexafluoride WFg 0.2871
Uranium Hexafluoride UFg 0.2178
Vinyl Bromide CoH3Br 0.5248
Vinyl Chloride CoH3Cl 0.5347
Vinyl Fluoride CoH3F 0.5743
Xenon Xe 1.3762
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J MAINTAIN HIGH PURITY GASES

The analysis system was designed to accurately measure the surface area of all types of
materials. It is important that the gases (especially krypton) used for these measurements be of
highest purity, especially when analyzing low surface area samples. Three ways to ensure high
purity gases are to always maintain:

m Thoroughly purged gas pressure regulators.
m Non-permeable gas lines.
= Leak-free connections.

Impure gas is strongly indicated, for example, if a series of measurements on a low surface area
material yields decreasing specific surface areas with decreasing quantities of sample. The
analyzer uses very small amounts of helium; therefore any residual air in the regulator can distort
results of subsequent analyses for quite some time.

Micromeritics offers the following suggestions to assist in maintaining high purity gases
(particularly helium):

m Use metal gas lines only.
m Remove trapped air from the regulator and gas lines.

USE METAL GAS LINES

Always use metal gas lines which have been carefully cleaned of any oils and greases used in the
manufacturing process. Do not use plastic or rubber gas lines. When these types of permeable,
nonmetallic gas lines are used with helium, contaminants accumulate at a much faster rate. This
causes errors in analysis results and can also contaminate a clean sample.

REMOVE TRAPPED AIR

When connecting the regulator to the gas cylinder, air is unavoidably trapped on the high and low
pressure sides of the regulator, as well as in the gas lines. Remove as much of this air as is
possible before opening the gas cylinder valve. If this air is allowed to remain in the regulator, it
will mix with the helium and cause inaccurate results in subsequent analyses. Or if the valve is
open for any length of time, the air trapped on the high pressure side may diffuse back into the gas
cylinder and contaminate its entire contents.

There are two methods for removing trapped air from the regulator lines: the Purge Method and
the Evacuation Method.
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PURGE METHOD

This is the preferred method for removing trapped air.

1. Goto Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go to Unit [n] > Show Instrument
Schematic.

/ If multiple instruments are installed, choose the correct Unit menu.

2. Close all valves by right clicking each valve, then click Close.

Ambient
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3. Open the regulator shut-off valve.
4. Open the gas cylinder valve briefly and allow the regulator to be charged with gas until the
high pressure gauge reads just over half the tank pressure, then quickly close the valve.

Gas tubing to instrument
Gas regulator shut-off valve
Low pressure gauge

High pressure gauge

Gas cylinder shut-off valve
Regulator connecter nut
Regulator control knob
Brass reducer fitting

ITOMMOO >

5. Use the Pressure Control knob to set the output pressure (gas cylinder pressure gauge) to
15 psig.
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6. Loosen the fitting at the instrument helium inlet until the low pressure side drops to approx-
imately 3 psig (0.02 MPa), then tighten the fitting.

7. Repeat steps 4, 5, and 6 three times.

8. Briefly open the gas cylinder valve, then use the Pressure Control knob to reset the reg-
ulator output pressure to 15 psig.

9. After the pressure has stabilized (indicating there are no leaks), open the gas cylinder valve.
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EVACUATION METHOD

/ To use this method, the gas tank must be within 10 feet of the instrument.

1. Do one of the following:

If... Then...

The regulator has not | Close the gas cylinder valve.
been filled with gas and

the gas line is attached | Open the regulator shut-off valve.
to the instrument:

The regulator is filled Close the gas cylinder valve.

with gas: Open the regulator shut-off valve.

Loosen the helium inlet fitting (or nut) on the instrument.

Allow all of the gas in the regulator to expel from the line (pressure
reading will be zero).

Retighten the helium inlet fitting (or nut).

2. Go to Unit > Enable manual control (if the instrument schematic is not displayed, go to
Unit > Show instrument schematic).

/ If multiple instruments are installed, ensure the correct Unit menu is selected.

3. Close all valves, then open valves 6, 7, and 10.

4. Allow evacuation to continue for 20 minutes. This pulls a vacuum on the helium line to the
gas cylinder. The manifold pressure transducer should fall close to zero.

/ Allow evacuation for a full 20 minutes. If evacuation time is too short, trapped air may
remain in the lines.

5. Close valves 6, 7, and 10.
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K PEAK DETECTION / INTEGRATION OPTIONS

CFR Dynamic Analysis and Chemisorption options are not applicable when the software is
Note installedin 21CFR11 environments.

/ This section applies only to dynamic analysis samples.

File Open > [.RPO file] > [Integration button]

(or select the Integration button while in the Peak Editor)

Peak detection parameters can be customized using the Integration button on the Report
Options window or the Integration button on the Peak Editor window. Peak detection options can
be customized while creating the sample file or after analysis. For Pulse experiments and Loop
calibrations, peaks are found using events that occurred during the analysis — such as the time
an injection started — instead of peak detection options.

Peak Detection/Integration Options @

Standard Settings
Baseline mode (@ Best fit baseline

() Snap to baseline
Minimum peak height: 0.25 %F.5.
Peak smoathing: 0 points

MNumber of points for smoaothing. If peak
smoothing value is 0, automatic selection is
enabled (1% of data points). Its purpose is
identifying peak edaes; it does not affect
peak height or area.

Advanced Settings

Sensitivity: 0.01 %%F.5.
Maximum shoulder ratio: 33 %
|  Maximum group separation: 33 %
Minimum peak area: 1.00  %F.5.min
Maximum baseline slope: 0.10 %F.5./min
OK ] [ Cancel ]
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L TEMPERATURE PROGRAMMED ANALYSES

CFR Dynamic Analysis and Chemisorption options are not applicable when the software is
Note installed in 21CFR11 environments.

Most temperature-programmed experiments are based on the following highly simplified steps:

Gas flows into the analyzer.

The gas interacts with the sample as the temperature changes.
Gas flows past the detector.

The detector collects data.

The application plots and calculates results.

ok wbd=

\ | 3 \
7

/ Ll N/

How the Detector Works

The detector contains heated filaments that measure the difference in gas thermal conductivity
sensed between the gases flowing over the sample and reference filaments.

The gases flowing past the detector cool the filament by extracting heat. How quickly any type of
gas removes heat from the detector is determined by its thermal conductivity?) . A gas with a high
thermal conductivity cools the filament rapidly, and more power is required to maintain its
temperature. A gas with a lower thermal conductivity removes heat from the filament more slowly.

When the sample reacts with the gas, it causes changes in the composition of the gas and,
consequently, changes the thermal conductivity of the gas. These changes are sensed by the
detector as an increase or decrease in the amount of power required to maintain the filament at a
constant temperature.

1) The thermal conductivity of a gas is its ability to conduct heat. Each gas has a distinct thermal
conductivity.
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Data that are Collected

The detector reports the amount of electricity (in volts) required to keep its temperature constant
during the analysis.

The Role of the Sample Temperature

Because the sample’s temperature determines how rapidly it interacts with the analysis gas (or if it
reacts at all), data are collected over the range of temperatures specified.

In some experiments, you may prefer to start collecting data at a very low temperature to establish
a baseline where the gas is completely unaffected by the sample. In other cases, you may prefer
to collect data after a reaction has begun. In still other experiments, your primary interest may be
determining the temperature at which the maximum reaction occurs.

For example, consider the example of a Temperature-Programmed Reduction (TPR). During the
TPR, a metal oxide is reacted with hydrogen to form a pure metal. This reaction is referred to as
“reducing” the metal; for example, TPR of a catalyst containing Platinum. Argon, which has a very
low thermal conductivity, is used as a carrier gas. It is blended in a fixed proportion with hydrogen,
an analysis gas with a much higher thermal conductivity. Then the gas mixture flows through the
analyzer, through the sample, and past the detector.

When the gas blend begins flowing over the sample, a baseline reading is established by the
detector. This baseline is established at a low enough temperature that no reduction of the sample
is occurring, so the baseline level recorded by the detector is that of the thermal conductivity of the
two gases in their fixed proportion. In other words, the proportion of gases flowing over the
detector is the same as the proportion of gases entering the analyzer, because at the low
temperature, there is no interaction with the sample.

A. Gas flows into the sample tube and through the
sample.

B. Before the reaction begins, the concentration of
gases exiting the sample tube is unchanged after
flowing through the sample.
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The temperature is then changed, and when a critical temperature is reached, hydrogen atoms in
the gas flow react with the sample, forming H,O molecules. The H,O molecules are removed from
the gas stream using a cold trap. As a result, the amount of hydrogen in the argon / hydrogen gas
blend inside the analyzer decreases, and the proportion between the two gases shifts in the
direction of argon, as does the mixture’s thermal conductivity.

A. As the temperature changes, the sample begins to
react with the gas(es) flowing through it.

B. The concentration of gases exiting the sample tube
is altered after passing through the sample. This
change in the gas concentration is recorded by the
Thermal Conductivity Detector downstream.

Since argon has a lower thermal conductivity than hydrogen, the mixture’s thermal conductivity
consequently decreases. The flowing gas removes heat from the filament more slowly, requiring
less electricity to maintain a constant filament temperature. The analyzer records the electrical
demand as it changes (this is called the detector signal). The detector signal is recorded
continuously over a range of temperatures. When these readings are graphed, the data form one
or more peaks. Peaks can be positive or negative; negative peaks are show in this example.

Signal vs Time

3
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Negative Peaks Legend

Item Description

1 Baseline readings. The gas(es) is (are) not reacting with the sample, so there is no
change in the signal from reading to reading.

2 As the temperature changes, the sample begins to react with one of the gases. There-
fore the gas mix is then made up of a larger proportion of the other gas. This causes a
shift in the mixture’s thermal conductivity. The detector measures this change by
recording the change in the amount of electricity required to maintain constant filament
temperature.

3 As temperature continues to increase, the interaction reaches a maximum, then begins
to diminish.

4 As fewer and fewer sample atoms are available to bond with the analysis gas, there is
less and less change in the mix of gases flowing into the analyzer and past the
detector, so the thermal conductivity shifts back toward the baseline value.

This example illustrates the fundamental concept upon which the analyzer operates. Of course,
the various types of analyses the analyzer can perform result in different types of traces. For
example, a pulse chemisorption analysis results in a series of peaks that gradually increases in
size as the sample is dosed with separate increments of gas. Initially, the gas uptake by the
sample results in smaller peaks. But when all the active sites are saturated, no more gas can be
taken up and the peaks become equal.

PEAK AREA

The area beneath each peak is calculated to provide information about the volume of gas reacted
during the analysis. The Calculations document can be found on the Micromeritics web page
(www.Micromeritics.com).

AUTOMATIC OPERATION

The analyzer application provides a simple format to specify all the analysis conditions for the
experiment; create a sample file which contains sample information and a list of specific steps the
analyzer will follow to perform the experiment(s). Then, the analyzer automatically performs the
analysis, from controlling the gas mixture and flow rate to monitoring the temperature and
pressure. After analysis, use the Peak Editor to adjust the peaks to create reports that contain the
data needed, without baseline noise or other undesirable effects.

Because up to 99 experiments can be specified and each experiment can contain up to 99 steps,
the analyzer can perform a wide variety of preparation and analysis functions automatically.
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CoLD TRAP

In some cases, it is preferred to trap substances resulting from the reaction. In the previous
example, H,O is produced during the analysis. If the gas flow is passed through the cold trap at an
appropriate temperature, the water can be removed before the gas flows past the detector.

INJECTION LOoOP

Injection loops are provided for injecting carefully measured doses of gases for analyses such as
Pulse chemisorption. The analyzer is shipped with a 0.5 cm3 loop installed. A 1 ml loop is also
available. If the sample file is set so that a loop is used for introducing gas into the analyzer, the
analyzer will automatically dose the sample as specified in the sample file.

SAMPLE PREPARATION AND CALIBRATION

Depending on the type of experiment(s) to be performed, sample preparation and/or calibration
may be required. Specific instructions are contained in the appropriate sections of this manual.

A sample is prepared for analysis by removing unwanted adsorbates from the surface of the
sample. This is usually accomplished by flowing gas over the sample and may include heating the
sample. The flowing gas may be inert or chemically active gases may be used to activate the
surface.

Calibration routines provide the analyzer and application with the appropriate information to
convert electrical signals to physically meaningful data such as volume adsorbed, loop volume,
and gas concentration.
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M VAPOR PURIFICATION

Physical adsorption of gases is generally used to calculate pore size and surface area of solid
materials. Using vapor adsorptives allows the sorption capacity and isosteric heat of adsorption,
the energy released as molecules adsorb on the sample surface, to be calculated by using
isotherms collected at different temperatures with the same vapor and adsorbent. Heats of
adsorption data are very useful in research applications. In the case of competitive adsorption, the
vapor with the highest heat of adsorption will adsorb first and have the strongest interaction with
the surface. However, if the heat of adsorption is too high, the molecule will be so strongly
adsorbed that desorption or regeneration of the material may be difficult. In order to properly
collect vapor isotherms, a purified vapor must be used. A liquid-filled reservoir is used as the
source of the vapor.

This procedure describes a freeze-thaw method to remove dissolved gases and air within the
reservoir so the vapor purity is suitable for analysis on the Flex. The general principles of this
method could also apply to vapor purification on other gas adsorption instruments. The basic
principle is to evacuate non-condensed species while the vapor reservoir is immersed in a
cryogenic bath. At the pressures achieved during the purification process, nitrogen and oxygen
are not condensed. The use of liquid nitrogen is limited to vapors that will not sublimate at
cryogenic temperatures.

:é 7oA
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1. Fill a clean vapor reservoir with liquid. Fill halfway (10 ml) if using water. Fill with approx-
imately 20 ml for other liquids.

2. Attach vapor reservoir to the Flex. See Vapor Source Container Installation on page 11-

17 in the Flex operator manual.

Firmly close the vapor shut-off valve above the liquid-filled reservoir.

On the schematic, open valve 4 to evacuate the space above the vapor shut-off valve.

Close valve 4 on the instrument schematic, then open the vapor shut-off valve on the reser-

voir. Allow the pressure to equilibrate in the vapor container.

o bk w

Flex Series Operator Manual
350-42800-01 (Rev R) — Apr 2021



M Vapor Purification EI micromeritics®

6.

Submerge the vapor reservoir in a cryogen bath. The use of liquid nitrogen as the cryogen
should be limited to vapors with no sublimation pressure at cryogenic temperatures. Wait
for the pressure in the vapor container to drop as low as possible. This may only be 150 Torr
for the first cycle but should be near zero after two or three cycles. A lab jack is useful to
hold and adjust the Dewar filled with liquid nitrogen.

Once the vapor has condensed and has frozen, open valve 4 on the instrument schematic
with the cryogen bath still in place and evacuate the vapor container (the vapor shut-off
valve should still be open). Pressures in the range of 104-10"° Torr should be achievable.
Close valve 4 on the instrument schematic and remove the cryogen bath. Let the vapor con-
tainer thaw. The vapor shut-off valve should remain open during this step. To expedite the
process, a warm water bath may be used temporarily to raise the temperature of the vapor
container closer to the ambient temperature. However, a layer of ice formed on the reservoir
could also create a barrier for heat transfer, so it is best to not introduce the water bath
immediately. If pressure stabilizes near the calculated saturation pressure at room tem-
perature, the vapor is free of impurities.

If the pressure does not stabilize around the calculated saturation pressure, repeat steps 3
to 8 until the pressure at the last step stabilizes near the calculated saturation pressure of
the vapor. When the vapor is pure, the pressure should stabilize around the same value
after each thawing cycle. Typically, three total purification cycles (two repeats) is sufficient.
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N Wetted Materials

N WETTED MATERIALS

Wetted Materials

Contact Micromeritics for assistance before running a gas such as ammonia or pyrid-
ine that is incompatible with some of the system components.

Material

Location

304 stainless steel , 403 stainless steel , Ceramic
(Al203), Silicon, SiO02, Si3N4, Gold, Viton, Low out
gassing epoxy resin

Vacuum gauge

316 Stainless Steel, Hastelloy C-22, 17-7 PH, 430SS,
Nickel, Kalrez (FFKM)

Mass Flow Controller (MFC) (for
chemisorption only)

Aluminum

NWY/KF ring in vacuum line

Aluminum alloys, stainless steels, fluoroelastomer
and nitrile O-rings, hydrocarbon lubricant, felt, rare
earth magnets, silicon nitride, phenolic resin, carbon-
fiber reinforced epoxy resin, fire retardant polypro-
pylene, polyamide and PVC.

Turbo pump

Borosilicate Glass

Physisorption sample tubes, filler
rods

Buna-N

m Gas inlet manifold, valve plun-
gers, and O-rings
= NW/KF ring in vacuum line

Buna-N, stainless steel, Platinum

TranSeal (optional)

Copper

Gas inlet lines

FFKM (Kalrez)

m Optional sample port O-rings
= Servovalve

Gold-plated copper

Turbo vacuum pump gasket and
vacuum gauge

Gold-plated nickel / iron

TCD filaments

Inconel

Transducers

Kel-F (PCTFE )

m Valve seats analysis manifold
m Valve seat exhaust valve
(chemisorption only)
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Wetted Materials (continued)

Material Location

PCTFE (Kel-f), Buna-N, FKM (Viton), Stainless steel, | Check seal (optional)
Borosilicate Glass

PTFE, FPM (fluroelastomer), Aluminum Diaphragm roughing pump

Quartz Chemisorption sample tubes, filler
rods, wool filter discs

Stainless steel = Manifolds, valve bodies, plumb-

ing, VCR gaskets, port trans-
ducers, filler rods.

m Gas inletlines (optional)

m Ferrules in exhaust line
(chemisorption only)

= TCD block

Teflon (PTFE) Ferrules in gas inlet manifold, PO
tube

Viton type A (FKM) Sample port O-rings
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O WORKSHEETS

Worksheets in this section may be copied as needed.

Sample Data Worksheet for Chemisorption on page O - 3
Sample Data Worksheet for Gas Adsorption on the next page
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SAMPLE DATA WORKSHEET FOR GAS ADSORPTION

Sample tube identification:

Sample Mass (g)

Before Degas | After Degas | After Analysis
Mass of empty sample tube set g
Mass of sample tube set plus sample g g g
Mass of sample (step 2 minus step 1) g g g

Degas Information

Degas apparatus

Temperature (°C)

Time (hours)

Actual time started

Actual time finished

Degas Notes:
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SAMPLE DATA WORKSHEET FOR CHEMISORPTION

Sample tube identification:

Sample Mass (g)

Before Degas After Analysis
Mass of empty sample tube set g g
Mass of sample tube set plus sample g g
Mass of sample (step 2 minus step 1) g g

Notes:
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micromeritics
EU DECLARATION OF CONFORMITY

This declaration of conformity is issued under the sole responsibility of the manufacturer:

Micromeritics Instrument Corporation
4356 Communications Drive
Norcross, GA 30093, USA

Hereby declares that the product:

FLEX™ SERIES Surface and Catalyst Characterization Analyzer
Models: 3Flex {3500)

is in conformity with the following EU harmonization legislation:

2014/35/EU - LVD Directive
2014/30/EU - EMC Directive
2011/65/EU - RoHS Directive

and that the equipment is in conformity with the following harmonized and other appropriate standards;

2014/35/EU (LVD)

EN 61010-1:2010/A1:2019 - Safety requirements for electrical equipment for measurement, control, and laboratory
use — Part 1: General requirements.

EN 61010-2-010:2014 - Particular requirements for laboratory equipment for the heating of materials

EN 61010-2-081:2015 - Particular requirements for automatic and semi-automatic laboratory equipment for analysis
and other purposes

2014/30/EU (EMC)

EN 61326-1:2013 - Electrical equipment for measurement, control and laboratory use — EMC requirements — Part 1:
General requirements

EN 61000-3-2:2014 - Part 3-2: Limits — Limits for harmonic current emissions (equipment input current < 16 A per
phase)

EN 61000-3-3:2013 - Part 3-3: Limits — Limitation of voltage changes, voltage fluctuations and flicker in public low-
voltage supply systems, for equipment with rated current <= 16 A per phase and not subject to conditional connection

2011/65/EU (RoHS)

EN 63000:2018 - Technical documentation for the assessment of electrical and electronic products with respect to the restriction of
hazardous substances

Name: John McCaffrey, Ph.D. Title: Vice President, R & D
Signature: (ﬁﬁ\, U/f Date of issue: 04/14/2021

Location: Norcross, GA USA

Document  350-49001-08 Revision ( 1)) 2021-04-14 Release #210035
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Index

INDEX

A

about this manual iv
active metals 3-13
adsorptive properties
create file 4-2
air filter, power supply, clean 12-11
Alpha-S method report 8- 3

analysis
blank analysis 6 - 25
perform 6 - 1

prepare for 6 -4
pulse chemisorption 2-33, 6 - 26
reference material analysis 6 - 30
sequence 6-23
TPD 6-37
TPO 6-39
TPR 6-41
types
pulse chemisorption 2-33
TPD 2-31
TPO 2-32
TPR 2-32
vapor analysis 6 - 43
analysis conditions 4 - 19
chemical adsorption tasks 4- 13
degas 4-5
parameter file 4-5
analysis types 2 - 31
analyzer
about 71-1
configure 2-15
schematic 2-24
show status 2 - 30
software 2- 1
type, specify 2-18
atomic weights B - 1

B

BJH
plot options 8- 11
report options 8-7
tabular report options 8- 12
BJH adsorption, cumulative pore volume
3Flex
report example 7 -44
BJH desorption cumulative pore volume
report example 7-43
burette. soap bubble 10 -4

C

calibration 10-1
cryostat D- 13
gas flow constant 10-2
load from file 10- 17
loop 710-15
match transducers 10-6
pressure transducer scale 70- 8
reset pressure 710- 10
sample servo valve 10- 10
save tofile 10-17
signal 10-11
calibration report 10- 13
calibration, file list 10 - 14
signal, file open 710-13
TCD
calibration file 710-12
catalyst pretreatment 2 - 33
chemical adsorption
tasks 4-13
clean
dewar 12-13
fillerrod 6-5
sample tubes 6-5
coldtrap 711-2
constant, individual gases 10-5
contact us Jii
control chartreport 7-7
corporate profile Ji
cryogen requirements 1-6
cryostat
about D -1

BET surface area plot report example 7 -42
BET surface area report example 7-41

calibration D-13
elevator D - 1
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enable D-1

operating instructions D - 2
preventive maintenance D - 12
remove from analyzer D -7
rotameter scale readings D - 8
sample file D -4

sample tube, install D - 6
troubleshooting D -9

D

dashboard
show 2-21
datalogging E - 1
data, manually enter 3-9
degas
in situ, heating mantle 5- 3
samples 6-20
SmartVacPrep 5-7
degassing
about 5-1
dewar
filland install 6-21
precautions 6-2,6-2,6-21
Dewar
check 12-13
clean 12-13
refill during analysis 6 - 44
DFT
model references F- 17
models based on classical theories F- 13
models based on statistical ther-
modynamics F -1
pore size report
options 8-13
regularization 8- 14, 8- 14
surface energy report options 8- 15
DFT Models F-1
diagnostics 9- 1
clean and verify the gas line 12-5
leak test 13-7
save files for problem diagnosis 9-5
schedule 9-3,9-3
show all readings 9-6
starttest 9-1
testreport 9-4
Difference method 8-61

Difference method report 8- 16
Dollimore-Heal
plot options 8- 22
report options 8- 19
tabular report 8- 23
Dubinin
pore volume report options 8- 26
report options 8 - 24
tabular report options 8- 27
transformed isotherm plot options 8- 28
dynamic analysis 4- 19
peak editor 2 - 34

E

EFUP viii
elevator, lubricate drive assembly 12 - 714
environmental defaults 2 - 20
environmentally friendly use period viii
equipment options and upgrades 17 -4
evacuate ports 5-8
evacuationrules 4-16
evaluate reportresults 7- 19
experiment steps

Flex 4-20
export files 2-35
exported data example G - 1

F

f-Ratio method report 8- 29
fields and buttons, common 2-3
file status 2-6
files

export 2-35

list 2-35

open asample file 3-7
fillerrod, clean 6-5
First Order Kinetics

report option 8- 31
flow measurement 10-3
free-space correction H- 1
free space

calculating values for micropore

analyses C-1
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Index

Freundlich report 8- 32
furnace
installation 17-4, 11-5
secure to elevator tray 717-5

G

gas
charts /-1
clean and verify the gas line 12-5
connect gas cylinder 712-9
conversion constants /-3
disconnect gas cylinder 712-8
flow
change during analysis 12 -22
constant calibration 70-2
guidelines for connecting 12 -4
maintain high purity gases J- 1
metal gas lines J- 1
replacement cylinder 712-8
requirements 7-6
typical used /-2
gas adosrption
report examples 7 -41
gas ports 2-15
general safety vi
graph
features and shortcuts 7 - 29
generate overlays 7 - 34
report options 8- 35
TCD analyzers 8- 35

H

hardware
pivot shelf 171-11
hardware installation 7171-1
heat of adsorption report 7 -2
heating mantle
installation 171-7
schematic 2-29
Horvath-Kawazoe
plot options 8-41
report options 8- 38
tabular report options 8-41

install

furnace 171-4

heating mantle 171-7

sample tube 6-10,6-16
instrument exterior, clean 12 - 14
instrument, status 2 -21
integration

dynamic analysis K- 1

peak editor K- 1

report options K- 1
intended use vii
interactive reports 7- 10
isotherm linear plot report example 7-45
isotherm report option 8-42
isothermal reaction 2-33

L

Langmuir
report option 8-44
leaks
performtest 13-7
libraries 2-12
listfiles 2-35
log
show instrument 2 - 23
loop
calibration 6-27
volume 6-26
loop calibration 710- 15
report example 7 -46
loop calibration report option 8 -47

maintain high purity gases J- 1
maintenance 12-1
clean and verify the gas line 12-5
clean instrument exterior 12 - 14
connect gas cylinder 12-9
disconnect gas cylinder 712-8
guidelines for connecting gases 12-4
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replace septum 171-15
replacement cylinder 12-8
sample tube O-ring 12 - 20
TCD assembly 717-16
vacuum pump 713-5
manual control
enable 11-3
manual, about this iv
mass flow controller 2-27
calibration 70-3
soap bubble burette 70 -4
match transducers, calibration 70-6
materials, wetted N - 1
menu structure 2-2
methods, about 2- 13
MicroActive reports 7-11
MP-Method
plot report options 8- 50
report options 8 -48
tabular report options 8- 51

N

NLDFT advanced PSD report 8-52

O

O-ring compatibility 73-6
operating instructions, cryostat D - 2
option presentation 2- 10
options report 8- 56
overlays
generate 7-34
multiple graph 7 - 34
sample file 7-37

P

parameter files
about 4-1
adsorptive properties 4 -2
analysis conditions 4-5
file name extensions 4- 1
report options 4 - 31
sample tube 4 - 33

parts and accessories 17-10
peak editor 7-12
dynamic analysis 2 - 34
pivot shelf 171-11
plot options
BJH 8- 11
Dollimore-Heal 8- 22
Dubinin transformed isotherm 8- 28
Horvath-Kawazoe 8-41
MP-Method 8- 50
pneumatic pressure 13-9
pore distribution data, import 7-40, 7 -40
port, backfill 5-2
power 13-5
power analyzer on and off 12-15
power failure, recover from 13-9
pressure calibration, reset 10- 10
pressure offset 10-7
pressure transducer scale calibration 710-8
preventive maintenance 12-12
cryostat D- 12
Psat
replace gasket 12- 16
replace tube ferrule 712- 16
pulse chemisorption
analysis 2-33,6-26
report option 8- 57
pump
oil-based vacuum pump 713-5
purge system 12-22
Python module A - 1
acquire basic information A- 10
acquire metal composition data A - 20
acquire overlay sample data A- 16
acquire reportresults A - 14
advanced reports A-1
get adsorptive data A - 32
get imported pore data A - 36
get metal composition A - 37
getreportresults A - 34
get sample information item A - 33
graphic report A - 25
MicModule Python calls A - 22
get overlay isotherm data A - 30
get primary isotherm data A - 28
overlay data A-19
reports A-6
scripts A-4
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Index

summary report A - 24
tables A-22

Q

quartz filter discs 6- 14

R

reference material analysis 6 - 30
references, DFT models F-17
regressionreport 7-5
relative thermal conductivity /- 1
report
summary
physical adsorption 8- 62
report examples
-t-Plot 7-47
BET surface area 7-41
BET surface area plot 7 -42
BJH desorption cumulative pore
volume 7-43
Flex
BJH adsorption, cumulative pore
volume 7-44
gas adsorption analyzers 7 - 41
isotherm linear plot 7 -45
loop calibration 7-46
TCD signal vs temperature 7 -48
TCD signal vstime 7-49,7-50,7-51,7
-562,7-53
report options
First Order Kinetics 8- 31
graph report TCD analyzers 8- 35
reports
about 7-1
advanced, Python module A - 1
Alpha-S method 8- 3
BET surface area 8- 5
BJH
adsorption/desorption 8-7
plot options 8- 11
tabular report 8-12
Control Chart 7-7
DFT pore size 8-13

DFT surface energy 8- 15
Difference method 8- 16, 8- 61
Dollimore-Heal
adsorption/desorption 8- 19
plot options 8- 22
tabular report 8- 23
Dubinin 8-24
pore volume 8-26
tabular 8-27
transformed isotherm plot 8- 28
evaluating reportresults 7- 19
f-Ratio method 8- 29
features and shortcuts 7-25
graphs 7-29
reports 7-25
Freundlich 8- 32
generate graph overlays 7 - 34
generate sample file overlays 7 - 37
heat of adsorption 7-2
Horvath-Kawazoe 8- 38
plot options 8- 41
tabular report options 8- 41
interactive 7-10
isotherm 8-42
Langmuir 8-44
MicroActive 7-11
MP-Method 8- 48
plot report options 8- 50
tabular report options 8- 571
NLDFT Advanced PSD 8- 52
options 4-31, 8-56
regression 7-5
sample audit trail 8-60
sample log 8- 60
selected 8- 1
Sinfelt method 8- 16, 8-61
SPC report options 7 -4
summary report options 8- 63
t-Plot report options 8 - 64
Temkin 8- 67
validation report options 8- 70

reports, Python module A -6
rotameter scale readings D - 8

S

safe servicing 12-3
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sample software
degas 6-20 about 2-1
mass, determine 6-8,6-13 for21CFR11 2-37
transfer to analysis port 5-4 setup 2-35

sample analysis

perform 6 - 33
sample audit trail report 8- 60
sample data worksheet O-2, O-3
sample file 3-2

about 3-1

cryostat D -4

open 3-7

overlays 7-37
sample log

report 8 - 60
sample servo

valve calibration 10- 10

sample tube
clean and label 6-5
cryostat D-6

installation 6-10,6-16
on schematic 2-26
parameter file 4-33
quartz filter discs 6 - 14
sample tube O-ring replacement 12 -20
schematic
heating mantle 2-29
instrument 2 - 24
shortcuts 2-27
transducers 2-29
septum
properuse 171-13
replace 11-13,11-15
shelf, pivot 11-11
shortcuts
schematic 2-27
shortcuts, application 2-8
show instrumentlog 2- 23
show instrument schematic 2 - 24
signal
calibration 70-11
filelist 10- 14
file open 10-13
report 70-13
Sinfelt method
report 8- 16, 8-61
soap bubble burette 10-4

updates 2-36
software uninstall 2-36, 2-42
SPC report 7-4
specifications 71-7
status
analyzer 2-30
instrument 2 - 21
summary report
options 8-63
physical adsorption 8- 62
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t-Plot
report example 7 -47
report options 8 - 64
tabular reports
BJH 8-12
Dollimore-Heal 8-23
Dubinin 8-27
Horvath-Kawazoe 8-41
MP-Method 8- 51
TCD
assembly, maintenance 17-16
signal vs temperature
, report example 7-48
TCD signal vs time
report example 7-49,7-50,7-51,7 -
52,7-53
Temkin report options 8- 67
temperature programmed
analyses L-1
desorption analysis 2- 31
oxidation analysis 2-32
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reduction analysis 2-32
temperature programmed decomposition
analysis 6 - 37
temperature programmed oxidation
analysis 6 -39
temperature programmed reduction
analysis 6 -41
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TPD analysis
description 2-31
TPO analysis 2-32,6-39
TPR analysis 6 - 41
description 2-32
transducers, schematic 2 - 29
TranSeal 12-21
troubleshooting 13- 1
and maintenance
elevator drive assembly, lubricate 12 -
14
leak test, perform 13-7
manual control, enable 771-3
power failure, recover from 713-9
power supply air filter, clean 12 - 11
preventive maintenance 12-12
Psat fitting gasket, replace 712- 16
Psat tube, ferrule 12-16
sample portfrit 12-18
cryostat D-9

U

unit configuration, specify gas ports 2- 15
unit selection 2- 19

\'

vacuum pump
oil-based 13-5
validation, report options 8- 70
vapor analysis, perform 6 - 43
vapor purification M - 1
vapor source
container, install 17-17
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wetted materials N -1
worksheet

sample data O-3
worksheet, sample data O-2
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